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Welcome to The Media Streaming Journal

Welcome to the latest edition of The Media Streaming Journal.

Software  based  multimedia  editors  have  increased  in  their  value  over  the  years.  Open  Source
multimedia  editor  applications  have  nudged  proprietary  software  applications  to  improve  their
effectiveness and ease of use. Kdenlive performs non-destructive editing on the source material and has
been around since 2000 with constant updates.

Please feel free to contact either the Publication Director (Derek Bullard) or myself if  you have any
questions or comments regarding The Media Streaming Journal.

Namaste

David Childers

The Grand Master of Digital Disaster
(Editor In Chief)
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www.radiosolution.info
Our Mission

Let our friendly, knowledgeable staff assist you to build your project, such as an online radio station
using our high end reliable video and audio streaming technologies. We want to become your partner for
all your hosting needs, as well as your one stop shop for radio products such as custom DJ drops and
radio ID’s.

Start An Internet Radio Station

Whatever you need to start Internet radio station, we will deliver! We provide high quality Internet Radio
services to make your music radio project a success. We can provide Wowza, Icecast, SHOUTcast hosting
and internet  radio  services to hobbyists,  deejays,  amateurs  and established professionals.  No radio
station client is too big or too small for Radiosolution.

Choose between complete hassle-free service packages or new features to add to start internet radio
station. Benefit from customized services and the latest in internet radio technology. You will receive
professional, personalized and better Internet Radio Station services than you have received up till now.
If you already have an Icecast or SHOUTcast hosting provider, we can still help you transfer your radio
server over to us with no hassle and at no charge.

Internet Radio Station Services

Launch your internet, digital, satellite or AM/FM radio station anywhere in the world with all of the right
tools.  A broadcasting specialist  is on standby to help you get started with an SHOUTcast or Icecast
hosting package. We have servers ready for reliable streaming in North America and Europe. Our hosting
packages  have  all  the  features  you  need  to  make  your  radio  station  project  a  success.

If you stream live or with an Auto DJ, we can provide you with the latest in web-based Cloud technology.
You will love the simple to use control panel. Discover how easy it is to manage live deejays, upload
fresh music and create custom scheduled programming. You will  be able to track your listeners by
getting real time statistics.

Starting your own Internet radio has never been easier.  Get in touch with us anytime to start  your
Internet radio station.

Radiosolution is a SHOUTcast hosting provider located in Quebec Canada. We also offer Icecast, Wowza
and Web Hosting services. Contact us to discuss the best option available as you start internet radio
station.  Radiosolution  can  provide  personalized  service  in  English,  Dutch,  and  French.  Starting  an
internet radio station can be intimidating, many people want to start one, but have no idea where to
start.  Radiosolution will  be there for you every step of  the way. Everyday people are searching the
internet for free SHOUTcast servers. With Radiosolution SHOUTcast hosting we will allow you to try our
services for FREE. By trying our services, you can be confident that you have chosen the best radio
server hosting provider. You have nothing to loose because we offer a 30 day satisfaction guarantee.
What are you waiting for? Contact us now! Radiosolution offers everything you need to start internet
radio station. You will not need to go anywhere else. We can create your website, market your station
and help you submit your station to online directories. We also feature the voice of Derek Bullard aka
Dibblebee He can create affordable commercials, DJ intros, sweepers, jingles, ids and so much more.

http://www.radiosolution.info/


The Order of the Iron Test Pattern is an association of people who have had the opportunity to work in or
around  the  television  and  broadcast  /  cable  industry.   People  who  have  an  interest  in  television
broadcasting are also welcome. 

                                              

https://www.facebook.com/Order-Of-The-Iron-Test-Pattern-103689774780581/

Hey You! Yes, You!
Why Should Anyone Listen to You?!

Do you need compelling, clever copy or catchphrases for
your Internet station?  If you do, please visit and let’s talk!

http://www.ielectrify.com/work-with-me/

I am a professional writer with 15+ years of experience
creating high-converting copy, for a variety of radio,

broadcasting and marketing applications.
https://www.wpclipart.com/people/professions/professions_3/

radio_announcer.png.html
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Kdenlive Manual

Kdenlive is a Non-Linear Video Editor and is free software primarily aimed at the Linux platform. The
software  can  also  work  on  BSD,  relying  only  on  portable  components.  Windows  versions  are  also
available, with some drawbacks. See Windows issues for more information. A port on MacOS is currently
in progress.



Kdenlive Manual
Welcome to the manual for kdenlive [https://kdenlive.org], the free and open source
video editor.

You can download this manual as an EPUB
[https://docs.kdenlive.org/en/epub/KdenliveManual.epub].

Getting started

Introduction

Installation

Quick Start
Basic workflow with a video example.

Tutorials

User Interface

User interface
Introduction to Kdenlive’s window system and widgets

https://kdenlive.org/
https://docs.kdenlive.org/en/epub/KdenliveManual.epub


Project Settings Dialog
Setting the correct project values

Key components
The Project Bin

Timeline

Monitors

Toolbars

Keyboard Shortcuts
Improve your workflow by using the keyboard

Workflow

Importing and assets management
Load files into Kdenlive and be prepared

Starting video editing

file:///C:/temp/calibre_20xkoptj/a0a3k5wx_pdf_out/importing_and_assets_management.html


Cutting and assembling
Start editing in the Timeline

See how the time line and the monitors are working

Effects
Add video and audio effects and compositions.

Create Titles and Subtitles and use Speech to Text.

Make color correction.

file:///C:/temp/calibre_20xkoptj/a0a3k5wx_pdf_out/cutting_and_assembling.html
file:///C:/effects_and_compositions/effects.html


Exporting
Render out your final video for distributing.

Troubleshooting, Glossary, Get
Involved

Troubleshooting
Solving specific Windows issues

General problem solving

Bug Reports
[https://kdenlive.org/en/bug-reports/]
How to file a bug.

Glossary
References and further information.

Get Involved

file:///C:/temp/calibre_20xkoptj/a0a3k5wx_pdf_out/exporting.html
https://kdenlive.org/en/bug-reports/
https://community.kde.org/Kdenlive/Workgroup/Documentation


[https://community.kde.org/Kdenlive/Workgroup/Documentation]
Contribute to this Manual.



Getting started
A short overview to start with Kdenlive.

Contents:

Installation
Minimum system requirements
Non-KDE Desktops
Kdenlive on Windows
Kdenlive in a Windows domain
Kdenlive on macOS
Configuration Information

Introduction
Video editing features

Quick Start
Creating a new project
Adding clips
Timeline
Rendering
References and notes

Tutorials
Written Tutorials
Video Tutorials



Installation
Visit the download [https://kdenlive.org/download/] page of the Kdenlive Web site for up to date information on installing
Kdenlive.

Minimum system requirements

Operating system: 64-bit Windows 7 or newer, Apple macOS 10.13.6 (High Sierra) or newer, 64-bit Linux.
Details see below.

CPU: x86 Intel or AMD; at least one 2 GHz core for SD-Video, 4 cores for HD-Video, and 8 cores for 4K-Video.
Details see below.

GPU: OpenGL 2.0 that works correctly and is compatible. On Windows, you can also use a card with good,
compatible DirectX 9 or 11 drivers.

RAM: At least 4 GB for SD-Video, 8 GB for HD-Video, and 16 GB for 4K-Video.

Note

If your computer is at the lower end of CPU and RAM requirements, you should use both the Preview Resolution
and Proxy features to help reduce preview lag.

Non-KDE Desktops

Kdenlive can be installed on non-KDE Desktops without any issues.

Kdenlive on Windows

Kdenlive runs only on 64bit version of Windows. Kdenlive runs on Windows 7 and newer. We cannot guarantee that
Kdenlive runs on server or embedded Windows version.

Kdenlive is available as an install and as a standalone version.

Install version: Needs administrator rights and gets installed on your local machine. It’s also listed as a
program.

It’s available for all users on your computer.
The Kdenlive files are always located in the same folder.

Standalone version: Doesn’t need administrator rights and isn’t installed. It’s not listed as a program. Is only
accessible for the user who has downloaded the file.

If you work with a normal user on your computer, you can use Kdenlive.
You can copy the Kdenlive folder on any external drive and run it on a different computer without
installing it. However, your personal settings and downloads within Kdenlive are related to the
computer you work on.

Double click the downloaded file.

https://kdenlive.org/download/


Point to the folder you like to store the Kdenlive folder

To start Kdenlive navigate to the bin folder and double click Kdenlive

Kdenlive in a Windows domain

If you want to use Kdenlive with domain users with using Windows Active Directory and/or Group Policies (GPOs)
make sure all users have read/write rights to the following folders:

%AppData%\kdenlive

%LocalAppData%\kdenlive

%LocalAppData%\kdenliverc

%LocalAppData%\kdenlive-layoutsrc

%LocalAppData%\kxmlgui5\kdenlivekdenliveui.rc

%AppData%\kdenlive\.backup

%LocalAppData%\knewstuff3

Do also make sure no GPO is blocking the access to these folders.

Kdenlive on macOS

Kdenlive runs with Intel based Mac’s on macOS 10.14 (Mojave) and newer (available on the download
[https://kdenlive.org/download/] page).

New in version 22.04.0.

Kdenlive is running with Intel based Mac’s not older than 10.13.6 (High Sierra) and on M1.

Install procedure

https://kdenlive.org/download/


Choose the option Open with DiskImageMounter (Default).

When the dmg file is downloaded, the DiskImageMounter will open. Drag the Kdenlive Logo into the Applications
Folder.

The files get copied.

MacOS will try to check the files for malware.

The message “kdenlive” cannot be opened, because Apple cannot search for malware in it will appear. Here you
have to click Show in Finder.



The Finder opens. Now right click on Kdenlive and choose Open.

The message that Apple can’t search for malware will appear again. Just click on Open and Kdenlive will open up.

Configuration Information

Kdenlive’s application-wide persistent settings are stored in the following locations, depending on your platform.

Linux Windows

~/.config/kdenliverc %LocalAppData%\kdenliverc



Linux Windows

~/.config/kdenlive-appimagerc

~/.config/session/kdenlive_*

~/.cache/kdenlive %LocalAppData%\kdenlive

~/.local/share/kdenlive %AppData%\kdenlive

~/.local/share/kdenlive/lumas %LocalAppData%\kdenlive\lumas

~/.local/share/kdenlive/.backup %AppData%\kdenlive\.backup

~/.config/kdenlive-layoutsrc %LocalAppData%\kdenlive-layoutsrc



Linux Windows

~/.local/share/kxmlgui5/kdenlive/kdenliveui.rc %LocalAppData%\kxmlgui5kdenlive\kdenliveui.rc

~/.local/share/knewstuff3 %LocalAppData%\knewstuff3

Windows

To reach above folders: windows + r then copy above path into the window.



Introduction

Contents

Introduction
Video editing features

Kdenlive is an acronym for KDE [http://www.kde.org] Non-Linear Video Editor.
It is a free software (GPL licensed [http://www.fsf.org/licensing/licenses/gpl.html])
primarily aimed at the Linux platform, but it also works on BSD [1] as it
relies only on portable components (Qt [https://www.qt.io/] and MLT
[http://www.mltframework.org/] framework). Windows versions are also available,
with some drawbacks. See Windows issues for more information. A port on
MacOS is currently in progress [https://invent.kde.org/multimedia/kdenlive/-/issues/993].

Non-linear video editing is much more powerful than beginners’ (linear)
editors, hence it requires a bit more organization before starting. However, it
is not reserved to specialists and can be used for small personal projects.

Through the MLT framework, Kdenlive integrates many plugin effects for
video and sound processing or creation. Furthermore Kdenlive brings a
powerful titling tool, a subtitling feature with automatic speech to text
conversion, and can then be used as a complete studio for video creation.

Video editing features

Multitrack edition with a timeline and virtually unlimited number of
video and audio tracks, plus facilities for splitting audio and video from
a clip in multiple tracks
Non-blocking rendering. You can keep working on a project at the same
time a project is being transformed into a video file
Effects and transitions can be used with ease, and you can even create
some wipe transitions of your own!

http://www.kde.org/
http://www.fsf.org/licensing/licenses/gpl.html
https://www.qt.io/
http://www.mltframework.org/
https://invent.kde.org/multimedia/kdenlive/-/issues/993


[1]

Simple tools for easy creation of color clips, text clips and image clips
Automatic Clips creation from pictures directories, with crossfade
transitions among the images
Configurable keyboard shortcuts and interface layouts
and much more!

Berkeley Software Distribution



Quick Start

Contents

Quick Start
Creating a new project
Adding clips
Timeline

Effects
Music

Rendering
References and notes

Creating a new project

Kdenlive directory structure

The first step is creating a new (empty) folder for our new project. I will call
it quickstart-tutorial/ in this tutorial. Then get some sample video
clips, or download them from here kdenlive-tutorial-videos-2011-
avi.zip (7 MB) [1] , and extract them to e.g. a quickstart-
tutorial/Videos/ subfolder inside the project folder.

The image on the left shows the suggested directory structure: Each project
has its own directory, with video files in the Videos subdirectory, audio files
in the Audio directory, etc. (Project and File management)



(The tutorial from now on assumes that you use the sample videos provided,
but it works with any.)

New Project dialog

Open Kdenlive and create a new project File ‣ New.

Choose the previously created project folder (quickstart-tutorial/) and
select an appropriate project profile. The video files provided above are
720p, 23.98 fps. [2] If you are using your own files and don’t know which
one to use, Kdenlive will suggest an appropriate one when the first clip is
added [3] , so you can leave the field on whatever it is.

If you like you can change to the dark theme: Settings ‣ Colour Theme i.e
Breeze-Dark

Adding clips



Project Bin: Adding video clips

Now that the project is ready, let’s start adding some clips (i.e. the ones you
downloaded). This works via the Project Bin widget; a click on the Add Clip
or Folder icon  directly opens the file dialog, a click on the small arrow
shows a list of additional clip types that can be added as well. Video clips,
audio clips, images, and other Kdenlive projects can be added via the default
Add Clip or Folder dialog.



Kdenlive window with the tutorial files

After loading the clips, Kdenlive will look similar to this. On the top left
there is the already known Project Bin. Right of it are the monitors that show
video; The clip monitor displays video from the original clips, the project
monitor shows how the output video will look, with all effects, transitions,
etc. applied. The third, also very important, item is the timeline (below the
monitors): This is the place where the video clips will be edited. There are
two different types of tracks, Video and Audio. Video tracks can contain any
kind of clip, audio tracks as well – but when dropping a video file to the
audio track, only the audio will be used.

Saving a Kdenlive project

Let’s save the work via File ‣ Save. This saves our project, i.e. where we
placed the clips on the timeline, which effects we applied, and so on. It can
not be played. [4] The process of creating the final video is called
Rendering.

Timeline

See also Timeline

Now comes the actual editing. Project clips are combined to the final result
on the timeline. They get there by drag and drop: Drag some Napoli
(assuming you are using the files provided above, as in the rest of this quick



start tutorial; If not, please make sure your screen is waterproof, and perhaps
tomatoproof) from the project bin, and drop it onto the first track in the
timeline. In this case track V2.

First clips in the timeline

Since some cutlery is needed as well, grab the spoon clip and drop it on the
first track as well (track V2). Then drag the Napoli to the beginning of the
timeline (otherwise the rendered video would start with some seconds of
plain black), and the Spoon right after the Napoli, such that it looks like in
the image on the left. (Where I have zoomed in with Ctrl + Wheel.)

Timeline cursor

The result can already be previewed by pressing Space (or the Play button
in the project monitor). You will see the Napoli directly followed by a
Spoon. If the timeline cursor is not at the beginning, the project monitor will
start playing somewhere in the middle; you can move it by dragging it either
on the timeline ruler or in the project monitor. If you prefer keyboard
shortcuts, Ctrl + Home does the same for the monitor that is activated.
(Select the Project Monitor if it is not selected yet before using the shortcut.)



Resize marker

Since after eating comes playing, there is a Billiards clip. Add it to the
timeline as well (track V1). For the first 1.5 seconds nothing happens in the
clip, so it should perhaps be cut to avoid the video becoming boring. An
easy way [5] for this is to move the timeline cursor to the desired position
(i.e. the position where you want to cut the video), then drag the left border
of the clip when the resize marker appears. It will snap in at the timeline
cursor when you move close enough.

Overlapping clips

To add a transition between eating (the Spoon) and playing billiards, the
two clips need to overlap. To be precise: place the second clip above or
below the first one. The first clip should end some frames after the second
one begins. Zooming in until the ticks for single frames appear helps here; it
also makes it easy to always have the same transition duration, five frames in
this case.

You can zoom in by either using the zoom slider at the bottom right corner of
the Kdenlive window, or with Ctrl + Mousewheel. Kdenlive will zoom to
the timeline cursor, so first set it to the position which you want to see
enlarged, then zoom in.



Transition marker

Now that the clips overlap, the transition can be added. This is done either
by right-clicking on the upper clip and choosing Insert a Composition and
choose Wipe or, easier, by hovering the mouse over the lower right corner of
the Spoon clip until the pointing-finger pointer is shown and the message
“Click to add composition” appears. The latter, by default, adds a wipe
transition, which is in this case the best idea anyway since the Spoon is not
required for playing.

The wipe transitions fades the first clip into the second one. See also
Transitions.

Let’s now add the last clip, the Piano, and again apply a wipe transition.
When adding it on the first track of the timeline (track V2), you need to click
on the new clip’s lower left edge to add the transition to the previous clip.

Effects



Effect List

The Piano can be colourized by adding an effect to it. Click on the effect
view (if effect view is not visible enable the view: View ‣ Effects). Type rgb
in the search field then double-click the RGB Adjustment effect.

Once the effect has been added, click on an empty part in the timeline and
you see its name on the timeline clip. It will also be shown in the
Effect/Composition Stack widget.

Effect Stack with RGB adjustment

To get a warm yellow-orange tone on the image, fitting the comfortable
evening, blue needs to be reduced and red and green improved.

The values in the Effect/Composition Stack widget can be changed by using
the slider (middle mouse button resets it to the default value), or by entering
a value directly by double-clicking the number to the right of the slider.



The Effect/Composition Stack widget always refers to the timeline clip that
is currently selected. Each effect can be temporarily disabled by clicking the
eye icon, or all effects for that clip can be disabled using the check box at the
top of the Effect/Composition Stack widget (the settings are saved though),
this is e.g. useful for effects that require a lot of computing power, so they
can be disabled when editing and enabled again for rendering.

For some effects, like the one used there, it is possible to add keyframes. The
framed watch icon indicates this. Keyframes are used for changing effect
parameters over time. In our clip this allows us to fade the piano’s colour
from a warm evening colour to a cold night colour.

Keyframes for effects

After clicking the keyframe icon (the clock icon framed in the previous
image), the Properties widget will re-arrange. By default there will be two
keyframes, one at the beginning of the timeline clip and one at the end. Move
the timeline cursor to the end of the timeline clip, such that the project
monitor actually shows the new colours when changing the parameters of the
keyframe at the end.

Make sure the last keyframe is selected in the Properties list. Then you are
ready to flood the piano with a deep blue.

Moving the timeline cursor to the beginning of the project and playing it
(with Space, or the Play button in the Project Monitor), the piano should
now change the colour as desired.



Keyframing was the hardest part of this tutorial. If you managed to do it, you
will master Kdenlive easily!

See also Effects.

Music

Audio fadeout

Since the clips do not provide any audio, let’s search for some nice piece of
music, from your local collection or on web pages like Jamendo
[http://www.jamendo.com]. The audio clip should, after adding it, be dragged to an
audio track on the timeline.

The audio clip can be resized on the timeline the same way as video clips
are. The cursor will snap in at the end of the project automatically. To add a
fade out effect at the end of the audio clip (except if you found a file with
exactly the right length) you can hover the top right (or left) edge of the
timeline clip and drag the red shaded triangle to the position where fading
out should start. [6]

Rendering

http://www.jamendo.com/


Rendering dialog

A few minutes left, and the project is finished! Click the Render button (or go
to Project ‣ Render, or press Ctrl + Enter) to get the dialog shown on the
left. Select the desired output file for our new video with all effects and
transitions, choose MP4 (works nearly everywhere), select the output file
location and press the Render to File button.

Rendering progress



[1]

[2]

[3]

[4]

[5]

[6]

After some seconds rendering will be finished, and your first Kdenlive
project completed. Congratulations!

References and notes

If you prefer Theora (which you probably don’t since Ogg Video usually
causes problems), you can alternatively download kdenlive-
tutorial-videos-2011-ogv.tar.bz2.

720 [http://en.wikipedia.org/wiki/720p] is the video height, p stands for
progressive scan [http://en.wikipedia.org/wiki/Progressive_scan] in contrast to
interlaced video [http://en.wikipedia.org/wiki/Interlaced_video], and the fps number
denotes the number of full frames per second.

Provided Configure Kdenlive Settings under Configure Kdenlive is set
to Check if first added clip matches project profile

To be correct, it can be played using melt yourproject.kdenlive,
but this is not the way you would want to present your final video since
it is (most likely) too slow. Additionally, it only works if melt is
installed.

Writing it this way suggests that there are several ways of cutting a clip.
This is in fact true.

This shaded triangle is a shorthand for adding the effect Fade ‣ Fade
out. Both ways lead to the same result.

http://en.wikipedia.org/wiki/720p
http://en.wikipedia.org/wiki/Progressive_scan
http://en.wikipedia.org/wiki/Interlaced_video


Tutorials

Contents

Tutorials
Written Tutorials
Video Tutorials

Written Tutorials

See Quick Start for a step-by-step introductory tutorial

Contents:

How To Do Split Screen Effect

Introduction to Kdenlive [http://opensource.com/life/11/11/introduction-kdenlive] by
Seth Kenlon
10 tools for visual effects with Kdenlive [https://opensource.com/life/15/12/10-
kdenlive-tools] by Seth Kenlon
Basic masking in Kdenlive [https://opensource.com/life/15/11/basic-masking-kdenlive]
by Seth Kenlon
Kdenlive Challenge (Multiple Masks & Tracks)
[http://www.ocsmag.com/2015/12/22/the-video-editing-challenge-part-i-kdenlive/] by Paul
Browns
Wikibooks Kdenlive manual [http://en.wikibooks.org/wiki/Kdenlive]

Video Tutorials

Image and Title Layers Transparency Tutorial - Open Source Bug
[https://www.youtube.com/watch?v=f6VHlOZutm8]

http://opensource.com/life/11/11/introduction-kdenlive
https://opensource.com/life/15/12/10-kdenlive-tools
https://opensource.com/life/15/11/basic-masking-kdenlive
http://www.ocsmag.com/2015/12/22/the-video-editing-challenge-part-i-kdenlive/
http://en.wikibooks.org/wiki/Kdenlive
https://www.youtube.com/watch?v=f6VHlOZutm8


How to do pan and zoom with Kdenlive video editor - Peter Thomson
[https://www.youtube.com/watch?v=B8ZPoWaxQrA]

Keyframe Animation - Linuceum [https://www.youtube.com/watch?v=M8hC5FbIzdE]

Kdenlive Tutorials by Arkengheist 2.0
[https://www.youtube.com/channel/UCtkSBZ0x71aeHmR3NNBTWwg] : Many tutorials
including Text effects, Transitions, Timelapse, Animation, Lower Thirds,
Rotoscoping, and more.

More videos can be found using a YouTube search [https://www.youtube.com/results?
search_query=kdenlive+tutorials] and on the Vimeo Kdenlive Tutorial Channel
[https://vimeo.com/groups/kdenlivetutorials/videos]

https://www.youtube.com/watch?v=B8ZPoWaxQrA
https://www.youtube.com/watch?v=M8hC5FbIzdE
https://www.youtube.com/channel/UCtkSBZ0x71aeHmR3NNBTWwg
https://www.youtube.com/results?search_query=kdenlive+tutorials
https://vimeo.com/groups/kdenlivetutorials/videos


How To Do Split Screen Effect
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How To Do Split Screen Effect

This effect is also known as picture in picture effect or PIP.

In this example we will see how to have 4 screens playing at once in the
video.

Example - 4 screens in one(YouTube) [https://youtu.be/YRs5UDuCVJg]

To create this effect you need 4 video tracks on the time line. Add extra
tracks to the time line from the Tracks menu.

You create a project/timeline like that shown in Figure 1 and described in
detail below.

Time Line Setup

Video 1 (appears in bottom left in the result) has no effects added to it.

https://youtu.be/YRs5UDuCVJg


Transition 1

Effect on Video 2

Video 2 (appears top left in result) has a Position and Zoom effect added to it
(See Figure 3). This effect has a sizing and positioning effect as part of it that
causes the Video on Video Track 2 to be scaled down 50% and be positioned
in the top left corner.

Standard composite transition between Video track 2 and Video
track 3.



Effect on Video 3

Video 3 (appears top right in result) has a pan and zoom effect added to it
(See Figure 5). This effect has a sizing and positioning effect as part of it that
causes the Video on Video Track 3 to be scaled down 50% and be positioned
in the top right corner.

Standard composite transition between Video track 3 and Video
track 4.

Effect on Video 4

Video 4 (appears bottom right in result) has a pan and zoom effect added to it
(See Figure 7). This effect has a sizing and positioning effect as part of it that
causes the Video on Video Track 4 to be scaled down 50% and be positioned
in the bottom right corner.



User interface
After starting Kdenlive the Kdenlive window should look something similar
to the image below; as Kdenlive’s user interface is consistent across all
platforms.

Kdenlive’s interface is separated into four main parts:

Menu Reference and Workspace Layouts at the very top.

Toolbars at the top and above the timeline

Window in the middle.

Status Bar at the bottom.

Kdenlive’s default Screen Layout (example editing view). Topbar
(blue), Toolbars (yellow), Window (green) and Status Bar (red).

This page introduces the Kdenlive user interface (UI), explaining where to
find each group of features, and how the highly focused and tightly integrated



Media, Edit, Color, Fairlight, and Deliver pages work together to let you
pursue nearly any post-production workflow you can imagine.

Customizing interface

The user interface model has a clear division between the different panes,
that they work on allows you to reorder them, drag them out into separate
windows or size them up as you will.

The interface is divided into many sections. The menu is on top and then on
the left you can make a note about the project. All loaded clips and videos
are in the project bin, the second section. Third section is the Effect list. You
can apply many transaction effects on your video. You can always watch the
project preview in the last section. You can create as many audio/video track
as you need. This is impressive about Kdenlive. If you’re new to video
editing then this is very useful. You can import multiple title clips inside
video track.

Remove/Adjust Sections

You won’t notice on the spot, but the tabs that appear on the bottom of the
panes aren’t built in them, but change according to what panes you have
aggregated into that particular frame. This way you can group functions that
you don’t expect to use simultaneously into a single place on the user
interface, thus reducing clutter.

If you don’t want certain sections on the screen then you can simply delete
them to make other sections wider. Just click the close button on that section
and that section will be closed, by removing unnecessary video/audio tracks
and now you can organize enough space to preview your project and all other
necessary sections are wider.



Kdenlive’s default Screen Layout, editing view

1. Project Bin

The top left section of the screen is known as the bin, library or browser,
where clips, still images, audio files etc. are displayed, ready for use.
Replicating the folder naming system within the editing software library will
help keep everything organized. It may be helpful to label each clip with one
or more descriptive keywords. These can be searched and are a useful way
to rapidly locate the desired footage, especially with the use of many clips. It
is preferable to edit using the same frame rate and frame size that the footage
was shot with.

2. Clip Monitor

The preview or canvas window (top centre) plays what is currently selected
in the project bin.

3. Project Monitor

This screen shows all clips, still images, audio files and effects such as titles
or transitions were be applied to the footage in the timeline. To apply effects,



select it from the effects menu and then drag and drop it between the two
clips where it is.

4. Timeline Toolbar

Trimming and other editing tools do not alter or delete the original footage,
they only adjust the copy that has been added to the timeline.

5. The Timeline

This is the area where clips are placed in the order in which they will appear
in the final video and trimmed to the desired length and content. When
assembling the initial “rough cut” of the video, users can place clips from the
project bin into the timeline in the desired sequence. To reorder clips simply
click and drag them to a new position. Trimming tools allow only the
relevant footage to be used by marking the desired start and end (“in” and
“out”) points on each clip, to shorten or lengthen it.

6. Audio Mixer

The sound quality and volume can be adjusted, either for the entire sequence
or selected sections. The editing software will display audio meters and
generally any dialogue or narration in a video should be at about -10dB most
of the time.

7. Status Bar

On the left side you see hints what you can do when you hover over items. In
the middle you see the names of the clips you hover over in the timeline.
Followed by mode you are in (default is Select). On the right end are
switches for Labels, Thumbnails, Snap and for zooming the timeline.



Clip Monitor - Right Click Menu

Contents

Clip Monitor - Right Click Menu
Play…

Play
Play Zone
Loop Zone

Go To
Go to Project Start
Go to Previous Snap Point
Go to Zone Start
Go to Clip Start
Go to Clip End
Go to Zone End
Go to Next Snap Point
Go to Project End

Markers
Add Marker
Edit Marker
Delete Marker
Delete All Markers
Go to marker…

Go to marker…
Save zone
Extract Zone
Extract frame
Set current image as thumbnail
Monitor overlay infos
Real time (drop frames)



These are the menu items that are available when you right click a clip in the
Monitors. These actions effect the clip that is currently selected in the The
Project Bin. Similar menu items are available from a Right click menu in the
Project monitor. However project monitor menu items effect the currently
selected clip on the timeline.

Play…

Play

Plays the clip currently selected in the project bin

Play Zone

Plays the current zone and stops. (See Monitors for info about what a Zone
is)

Loop Zone

Plays the current zone in a continuous loop. (See Monitors for info about
what a Zone is)

Go To



Go to Project Start

When this item is selected from Clip Monitor it goes the beginning of the
clip. (When selected in project monitor it goes to the beginning of the
project)

Go to Previous Snap Point

Moves the clip position to the previous Editing Point. Snap points are
sections in clips that other clips snap to when “Snap” is turned on.

Snap points include markers, zone in-points, zone out-points, guides,
transition start points etc

Go to Zone Start

Goes to the start of the Zone. (See Monitors for info about what a Zone is)

Go to Clip Start

Not working. Use Go To Project Start to make the clip monitor move to start
of the clip.

Go to Clip End

Not working. Use Go To Project End to make the clip monitor move to end of
the clip.

Go to Zone End

Goes to the end of the Zone. (See Monitors for info about what a Zone is)

Go to Next Snap Point

Moves the clip position to the next Editing Point. Snap points are sections in
clips that other clips snap to when “Snap” is turned on.



Snap points include markers, zone in-points, zone out-points, guides,
transition start points etc

Go to Project End

When this item is selected from Clip Monitor it goes the end of the clip.
(When selected in project monitor it goes to the end of the project)

Markers

Add Marker

Adds a new clip into the clip at the current time point.

Edit Marker

Brings up a dialog where you can edit the clip that is at the current time
point. Use Go to marker to put the monitor at the marker you want to edit.

Delete Marker

Deletes the clip that is a the current timepoint. Use Go to marker to put the
monitor at the marker you want to delete.

Delete All Markers

Deletes all the Clips from the current clip.

Go to marker…

Same a Go to Marker Clip Monitor - Right Click Menu.

Go to marker…



The menu item pops out a list of existing Clips to select from. When one is
selected the Clip monitor moves to that marker.

Save zone

This brings up the Save Zone dialog

This causes the current zone (see Monitors) to be saved as a .mlt file. This
is a MLT video playlist file which is an xml format file describing the zone
that we saved.

You can then load the .mlt files as clips into the project monitor and edit
them like any other clip.

Extract Zone

This brings up the Cut Clip dialog which appears to be setup to extract the
zone into a new file and add it to the project bin.



On the authors 0.9.2 and 0.9.5 version of Kdenlive this feature is broken for
.dv format clips at least. It does work for .mp4 type clips. However, the
accuracy of the cuts on the clip is way out.

ffmpeg version 0.8.3-4:0.8.3-0ubuntu0.12.04.1, Copyright (c) 
2000-2012 the Libav developers 
 built on Jun 12 2012 16:37:58 with gcc 4.6.3 
[dv @ 0x9d71480] Can't initialize DV format! 
Make sure that you supply exactly two streams: 
    video: 25fps or 29.97fps, audio: 2ch/48kHz/PCM 
    (50Mbps allows an optional second audio stream) 
Output #0, dv, to '/home/ttguy/Videos/Tape3_006_0.dv': 
 Metadata: 
   encoder         : Lavf53.21.0 
   Stream #0.0: Video: dvvideo, yuv420p, 720x576 [PAR 64:45 
DAR 16:9], q=2-31, 28800 kb/s, 90k tbn, 25 tbc 
   Stream #0.1: Audio: pcm_s16le, 32000 Hz, 2 channels, 1024 
kb/s 
Stream mapping: 
 Stream #0.0 -> #0.0 
 Stream #0.1 -> #0.1 
Could not write header for output file #0 (incorrect codec 
parameters ?) 

Extract frame

Extracts the frame currently in the clip monitor as a .PNG image which you
can save to the file system.



Set current image as thumbnail

This will change the thumbnail that represents this clip in the project bin to
the frame that is currently selected in the clip monitor.

Monitor overlay infos

???

Real time (drop frames)

Setting this to the Checked state means the clip monitor will drop frames
during playback to ensure the clip plays in real time. This does not effect the
final rendered file - it just effect how the clip appears when being previewed
in the clip monitor



Project Monitor - Right Click menu
These are the menu items that are available when you right click a clip in the
Monitors. These actions effect the clip that is currently selected in the
timeline. Similar menu items are available from a Right click menu in the
clip monitor. However clip monitor menu items effect the currently selected
clip on the project bin.

Contents

Project Monitor - Right Click menu
Play…

Play
Play Zone
Loop Zone
Loop Selected Clip

Go To
Go to Project Start
Go to Previous Snap Point
Go to Zone Start
Go to Next Snap Point
Go to Project End

Extract frame
Example how to extract frame
Split View
Monitor overlay infos
Real time (drop frames)

Play…

Play



Plays the clip currently selected in the project bin

Play Zone

Plays the current zone and stops.

Loop Zone

Plays the current zone in a continuous loop.

Loop Selected Clip

Go To

Go to Project Start

When this item is selected from Project Monitor it goes the beginning of the
project.

Go to Previous Snap Point

Moves the clip position to the previous Editing Point. Snap points are
sections in clips that other clips snap to when “Snap” is turned on.

Snap points include markers, zone in-points, zone out-points, guides,
transition start points etc

Go to Zone Start

Goes to the start of the Zone.

Go to Next Snap Point

Moves the clip position to the next Editing Point. Snap points are sections in
clips that other clips snap to when “Snap” is turned on.



Snap points include markers, zone in-points, zone out-points, guides,
transition start points etc

Go to Project End

When this item is selected from Project Monitor it goes the end of the
project.

Extract frame

Extracts the frame currently in the project monitor as a .PNG image which
you can save to the file system.

Example how to extract frame

Kdenlive sends that frame to the stills gallery, which includes the image and
the node structure. You can see if you display node graph by right-clicking,
which is helpful to copy and paste adjustments for other clips.

Click export, name it something logical, pick a safe location on your
computer and change the format down below to png.



Split View

Selecting this allows you to view all the video tracks at once in split screen
in the project monitor. See picture.



Monitor overlay infos



4 different monitor overlays help you to show you more information about
your videos. These overlays will not be rendered to the final video.

Real time (drop frames)

Setting this to the Checked state means the clip monitor will drop frames
during playback to ensure the clip plays in real time. This does not effect the
final rendered file - it just effect how the clip appears when being previewed
in the clip monitor



Monitors
Kdenlive uses 2 monitor widgets to display your videos: Clip Monitor and
Project Monitor. A third monitor - the Record Monitor - previews video
capture. These monitors can be selected by clicking the corresponding tabs
which appear at the bottom of the monitor window.

Resizing the Monitors

You can resize the monitors by dragging the sizing widget. It is a bit tricky to
find the bottom widget. You need to hover just between the bottom of the
monitor tab and the timeline

Monitor zoombar

New in version 20.08.0.



The Monitors get zoom bars. To activate: hover over the timeline ruler and
CTRL + Mouse wheel.

New in version 19.04.0.

Support for external monitor display using Blackmagic Design decklink
cards.

Monitor toolbar

New in version 19.04.0.



Support multiple guide overlays. Move with the mouse to the upper-right
corner of the monitor to access the toolbar.

New in version 22.08.0.

The color of the guide overlays can be changed. See Monitor toolbar

Preview resolution

New in version 20.04.0.



Preview resolution speeds up the editing experience by scaling the video
resolution of the monitors. It can be used of proxies instead.

Clip Monitor

The Clip monitor displays the unedited clip that is currently selected in The
Project Bin.



Widgets on the Clip Monitor

0. Insert Zone In Project Bin button - click this to add the current zone to
the project bin. The selected zone will appear as child clip in the
project bin - like the clip shown as Zone1 in the screen shot.

1. Set zone start button - click this to set an ‘in’ point.
2. Set zone end button - click this to set an ‘out’ point.
3. Zone duration indicator - selected by setting in and out points. Dragging

the clip from the clip monitor to the timeline when there is a selected
zone causes the selected zone, not the entire clip, to be copied to the
timeline.

4. Position Caret - can be dragged in the clip. (In ver >=0.9.4 and with
OpenGL turned on in Settings ‣ Configure Kdenlive ‣ Playback, audio
will play as you drag this.)

5. Timecode widget - type a timecode here and hit Enter to go to an exact
location in the clip. Timecode is in the format
hours:minutes:seconds:frames (where frames will correspond to the
number of frames per second in your project profile).

6. Timecode arrows - can be used to change the current position of the clip
in the clip monitor.

Creating Zones in Clip Monitor

Zones are defined regions of clips that are indicated by a colored section in
the clip monitor’s timeline - see item 3 above. The beginning of a zone is set



by clicking [ (item 1 in the pic above). The end of a zone is set by clicking ]
(item 2 in the pic above)

Clip Monitor Right-click menu

The Clip Monitor has a right-click (context) menu as described here.

Seeking

New in version 20.08.0.

Inside the clip monitor: hold down Shift and move the mouse left/right.

Drag audio or video only of a clip in timeline

New in version 19.04.0.

Move with the mouse to the lower-left corner of the clip monitor to access
the Video/Audio icons. Hover with the mouse either over the audio or video
icon left click to drag either video or audio part into the timeline.

Project Monitor

The Project Monitor displays your project’s timeline - i.e. the edited version
of your video.



Project Monitor Widgets

1. The position caret. Shows the current location in the project relative to
the whole project. You can click and drag this to move the position in
the project.

2. The timecode widget. You can type a timecode here and press Enter to
bring the Project Monitor to an exact location.

3. Timecode widget control arrows. You can move the Project Monitor
one frame at a time with these.

Creating Zones in Project Monitor

You can use the [ and ] buttons to create a zone in the Project Monitor the
same way you make zones in the clip monitor. The zone will be indicated by
a colored bar both on the timeline and underneath the Project Monitor.



You can get Kdenlive to only render the selected zone - see Guide Zone.

Project Monitor Right-click menu

The project monitor has a right-click (context menu) as described here.

Multicam Editing

New in version 20.04.0.



Enable the multirack view via menu Monitor ‣ Multitrack view.

New multicam editing interface allows you to select a track in the timeline by
clicking on the project monitor.

Separate Clip and Project Monitors

You can click on the Tab names that label the Monitors and drag the monitor
out into its own window.



To put the monitors back into the Tabbed view - click on the monitor’s title
bar and drag the window on top of the other monitor window.

If the monitor has no title bar (intermittent defect) then you can not do this
and you will need to reset kdenlive settings by deleting ~/.config/kdenliverc



Timeline

Contents

Timeline
Zoombars
Key binding information
Timeline visuals
Split Audio/Video
Timeline Cursor/Position Caret/Playhead
Tracks

Resizing tracks
Keyboard Navigation
Keyframe handling
Configurable tracks

Disabling individual clips
Continuously loop playback

The timeline is the central part of Kdenlive. It is made of 4 different areas
(see screenshot).

1 - Track resizing icon. This icon allows you to adjust the track height in the
timeline from normal to small. This does not affect the video or the render in
any way. The default height of tracks can be configured in Kdenlive’s
Configure Kdenlive dialog.



2 - Timeline ruler. This shows the time in frames or in hh:mm:ss notation.
The area highlighted in green is called the selection zone, and is useful if you
want to render only a part of your project. Left-clicking in the timeline ruler
will move the Timeline and seek to that position. The Timeline ruler context
menu allows you to manage Guides.

3 - Track header. This box shows some options for a track. First is the track
name (Main Video Track in the screenshot). That name can be changed by
simply clicking in it. Below are icons to

Lock the track  which will prevent adding clips, removing
clips, or moving of clips on the timeline;
Mute the track 
Hide video  from this track; and,
Enable/Disable track effects  allows you to enable or disable
the effects applied to the track.
Right clicking in the track header will give you a context menu
allowing to manage (add / delete) tracks. See configure tracks

4 - The track itself, this is where you can drop your clips.

Zoombars

New in version 21.04.0.

Besides the availability of zoombars in the monitor and keyframe scroll bars,
zoombars are now available in the timeline as well. You can easily zoom
in/out in the timeline by dragging the edges of the timeline scrollbar. (Vertical
zoombars coming soon.) Recommend playing this video in full-screen mode.



Key binding information

New in version 21.04.0.

Key binding info has been added on the left while context item information
has been moved to the right of the Status Bar. Recommend playing this video
in full-screen mode.

Timeline visuals

New in version 21.04.0.

The timeline got a visual overhaul with more and better looking
guides/marker colors, the guides have been moved above the timeline ruler
while preview and zone bars have been moved below.

Before (above) and after (below)

Split Audio/Video

New in version 19.04.0.



The way timeline tracks work has changed. Each track is now either audio or
video, and will only accept audio and video clips respectively. When
dragging an AV clip from the project bin in the timeline, the clip will be
automatically split, the video part going on a video track, and the audio part
on an audio track.

The separation of audio/video is important for implementing same-track-
transitions.

Timeline Cursor/Position Caret/Playhead

This indicates the position we are displaying in the Monitors. You can scroll
the position by dragging the Timeline cursor (a.k.a Position Caret or
Playhead).



Beginning with version 0.9.4, dragging the timeline cursor will play the
audio of the clip (a.k.a. Audio Scrubbing). This feature only works if you
have checked Use Open GL for video display in Configure Kdenlive.

Tracks

The timeline is made of tracks. There are two kinds of tracks: audio and
video. The number of tracks is defined when creating a new project in the
Project Settings Dialog. Adding a clip in timeline can be achieved by
dragging it from the The Project Bin or the Monitors. More about tracks see
Tracks

Resizing tracks

New in version 19.04.0.

Tracks can be individually resized. (Holding down Shift makes all video or
audio tracks change in height simultaneously.)

Switch live between two different layout modes (Mixed or Split).



Keyboard Navigation

New in version 19.04.0.

You now have the possibility to move clips and compositions with your
keyboard. To do it, select a clip in timeline and use the Grab Current Item
(Shift + G) function from the Timeline menu.

You can then move the item with your arrow keys. Keyframes can also be
moved individually. Just click on a keyframe in timeline, then move it
left/right with arrows, change its value with + and -. Alt + arrow to go to
another keyframe.

Keyframe handling

New in version 19.04.0.



Add a new keyframe by double clicking in timeline.
You can move a keyframe without altering its value by using the vertical
line that appears when you are above or below a keyframe.
Remove a keyframe by dragging it far above or below the clip limits.

Configurable tracks

New in version 19.04.0.

Video track: You can choose to display between:

In frame
In/Out frames
All frames or
No thumbnails.



Audio track: You can enable:

Show Record Control to record audio direct into the track. More details
see Audio recording.
Separate Channels to see each channel of an audio track (i.e stereo,
5.1)
Normalize Audio Thumbnails maximize the audio level peak to -3dB.

Disabling individual clips

New in version 19.04.0.



Individual clips can be disabled while still in the timeline but with no audio
and no video – (works for all clip types). Right-click on the clip and choose
Disable clip or Enable clip.

Continuously loop playback

Disable Pause playback when seeking in Timeline settings (Settings ‣
Configure Kdenlive ‣ Timeline).
Make a timeline zone the length you like to loop.
Loop Zone (Ctrl + Shift + Space)

See also:

Timeline Menu



Timeline Menu

Contents

Timeline Menu



Resize Item Start
Resize Item End
Current Clip
Guides
Group Clips
Ungroup Clips
Add Effect
Show video thumbnails
Show audio thumbnails
Show markers comments
Snap
Zoom In
Zoom Out
Fit zoom to project
All clips ‣ Ripple Delete

Contents:

Tracks
Master effects
Insert Track
Delete Track
Select All in Current Track
Select All
Deselect
Toggle Track Lock



Toggle All Track Lock
Toggle Track Target
Toggle Track Аctive

Insert Clip Zone in Timeline
Timeline>Space

Insert Space
Remove Space

Selection Menu
Current Clip Menu

Cut Clip
Delete Selected Item
Edit Duration
Save clip



Tracks

Contents

Tracks
Master effects
Insert Track
Delete Track
Select All in Current Track
Select All
Deselect
Toggle Track Lock
Toggle All Track Lock
Toggle Track Target
Toggle Track Аctive

The submenu for inserting/deleting tracks can also be displayed by right-
clicking the track title (anywhere except the track name).

Master effects



New in version 19.12.0.

Let user quickly apply audio or video effects to all tracks. This can be useful
if you want one or more effects to be applied throughout the video.

Click the Master button above track headers to see master effect stack.

Insert Track

Displays a dialog which lets you choose which type of track to insert and
where – before or after a specified existing track.

Delete Track



Displays a dialog which lets you choose which track to delete.

Select All in Current Track

Selects all clips in the current track.

Select All

Selects all clips in all tracks.

Deselect

Cancels the selection.

Toggle Track Lock

Disables or allows editing on the selected track.

Toggle All Track Lock

Disables or allows editing on all tracks.

Toggle Track Target



Click to toggle track as target. Target tracks will receive the inserted clips.

Toggle Track Аctive

Click to make track active/inactive. Active tracks will react to editing
operations.



Insert Clip Zone in Timeline

Contents

Insert Clip Zone in Timeline

This menu item is available in the Timeline Menu on the Insertion sub menu.
Shortcut is V

Keyboard command “v” and “b”: Since version 19.08 “3 point editing with
keyboard shortcuts” is implemented. Source and target has to be activated
that the clip gets inserted into the timeline.

More info here: https://kdenlive.org/en/2019/08/kdenlive-19-08-released/

Say you have a 10 sec. zone defined on a clip in Clip Monitor and on the
timeline you have a 20 sec. zone defined somewhere. When you press V or
select Insert Clip Zone in Timeline (overwrite) , it will insert the 10 sec.
segment of the clip from the Clip Monitor at the beginning of the zone on the
timeline. If there happens to be another clip there already, it will overwrite
it, completely or partially, depending on how long the existing clip was.

https://kdenlive.org/en/2019/08/kdenlive-19-08-released/


Regions selected on time line and in clip monitor - blue regions.

Select Insert Clip Zone in Timeline (overwrite) and the section in the clip
overwrites the section on the timeline



Timeline>Space

Contents

Timeline>Space
Insert Space
Remove Space

Insert Space

Space brings up a submenu with Insert Space and Remove Space options.
Inserting a space is a useful feature when you want to push all the existing
clips on the timeline aside to make room for new clips but also want to
preserve the relationships among all the clips that were shifted, including
their transitions.

In addition to invoking this menu from Timeline ‣ Space, you can also bring it
up by right-clicking on an empty spot on a track in the timeline. There are a
couple of important differences with how Insert Space behaves, though,
depending on which method you choose. First, using Timeline ‣ Space ‣



Insert Space brings up the Add Space dialog shown in Figure 1 where the
default choice for Track: is All tracks.

When you access the menu by right-clicking on a track, the same dialog
appears but the default is the track you clicked on. In either case, you can
obviously override the default by picking another option (Figure 2). The
other difference is that the insertion happens at the playhead when the
operation originates from the Timeline menu; it takes place at the mouse
cursor position when right-clicking.

And in case you’re wondering, the default Duration for the inserted space is
65 frames, which is not configurable in the Kdenlive or Project settings. 65
frames will equate to different amounts of time depending on the frame rate
set in your project profile. In the example, our project’s frame rate happens
to be 30 fps and that’s why the default Duration works out to be
00:00:02.05.



Let’s look at an example, albeit an unrealistic one, of how inserting a space
from the playhead position will affect clips and transitions on different
tracks. In general, inserting a space will shift any clips that the playhead is
touching as well as all clips to the right of the playhead on the affected
track(s). Transitions are a little trickier because they span two tracks. They
are assumed to “belong” to the higher track (regardless of the direction of the
transition) and so if the playhead is touching them, they will go if the higher
track is included in the shift. Figure 3 shows a scenario with clips on three
video tracks before inserting a space. All of the following examples assume
we’re starting from this position.

In Figure 4, we have chosen to insert a space on All Tracks. Since the
playhead was touching both transitions and the color clips on tracks 2 and 3,
it shifted them, along with all the clips to the right of the playhead. It did not
shift the black clip on track 1 because it was to the left of the playhead.



In Figure 5, we chose Track 1. The transition went because it “belongs” to
the black clip on track 1, but the clip itself did not go because it was to the
left of the playhead. The red clip on track 1 also went because it was to the
right of the playhead.

In Figure 6, we shifted the clips on Track 2. Now the Dissolve transition
between tracks 1 and 2 does not shift, even though the playhead was touching
it, because it belongs to track 1. The other transition does go, because it
belongs to the higher track 2.



Finally, In Figure 7, we chose track 3 and just the clips move.

If we had started this process by right-clicking on a spot on track 1 or track 3
which corresponds to the playhead position in the example, the results would
have been the same.

Remove Space

Remove Space is not the exact opposite of Insert Space.

The similarities are:

If you access Remove Space from the Timeline menu, the playhead
governs where the removal will happen. When using right-click, it
happens at the mouse cursor.
Transitions will move with clips on the higher track.

There are the following differences:

It only works on one track at a time – there is no All Tracks option.
If you accessed Remove Space from the Timeline menu, the playhead
must be on an empty space in the track where the space is to be
removed.
You can not set the duration of the space to be removed – all the empty
space between clips is removed. All the clips and transitions to the right
of the playhead or mouse cursor will be shifted left until the first clip
encounters another clip or the beginning of the track.



Selection Menu

Contents

Selection Menu

The purpose of this submenu is to allow you to select multiple clips or
transitions on the timeline for the purpose of performing operations on all of
them simultaneously. However, it should be said up front that making
selections this way is not very practical. That’s because, in order to select a
clip or transition using this menu, you must first position the playhead on it. A
much quicker and easier way is to press Ctrl + left-click on each clip
you want to add to the selection. The clips do not have to be contiguous to be
selected using this method. If the clips you want to select are all contiguous,
you can press Shift + left-click and drag your mouse over all the clips.



In Figure 1, three of the five clips on the timeline have been selected using
the Ctrl + left-click method. At first, it might be difficult to tell which
clips are part of the selection because of the different colors. Kdenlive
indicates that a clip is selected by changing the color of the filename text to
white; unselected clips show the filename with black letters. So even though
two of the selected clips have a light blue outline and the third is outlined in
a red border, they are all part of the same selection (the clipxx.MOV
filenames are all in white). Conversely, clip03.MOV and clip05.MOV are
not part of the selection – their text is black.

Now that multiple clips have been selected, you can do things like moving,
copying, pasting or deleting all of them at once. Or you can use the Grouping
option to perform other advanced operations on the clips. Figure 2 shows
that the selected clips from Figure 1 have been moved to another track by
grabbing any of the selected clips with the mouse and dragging them.
Clicking anywhere outside of the selected clips will unselect all of them.
Note however, that if you had used the Group Clips option on the selections,
the clips will still be grouped even though they are no longer selected.



Selecting multiple transitions works just like selecting clips. Click on the
first one and then Ctrl + left-click on as many others as you’d like to
add to the selection. Figure 3 shows two Dissolve transitions selected. These
transitions can now be copied, moved, deleted, etc. just as with clips.



Current Clip Menu

Contents

Current Clip Menu
Cut Clip
Delete Selected Item
Edit Duration
Save clip



Before using the operations on this menu, you must first select the clip or
clips on which you want to make the changes. The first two menu choices,
Cut Clip and Delete Selected Item, can be performed on either a single clip
or a group of clips. The other two, Edit Duration and Save clip, will only
work on a single clip.

Cut Clip

Figure 1.

Figure 2.

Cut Clip performs the same operation as the Editing, but it works differently.
When the Razor tool is enabled, you can click on any clip on the timeline and
that clip will be cut where you clicked. To use Cut Clip from the menu or its
Shift + R keyboard shortcut, you must first select the target clip or clip
group and then position the playhead where you want the cut to occur.
Figures 1 and 2 show the before and after of such an action. Unlike using the
Razor tool, you can even cut a clip this way while it is playing (again, as
long is it is selected first). If you try to perform the operation when the
playhead is on an unselected clip, nothing will happen.



Delete Selected Item

This menu choice does just what it says. Selected clips will be deleted from
the timeline (but not from the project). If multiple clips are selected or
grouped, they will all be deleted.

Edit Duration

This option is an alternative to dragging with the mouse for changing not just
the duration but also the position of clips on the timeline. Adjusting the time
values directly with spin boxes gives more fine-grained control than dragging
with the mouse. A quicker way than using the menus to bring up the Duration
dialog is to simply double-click on a clip in the timeline.

Figure 3.

Figure 3 shows an example of a 10-second clip located at the 1 minute
position on the timeline. You can see that the Crop start and Crop end values
are blank. This indicates that 10 seconds is the full, uncut length of the clip.
We can’t increase its duration (there’s just no more material available) but
we can crop it to remove material from the beginning, end, or both.



Figure 4.

Figure 4 shows the result of cropping 1 second from the start and end of the
clip. This leaves an 8-second clip, still positioned at the 1 minute mark on
the timeline. In the case of the example, we could also adjust its position
because there is empty space on either side of the clip. If there happened to
be other clips adjacent to the selected clip, you would not be able to adjust
its position with this method, even if you have Editing enabled. This is a case
where dragging the clip with the mouse does have an advantage.



Figure 5.

The examples shown above apply to video clips. Still images, Color and
Title clips are a slightly different. Since their content is static, the concept of
cropping doesn’t apply to them. Therefore, if you double-click on one of
those clips, you will only be offered options to change
‘’Position*and*Duration’’ (Figure 5).

Save clip

Figure 6.

Use this option to save a copy of the current clip as an XML file. When you
select it, you will be presented with the Save As dialog, a portion of which
is shown in Figure 6. The saved file is basically a proxy clip which points
back to the original file. It not only references the original selected clip but
also stores all the properties of that clip, including any effects (but not
transitions) which were applied when you did the save. The saved file can
be added back as a clip to the project and used on the timeline like a regular
video clip. It will retain the properties of the original source clip as they
were when you saved them, even if you go back later and modify the source
clip.



Workspace Layouts

Contents

Workspace Layouts

New in version 20.08.0.

These workspaces aim to improve the layout for each stage of video
production:

Logging for reviewing your footage
Editing to compose your story in the timeline
Audio for mixing and adjusting your audio
Effects for adding effects
Color for adjusting and color grading



Check out this video [https://www.youtube.com/watch?v=BdHbUUjfBLk] for more
details.

https://www.youtube.com/watch?v=BdHbUUjfBLk


Toolbars

Contents

Toolbars
Main and Extra Toolbars
Configuring the Toolbars
Hiding and Showing the Toolbars

Main and Extra Toolbars

Kdenlive has a Main Toolbar,

an Extra Toolbar, which by default contains the Render button,

and a status toolbar.

For more info on the status toolbar see Editing.

Configuring the Toolbars

The tools that are available on these are defined in Settings ‣ Configure
Toolbars.



Hiding and Showing the Toolbars

You can toggle the hiding and showing of the toolbars from the View Menu
using the Main Toolbar and Extra Toolbar menu items. You can also control
this from the Toolbars Shown menu item in the Settings menu.



Keyboard Shortcuts

Contents

Keyboard Shortcuts
File
General
Navigation and Playback
Project Bin
Editing
Timeline
Titler
Render
Settings
Raise widgets with shortcuts (window)
Shortcuts for keyframe functions
Command Bar

File

Action
Name Shortcuts Description

New Ctrl + N Creates a new Kdenlive project

Open… Ctrl + O Opens a Kdenlive project

Quit Ctrl + Q Exits Kdenlive



Action
Name Shortcuts Description

Save Ctrl + S Saves the current state of the project

Save
As…

Ctrl + Shift

+ S

Saves the current state of the project with the
name of your choice

General

Action Name Shortcuts Description

Collapse/Expand
Item <

Copy
Ctrl + C

Alternate:
Ctrl + Ins

Current selection

Delete Selected
Item Del

Find Action… Ctrl + Alt +

I

Opens the action window. Only
possible with this shortcut.



Action Name Shortcuts Description

Full Screen
Mode

Ctrl + Shift

+ F

Kdenlive
Handbook F1

Switch Monitor
Fullscreen F11 Monitor

Paste
Ctrl + V

Alternate:
Shift + Ins

Redo Ctrl + Shift

+ Z

Rename… F2

Show Menubar Ctrl + M

Show Menubar

Shows the menubar again after it has
been hidden



Action Name Shortcuts Description

Select All Ctrl + A

Works in:

Timeline
Project Bin
Titler

Undo Ctrl + Z

Up Alt + Up

What’s This? Shift + F1

Zoom In

Ctrl + +

Alternate:
Ctrl + =

Works in Timeline only

CTRL + Mouse

wheel

Works in:

Timeline
Clip Monitor
Project Monitor
Project Bin
effects keyframe pane

Zoom Out Ctrl + - Works in Timeline only



Action Name Shortcuts Description

CTRL + Mouse

wheel

Works in:

Timeline
Clip Monitor
Project Monitor
Project Bin
effects keyframe pane

Increment,
Decrement Mouse wheel

Works in:

Timeline, scroll the timeline
left/right
Timeline Ruler, project monitor
Clip Monitor
Project Bin
effects keyframe pane, numbers
and selections

Add to the
selection

Shift + left

click

Timeline: adds clicked clips to the
selection

shift +

dragging

Timeline: adds multiple clips to the
selection

Titler: adds clicked clips to the
selection

Project Bin: adds all clips between
already selected clip and clicked clip



Action Name Shortcuts Description

Add to the
selection

Ctrl + left

click

Project Bin: adds clicked clips to the
selection

Effect: select keyframes

Double click double click

Edit bookmark

Project Bin: double click on a clip
shows properties

Project Bin: double click on an
empty place opens add clip or folder

Timeline: double click a clip shows
duration

Navigation and Playback

Action Name Shortcuts Description

Align Playhead to
Mouse Position P Timeline

Forward L Playback

Forward 1 Frame Right Playback



Action Name Shortcuts Description

Forward 1 Second Shift + Right Playback

Go to Clip End End Timeline

Go to Clip Start Home Timeline

Go to Next Guide Ctrl + Right Timeline

Go to Next Snap Point Alt + Right Timeline

Go to Previous Guide Ctrl + Left Timeline

Go to Previous Snap
Point Alt + Left Timeline

Go to Project End Ctrl + End Timeline

Go to Project Start Ctrl + Home Timeline

Go to Zone End Shift + O Timeline

Go to Zone Start Shift + I Timeline



Action Name Shortcuts Description

Loop Zone Ctrl + Shift + Space Playback

Pause K Playback

Play Space Playback

Play Zone Ctrl + Space Playback

Rewind J Playback

Rewind 1 Frame Left Playback

Rewind 1 Second Shift + Left Playback

Playback clip Shift and move the mouse
left/right

Inside the clip
monitor

Project Bin

Action Name Shortcuts Description

Closing the extra bins CTRL + w



Editing

Action
Name Shortcuts Description

Focus
Timecode =

Insert Zone
in Project
Bin

Ctrl + I Clip monitor

Set Zone In I

Set Zone
Out O

Switch
Monitor T

Switch between clip monitor and project
monitor (timeline)

Select
Target 1 Ctrl + 1 3-point-editing

Select
Target 2 Ctrl + 2 3-point-editing

Select
Target 3 Ctrl + 3 3-point-editing



Action
Name Shortcuts Description

Select
Target 4 Ctrl + 4 3-point-editing

Select
Target 5 Ctrl + 5 3-point-editing

Select
Target 6 Ctrl + 6 3-point-editing

Select
Target 7 Ctrl + 7 3-point-editing

Select
Target 8 Ctrl + 8 3-point-editing

Select
Target 9 Ctrl + 9 3-point-editing

Switch All
Tracks
Active

Alt +

Shift + A
3-point-editing

Toggle All
Track Lock

Ctrl +

Shift + L
Tracks



Action
Name Shortcuts Description

Toggle All
Tracks
Active

Shift + A 3-point-editing

Toggle
Track
Active

A

3-point-editing Activate the track as a target
with shortcut A (this connects the track to the
source)

Slip
multiple
clips at
once

Shift +

move

select all clips you want to slip with the
selection tool using Shift then enable the slip
tool and go ahead…

Slip a clip left/right

Slip can be done with the mouse, with the
left/right keys and with the buttons on the
monitor toolbar.

Timeline

Action Name Shortcuts Description

Add Clip to Selection Alt + +
Adds the clip of the active track to
the selection at playhead position.



Action Name Shortcuts Description

Add Marker/Guide
quickly Num + *

On Numlock pad: * adds a
marker/guide

Add Subtitle Shift + S Adds a subtitle at playhead position.

Add Transition to
Selection

Alt +

Shift + +

Add/Remove Guide G Adds a guide at playhead position.

Group Clips Ctrl + G Current selection

Ungroup Clips Ctrl +

Shift + G
Current selection

Cut All Clips Ctrl +

Shift + R

Cuts all clips at playhead position.
Except tracks which are locked.

Cut Clip Shift + R
Cuts the clip of the active track at
playhead position.

Deselect Clip -

Deselect Transition Shift + -



Action Name Shortcuts Description

Extract Timeline Zone Shift + X

Grab Current Item Shift + G
Select a clip -> Shift + G -> move
the clip with left/right

Insert Clip Zone in
Timeline V

Lift Timeline Zone Z

Mix Clips U

Or double click. Play head must be
on the end/begin of 2 clips. Creates
a transition between 2 clips on the
same track.

Multitrack View F12
Tool -> Multicam tool must be
disabled

Overwrite Clip Zone
in Timeline B

Resize Item End )
On active track: Cut and deletes the
end of the clip at playhead position.



Action Name Shortcuts Description

Resize Item Start (
On active track: Cut and delete the
start of the clip at playhead position.

Select Clip +

Select Transition Shift + +

Start Preview Render Shift +

Return

Razor Tool X Tools

Selection Tool S Tools

Spacer Tool M Tools

Deselect Ctrl +

Shift + A
Tracks

Select Audio Track 1 Alt + 1 Tracks

Select Audio Track 2 Alt + 2 Tracks

Select Audio Track 3 Alt + 3 Tracks



Action Name Shortcuts Description

Select Audio Track 4 Alt + 4 Tracks

Select Audio Track 5 Alt + 5 Tracks

Select Audio Track 6 Alt + 6 Tracks

Select Audio Track 7 Alt + 7 Tracks

Select Audio Track 8 Alt + 8 Tracks

Select Audio Track 9 Alt + 9 Tracks

Select Video Track 1 1

Track selection in general and for 3-
point-editing

Multicam tool: You trim the clips in
the desired track while the timeline
is playing

Select Video Track 2 2

Track selection in general and for 3-
point-editing

Multicam tool: You trim the clips in
the desired track while the timeline
is playing



Action Name Shortcuts Description

Select Video Track 3 3

Track selection in general and for 3-
point-editing

Multicam tool: You trim the clips in
the desired track while the timeline
is playing

Select Video Track 4 4

Track selection in general and for 3-
point-editing

Multicam tool: You trim the clips in
the desired track while the timeline
is playing

Select Video Track 5 5

Track selection in general and for 3-
point-editing

Multicam tool: You trim the clips in
the desired track while the timeline
is playing

Select Video Track 6 6

Track selection in general and for 3-
point-editing

Multicam tool: You trim the clips in
the desired track while the timeline
is playing



Action Name Shortcuts Description

Select Video Track 7 7

Track selection in general and for 3-
point-editing

Multicam tool: You trim the clips in
the desired track while the timeline
is playing

Select Video Track 8 8

Track selection in general and for 3-
point-editing

Multicam tool: You trim the clips in
the desired track while the timeline
is playing

Select Video Track 9 9

Track selection in general and for 3-
point-editing

Multicam tool: You trim the clips in
the desired track while the timeline
is playing

Switch Track Target
Audio Stream ' Tracks

Toggle Track
Disabled Shift + H Tracks

Toggle Track Lock Shift + L Tracks



Action Name Shortcuts Description

Toggle Track Target Shift + T

3-point-editing

Select a video or audio track in the
timeline (up/down arrow key) and
set it as source with Shift + T.

Resize only audio or
video part of a clip

Shift +

resize
Only possible with keyboard

Move audio or video
part to another track
independently.

Alt + move Only possible with keyboard

Adjust the speed of a
clip

Ctrl +

dragging
Only possible with keyboard

Return from any tools
back to Selection tool. ESC: Only possible with keyboard

Tracks resized
simultaneously

Shift +

dragging
Either for video or audio tracks.

Tracks resized
simultaneously to
normal

Shift +

double

click

Normalize track height either for
video or audio tracks.



Action Name Shortcuts Description

Track selection up/down

Titler

Action Name Shortcuts Description

Add text Alt + T Click on the canvas to add text

Add rectangle Alt + R Drag the mouse to draw a rectangle

Add ellipse Alt + E Drag the mouse to draw a ellipse.

Insert an image Alt + I Insert an image

Back to selection tool Alt + S

Move selected items
vertical only. Shift

Hold Shift moves selected items
vertical only.

Move selected items
horizontally only.

Shift +

Alt

Hold Shift + Alt moves selected
items horizontally only.

Render



Action Name Shortcuts Description

Render… Ctrl + Return Opens the Render window.

Settings

Action Name Shortcuts Description

Configure Kdenlive… Ctrl + Shift + ,
Opens the configure
window

Configure Keyboard
Shortcuts… Ctrl + Alt + ,

Opens the shortcut
window

Raise widgets with shortcuts (window)

New in version 21.08.0.

With the word “raise” you see all dock widgets (window) on which you can
assign shortcuts to raise dock widgets (window). The actions are called like
“Raise Project Bin”.



Click into the image to start the animation.

Shortcuts for keyframe functions

New in version 21.08.0.

Allow assigning shortcuts to 3 keyframe functions: Add/Remove Keyframe,
Go to next keyframe and Go to previous keyframe. Click on the clip and you
can add/remove keyframe by shortcut.

Command Bar

New in version 21.08.0.

file:///C:/temp/calibre_20xkoptj/a0a3k5wx_pdf_out/_images/shortcuts.gif


The command bar allows to easily searching for any action in Kdenlive like
changing themes, adding effects, opening files and more. It can be accessed
with the shortcut: Ctrl + Alt + i. The shortcut is defined by KDE-Framework,
so do not change it. (This feature requires KDE Frameworks lib version
5.83).



Menu Reference
Contents:

File Menu
New
Open…
Open Recent
Save
Save As…
Save Copy…
Revert
Transcode Clips…
Close
Quit

Edit Menu
Undo
Redo
Copy
Paste
Paste Effects

View Menu
Audio Signal
Audio Spectrum
Clip Monitor
Effects
Effect Stack
Histogram
Layouts
Project Monitor
RGB Parade
Screen Grab
View Timeline
Show Title Bars
Spectrogram



Transition
Undo History
Vectorscope Window
Waveform

Project Menu
Adjust Profile to Current Clip
Clean Project
Create Folder
Generators
Online Resources
Open Backup File
Reverse Clip
Stop Motion Capture
View Mode

Tool Menu
Clip Menu

Markers Menu Item
Automatic Transition
Other Items

Timeline Menu
Tracks
Insert Clip Zone in Timeline
Timeline>Space
Selection Menu
Current Clip Menu

Monitor Menu
Play
Play Zone
Loop Zone
Loop selected clip
Go To
Rewind
Rewind 1 frame
Rewind 1 second
Forward 1 Frame
Forward 1 Second
Forward



Set Zone In
Set Zone Out
Switch monitor fullscreen
Deinterlacer
Interpolation
Switch monitor
Insert zone in project bin
Insert zone in timeline

Settings Menu
Settings Menu - Mac OS X
Configure Language



File Menu

Contents

File Menu
New
Open…
Open Recent
Save
Save As…
Save Copy…
Revert
Transcode Clips…
Close
Quit

New

Creates a new Kdenlive project. The default keyboard shortcut is Ctrl + N.

See Quick Start.

The default settings that appear on this feature are defined under Settings ‣
Configure Kdenlive > Configure Kdenlive.

Open…

Opens a project that has been saved in a Project File Details format file. The
default keyboard shortcut is Ctrl + O.

Open Recent



Displays a picklist of recently saved files (up to 10) to choose from. Click
the Clear List choice when you want to start over with a fresh list.

Save

Saves the current state of the project in a Project File Details format file.
Prompts for a file name if this is the first time the file is being saved. The
default keyboard shortcut is Ctrl + S.

Save As…

Saves the current state of the project in a Project File Details format file of
your choice. The default keyboard shortcut is Ctrl + Shift + S.

Save Copy…

Revert

This abandons any changes to the project you have made since last saving
and reverts back to the last saved version of the project.

Transcode Clips…



Use this to convert a video or audio clip from one codec/format to another.

Choose one source file or multiple source files and a profile that represents
the desired destination codec/format. Optionally change the destination path
and file name and hit Start. Otherwise, hit Abort to close the windows.

Transcoding a clip should be faster than loading the clip into the timeline and
re-encoding it into a different format.

Add clip to project controls if after the conversion, the new clip is
added to the The Project Bin.
Close after encode Uncheck this checkbox if there is the need to convert
to another format after the conversion.

Close

Not sure what this is supposed to do. It is always greyed out on my Kdenlive.

Maybe it is there ready for a version of Kdenlive that can have more than one
project open at a time.



Quit

Exits Kdenlive. Prompts you to save any unsaved changes. The default
keyboard shortcut is Ctrl + Q.

Contents:

DVD Wizard
Screen 1 of the DVD Wizard
Screen 2 of the DVD Wizard
Screen 3 of the DVD Wizard
Screen 4 of the DVD Wizard



DVD Wizard

Contents

DVD Wizard
Screen 1 of the DVD Wizard
Screen 2 of the DVD Wizard
Screen 3 of the DVD Wizard
Screen 4 of the DVD Wizard

Note

Removed since Version 21.08

With the move to MLT7 the DVD Wizard was removed as it was
unmaintained since long.

This feature allows you to author a DVD with a simple menu. Nothing flashy.

Screen 1 of the DVD Wizard

Select a file here that you have rendered using one of the Rendering.



Screen 2 of the DVD Wizard

First click on the 00:00:00 in the center to select a file to play. Then play the
file in the preview window and add chapters at the cursor’s time point by
clicking the Add Chapter button.



Screen 3 of the DVD Wizard

The first two buttons on the side allow you to add and delete menu buttons.
You define what the button does using the Target drop down list.



Screen 4 of the DVD Wizard

Click the Create ISO Image button on this screen to author your DVD. Click
Finish only after you have clicked Create ISO Image button. Clicking Finish
closes the DVD wizard without prompting for you to complete the job.



Result of successful DVD creation



Resulting iso-file can then be written into writable DVD-disk using programs
like K3b. File can also be viewed with most video player applications like
Kaffeine, Vlc or Smplayer (Disk menu might have issues to play correctly).



Edit Menu

Contents

Edit Menu
Undo
Redo
Copy
Paste
Paste Effects

Undo

Edit ‣ Undo is used to reverse the last change you made or operation you
performed in Kdenlive. If you have made multiple changes to your project,
Undo can be used repeatedly to rollback each of the changes in the reverse
order they were performed. Undo can also be executed from the icon on the
Extra Toolbar (Settings ‣ Toolbars Shown) or by using the keyboard
shortcut Ctrl + Z.

To view a navigable list of all the changes which can be undone, see Undo
History.

Redo

Edit ‣ Redo reverses the previous :Undo operation. The default keyboard
shortcut is Ctrl + Shift + Z.

Copy



Copies a clip selected in the timeline to the clipboard. The default keyboard
shortcut is Ctrl + C. It also copies the effects attached to the clip to the
clipboard. Use Paste to paste the clip into a different spot on the timeline.
Use Paste Effects to paste just the effects from the copied clip onto a
different clip.

Paste

Pastes an existing clip in the clipboard into a different spot on the timeline.
The default keyboard shortcut is Ctrl + V.

Paste Effects

Pastes just the effects from a clip existing in the clipboard onto a different
clip.



View Menu

Contents

View Menu

From the View menu you can control which windows appear on the screen.
You can also save the layout or load a saved layout.



Contents:

Audio Signal
Audio Spectrum
Clip Monitor
Effects
Effect Stack
Histogram
Layouts

Load Layout
Save Layout
Manage Layouts

Project Monitor
RGB Parade
Screen Grab
View Timeline
Show Title Bars
Spectrogram
Transition
Undo History
Vectorscope Window
Waveform



Audio Signal

Contents

Audio Signal

You can monitor the levels of the audio as the clip plays with this widget.



Audio Spectrum

Contents

Audio Spectrum

This allows you to monitor the audio properties of your clip in detail. The
graph only display data while the clip is playing in the clip or project
monitor.

It graphs the loudness of the audio (in decibels - vertical axis) for each audio
frequency (horizontal axis) in the current frame. The blue curve is +- the
maximum over the previous few samples.

See also Spectrogram scope which displays a graphical representation of the
audio spectrum over the entire clip.



For more information see Granjow’s blog on Audio Spectrum



Clip Monitor

Contents

Clip Monitor

Toggles the display of the Monitors.



Effects

Contents

Effects

Toggles the display of the Effects





Effect Stack

Contents

Effect Stack

Toggles the display of the Effects



Histogram

Contents

Histogram

This scope displays a frequency histogram of the luminance of the color
components of the video. This information is useful when used in
combination with color correction effects to perform color correction on the
video. Color correction includes increasing the brightness or adjusting the
white balance to ensure that white remains white and not blue.

The histograms have the luminance on the horizontal axis going from 0 on the
left to 255 on the right. The vertical (Y) axis represents the count of the total
number of pixels in the current video frame with a given luminance.



For more information read Granjow’s blog on the histogram scope.

Attention

Windows issue with scopes



Layouts

Contents

Layouts
Load Layout
Save Layout
Manage Layouts

Load Layout

Lets you switch to a previously saved custom layout. Once you load a saved
layout, that layout will remain the current one when starting Kdenlive until
you switch to another saved layout or modify the current one. If you do make
changes to a custom layout after loading it and then quit Kdenlive, you will
not be prompted to save your changes to the named layout. The changes will
be remembered and applied the next time you launch Kdenlive, but be aware
that you are now working with an unnamed layout. If you like the layout and
want to preserve it, save it back to the original name or save it as a new
name.

Save Layout



Kdenlive allows a great deal of freedom to customize screen layout. You can
choose which windows to display and where to position them. You can
resize them or undock them and move them to a second monitor. Any changes
you make to the layout will be automatically saved so that the next time you
start Kdenlive, things will look as you left them. This is fine if you have one
layout that works for all your projects. However, you may want to have
different layouts for different types of projects and be able to switch between
them as needed.

Kdenlive lets you name and save up to four custom layouts. In the example
shown, no custom layouts have been saved yet so they are just labeled 1
through 4. Click Save Layout As and then choose one of the four choices
presented.

The Save Layout dialog appears and you can give your custom layout a name.

Now you can easily switch to that layout whenever you’d like by choosing
the corresponding Load Layout menu selection.

Manage Layouts



Project Monitor

Contents

Project Monitor

Toggles the display of the Monitors.



RGB Parade

Contents

RGB Parade

Displays a histogram of R, G and B components of the video data. This data
is a 3D histogram.

The horizontal axis represents the horizontal axis in the video frame. The
vertical axis is the pixel luminance from 0 to 255. The brightness of the point
on the graph represents the count of the number of pixels with this luminance
in this column of pixels in the video frame.

In the sample screenshot below of a green screen with a shadow on it and
with a right edge that reveals a white wall, you can see how the scope works.
The circled regions labeled 1 are on the right side representing the fact that
there are several columns of pixels that are quite bright whitish/gray. So
these regions are higher up on the Y axis.

The regions labeled 2 are in the middle of the scope and the dip in the graph
there shows the shadow on the screen at this point. The average luminance of
the pixels in these columns is lower.



For more information, see Granjow’s blog on the waveform and RGB Parade
scopes. This blog gives some information on how to use the data provided by
the RGB Parade to do color correction on video footage.

The RGB Parade option in the View menu is somewhat different from the
RGB Parade in that View ‣ RGB Parade displays the histogram in the
application whereas the RGB Parade effect writes the histogram into the
video output file.

Attention

Windows issue with scopes



Screen Grab

Contents

Screen Grab

Start recording: click the “record” button.

Stop record: click the “record” button again.

For more information see Screen Grab

Clicking on the configure button brings you to the Configure Kdenlive
window.



View Timeline

Contents

View Timeline

Toggles the display of the Timeline



Show Title Bars

Contents

Show Title Bars

This toggles the display of the title bar and control buttons on dockable
windows in Kdenlive.

 



Spectrogram

Contents

Spectrogram

This allows you to monitor the audio properties of your clip in detail. The
spectrogram displays the loudness (in decibels) of the audio at different
audio frequencies over the entire length of the clip. In the spectrogram, the
horizontal axis represents the audio frequency and the loudness is
represented by the brightness (version <= 0.9.8) or the colour (version >=
0.9.10) of the pixel on the graph. The vertical axis represents frame number.



 



For more information see Granjow’s blog on Spectrogram

Attention

Windows issue with scopes



Transition

Contents

Transition

Toggles the display of the Transitions



Undo History

Contents

Undo History

There may be times when you want to quickly restore your project to the state
it was in several changes ago. Instead of repeatedly executing single undo
operations, it might be more efficient to jump right to the operation in
question – if you could easily locate it.

That’s where View > Undo History comes in. It opens a dockable window
which lists all the changes made to your project in the order they were made.
When a project file is first opened, the window looks like Figure 1.

Each operation you perform from then on gets added to the list, as shown in
Figure 2. Notice that the most recent operation you have performed is
highlighted.



In this example, if you wanted to undo the last three operations with one
click, all you have to do is click on the Create color clip entry and those
three changes will be reversed in one fell swoop. At this point, if you are
unhappy with undoing those changes, you can easily redo them by clicking on
any of the entries which are still in the list.

However, if you decided that reverting to that Create color clip entry looked
good and you then made another change to the project, the three remaining
operations that were in the list in Figure 3 will be flushed from the buffer and
no longer available. They will be replaced by the new operation you just
performed. See the result in Figure 4.

Whenever you save your project, the icon that looks like a broom with the
red X is repositioned next to the most recent operation in the list. Figure 5
shows three additional operations which were performed after the file save



shown by the circle. After saving the file, you can still revert back to changes
which were made before the save.



Vectorscope Window

Contents

Vectorscope Window

This window allows you to monitor the colour properties of your clip in
detail.

The Vectorscope shows the hue and saturation distribution in a way we can
understand without problems. This is useful for quickly recognizing color
casts, but also helps judging the color distribution of a clip and matching it to
others.

See Granjow’s blog here and here on the Vectorscope.



Attention

Windows issue with scopes



Waveform

Contents

Waveform

This data is a 3D histogram. It represents the Luma component (whiteness) of
the video. It is the same type of graph as for the RGB Parade. The horizontal
axis represents the horizontal axis in the video frame. The vertical axis is the
pixel luma from 0 to 255. The brightness of the point on the graph represents
the count of the number of pixels with this luma in this column of pixels in the
video frame.



For more information see Granjow’s blog on the waveform and RGB parade
scopes. This blog gives some information on how to use the data provided by
the RGB parade to do color correction on video footage.

Attention

Windows issue with scopes



Project Menu

Contents

Project Menu

Add Clip or Folder…
Add Color Clip…
Add Slideshow Clip
Add Title Clip…
Add Template Title…
Create Folder
Online Resources
Generators



View Mode
Clean Project
Render…
Extract Audio
Adjust Profile to Current Clip
Archive Project…
Open Backup File…
Project Settings…

Contents:

Adjust Profile to Current Clip
Clean Project
Create Folder

Create additional bins
Generators
Online Resources

Freesound Audio Library
Freesound Audio Library - Future version
Archive Org Video Library
Open Clip Art Graphic Library

Open Backup File
Reverse Clip
Stop Motion Capture
View Mode



Adjust Profile to Current Clip

Contents

Adjust Profile to Current Clip

This function is available from the Project Menu menu.

This function offers up a suggested Project Profile that would be most
suitable for the properties of the currently selected clip (selected in the
Project Bin?).

You get to see the profile it suggests and accept the suggestion or cancel.



Clean Project

Contents

Clean Project

Available from the Project Menu menu this function removes any clips from
the Project Bin that are not currently being used on the timeline. The files
remain on the hard drive and are only removed from the Project Bin.

You can undo this action with Ctrl + Z.

This is different from the Project Settings Dialog button on the Project Files
tab in Project Settings which deletes files not used by the project from the
hard drive.



Create Folder

Contents

Create Folder
Create additional bins

There are three ways to access a menu containing this option: from the
Project Menu menu, the Clips dropdown on the Project Bin toolbar or by
right-clicking on a clip in the Project Bin. This menu item creates a folder in
the Project Bin. It is a virtual folder, not one created on your hard disk. You
can use this feature to organize your Project Bin when it gets very large or
complex by placing clips in folders, which can then be collapsed to free up
space in the tree. Existing clips in the Project Bin can be moved to a folder
using drag and drop. New clips can be added directly to a folder by first
selecting the folder (or any clip in the folder) and then choosing the Add Clip
option from one of the dropdown menus described above.

Edit the name of the folder: select the folder and right-click on the text
Folder or press F2.



Create additional bins

New in version 21.12.

You can create a separate bin from each folder, following these steps.



Generators

Contents

Generators

Used to create a clip with either a countdown timer or noise.

This option is also available from the Add Clip icon in the Project Bin – see
Clips.



Online Resources

Contents

Online Resources
Freesound Audio Library
Freesound Audio Library - Future version
Archive Org Video Library
Open Clip Art Graphic Library

Available from the Project Menu menu and the Clips dropdown, this feature
allows you to search online audio, video and graphics libraries for resources
to download.

New in version 21.04.0.

The new online resources window features more source footage providers
such as Pixabay [https://pixabay.com/] and Pexels [https://www.pexels.com/] besides the
already available Freesound [https://freesound.org/] and Internet Archive
[https://archive.org/]. Other possible providers are being considered, see here
[https://invent.kde.org/multimedia/kdenlive/-/issues/918] for more details.

https://pixabay.com/
https://www.pexels.com/
https://freesound.org/
https://archive.org/
https://invent.kde.org/multimedia/kdenlive/-/issues/918


It is important to give credit to the downloaded sources so we’ve added an
option to directly import the license attribution as a project note.



Freesound Audio Library

The Freesound Audio Library part of this became non-functional on old
versions of Kdenlive in October 2015 because freesound now requires user



registration. If you are using an old version of Kdenlive, you can still
download great audio clips from https://www.freesound.org/ – just not
through the Kdenlive interface.

Version 15.12 (December 2015) allowed users to automatically download
the high-quality .mp3 preview file from freesound using the Online
Resources module.

Freesound Audio Library - Future version

A future version of Kdenlive will allow you to authenticate Kdenlive with
your free freesound web account and download the high-quality files.

If the Online Resources dialog offers up this error, Error Getting Access
Token from Freesound. Try importing again to obtain a new freesound

https://www.freesound.org/


connection hit the import button again to make it try to establish a new
authentication handshake with the freesound website.

On hitting the import button, and if this is the first time you have used the
freesound library, you will be presented with a login dialog where you can
use your freesound account credentials to authenticate and download the
highest-quality version of the audio file. If you do not have a freesound
account, you can choose to download the high-quality .mp3 preview version
of the file instead.

It might take a few seconds for the freesound web page to load in the window
– be patient.

Once you have logged into the freesound system, you must grant Kdenlive
permission to access your freesound account.



You can revoke Kdenlive’s access to your freesound account from the
freesound website. Log in to your account and click the link in the App
permissions section on the settings page “Manage your list of permissions
granted to API applications” http://freesound.org/home/app_permissions/.

Once permission is granted, Kdenlive obtains authentication keys that it
saves to the kdenlive config file (/~/.config/kdenliverc). It uses these
keys to automatically authenticate on future file import requests. Delete the
tokens from the kdenlive config file to prevent this.

Archive Org Video Library

This searches the internet archives video library for video files that you can
import into Kdenlive. Animated .gifs are displayed as video previews

http://freesound.org/home/app_permissions/


Open Clip Art Graphic Library

This searches the Open Clip Art library for clip art that can be imported into
Kdenlive



Open Backup File

Contents

Open Backup File

This allows you to open up the automatic backups of the projects that
Kdenlive creates.

See Backup.



Reverse Clip

Contents

Reverse Clip

This menu item is available from the Clip Jobs menu that appears when you
The Project Bin on a clip in the Project Bin or from under the Project Menu
menu when a clip is selected in the Project Bin. It is used to create a clip
which plays in reverse.

This feature became available in version 0.9.6 of Kdenlive.

When you select the Reverse Clip option from the menu, a new clip is
created in the Project Bin. It has the same file name as the clip from which it
was created, but with a .mlt extension appended. You can then add this clip
to the timeline and when you play it, the video of the original source clip will
played, but in reverse.

Note



1=According to legacy Mantis bug tracker ID 2933 some clips will only
produce white image and error on reverse.



Stop Motion Capture

Contents

Stop Motion Capture

Capture images a frame at a time from a camera plugged into the HDMI port
of a Linux-compatible capture card to create stop motion animation. You can
also transparently overlay the last captured frame on the monitor to easily see
the difference with current live feed.

See j-b-m’s blog [http://kdenlive.org/users/j-b-m/coming-soon-your-desktop] on this feature.

http://kdenlive.org/users/j-b-m/coming-soon-your-desktop


View Mode

Contents

View Mode

Available from the Project Menu menu this function allows switching
between Tree view and Icon view on the Project Bin.

In the Tree view mode, the Project Bin shows items as a hierarchy. Each item
in the list can have several respectively indented subitems.

The Project Bin in the Icon view is a flat grid of items shown by their
thumbnails with captions.



Tool Menu

Contents

Tool Menu

The options on this menu provide three modes and six tools which affect how
operations are performed on clips in the timeline. These same options can
also be accessed from Track Compositing and Timeline Edit Tools. More
details on their usage can be found there.



Clip Menu

Contents

Clip Menu
Markers Menu Item
Automatic Transition
Other Items

The functions controlled from this menu affect the clip that is selected in the
timeline. This is in contrast to Project Menu functions which affect the clips
selected in the Project Bin.

Markers Menu Item



The menu allows you to Add, Edit and Delete in Clip Menu - Markers.

Automatic Transition

When a transition is selected, this menu item allows you toggle the transition
to and from Transitions mode.

Other Items

The other menu items which appear when in the Clip menu are also available
from the The Project Bin.

Extract Audio
Clip Jobs

Stabilize
Automatic Scene Split
Duplicate Clip with speed change

Transcode Menu Item
Locate Clip…
Reload Clip
Duplicate Clip
Proxy Clip
Clip In Timeline
Clip Properties
Edit Clip
Rename…
Delete Clip

Contents:

Clip Menu - Markers
Add Marker
Edit Marker…
Delete Marker
Delete All Markers



Go To marker …
Clip In Timeline
Delete Clip
Edit Clip
Extract Audio
Stabilize
Transcode Menu Item
Rename Clip
Clip Menu — Locate Clip
Clip Menu — Replace Clip
Clip Menu — Reload Clip
Clip Menu — Duplicate Clip
Automatic Scene Split
Duplicate Clip with speed change



Clip Menu - Markers

Contents

Clip Menu - Markers
Add Marker
Edit Marker…
Delete Marker
Delete All Markers
Go To marker …

These menu items are for modifying the clip that is currently selected in the
timeline. The Markers menu is also available from Right-Click Menus

The items that appear as sub-menu items on the Clip>Markers menu item are
…



Add Marker

Adds a marker to the clip at the current timepoint. Markers are properties of
the clips in the project bin. So this action puts a marker in the clip in the
project bin.

Edit Marker…

For this to work the cursor caret needs to right on top of a marker. If you are
not then you get an error on the bottom left “No Marker found at Cursor
time”. Since the Go To Marker for the clip menu does not work, it is some
times a bit tricky to make this menu item work.

Editing a marker in the timeline causes the marker to update in the project bin
and thus it also updates anywhere else the clip appears in the timeline.

Delete Marker

For this to work the cursor caret needs to right on top of a marker. If you are
not then you get an error on the bottom left “No Marker found at Cursor
time”. Since the Go To Marker for the clip menu does not work, it is some
times a bit tricky to make this menu item work.

Markers are properties of the clips in the project bin. So this action removes
the marker from the clip in the project bin an thus from any other instances of
this clip in the timeline.

Delete All Markers

Deletes all markers from the current clip. Does not appear to work - get
“Cannot find clip to remove marker”

Go To marker …



The Go To Marker menu item (clip menu) does not appear to work properly.
Choosing a marker from this menu item causes the cursor caret to scoot to the
end of the clip - it does not stop at the marker chosen. The Clip Monitor -
Right Click Menu on the Clip Monitor right click menu does work.



Clip In Timeline

Contents

Clip In Timeline

This menu item is available from The Project Bin on a clip in the Project Bin
or under the Project Menu menu when a clip is selected in the Project Bin. It
is useful for quickly locating all the places where a clip is used on the
timeline.

Selecting the Clip In Timeline menu item brings up a flyout that lists all
instances of the selected clip, identified by their track and position on the



timeline. Clicking on an entry in the list will reposition the playhead to the
beginning of indicated clip.

In the example, we have clicked on the third video entry which is located on
video track 1 at the 00:35;09 mark and the playhead is now located at the
start of that clip.

This option will be greyed out if the clip is not being used in the timeline.

See also Clip in Project Bin found by Right-Click Menus on a clip in the
timeline.



Delete Clip

Contents

Delete Clip

This menu item is available from The Project Bin on a clip in the Project Bin
or under the Clip Menu when a clip is selected in the Project Bin.

This function removes the clip from the Project Bin and from the timeline if it
is being used on the timeline.

You are warned if the clip is in use on the timeline.



Edit Clip

Contents

Edit Clip

This option is available from Clip Menu or by right-click on the clip in the
project bin for following clip types:

audio
image
animation (new in version 22.08)

It opens the clip in an external software specified in Default Apps (Settings ‣
Configure Kdenlive… ‣ Environment page ‣ Default Apps tab) ready for
editing.

If the path is not set a pop-up window appears to define the path to the
external software on your computer:

Once the path is set the application starts and opens the clip you like. The
entered path gets added automatically in Default Apps.

More details for installing the external software and how to set the path see
Default Apps.



Hint

The option is greyed out for video clips because Kdenlive is the video
editor - only audio, image and animation clips are edited by external
software.



Extract Audio

Contents

Extract Audio

This feature extracts the audio out of a video clip into a .WAV file and adds it
to the The Project Bin.

This menu item is available from The Project Bin on a clip in the Project Bin
or under the Clip Menu when a clip is selected in the Project Bin.

The process runs as a job in the Project Bin.





Stabilize

Contents

Stabilize

This menu item is available from The Project Bin on a clip in the Project Bin
or under the Project Menu menu when a clip is selected in the Project Bin.

This feature applies image stabilization algorithms to the clip which can
reduce the shakiness of a bit of footage.

Stabilize



Based on the tooltips from this screen and the docs here
[http://public.hronopik.de/vid.stab/features.php?lang=en], this is what all the options mean:

Accuracy

http://public.hronopik.de/vid.stab/features.php?lang=en


Accuracy of shakiness detection. Should be >= shakiness factor. 1: low
(fast processing). 15: high (slow processing). Default: 4. Recommended:
8.

Shakiness
How shaky is the video? And how quick is the camera? 1: little (fast
processing). 10: very strong/quick (slow processing). Default = 4. Note:
large values may also reduce the accuracy. This is due to the internals of
the movement-detection. Typically you don’t need a value greater than 7.

Stepsize
Step size of search process. Region around minimum is scanned with 1
pixel resolution. Default = 6.

Min. contrast
Below this contrast, the field is discarded. Range 0-1. Default = 0.3. You
may want to use a smaller value for a really low contrast clip.

Smoothing
Controls the amount of smoothing/stabilization. The larger the value for
smoothing, the more camera movements are compensated. The resulting
clip has a lower change in camera speed. Technically it is the number of
frames for lowpass filtering = (smoothing * 2) + 1.

For example, with a with 25 fps clip, a value of 12 for the smoothing
factor means we would smooth over one second - 12 frames behind the
current frame + the current frame (1) + 12 frames after the current frame.
Default = 10.

Demo of the difference here
[http://public.hronopik.de/vid.stab/files/skiing_veryshaky_short_vs_longsmoothing_above.ogv]
(top:3, bottom: 30).

Max shift
Maximal number of pixels to translate image. Default = -1. No limit.

Max angle

http://public.hronopik.de/vid.stab/files/skiing_veryshaky_short_vs_longsmoothing_above.ogv


Maximum angle to rotate in radians. Default = -1, which means no limit.

Crop
Unchecked means the border of the transformed frames contains the
pixels from previous frames. Checked = black background. Default =
unchecked.

Zoom
Additional zoom during transform. Percentage to zoom > 0 = zoom in, < 0
= zoom out. The zoom specified here is in addition to the optimum zoom
calculated by the program when optzoom is checked. Default = 0.

Optimal Zoom
Use optimal zoom (calculated from transforms). Causes video to zoom
until 90% of transformations are hidden. Default is checked. Hint: You
can further zoom in with the zoom option.

Optimal Zoom
Zoom per frame (used when “Optimal Zoom” = 2)

Sharpen
Sharpen transformed image. Amount of sharpening: 0: no sharpening.
Uses filter unsharp with 5x5 matrix. Default = 0.8.

Show fields
0 = draw nothing, 1 or 2 = show fields and transforms. Use 1 or 2 to
preview what the process is going to do. Example
[http://public.hronopik.de/vid.stab/files/skiing_veryshaky_visualized8_short.ogv]. Default = 0.
Non-zero values of this parameter are not relevant in the Kdenlive
implementation - use zero.

Tripod
Reference frame

Example of the effect of running stabilize - transcode from the original author
- Georg Martius.

http://public.hronopik.de/vid.stab/files/skiing_veryshaky_visualized8_short.ogv


Side by side https://youtu.be/HYE3KAl8RAQ

Deshaked https://youtu.be/c3CEm8bgVQ0

Original https://youtu.be/cRA5H1LYzM4

https://youtu.be/HYE3KAl8RAQ
https://youtu.be/c3CEm8bgVQ0
https://youtu.be/cRA5H1LYzM4


Transcode Menu Item

Contents

Transcode Menu Item

From right-click on a clip in The Project Bin, one of the items that appears in
the menu is the Transcode submenu.



Choose a transcode profile from the available list to transcode the selected
clip into a different video format. The options are controlled by Configure
Kdenlive. The transcoding is done by the ffmpeg [http://www.ffmpeg.org/] program.

http://www.ffmpeg.org/


The above screenshot is the dialog presented after choosing a transcode
profile for transcoding the clip. The wrench icon toggles the display of the
details of the command that will be used for transcoding. The description
comes from the description supplied in the Configure Kdenlive for this
functionality.

Use the checkbox to cause the transcoded clip to be added to the Project Bin
once the transcode job has finished.

While the transcode job is running, the Project Bin will display a progress
bar on the thumbnail of the clip and a job list menu item will appear at the
top of the Project Bin.



Rename Clip

Contents

Rename Clip

Change the name of a clip in the Project Bin to an arbitrary name. Does not
rename the file on the file system.

This menu item is available from The Project Bin on a clip in the Project
Bin.



Clip Menu — Locate Clip

Contents

Clip Menu — Locate Clip

This menu item is available from The Project Bin a clip in the Project Bin.
Locate Clip opens up the systems file browser at the location on the file
system where the selected clip is stored. Useful for tracking down the
sources of clips in the project bin.



Clip Menu — Replace Clip

Contents

Clip Menu — Replace Clip

New in version 20.04.0.

This menu item is available from The Project Bin a clip in the Project Bin.
Replace Clip will allow you to select a different file but keep all of the uses
on the timeline. This can be useful if you work first with placeholder clips
(i.e. low resolution) and on the end, before rendering, you replace the clip
with the final clip.



Clip Menu — Reload Clip

Contents

Clip Menu — Reload Clip

This menu item is available from The Project Bin a clip in the Project Bin.
Reload Clip will re-import the clip into Kdenlive from the system. This is
useful when you edit a clip outside of Kdenlive and want Kdenlive to update
it in the project.



Clip Menu — Duplicate Clip

Contents

Clip Menu — Duplicate Clip

This menu item is available from The Project Bin a clip in the Project Bin.
Duplicate Clip will add another clip in the project bin from the first clip.
This can be useful when applying effects to clips, and allowing you to have
the same source file with two different sets of applied effects.



Automatic Scene Split

Contents

Automatic Scene Split

This job detects Scene changes in the clip and create markers or cut the clip
into sub clips.

Cut scenes are numbered and sorted under the clip in the project bin window
and will be saved with your project.



 

This menu item is available from the Clip Jobs menu that appears when you
The Project Bin on a clip in the Project Bin.





Duplicate Clip with speed change

Contents

Duplicate Clip with speed change

This menu item is available from the Clip Jobs menu that appears when you
The Project Bin on a clip in the Project Bin or from under the Project Menu
menu when a clip is selected in the Project Bin.

This feature used to be Reverse Clip and was available from version 0.9.6 of
Kdenlive. From version 17.04 it can still be used to reverse the clip - by
entering a speed of minus 100%. But you can create clips of other speeds
too. With the new version of the clip job the sound in the clip is also
reversed - so you can learn backwards talking!



When you select the Duplicate Clip with speed change option from the
menu, a new clip is created in the Project Bin. It has the filename you
supplied in the dialog with a .mlt extension. You can then add this clip to the
timeline and when you play it, the video of the original source clip will
played, but at the new speed (or in reverse).



Monitor Menu

Contents

Monitor Menu
Play
Play Zone
Loop Zone
Loop selected clip
Go To
Rewind
Rewind 1 frame
Rewind 1 second
Forward 1 Frame
Forward 1 Second
Forward
Set Zone In
Set Zone Out
Switch monitor fullscreen
Deinterlacer
Interpolation
Switch monitor
Insert zone in project bin
Insert zone in timeline



The monitor menu contains controls for viewing and navigating through the
clips in your project for the purpose of making edits and seeing the effects of
your changes. Depending on which monitor window you have selected at the
time, the controls will affect either the currently selected clip in the Project
Bin (Clip Monitor) or the playhead in the Timeline (Project Monitor).

With the exception of the Deinterlacer and Interpolation items, it is much
more practical to perform the actions on this menu using the associated
keyboard shortcuts or the buttons at the bottom of the monitor windows.

Play

Play Zone

Loop Zone



Loop selected clip

Go To

Rewind

Rewind 1 frame

Rewind 1 second

Forward 1 Frame

Forward 1 Second

Forward

Set Zone In

Set Zone Out

Switch monitor fullscreen

Deinterlacer

Interpolation

Switch monitor

Insert zone in project bin



Insert zone in timeline



Settings Menu

Contents

Settings Menu
Settings Menu - Mac OS X
Configure Language

Manage Cached Data
Run Config Wizard
OpenGL Backend Windows only: You can switch the OpenGL backend
if you have playback issues.
Force Breeze Icon Theme
Color Theme
Style



Show Menubar
Toolbars Shown
Show Status bar
Configure Language…
Configure Keyboard Shortcuts
Configure Toolbars
Configure Notifications
Configure Kdenlive

Settings Menu - Mac OS X

On the Mac OS X build of Kdenlive the Settings menu does not contain the
Configure Kdenlive menu item. The equivalent on Mac OS X is the
Preferences menu item found under the Kdenlive menu.



Configure Language

Setting Kdenlive to your preferred language.

Contents:

Configure Kdenlive
Misc
Project Defaults



Proxy Clips
Timeline
Environment

MLT Environment
Default Folders
Default Apps
Mime types

Colors
Speech To Text
Capture

Configure Firewire Capture
Configure Screen Grab Capture
Blackmagic
Audio

Jog Shuttle
Linux
Windows

Playback
Transcode

Transcode Options
Configure Notifications
Configure Shortcuts
Download New Project Profiles
Download New Render Profiles
Upload/Share Render Profiles
Download New Wipes
Full Screen Mode
Manage Project Profiles
Run Config Wizard
Color Theme
Toolbars Shown



Configure Kdenlive

Contents

Configure Kdenlive
Misc
Project Defaults
Proxy Clips
Timeline
Environment

MLT Environment
Default Folders
Default Apps
Mime types

Colors
Speech To Text
Capture

Configure Firewire Capture
Configure Screen Grab Capture
Blackmagic
Audio

Jog Shuttle
Linux
Windows

Playback
Transcode

Transcode Options

Following settings applies when you start a project with New.

Misc



Open the last project on startup

Check if the first added clip matches the project profile

Crash recovery (Auto Save)

Use KDE job tracking for render jobs

Use on-monitor effects

Disable parameters when the effect is disabled

Default Durations

Automatically import image sequences

Transparent background for imported images

Project Defaults



Configures what the project settings will look like by default when you
choose File –> New.

Proxy Clips

Configures what the proxy settings will be when you choose File –> New.



Timeline

Configure how the timeline appears in Kdenlive



Thumbnails

Video: Turns on video thumbnail by default.
Audio: Turns on audio thumbnail by default.
Separate channels: If checked you will get a separate waveform in the
audio thumbnail for each audio channel in the audio track. If unchecked
you will get a single waveform as the audio thumbnail.

Settings

Autoscroll while playing
Pause playback when seeking: Enabled: It stops playback while you
click on a new position in the timeline. Disabled: Playback is ongoing
while you click on a new position in the timeline. It allows looping
playback, see Continuously loop playback.
Zoom using vertical drag in the ruler
Track Height: defines the default track height in pixels for the tracks on
the timeline.

Multi stream audio clips



On import, enable: select if all audio streams, first audio stream, first 2
audio streams should be imported.

Check if project contains enough audio tracks. If enabled Kdenlive asks
if it should generate the additional audio tracks needed automatically.

Raise properties pane when selecting in timeline

More details here

Environment

MLT Environment

Environment variables on Windows



Environment variables on Kdenlive normal installed on Linux
(Appimage, Flatpak, Snap may have integrated paths)

Environment variables on MacOS

This setting tells Kdenlive where to find the MLT executables and profile
files. Only advanced users would really need to change these settings.
Kdenlive is basically a front end to the MLT program and this setting tells
Kdenlive where to find the engine that runs the whole application.

Path to the MediaInfo file. If filled in Kdenlive shows more details in clip
properties.

Proxy and Transcode Jobs

Concurrent threads This will set the number of threads the program will
attempt to use when calling ffmpeg to encode Clips. This will be what
kdenlive passes to the ffmpeg -threads parameter. Increasing this parameter
may not have an effect if you have changed the proxy encoding settings using
Project Settings Dialog to a codec that ffmpeg does not do multi-thread on.
(Multi-threading is supported for MPEG-2, MPEG-4, H.264, and VP8)



New in version 22.08.

Use lower CPU priority for proxy and transcode tasks

This adds a Kdenlive setting to lower the priority of the proxy rendering
(QProcess). This helps keep the main UI responsive when proxies are
rendering.

Deprecated since version 19.04.

Processing and transcode jobs: This is experimental and was removed in
ver 0.9.10. This number was passed to melts real_time consumer property.
This parameter increases the number of threads the program uses for video
decoding and processing (but not encoding which is controlled via
Rendering). See mlt doco [https://www.mltframework.org/faq/#does-mlt-take-advantage-of-
multiple-cores-or-how-do-i-enable-parallel-processing]. Using this has potential side effects
- see this [https://forum.kde.org/viewtopic.php?f=265&t=122140#p317318] forum post from
the author of the Melt program.

If you want to experiment with multi threading in versions higher than 0.9.10
you could add something like “real_time=-4” to a custom render profile. And
yes that is a minus 4 in the example - as per the mlt doco
[https://www.mltframework.org/faq/#does-mlt-take-advantage-of-multiple-cores-or-how-do-i-enable-
parallel-processing] - numbers <0 implement threading without dropping frames.

Default Folders

Default folders on Windows.

https://www.mltframework.org/faq/#does-mlt-take-advantage-of-multiple-cores-or-how-do-i-enable-parallel-processing
https://forum.kde.org/viewtopic.php?f=265&t=122140#p317318
https://www.mltframework.org/faq/#does-mlt-take-advantage-of-multiple-cores-or-how-do-i-enable-parallel-processing


Default folders on Linux.

Default folders on MacOS.

This setting controls where Kdenlive expects project files to be by default. It
also controls what folder Kdenlive will use as a temporary file storage
location and it controls where files captured from an external source will be
saved.

Default Apps

This setting controls what external application opens when you choose Edit
Clip for a clip in the project bin.

Image editing: A free software would be Krita [https://www.audacityteam.org/].

https://www.audacityteam.org/


Audio editing: A free software would be Audacity [https://krita.org/en/].

Animation editing: Kdenlive updates automatically files which are saved in
Glaxnimate. Glaxnimate can be downloaded from here
[https://glaxnimate.mattbas.org/] (Linux, Windows, Mac).

Mac user: Instruction how to install and run dmg files.

Windows user: Make sure all the paths points to an .exe file.
Glaxnimate.exe is in folder C:/YourPath/glaxnimate-
x86_64/glaxnimate/bin/glaxnimate.exe.

Hint

There is no application for video editing - because Kdenlive is a video
editor.

Mime types

Specifies the Media Types (formerly known as MIME types) which Kdenlive
can working with.

New in version 22.08.

Added file type: AVIF, HEIF and JPEG XL

Added animation file type: Json (Lottie animations) and rawr (Glaxnimate
animation)

https://krita.org/en/
https://glaxnimate.mattbas.org/


Colors

Audio thumbnail colors Click on the color bar and change the color of the
audio wave thumbnail.

New in version 22.08.0.

Monitor overlay color Click on the color bar and change the color of the
monitor overlay lines. See Monitor toolbar

Speech To Text



More details about speech to text see here.

Capture

Note

At least Firewire capture was removed in porting to KDE 5 due to lack of
manpower.

Configure the Capturing Video devices (Firewire, FFmpeg, Screen Grab,
Blackmagic, Audio) from this section.

Configure Firewire Capture

The image shows the Configure Firewire capture tab which can be accessed
from the Settings ‣ Configure Kdenlive menu or from the spanner icon in the
Capturing Video



The firewire capture functionality uses the dvgrab [http://linux.die.net/man/1/dvgrab]
program. The settings applied here to define how dvgrab will be used to
capture the video.

Capture Format options are

DV RAW
DV AVI Type 1
DV AVI Type 2
HDV

The first three are quality-wise the same (exactly the same DV 25Mb/s
standard definition codec), just packed differently into the file. Type 2 seems
to be the most widely supported by other applications.

http://linux.die.net/man/1/dvgrab


The raw format contains just the plain video frames (with audio interleaved)
without any additional information. Raw is useful for some Linux software.
Files in this format can also be played with Windows QuickTime when
renamed to file.dv.

AVI files may contain multiple streams. Typically, they include one video and
one audio stream. The native DV stream format already includes the audio
interleaved into its video stream. A type 1 DV AVI file only includes one DV
video stream where the audio must be extracted from the DV video stream. A
type 2 DV AVI file includes a separate audio stream in addition to the audio
data already interleaved in the DV video stream. Therefore, the type 2 DV
AVI file is redundant and consumes more space.

HDV is a high-definition format used on tape-based HD camcorders.

Add recording time to captured file name option: If this is unchecked then
each captured file will get a sequential number post-pended to the file names
listed in the Capture file name setting. With this checked, date and timestamp
(derived from when the footage was captured) is post-pended to the capture
file name, e.g. capture2012.07.15_11-38-37.dv

Automatically start a new file on scene cut option: With this checked it
tries to detect whenever a new recording starts, and store it into a separate
file. This is the -autosplit parameter in dvgrab [http://linux.die.net/man/1/dvgrab] and
it works by detecting timecode discontinuities from the source footage.
Where a timecode discontinuity is anything backward or greater than one
second it will start a new capture file.

The dvgrab additional parameters edit box allows you to add extra dvgrab
switches to the capture process that will run. See dvgrab manual
[http://linux.die.net/man/1/dvgrab] for more info.

Configure Screen Grab Capture

http://linux.die.net/man/1/dvgrab
http://linux.die.net/man/1/dvgrab


These settings configure screen grab within Kdenlive. More details see here.

Blackmagic

If you have a Blackmagic DecLink video capture card you can set here the
import parameter.

Audio



Microphone settings, either for screen Capturing Video or for Capturing
Audio (Dubbing) direct into the timeline.

Jog Shuttle

Configure a connected Jog-Shuttle device. Contour ShuttlePro and Contour
ShuttleXpress are known to work.

Linux

Ensure that your Jog-Shuttle device is connected via USB and working. An
udev rule is necessary to correct the access rights to the device file: Create a



file /etc/udev/rules.d/90-contour-shuttleXpress.rules with the line:

SUBSYSTEMS"usb", ATTRS{idVendor}

"0b33", ATTRS{idProduct}=="0020", MODE="0444"

for Contour ShuttleXpress or

SUBSYSTEMS"usb", ATTRS{idVendor}

"0b33", ATTRS{idProduct}=="0030", MODE="0444"

for Contour ShuttlePRO V2. Obtain the device file by a command

fgrep Contour -A4 /proc/bus/input/devices 

The last line of the output says

H: Handlers=mouse0 event3 

which should tell the device file to be entered into kdenlive’s setting dialog:
In the text field enter /dev/input/event3 (use the last word on the line above
to specify the device file in /dev/input), set the buttons and apply the changes.



Enable Jog-Shuttle. For the Contour ShuttleXpress the buttons 5 - 9 are
relevant, whereas Contour ShuttlePro uses all buttons. The actions for the
jog- and the shuttle wheel are working as expected.

Windows

On the desktop, bottom-right opens the system tray. Right-click on the
Contour icon and choose “Open control Panel”.



In the configuration window choose under “Application setting” the program
“Adobe Premiere Pro CS&amp;CC (Edit)”. Then click on Options ‣ Create
new settings ‣ Copy contents from Current Settings.

Then choose Kdenlive.exe in C:Program Fileskdenlivebin.



Now the basic functionality should work. Adjust the buttons of the shuttle
with shortcuts as you like.

Hint

You can make Kdenlive settings from scratch using Options ‣ Create new
settings ‣ Create Empty Settings when creating new settings.

Playback

Configure the Video and Audio drivers and devices. For advanced users
only.



Playback view on Windows.

Audio driver on Linux.

Audio driver on MAcOS.

Audio driver



Windows: WinMM (Win7), Wasapi (Win10), DirectSound. If you have
any audio issue or playback stuttering you may change to another audio
driver.

In version 0.9.4 of Kdenlive, checking the “use Open GL for video
playback” checkbox turns on the ability to have audio scrubbing available for
use in the clips. Audio scrubbing lets you hear the audio at the playhead
position as you drag the playhead so you can quickly find a particular sound
or event in the audio. This feature can be useful for placing the play head at
the correct spot in the clip relative to an important bit of audio.

In ver 15.04 or higher, there is no “use Open GL for video playback”
checkbox - Open GL is used by default. On Windows you can set the
OpenGL backend under Settings ‣ OpenGL Backend

Transcode

This controls the Transcode Menu Item functionality. The parameters section
are ffmpeg parameters. Find help on them by issuing ffmpeg -h at a
command line.



Transcode Options

Option Description Parameters Meanings of
Parameters

Wav 48000Hz Extract audio as
WAV file -vn -ar 48000

-vn=disable
video, -ar 48000
= set audio
sampling rate to
48kHz

Remux with
MKV

-vcodec copy -
acodec copy -sn

copy the video
and the audio. -sn
= disable
subtitles



Option Description Parameters Meanings of
Parameters

Remux MPEG-2
PS/VOB

Fix audio sync in
MPEG-2 vob
files

-vcodec copy -
acodec copy

copy the video
and the audio



Configure Notifications

Contents

Configure Notifications

This feature allows you to customize the feedback the application provides
when certain events happen. For example, you can change the sound effect
that fires when rendering finishes.



Configure Shortcuts

Contents

Configure Shortcuts

Allows modification of the keyboard shortcuts for various Kdenlive tasks.

Icons, bottom row

Defaults: set back the shortcuts to default.

Manage Schemes: opens the Shortcut Schemes.

Print…: opens the printer window dialog and you can print the actual
shortcuts.

Icons, Shortcut Schemes



Current scheme: switching between schemes you have saved on your
computer.

New…: creates a new empty shortcut scheme

Delete: deletes your actual scheme.

More Actions: your actual scheme can be:

saved (storage place see Configuration Information)
exported
imported
or download new schemes from the KDE server.



Download New Project Profiles

Contents

Download New Project Profiles

Note: Since around August, 2013 when the kdenlive.org web site was
refurbished, this feature has been unavailable and the “Get Hot New Stuff”
window will wait forever to update. See Mantis 3133
[https://bugs.kdenlive.org/view.php?id=3133].

The Download new Render profiles is now working as at Oct 2015.
However the download New Project Profiles is still not working as at Oct
2015.

https://bugs.kdenlive.org/view.php?id=3133


Download New Render Profiles

Contents

Download New Render Profiles
Upload/Share Render Profiles

This feature allows you to download new render profiles that have been
shared by the community. These will then appear as options in the Rendering
window.



The new render profile installed above shows up in the Web Sites category
under Custom.

Note

It has the big red cross because the render profile is in need of an audio
codec not installed on this machine

The installed files are placed in
/usr/share/mlt/presets/consumer/avformat

Upload/Share Render Profiles
If you want to share a render profile you can do so at the KDE Store page
[https://store.kde.org/browse?cat=334]. You need to create a login, then you can upload
your custom rendering profile file, which is on Linux stored in
.local/share/kdenlive/export/customprofiles.xml and on Windows
stored in %LocalAppData%kdenliveexportcustomprofiles.xml. The file
contains all your custom rendering profiles so you should copy it and remove
the ones you don’t want to export.

Profiles submitted there appear in the Download New Render Profiles.

https://store.kde.org/browse?cat=334


Download New Wipes

Contents

Download New Wipes

This feature allows you to download and install files that can be used as
Wipe files in the Composition - Wipe transition. These files are greyscale
images in the pgm format.

If you have your own wipe files that you would like to share with the
community you can upload them to store.kde.org [https://store.kde.org/browse/cat/185/]
which should make them available from this Download New Wipes function.

https://store.kde.org/browse/cat/185/


Full Screen Mode

Contents

Full Screen Mode

Selecting this causes Kdenlive to fill the entire screen. Select this menu item
again to undo full screen mode.



Manage Project Profiles

Contents

Manage Project Profiles

This is available from the Settings menu.

Once the dialog appears, select a profile to modify from the drop down.

Next, click the button with a green plus on it. This will make all the
Properties fields editable.

Fill in the settings for your project profile, give it a new Description and
click the OK button.



See also HOWTO Produce 4k and 2K videos, YouTube compatible
[https://forum.kde.org/viewtopic.php?f=272&t=124869]

Download New Project Profiles

https://forum.kde.org/viewtopic.php?f=272&t=124869


Run Config Wizard

Contents

Run Config Wizard

This feature re-runs the config wizard that runs when you first install or
upgrade Kdenlive. It gives you the opportunity to choose the default settings
again for things like the default project settings. It also resets many settings
back to “factory defaults” so it can be useful to run this if the Kdenlive
application is misbehaving.



Color Theme

Contents

Color Theme

Brings up a list of pre-configured color themes to choose from. Some people
have strong preferences about whether light or dark themes are better for a
video editor. There are some of both to choose from here.



Toolbars Shown

Contents

Toolbars Shown

Toggles the display of the Main and Extra Toolbars



Importing and assets management
Contents:

Capturing Video
Firewire
FFmpeg
Screen Grab
Blackmagic
Footnotes

Capturing Audio (Dubbing)
Version 19.04

Media Browser
The Project Bin

Create additional project bins
Clip - Right-Click Menu

Project and File management
File Structure



Capturing Video

Contents

Capturing Video
Firewire
FFmpeg
Screen Grab
Blackmagic
Footnotes

Note

At least Firewire and webcam capture were removed in porting to KDE 5
due to lack of manpower.

Kdenlive provides functionality for capturing video from external devices;
e.g., Firewire, FFmpeg, Screen Grab and Blackmagic.

You configure video capturing from Settings ‣ Configure Kdenlive ‣ Capture
(more on this Configure Kdenlive).

You define the destination location for your captures by using Settings ‣
Configure Kdenlive ‣ Environment ‣ Default Folders (more on this
Configure Kdenlive).

To execute a video capture, select the Monitors and choose the capture
device from the dropdown in the bottom right.



Firewire

Note

This option is not available in recent versions of Kdenlive. Use dvgrab
directly in a terminal to capture video from firewire.

This captures video from sources connected via a firewire (also known as -
IEEE 1394 High Speed Serial Bus) card and cable. This functionality uses
the dvgrab [http://linux.die.net/man/1/dvgrab] program and the settings for this can be
customized by clicking the spanner icon or choosing Settings>Configure
Kdenlive. See Configure Kdenlive.

http://linux.die.net/man/1/dvgrab


To perform a capture:

Plug in your device to the firewire card and turn it on to play mode
Click the Connect Button

Click the Record Button – note it toggles to grey while you are
recording
Click the Record button again to stop capture. Or click the stop button.
Once capturing is finished, click the disconnect button

In the Captured Files dialog, click the import button to have the
captured files automatically imported into the project bin.

Note

If your device does not start playing the source device when you click the
record button, you may have to start playback on your device manually and



then click record.

FFmpeg

I believe this captures video from an installed Web Cam using
Video4Linux2.

Screen Grab

This captures video of the PC screen.

Open screen grab: View ‣ Screen Grab.

Start recording: click the “record” button.

Stop record: click the “record” button again.

The recorded clip will be added in the project bin.

Settings can be adjusted in Configure Kdenlive

To check on your linux distro, type ffmpeg -version in a terminal and look
for --enable-x11grab in the reported configuration info. [1]

If you are capturing the screen and using the X246 with audio settings and
you get a crash as shown in the screen shot…



[1]

…then consider creating a profile for audio capture where -acodec
pcm_s16le is replaced by -acodec libvorbis -b 320k. See Configure
Kdenlive.

Blackmagic

This is for capturing from Blackmagics decklink [http://www.blackmagic-
design.com/uk/products/decklink/] video capture cards (AFAIK). Not sure how stable
this code is at the moment. Mentioned in legacy Mantis bug tracker ID 2130.

Footnotes

There are now two branches of ffmpeg: a Libav branch and an
ffmpeg.org branch. The ffmpeg version from the latter branch reports the
configuration when you run with ffmpeg -version. The Libav version

http://www.blackmagic-design.com/uk/products/decklink/


does not. So this method to check for the --enable-x11grab does not
work if you have the Libav version of ffmpeg.



Capturing Audio (Dubbing)

Contents

Capturing Audio (Dubbing)
Version 19.04

You can use Kdenlive to capture audio from a microphone while you play
your project in the Project Monitor. In this way you can dub in a voiceover.

Under the Record Monitor, choose FFmpeg capture and enable Audio only
and hit the Record button. Then move back to the Project Monitor and hit
Play. You can now record audio only while the clip is playing. (This feature
has had some issues in the past. It has worked in ver 0.9.4 - see bug #2910
[https://bugs.kdenlive.org/view.php?id=2910])

Version 19.04

New in version 19.04.

An option in track headers allows you to have audio record controls. This
enables you to play your project while recording a voice over comment. Very
handy for making tutorials.

You will need to right-click an audio track and then click Show Record
Controls.

https://bugs.kdenlive.org/view.php?id=2910


Note

This will likely record stereo audio, which can be mixed down to mono
using the Audio correction Copy Channels effect.



Media Browser

Contents

Media Browser

New in version 21.04.0.

The new Media Browser allows you to easily navigate through your file
system and add clips directly to the Bin or Timeline. You can enable it from
View menu.



The Project Bin

Contents

The Project Bin
Create additional project bins
Clip - Right-Click Menu

The Project Bin is a view in Kdenlive which lists all the clips that are
associated with the project. In earlier versions of Kdenlive this view was
known as the Project Bin. In addition to the new name, versions 15.04 and
higher introduced two new options to the view’s toolbar. The list following
the example describes the options represented by the icons on the toolbar
(identified by the numbers in the screenshots).

20.04+



1, 10. Opens the Project Folder in a window for selecting video and audio
clips to be added to the bin (1). Or double click on free space (10).

2, 10. Displays a drop down list for adding other clip types to the Project
Bin (2). Or right-click on free space (10).

Options from Menu under Icon 2

Add Clip or Folder
Add Color Clip
Add Image Clip
Add Title Clip
Add Template Title Clip
Create Animation… (new in version 22.08)
Online Resources
Generators

3, 10. Allows you to add folders to the Project Bin (3). Or right-click on free
space (10) and select Create Folder to add folder. These are not actual file
system folders but virtual folders to help you organize large Project Bins.
See Create Folder



4. Deletes the selected clip from the Project Bin (but not from the file
system).

5 Color tagging.

New in version 20.04.0.

Menu under Icon 5

Edit tags: double click a tag for changing the description.

New in version 22.08.



You can: add, delete and reordering tags.

Reordering tags: grab a tag and drag it to the desired place in the list.

6. Brings up additional options shown below for customizing the Project Bin
view .



Menu under Icon 6

7 Filter by tags and stars

Menu under Icon 7

Filtering by clip type



Menu under Icon 7

8. A search box to display all the clips in the bin whose filenames or titles
contain the entered text.

9. Number of times this clip is used in the project timeline

Clips can be dragged from the Project Bin to the Timeline.

Create additional project bins

New in version 21.12.



You can create various bins from folders you have created. Right-click the
folder name and choose Open in new bin

Closing the extra bins either by pressing CTRL + w or on the bin you want to
close click on  and choose Close .

Clip - Right-Click Menu

The images below show the menu items available when you right-click a clip
in the Project Bin.



The menu items which appear when you right-click on an item in the Project
Bin are also available from the Clip Menu.

Extract Audio

Transcode Menu Item

Clip Jobs

Stabilize
Automatic Scene Split
Duplicate Clip with speed change

Clip In Timeline

Clip Menu — Locate Clip

Clip Menu — Reload Clip

Clip Menu — Replace Clip

Clip Menu — Duplicate Clip

Clips



Clips

Edit Clip

Rename Clip

Delete Clip

If you want to reverse a clip you can do it via Motion Effects - Speed or by
Duplicate Clip with speed change



Project and File management

Contents

Project and File management
File Structure

File Structure

As already pointed out in the Quick Start, we suggest using a different project
folder for each project. Kdenlive will generate the following folders for
caching in the project folder:

/proxy/ for the Clips that have been generated
/thumbs/ for thumbnails to all used clips
/titles/ default location for the Titles saved outside the project file
/.backup/ for your project’s automatic Backup These directories can
be deleted if not required anymore (for example for saving space on the
harddrive). Kdenlive will create them again when you load the project
the next time.

Warning

The /titles/ directory is the default directory for saved
.kdenlivetitle title files. Make sure that you did not save any important
files in there before deleting it.

Source clips can be located anywhere. Still, here are some thoughts about
their location:



Material (images, clips, audio) that is used for one project only can be
put into a subdirectory of the project folder as well. This keeps all
important files together, and searching for the files takes less time.
Material that is used by multiple projects is convenient when kept
together. I’ve got a video collection the same way that I have a photo
collection.

Contents:

Archiving
Auto Save
Backup
Clips
Annotating
Project File Details
Project Settings Dialog



Archiving

The Archiving feature (Project ‣ Archive Project, see Project Menu) in
Kdenlive allows you to copy all files required by the project (images, video
clips, project files,…) to a folder, and alternatively to compress the whole
into a tar.gz or a zip file.

Archiving changes the project file to update the path of video clips to the
archived versions.

This can be useful if you finished working on a project and want to keep a
copy of it, or if you want to move a project from one computer to another.

The resulting tar.gz or zip file can be opened directly in Kdenlive with File ‣
Open, then switch file ending to Archived Project.



Kdenlive will uncompress it to a location you specify before opening it.

If you have archived the project with the option Archive only timeline clips,
Kdenlive ask what it should do with the not archived clips.



Auto Save
Autosaves are generated 3 seconds after the user do a undoable action, BUT
only if you don’t do another action within these 3 seconds. These autosaves
are offered the first time after you open the project again in case the autosave
is newer than the last saved project version. Autosaves are stored in stale
files, not in normal *.kdenlive files



Backup

Contents

Backup

The Backup widget, found in Project ‣ Open Backup File allows you to
restore a previous version of your project file.

In case something went wrong (corrupted project file, unwanted change, …),
you can now restore a previous version of the file using this feature. Just
select the version you want and click Open.

The backup files are automatically created each time you save your project.
This means that if you save your project every hour, the backup widget will
show you a list of all the saved files, with a small image of the timeline at the
time you saved the project.

Kdenlive keeps up to 20 versions of your project file in the last hour, 20
versions from the current day, 20 versions in the last 7 days and 20 older
versions, which should be sufficient to recover from any problem.



Clips

Contents

Clips
Clips (Video, Audio, Images and Animation)
Color clips
Image Sequence clips
Title clips
Create Animation
Online Resources
Stop Motion
Proxy clips
Clip Properties

File Info
Properties
Audio properties
Markers
Metadata
Analysis

Generators
Counter
White Noise
Color Bars

See also Clip Menu.

Clips (Video, Audio, Images and Animation)

The  button (or Add Clip or Folder… or double click into an empty place
in the project bin) brings up the Add Clip Dialog where you can choose



video, audio, animation (new in version 22.08) or still image clips to add to
The Project Bin.

The button  labeled 1 toggles File Preview on and off (applies to image
files only).

The slider labeled 2 adjusts the size of the preview icons.

Checkbox Import image sequence (labeled 3) enables the import of a series
of images that can be used to make a stop motion animation.

New in version 21.12.

Checkbox Ignore subfolder structure (labeled 4) enables import video
footage or audio recording folders while automatically ignoring any sub-
folder structures created by some devices, such as the Sony XDCam,
Panasonic P2, Canon camcorders or Zoom audio recorders.

You can add other types of clips by choosing a clip type from the menu
brought up from the drop down button next to the  button.



Color clips

Add Color Clip…: Color clips are images composed of a single color that
can be added to the Project Bin. They can be useful to provide a background
on which to place titles.

Add color clips by choosing Add Color Clip from the drop down button next
to the  button.

This brings up the Color Clip dialog from which you can choose a color and
a duration.

Clicking OK adds the clip to the project bin. The clip can then be dragged to
the timeline. The duration of the color clip can be adjusted on the timeline.



Image Sequence clips

Add Image Sequence: Image Sequence clips are clips created from a series
of still images. The feature can be used to make an animation from a
collection of still images or to create a slideshow of still images. To create
the former, use a short frame duration; to create the latter, use a long frame
duration.

To create an image sequence clip, choose Add Image Sequence from the Add
Clip drop down list.

From the Image Sequence dialog choose Filename pattern as Image
selection method.



Browse to the location of the images which will make up your image
sequence and select the first image. The subsequent images that are to be
used in the slide show will be selected based on some sort of filename
algorithm that predicts what the next image file name should be.

For example, if the first image is 100_1697.jpg then the next will be
100_1698.jpg, etc.

Select an appropriate frame duration – this defines how long each image be
displayed.

Then hit OK. A video file made up of all the images in the folder from which
you selected the first frame file from will be added to the Project Bin.

You can then drag this video to the timeline.

Center crop: automatically fills the output video frame with the images while
maintaining their aspect ratio by zooming the image and cropping equal
amounts from each edge until can fill the full frame. Without this option, the
image will not be zoomed, but black bars will appear when the photo
orientation or aspect does not match the video’s.

Animation: adds preset slow smooth pan and zoom effects also known as the
Ken Burns Effect. You can choose no animation, pans only, zooms only, or a
combination of pans and zooms. Each option also has a low pass filter to
reduce the noise in the images that may occur during this operation. Low pass
filtering is much slower, so you should preview without it, and then enable it
to render.

Title clips

See Titles.

Create Animation

New in version 22.08.



Create Animation…: Creates a new animation. Give a name for your new
animation and it opens Glaxnimate and adds the newly created animation to
the project bin. You can then edit the animation in Glaxnimate by right-click
on the animation and choose Edit Clip and whenever you save it, it is
automatically updated in Kdenlive.

Kdenlive supports Json (Lottie animations) and rawr (Glaxnimate animation)
animation.

Json and rawr files contains an alpha channel so the imported animations
have a background which is not visible.

If Glaxnimate is not installed on your computer following message pops-up:

For Glaxnimate installation see here.

Online Resources

See Online Resources.

Stop Motion

See Stop Motion Capture.

Proxy clips



Proxy clips create a lower-quality transcode of the original footage for use in
real-time rendering in the project monitor. This allows for a smoother editing
experience even on slower computers with High Definition footage. When
rendering, by default, the original quality footage is used and not the proxy
footage. For example, Video decoding of H.264 or H.265 clips, requires a
lot of computing power to decode and could cause playback stutter when
rendering effects in real time.

Proxy clips can be enabled/disabled for the current project in the Project
Settings (Project ‣ Project Settings… ‣ Proxy tab ‣ Enable Proxy Clips
option).

To enable proxy clips by default for new projects, go to Settings ‣ Configure
Kdenlive… ‣ Proxy Clips page ‣ Enable Proxy Clips option. See also the
Project Settings Dialog page.



As soon as proxy clips are enabled, they can be generated for specific
project clips in the Project Bin widget via the context menu Proxy Clip. After
you select Proxy Clip for a clip, a job will start to create the clip. You can
view the progress of this job by looking at the little gray progress bar that
appears at the bottom of the clip in the Project Bin – see picture. Clicking
Proxy Clip again disables the proxy for this clip.

You can multi-select clips in the Project Bin and select Proxy Clip to start a
batch proxy clip generation job which will queue up multiple proxy clip
generation jobs.

Once the proxy clip creation has completed, the proxy clip will appear with
a P icon in the Project Bin.

When rendering to the final output file, you can choose whether to use the
proxy clips as well. It is disabled by default , but for a quick rendering
preview it is useful.

Clip Properties

You can display and edit clip properties by selecting a clip in the The Project
Bin and choosing Clip Properties from the Project menu or from the right-
click menu. Or by turning on the display of clip properties the View and
enable Clip Properties.

File Info



The File Info tab displays information about the file.

Properties



The Properties tab displays advanced properties of the clip where you can
select a check box and then force the clip to take the property you specify.
For example, you can use Aspect ratio to tell a clip that seems to have
forgotten it was 16:9 ratio that it really is 16:9 ratio.

Advanced Clip property options are:

Duration: Change the clip duration. If the duration is shorter than the
clip duration, then the clip is cropped. If the duration is bigger than the
clip duration, then the last image is repeated until the new duration is
over.
Aspect ratio: Change the clip aspect.
Proxy clips: Enable a proxy clip for this clip. See Clips.
Frame rate: Change the clip frame rate. See Wikipedia Frame rate
[https://en.wikipedia.org/wiki/Frame_rate].
Scanning
Field order
Disable autorotate

https://en.wikipedia.org/wiki/Frame_rate


Threads
Video stream
Audio stream
Colorspace
Full Luma

Audio properties

For each channel you can adjust:

1. Choose which audio channel should be enabled or disabled. Rename
with double click.

2. Normalize the channel
3. Swap the channels
4. Copy a channel on the other one
5. Adjust the volume

for all channels:

6. Adjust the synchronization time related to the video of the clip.



Markers

You can use the Markers tab to add markers for certain points in the source
file that are important. However, it is probably easier to add markers to your
clips via the Monitors because that allows you to preview the file at the
location where you are adding the marker.

Once markers are put in your clip, you can access them in the Monitors by
right-clicking and selecting Go To Marker (see picture.) Also note how the
markers appear as red vertical lines in the Clip Monitor (see yellow
highlighted regions in the picture.) You can turn on the display of the marker
comments in the timeline too (see Editing).



Markers can also be added to clips on the timeline. Right-Click Menus the
clip and choose Markers ‣ Add Marker. Markers added this way also appear
in the clip in the Project Bin.

Metadata

You expect this to show any meta data that is contained in the clip. Does not
appear to work.

Analysis



You can view and delete motion vector data that is associated with the clip
from here. This is data created by Auto Mask

Button 1 Will delete the selected analysis data, Button 2 will allow you to
export the data (semi colon delimited text file), Button 3 will allow you to
import analysis data.

Generators

Counter



This generates a counter timer clip in various formats which you can put onto
the timeline.

You can choose to have the clip count up by checking that option, otherwise it
will count down by default. The No Background option will remove the
background from the counter leaving only the grey background without the
lines.

To change the size and position of the clip, you can add an effect to the clip
on the timeline such as the Position and Zoom or the Transform.

White Noise



This generates a video noise clip – like the “snow” on an out-of-tune
analogue TV. In ver 17.04 it generates audio white noise as well as video
snow.

Color Bars



This generator came in to Kdenlive around ver 17.04. Generates a color test
pattern of various types. Including PAL color bars, BBC color bars, EBU
color bars, SMPTE color bars, Philips PM5544, FuBK



Annotating

Contents

Annotating

Sometimes, you want to keep some notes about your project to remember
ideas or things to do. For this task, Kdenlive provides a “Notes” widget that
is available through View ‣ Project Notes.

It is basically a small text editor, but also has the ability to create links to
some places in your project’s timeline. To add a timeline link as shown in the
snapshot on the left, right click in the Notes widget and choose Insert
Current Timecode. That will add a clickable link to the current project
monitor timecode.

You can also provide annotations using Guides or Clips



Project File Details

Contents

Project File Details

Kdenlive projects consist in a singe .kdenlive file (in XML format),
gathering :

target video and audio properties
references to all the source materials (and to their lighter proxies work
copies)
clips arrangement on the timeline, with effects applied, and everything
to get the final result

Project files are associated with a working directory, in which Kdenlive will
generate proxies and thumbs, so that an overview of your media always
shows up quickly (if you move your project file, you should declare the
directory change in the project properties).

New in version 20.08.0: A major refactoring of the project file fixes a long
standing issue with the decimal separator (comma/point) conflict causing
many crashes.

Warning

Projects created with 20.08 forward are not backwards compatible, that is,
you won’t be able to open your .kdenlive project files with older
versions.



Project Settings Dialog

Contents

Project Settings Dialog
Project Settings Tab

Project Folder
Video Profile
Tracks
Thumbnails
Proxy Clips Tab

Metadata Tab
Project Files Tab
Cache Data Tab

This is reached via Project Settings in the Project Menu menu. This dialog
has 3 Tabs.

Project Settings Tab



The Project Settings dialog is shown when you start a new project (File ‣
New). This allows you to set all basic properties for your project. You can
also edit the properties of your current Project Menu in Project ‣ Project
Settings.

Project Folder

As recommended in the Quick Start section, you should create a new folder
for your project. This folder will hold all temporary files that are used during
the editing of your project (thumbnails, proxy clips, etc).

Video Profile

The video profile will define the format of your project. A list of predefined
formats is available in Kdenlive, for example DV / DVD PAL, HD 1080i 25
fps, etc.

You can use the pull-down menus to filter the list of profiles by FPS (Frames
per second) or Scanning (Interlaced or Progressive)

The profile defines the video resolution, as well as display aspect ratio,
color space and a few other parameters.



You should carefully choose your project format and select the one which
best fits your desired output. All video operations on the project (like
compositing, scaling, etc) will then use this profile. Advanced users can
create custom project profiles in Manage Project Profiles.

For example, if your goal is to create a DVD, you should use a DVD profile
with the correct frame rate (PAL / NTSC) and display ratio (widescreen or
not).

Tracks

You can select the default number of audio and video tracks that your project
will have. You can always add or remove tracks in an existing project.

Thumbnails

The Audio and Video thumbnails are shown in the Timeline. They can also
be enabled/disabled through buttons in the Status Bar.

Proxy Clips Tab



When the Proxy Clip feature is enabled, Kdenlive will automatically create
reduced versions of your source clips, and use these versions for your
editing. Kdenlive will replace the proxy clips with the originals for a full
resolution when rendering.

The Generate for videos larger than x pixels option will automatically
create proxy clips for all videos added to the project that have a frame width
larger than x. This also applies to images.

You also have the choice to manually enable / disable proxy clips for each
clip in your project bin by right-clicking on the clip and choosing Proxy Clip.



You can choose an Encoding profile for the proxy clips, which will define
the size, codecs and bitrate used when creating a proxy. The proxy profiles
can be managed from the Kdenlive Settings dialog (Settings ‣ Configure
Kdenlive ‣ Project Defaults).

Metadata Tab

Screenshots below show the Metadata tab of Kdenlive.

Metadata set up here will be written to the files rendered from the project if
Rendering is checked in File Rendering.



Project Files Tab



From here you can export the project files data.

If you want to remove unused files from your project use Project > Clean
Project.

Cache Data Tab



The Cache data tab shows the data used in the project including the timeline
preview, proxy clips, audio thumbnails, and video thumbnails.

You can click on the trashcan icon to clear the cache data for that category.



Cutting and assembling
Contents:

Editing
Seeking through your project
Cutting a clip
Resizing a clip
Change speed of a clip
Removing Space Between Clips
Timeline Toolbar
Track Compositing
Timeline Edit Modes
Timeline Edit Tools
Status Bar
Cutting Footage from multiple aligned tracks - Ripple Delete
3 point editing

Grouping
How to Group Clips
Cutting Grouped Clips
Removing Clip Grouping

Guides
Export guides as chapter
Move Guides with Spacer Tool

Right-Click Menus
Clip in Timeline
Empty Space in Timeline



Editing

Contents

Editing
Seeking through your project
Cutting a clip
Resizing a clip
Change speed of a clip
Removing Space Between Clips
Timeline Toolbar
Track Compositing

High Quality
None
Preview

Timeline Edit Modes
Normal Mode
Overwrite Mode
Insert Mode

Timeline Edit Tools
Selection Tool
Razor Tool
Spacer Tool
Slip Tool
Ripple Tool
Multicam Tool

Status Bar
Split Audio and Video Automatically
Automatic Transitions
Show Video Thumbnails
Show Audio Thumbnails
Show marker comments
Snap
Fit Zoom to Project



Zoom project
Cutting Footage from multiple aligned tracks - Ripple Delete
3 point editing

Source
Target
Examples of advanced edit

Editing is done in the Timeline. Add a clip by dragging it from the The
Project Bin or the Monitors. Once a clip is dropped on a track, it can be
moved (drag and drop it) to another place on the same track or onto another
track.

New in version 19.08.0: Editing with keyboard shortcuts was introduced



This will speed up the editing work and you can do editing steps that are not
possible or not as quick and easy with the mouse. Working with keyboard
shortcuts in 19.08 is different as in the former Kdenlive versions. Mouse
operations have not changed and working as before. See 3 Point Editing

Seeking through your project

The timeline cursor shows your current position in the project. The positions
of the cursors on the timeline ruler and Project Monitor are always in sync.
Position can be moved in the following ways:

Keyboard shortcut: right / left arrows for one frame, Shift+ right / left
for 1 second
Clicking/dragging in the Timeline or in an empty area of the timeline.
Clicking/dragging in the Monitors ruler.
Rotating the mouse wheel while the pointer is over the Timeline or over
the Monitors
Editing the timecode in the Monitors timecode widget
Clicking the up or down arrows on the Monitors timecode widget

Cutting a clip

To cut a clip, the easiest way is to place the timeline cursor where you want
to cut the clip, then select the clip (left click in it) and use the menu Timeline
‣ Current Clip ‣ Cut Clip (default shortcut: Shift + R).

Or Right Click ‣ Cut Clip

Alternatively - use the Spacer Tool.

Resizing a clip

A clip can be resized from its start or end by dragging its left or right edge. If
you want a more precise resize, you can place the timeline cursor wherever
you want the resize to end and use the menu Timeline ‣ Resize Item Start
(default shortcut: ( or Timeline ‣ Resize Item End (default shortcut: ))



To even more precisely control the length of a clip, double click it in the
timeline and adjust its duration using the Clip duration dialog. You can have
frame-level accuracy with this method.

You can also resize a clip by cutting it with the Razor Tool and then deleting
the bit you do not want.

New in version 19.08.

Adjust AV clips independently with Shift + resize to resize only audio or
video part of a clip.

alt + Move in timeline allows to move the audio or video part to another
track independently.

Change speed of a clip

New in version 19.08.



Adjust the speed of a clip by pressing CTRL + dragging a clip in the
timeline.

Doing with right click on the clip see Change speed.

Removing Space Between Clips

Right click in the space between the clips and choose Remove Space. Be
aware however that if you have clips on multiple tracks in the timeline and
they are not grouped, then removing space may disturb the alignment of the
clips between the different tracks – the space is only removed from the
timeline where you clicked. Under this situation it may be safer to use the
Spacer Tool.

Timeline Toolbar



There is a toolbar between monitors and the timeline that controls various
aspects of the editor.

1. Track Compositing drop down.

Changed in version 22.08.

Track compositing is now a simple checkbox instead of the deprecated
none/high resolution choice.

When enabled Kdenlive is set to High Quality

When disabled Kdenlive is set to None



Deprecated since version 22.08.

1a, 1b and 1c cannot be selected anymore.

1a. None

1b. Preview

1c. High Quality

1d. Mixed Audio tracks changes the order in which tracks are displayed to
mixed audio and video tracks. For example, from the bottom of the timeline
to the top of the timeline: A1, V1, A2, V2, A3, V3

1e. Split Audio tracks changes the order in which tracks are displayed to
separate audio and video tracks. For example, from the bottom of the
timeline to the top of the timeline: A1, A2, A1, V1, V2, V3

1f. Split Audio tracks (reverse) changes the order in which tracks are
displayed to separate audio and video tracks with the audio tracks in reverse
order. For example, from the bottom of the timeline to the top of the timeline:
A1, A2, A3, V1, V2, V3

2. Timeline Edit Mode Drop Down. These same settings can be found
under the Tool menu.

2a. Timeline Normal Mode

2b. Timeline Overwrite Mode

2c. Timeline Insert Mode

3. Use timeline zone  / Do not use timeline zone  for insert (toggles).
See :Insert and Overwrite: advanced timeline editing for more details.

Tool Group (one of these 3 can be active)

Active buttons are grey.



4. Selection Tool - Also selected with the ‘S’ hotkey. Allows the selection
and manipulation of clips on the timeline

5. Razor Tool - Also selected with the ‘X’ hotkey, or to cut at the point of
the play head use “Shift-R”. This allows a clip to be cut into two clips.

6. Spacer Tool - Also selected with the ‘M’ hotkey. This tool will select
all clips at one point in the timeline and allow them to be shifted at
once.

7. Position indicator - displays the time point or frame number of the
location of the hovering mouse on the left side, and the total length of the
project on the right side.

7a. hh:mm:ss:ff; Sets the position indicator to display time units

7b. Frames Sets the position indicator to display frames

8. Mix Clips - allows same-track transitions to be applied between two
clips. See Mixes for a detailed explanation.

9. Insert Clip Zone in Timeline. See Insert and Overwrite: advanced
timeline editing for more details.

10. Overwrite Clip Zone in Timeline. See Insert and Overwrite: advanced
timeline editing for more details.

11. Extract Timeline Zone
12. Lift Timeline Zone
13. Favourite Effects
14. Start Preview Render

14a. Stop Preview Render

14b. Add Preview Zone

14c. Remove Preview Zone

14d. Remove All Preview Zones

14e. Automatic Preview

14f. Disable Timeline Preview



14g. Manage Cached Data

New in version 22.04:

14h. Preview Using Proxy Clips. Option to render preview using original
clips, not proxies (disabled by default).

Items 14, 14a-14g are covered in detail by Timeline preview rendering
article.

1. Show/Hide the Audio Mixer tool. The audio mixer tool allows audio to
be managed in the project.

2. Show/Hide the Subtitle Tool. This will show or hide the subtitle track
where subtitles can be created or edited in the project.

Track Compositing

The track compositing applies uniformly to all tracks in your timeline.

Tip

Under certain compositing conditions, if you see the outcome of a transition
not to be what you would expect, try to switch track compositing off for a



quick check. If the oddity is gone, then this is an interference between the
automatic timeline track compositing and your user transitions.

Changed in version 22.08.

Track compositing is now a simple checkbox instead of the none/high
resolution choice.

High Quality

When track compositing is set to High-Quality tracks with alpha channel
information will be automatically composited with the other tracks using an
algorithm that is somewhat slower than the algorithm used with Preview but
which retains higher fidelity color information.

None

When Track Compositing is set to None you will not get tracks with alpha
channel information to composite with the other tracks unless an explicit
composite or affine transition is added between the clips. This is basically
kind of an expert mode when you need full control over any compositing in
your timeline.

Preview

Deprecated since version 21.08.

Note

Final rendering always uses either High Quality or None. So Preview
quality is, well, for preview only.

When track compositing is set to Preview tracks with alpha channel
information will be automatically composited with the other tracks using an



algorithm that is somewhat faster than the algorithm used with High Quality
but which slightly degrades the colors.

Timeline Edit Modes

Normal Mode

In this edit mode, you can not drag clips on top of other clips in the same
track in the timeline. You can drag them to another track in the timeline but
not into the same track at the same time point as an existing clip. Contrast this
to overwrite mode.

Overwrite Mode

In this edit mode, you can drag a clip onto a track where there is an existing
clip and the incoming clip will overwrite that portion of the existing clip (or
clips) covered by the incoming clip.

Before



After

In the “After” screenshot above, you can see that the clip which was dragged
from the upper track has replaced a portion of the clip on the lower track.

Rearrange clips in the timeline

Performing a rearrange edit. This technique lets you quickly change the order
of clips in the timeline.

Drag a clip, as you drop it to a new location performs an overwrite edit that
overwrites the existing clip.

Insert Mode

With this mode selected and you drop a selection into the timeline the
selection will be inserted into the timeline at the point where the mouse is
released. The clip that the selection is dropped on is cut and clips are moved
to the right to accommodate the incoming clip.



Before

During

After. Incoming Clip inserted. Clips after the insert point are
shifted Right

Rearrange edit in the timeline

Performing a rearrange edit. Only clips in the destination track are shifted;
clips in other tracks are not affected. This technique lets you quickly change



the order of clips in the timeline.

It always closes all space in the track.

Drag a clip, as you drop it to a new location. Releasing the clip performs an
insert edit that shifts clips in the destination track only.

Timeline Edit Tools

Selection Tool

Use this to select clips in the timeline. The cursor becomes a hand when this
tool is active.

Razor Tool

Use this to cut clips in the timeline. The cursor becomes a pair of scissors
when this tool is active.

ESC: Return from any tools back to Selection tool.

Spacer Tool



Use this tool ( ) to temporarily group separate clips and then drag them
around the timeline to create or remove space between clips. Very useful.
Experiment with this tool to see how it works.

In the above example, these clips are not grouped. However, the spacer tool
groups them temporarily for you so you can move them all as a group.

ESC: Return from any tools back to Selection tool.

New in version 21.12.

Slip Tool

Slip keeps the original duration of the clip. Like working with old film
material: beneath the given “window” of the clip length it slips the film strip
back and forth.



Use Slip ( ) to trim, in a single operation, the IN and OUT points of a clip
forward or backward by the same number of frames, while keeping the
original duration and without affecting adjacent clips.

You can slip multiple clips at once now: select all clips you want to slip with
the selection tool using Shift then enable the slip tool and go ahead…

Slip can be done with the mouse, with the arrow keys and with the buttons on
the monitor toolbar.

ESC: Return from any tools back to Selection tool.

Ripple Tool



Ripple changes the original duration of the clip. Like working with old film
material: You lengthen or shorten the film strip and move the adjacent clips
back and forth as you do that.

Use Ripple ( ) to trim a clip and shift following clips in the track by the
number of frames you trim. When you shorten a clip by this action all clips
that follow the cut shift back in time, contrariwise, when you extend a clip
the clips after the cut shift forward in time. If an empty space is on the track it
behaves as a clip and it shifts in time as a standard clip would be.

You can Ripple only a single clip at once.

Ripple can be done with the mouse only.

ESC: Return from any tools back to Selection tool.

Multicam Tool



Add your clips in different tracks, but at the same position in the timeline and
activate the multicam tool by going to menu Tool -> Multicam tool. You may
trim the clips in the desired track while the timeline is playing by pressing
their corresponding numbers (for track V1, press key 1; for track V2 press
key 2, etc…) or simply select the desired track in the project monitor by
clicking on it with the mouse.

Select multicam tool will switch on the multitrack view in the project
monitor and set a marker at the current timeline position. You can then
seek/play to the wanted position, click on a track view in the project monitor
and it will lift all tracks except for the previously active track. You can then
repeat seek and click in another track to continue lifting tracks.

It doesn’t stop playing when you perform the operation to avoid to lose the
rhythm and to work as you are working during a live broadcasting. If you
need to correct the editing you can manually stop and trim the cut as you do
when you video editing as normal.



The audio tracks is not involved in the process as you generally use only one
audio track (the one which come from the main mixer to which the other ones
are synced to)

ESC: Return from any tools back to Selection tool.

Status Bar

24. Split Audio and Video Automatically
25. Automatic Transitions
26. Show Video Thumbnails
27. Show Audio Thumbnails
28. Show marker comments
29. Snap
30. Fit Zoom to Project
31. Zoom Out
32. Zoom Project
33. Zoom In

Split Audio and Video Automatically

When this is on and you drag a clip to the timeline, the audio in the clip will
end up on an audio track and the video on a video track. You can achieve the
same result if you select the clip, Right-Click Menus, Split Audio. When this
is off and you drag a clip onto the timeline, both the audio and video tracks
are combined into one video track.

Automatic Transitions

When active any transitions added to the timeline will have the automatic
transition option checked by default. See Transitions



Show Video Thumbnails

When on, the video clips in the timeline will contain thumbnails as well as a
filename. Otherwise, they just have the clip filename.

When the timeline is zoomed in to the maximum, the video track will show a
thumbnail for every frame in the clip. When the timeline is not on maximum
zoom, the video track will show a thumbnail for the first and last frame in the
clip.

Show Audio Thumbnails

When on, the audio clip will have a wave representation of the audio data as
well as a filename. Otherwise, they just have the clip filename.

Show marker comments

This toggles on and off the display of the comments saved within Clips (the
text with the gold background in the example below) and within Guides (the
text with the purple background).

Snap

When this feature is on, dragging the beginning of one clip near to the end of
another will result at the end of the first clip snapping into place to be
perfectly aligned with the beginning of the second clip. As you move the two
ends near to each other, as soon as they get within a certain small distance,
they snap together so there is no space and no overlap. Note that this occurs
even if the clips are on different tracks in the timeline.



Clips will also snap to the cursor position, markers and Guides.

Fit Zoom to Project

This will zoom the project out so that it all fits in the timeline window. This
is the same function that is triggered by Timeline Menu Menu item, Fit Zoom
to Project.

Zoom project

The magnifying glasses zoom in or out on the timeline. The slider adjusts the
zoom by large increments. These same settings are controlled by the Timeline
menu items, Zoom In and Zoom Out.

Cutting Footage from multiple aligned tracks -
Ripple Delete

This is available on the Timeline menu under All clips ‣ Ripple Delete [1] .

Seems missing in Kdenlive 17.04 & 18.04

Mark In and Out points in the Project Monitor, then choose Timeline ‣ All
clips ‣ Ripple Delete (or Ctrl + X). Kdenlive deletes all footage between
the In and Out points in unlocked tracks, slides everything else back to fill the
gap, and puts the playhead on the In point.

3 point editing

New in version 19.08.0.

3 important points to understand the 3 point editing concept (with keyboard
shortcuts):

Source



On the left of the track head the green vertical lines (V1 or A2). The green
line is connected to the source clip in the project bin. Only when a clip is
selected in the project bin, the green line shows up depending on the type of
the clip (A/V clip, picture/title/color clip, audio clip).

Target



In the track head the target V1 or A1 is active when it’s yellow. An active
target track reacts to edit operations like insert a clip even if the source is not
active.

The concept is like thinking of connectors

Connect the source (the clip in the project bin) to a target (a track in the
timeline). Only when both connectors on the same track are switched on the
clip “flow” from the project bin to the timeline.

Important

Active target tracks without connected source react on edit operations.



Examples of advanced edit

Here is a brief introduction to the 3 point editing system.

1. Select a clip in the project bin with an up/down arrow
2. Navigate the clip by the JKL keys or by the left/right arrows and set

the IN and the OUT point by the I and O keys.
3. Hit T to change to the timeline
4. Select a video or audio track in the timeline (up/down arrow key) and

set it as source with Shift + T.
5. Activate the track as a target with shortcut A (this connects the track to

the source)
6. Hit V (insert) or B (overwrite) to add the clip at the play-head position

or to fill the selected area in the timeline if it is active. If you need to



[1]

activate it use the G key.

In the following example, we want only to insert the audio part of a clip in
A2 and we want to create a gap in all the other video and audio tracks:

1. Activate all the target tracks which contain clips (yellow buttons).
2. Activate just the audio source on A2
3. Press V (insert).

available on bleeding edge version > 0.9.10 (Jan2015)



Grouping

Contents

Grouping
How to Group Clips
Cutting Grouped Clips
Removing Clip Grouping

FAQ

Grouping clips allows you to lock clips together so that you can move them
as a group and still retain their positions relative to each element in the
group.

How to Group Clips

You can select multiple clips in preparation for grouping them by holding
shift and clicking the mouse and dragging in the timeline.

To group the selected clips select Timeline ‣ Group Clips or right-click the
selected clips and choose Group Clips.



Cutting Grouped Clips

Grouping is also useful if you have separate audio and video tracks and need
to cut and splice both tracks at exactly the same point (e.g. for audio sync
reasons).

If you cut the video clip using the Editing when there is an audio clip grouped
to it, then Kdenlive cuts the audio clip at the same point automatically.

  

Removing Clip Grouping

To remove the grouping on clips, select the group of clips and choose
Timeline ‣ Ungroup Clips.

FAQ

Q: How to delete sound track only?

A: Right-click on the clip and choose Split Audio. The audio will move to an
audio track but be grouped with the video track.



Right-click again and choose Ungroup Clips.

Then you can delete just the audio track.

Alternatively you can keep the audio in the clip and use the Audio Correction
‣ Mute effect to just mute the soundtrack on the clip.

Yet another method is to select Video only from the Clip Menu.



Guides

Contents

Guides
Export guides as chapter
Move Guides with Spacer Tool

Guides are labels on the timeline that can be added by right-clicking at a spot
on the timeline ruler and choosing Add/Remove Guide or press G. You can
put a comment in the guide and make the comment display by choosing
Editing in the Timeline menu or by clicking on the Editing button.

New in version 21.08.

Guides Locked: See Move Guides with Spacer Tool

New in version 22.04.

Set Zone In/Out. See Timeline preview rendering

Add Project Notes: See Annotating



New in version 20.12.

Add Subtitle: See Subtitle

Guides in the picture below are the purple flags. Not to be confused with
Clips (gold in the picture below). Guides are static on the timeline and are
stationary when clips are moved around. Markers are inside the clips and
move with the clips.

Guides can be used to define regions for rendering. See Rendering Using
Guides and Rendering Scripts.

Guides can also be used as chapters for DVD videos. See Rendering Using
Guides and Rendering Scripts.

New in version 22.08.

Export guides as chapter

Guides can mark chapters or different sections of a video while editing.
Uploading edited videos to platforms like YouTube, the guides can be
exported as chapter marks that are supported by YouTube. This can be done
by Copy to Clipboard and paste then into YouTube.

Right click in the timeline ruler and choose Export Guides or Timeline ->
Guides -> Export Guides. Then the window Export guides as chapters
description appears.



Marker Type: Choose one of the guide types to mark chapters and use other
types to do other things.

Offset: This adds the ability to set a general offset (hh:mm:ss:ff) to each
guide.

Format: This defines how the chapter marks are exported. When using the 2
default format strings (as shown on the picture), Kdenlive check if the
chapter marker matches YouTube’s guideline, and display a notice if it
doesn’t match.

i: Shows all possible export strings. Select the string you want and Kdenlive
adds it to the Format for export. Add spaces between the strings as needed.



{{timecode}} adds guide position in HH:MM.SS (default)

{{comment}} adds the guide text (default)

{{frame}} adds the frame number of each guide

{{index}} adds guide number

{{nexttimecode}} adds next guide position in HH:MM.SS

{{realtimecode}} adds guide position in HH:MM:SS:FF

Reset: Resets the settings to the default: {{timecode}} {{comment}}

Exported: Shows what get exported. To change the guide text you have to
edit the guide in the timeline.

Copy to Clipboard: Copy the data viewed in Exported into the clipboard to
use it in other applications (Youtube).

Move Guides with Spacer Tool

New in version 21.08.0.

Easily moves Guides along with clips using the Spacer Tool by using the
new Guides Locked option.



Right-Click Menus

Contents

Right-Click Menus
Clip in Timeline

Change speed
Empty Space in Timeline

Clip in Timeline

This is the context menu that appears when you right-click on a clip in the
timeline. A different menu appears if you click in empty space in the
timeline.



Copy will copy the clip and selected clips to the clipboard.
Paste Effects will paste only the effects of the last copied clip to the
selected clip. See Paste Effects.
Delete Effects will remove all effects from the selected clip.
Group Clips - see Grouping
Ungroup Clips - see Grouping
Edit Duration - will open the Duration Dialog and will allow you to
adjust the position of the clip in the timeline, what time point of the



source clip to start on the timeline, the duration of the clip, and what
time point of the source clip to end on the timeline. Note that Kdenlive
will automatically adjust co-related values.

Restore audio will add any audio track that is part of the original clip to
the timeline



Disable clip will disable the clip so it will not render in the project
monitor or in a final video render. To disable the video or audio part of
an A/V clip you have to un-group the A/V clip, disable the video or
audio part and group the A/V clip again.



Extract clip will remove the clip from the timeline and the space it
occupied.

Save timeline zone to bin will take the selected timeline zone and add
markers to your clips in the project bin.

The markers sub-menu allows you to add, edit and remove markers
from your clips that are displayed on the timeline. These markers will



move with the clips. See Clip Menu - Markers.

Set Audio Reference and Align Audio to Reference are used to align
two clips on different tracks in the timeline base on the audio in the
tracks. This is useful if two cameras recorded the same scene
simultaneously. Kdenlive can use the almost identical audio track to
align the two clips.

To use this feature:

Select the clip that you would like to align to.
Right click, select Set Audio Reference.
Select all the clips that you would like to get aligned.
Right-click and select Align Audio to Reference.

Change speed

Change speed will open the change speed dialog that will allow you to
increase or decrease the playback speed of a clip, allow you to play the
clip in reverse, and will enable / disable pitch compensation for the
audio on a speed-adjusted clip.

Doing speed change of a clip with the mouse see: Change speed of a
clip

Clip in project bin will highlight the selected clip in the project bin.



Cut Clip Selecting this will cause the selected clip to be cut at the
location of the Timeline. See also Editing.

Insert Effect will open a sub-menu to allow you to quickly add the
Transform or the Lift/Gamma/Gain effects.

Insert composition will open a sub-menu to allow you to quickly add
the Compositing with Transparency or the Composition - Wipe
composition

Empty Space in Timeline

A different menu appears if you click in empty space in the timeline.

Paste will paste a clip from the clipboard into the timeline
Insert Space will open the Insert Space dialog and will allow you to
insert blank space in the timeline in a single track.
Remove Space will remove all space between clips on the track.
Remove Space in All Tracks will remove space between clips on all the
tracks.
Add/Remove Guide will add a guide to the timeline.
Edit Guide will allow you to edit the guide label.
Go to Guide will pop-up a sub-menu with a list of your guides and will
move the timeline position marker to that guide.
Insert composition will open a sub-menu to allow you to quickly add
the Compositing with Transparency or the Composition - Wipe
composition



Effects and compositions
Contents:

Audio
Audio Mixer
Multiple audio streams
Audio recording

Effects
Effects Tab
The Properties Tab and its Menu
Keyframes in effects
Master effect
Effect Zones
Time Remapping (Speed Ramps)
Masking Effects
Seek To Active Frame
Effects Demos
Effects Categories
FAQ

Alphabetical List of Effects and Compositions
Speech to text

Install Python
Install a language
Speech recognition
Silence detection

Subtitle
Titles

Create and Edit Title
Typewriter
Scroll Title Vertically
Scroll Title Horizontally
Save a Title
Load a Title
Title Template



Template Titles - User-Defined
How to fade titles in and/or out
How to fade in more than one title sequentially
FAQ

Transitions
Mixes
Compositions
Available Transitions



Audio
Kdenlive has some tools for handling audio. Beside the audio spectrum
viewer and some audio effects, you have following possibilities:

Audio Mixer

New in version 19.12.0.

Changed in version 22.08.



The audio mixer has following functions for each channel:

1. Channel number (audio track number) or Master channel
2. Mute an audio channel
3. Solo an audio channel
4. Record audio direct on the track of the related audio channel
5. Opens the effect stack of the related audio channel
6. Balance the audio channel. Either with the slider or with values
7. Adjustment of the volume



Multiple audio streams

New in version 20.08.0.

Multiple audio streams of a video clip. In clip properties on the tab audio
you can adjust and manipulate each audio stream. More details see here
Audio properties

Audio recording

Changed in version 22.08.

There is now a mic button in the mixers (number 4 in above picture) instead
of the record button. Pressing the mic button will enter in audio monitoring
mode (levels show mic input and volume slider selects the mic level). While
recording you see a live waveform appearing on timeline.

Enabling mic displays the track head record control and it get colorized.



Start record: press spacebar or click the record button on the track head. A
countdown start in project monitor.

Pause: press spacebar

To resume: press spacebar again

Stop record: press esc or click the record button in the track head. The
audio clip get added in the timeline and project bin.



Effects

Contents

Effects
Effects Tab
The Properties Tab and its Menu

The Properties Tab
Reset Effect
Save Effect
Create Group
Create Region

Keyframes in effects
Working with keyframes in the effect stack
Exchange keyframes across effects

Master effect
Effect Zones
Time Remapping (Speed Ramps)
Masking Effects
Seek To Active Frame
Effects Demos
Effects Categories
FAQ

Effects in Kdenlive can be used to modify the audio and video properties of
the source material.

You add effects to clips by choosing them from the Effects Tab and dragging
them onto a clip in the timeline. Or by selecting a clip in the timeline and
choosing the Timeline ‣ Add Effect menu item or Add Effect from Clip in
Timeline Right-Click Menus menu . For more detail see Quick Start.



The effects that are in play on a given clip can be viewed and edited via the
Properties Tab that displays when the clip in question is selected in the
timeline.

You can also apply effects to an entire track. This is achieved by dragging an
effect from the Effect Tab to the Track Header. Or you can click on the
track header and choose the Timeline ‣ Add Effect menu item. Tracks which
have effects added in this fashion will have a gold star icon in the track
header.

Figure 1a. Track header showing effect icon enabled indicating an
effect has been added to this track.

Effects Tab

Make the Effects Tab visible use the View ‣ Effects menu item.



Figure 1b - effects tab. The Information icon (6) has been toggled
so that the tab displays a brief description of the selected effect at
the bottom

The effects tab has 5 different icons that cause the application to show and
hide different categories of effects.

Changed in version 22.08: Main tab now displays all video and audio
effects.

By default the effects tab displays the “Main Effects” (Icon 1 selected) which
show all video and audio effects.

Icon 2 makes it display all the video effects categories (This option hides the
Audio Correction category that is in the “Main Effects” and adds the Misc
and Motion categories).



Icon 3 makes it display all the Audio effects categories

Icon 4 is Custom effects

Icon 5 is Favorite Effects. This is the same list that appears in the “Insert an
Effect …” context sensitive menu obtained on a clip in the timeline. An effect
gets in this list by choosing Add to Favorites from the context sensitive menu
on each of the effects.

Icon 6 toggles the information display which - when on - shows a description
of what the effect does.

Icon 7 let you download effects users had created and uploaded to the KDE
Kdenlive store.

To add an effect to a clip, simply drag it from the Effects Tab to the clip on
the Timeline.

The Properties Tab and its Menu

The Properties Tab

The Properties Tab displays the settings for the effects on the currently
selected clip (Figure 3) or the settings for the currently selected transition
(Figure 4) depending on whether it is a clip or a transition that is currently
selected.



Figure 3 - Properties when a clip with effects is selected



Figure 4 - Properties when a transition is selected

Click the eye icon shown at 2 to temporarily disable the effect and toggle the
button to the state shown at 1. Click the empty eye icon shown at 1 to re-
enable a disabled effect and toggle the button to the state shown at 2.

Toggle effect on and off



To remove an effect from a clip, click the trash can icon labelled 3 in the
image below. The arrow labelled 1 minimizes the effect in the Properties
Window. And the icon labelled 2 brings up the Properties Tab menu shown.

Reset Effect

This reverts all the settings in the effect back to their default values.

Save Effect

This allows you to save the current effect and all its settings. The saved
effect will appear in the Effect List in the Custom category.

Create Group

This creates an Effect Group. An Effect Group is a place holder for multiple
effects. You can then save the group of effects – they will the appear in the
Effect List, in the Custom Section. You can then later apply the whole group
of effects to other parts of the timeline.

To add effects to the group, first add the effect in question to a clip. Then
drag that effect and drop it onto the Effect Group in the Properties Tab.



Create Region

New in version 0.9.3.

The “Create Region” feature enables a user to apply an effect to a part of a
clip only. It is a really powerful feature but currently the UI is not fully ready
to get its full potential.

Basically, you add an effect to a clip – for example “Sepia” – then you go in
the effect’s menu and select “Create Region”. This will now open a file
dialog.

In that dialog, you need to point to an MLT clip with alpha transparency. This
is where Kdenlive is not 100% ready because there are many ways we could
create such clips, using for example a threshold filter or rotoscoping. But as
a start, let’s say you can open any image with alpha transparency, or a title
clip created with Kdenlive. Then, the “sepia” effect will only be applied on
the non-transparent areas of this “region” clip.

Keyframes in effects

Many effects use the concept of “Keyframes”. Keyframes are user-defined
points in your clip where you want an effect to start, stop or change. You can
set the parameters for your effects to different values at different keyframes
and Kdenlive will then gradually change the parameters between the two
keyframes so that by the time the video has arrived at the next keyframe it
will have adjusted the parameter to match that key frame. It interpolates
between keyframes.

See Quick Start for an example on keyframing the RGB adjustment effect.

New in version 20.08.0.

Effect panels get zoom bars. Adjusting keyframes just get easier.



Working with keyframes in the effect stack

New in version 21.04.0.

The effect’s keyframe panel has new icons, improved keyframe grabbing and
new functions like:

1. Select the keyframe you want to move
2. Move the cursor to the position where you want to move the keyframe to
3. Click on Move selected keyframe to cursor position



1. Select the keyframe you want to duplicate
2. Move the cursor to the position where you want to insert the new

keyframe
3. Click on Duplicate selected keyframe

1. Select all keyframes you want to apply the value on
2. Go to one of the selected keyframes and change the value(s) as you want
3. Click on Apply values to selected keyframes
4. Select the parameters you want to apply and click on OK

Select keyframes with Ctrl + click

Rubber select select keyframes with Shift + click



Move multiple keyframes at once

Exchange keyframes across effects

You can import and export keyframes from/to the clipboard. This feature is
not only useful to copy keyframes from one clip to another, it can e.g. also be
used to copy the results of the motion tracker to a transform effect.

To export the keyframes the clipboard click on  inside the keyframe
widget and choose Copy keyframes to clipboard.



To import keyframes from the clipboard click on  inside the keyframe
widget and choose Import keyframes from clipboard. If you have valid data
on your clipboard you should see a dialog similar to the screenshot where
you can adjust the mapping of the data.

Master effect

New in version 19.12..0.

The ability to apply audio or video effects to all tracks. See Master effects

Effect Zones



New in version 21.04.0.

The new Effect Zones allow you to apply effects to specific regions of tracks
or the timeline. Zones can be set from the effect zone bar in the timeline or
from the interface in the effect panel.

Track Effect Zone

Master Effect Zone

Time Remapping (Speed Ramps)

New in version 21.08.0.



The new Time Remap feature allows to keyframe the speed of a clip.

Masking Effects

New in version 21.08.0.

Masking Effects

You may now apply effects to only affect specific regions of a clip by using
masks. Do note that this is only the initial implementation so expect an
improved workflow in the coming releases. For now the process involves 3
steps:

1. Add one of the 3 available masks: Shape alpha (mask), Rotoscoping
(mask) or Alpha shapes (mask).

2. Add an effect (or effects) to be applied to the masked region.
3. Add Mask Apply to activate the mask to the effects in step 2.

You may apply more than one mask per clip by following the same 3 step
process.



Seek To Active Frame

Some keyframe controls have a seek to active frame button

(Labeled 1 in screenshot A below). When seek to active frame is toggled on
and you click on one of the keyframes in the keyframe list, Kdenlive will
scroll the preview window to that keyframe. In the example of the
screenshot, we have selected the keyframe at 9:20 in A and the clip position
caret (highlighted in red box) shows the location of this keyframe. Clicking
the keyframe at 10:00 in B shows how the clip position has moved.

Effects Demos

The following three YouTube videos display the results of a number of the
video effects available in Kdenlive (Spanish captioning).



https://youtu.be/C6oeu2Yc64I

https://youtu.be/jrC4F_G64jA

https://youtu.be/XMoSgHHbA4k

Another YouTube video (English Captions).

https://youtu.be/capV7lUzbOw

See also this YouTube play list from Franz M.P. [http://www.youtube.com/playlist?
list=PLc1VErdvjnSFE6w6sryFWIu4lfKavhnvz]

Effects Categories

See also Alphabetical List of Effects and Compositions for an alphabetical
list of effects and transitions.

The effects are divided into the following categories:

Alpha manipulation
Analysis and Data
Artistic Effects
Audio channels
Audio Correction
Audio Effects
Blur and Hide
Color
Color Correction
Crop and Transform
Custom Effects
Distort
Enhancement
Fade
Misc Effects
Motion

https://youtu.be/C6oeu2Yc64I
https://youtu.be/jrC4F_G64jA
https://youtu.be/XMoSgHHbA4k
https://youtu.be/capV7lUzbOw
http://www.youtube.com/playlist?list=PLc1VErdvjnSFE6w6sryFWIu4lfKavhnvz


The available effects are defined by .xml files found in
.local/share/kdenlive/effects (e.g.
/usr/share/kdenlive/effects).

These .xml files contain the default values for the effects parameters. So if
you don’t like the default values for the effects in Kdenlive, you can modify
the defaults by editing these .xml files.

FAQ

Q: How to duplicate an effect to use similar settings somewhere else?

A: Select your effect in the timeline. In the Properties Tab choose Save (from
the Effects). You will now find this effect available in the Effect List
Custom section.

A: Other solution: select a strip containing the effect, Copy, then, where you
want to apply it again, right-click and select Paste effect instead of Paste.

Q: How to apply an effect on several clips (all) at the same time?

A: You can select multiple clips with Shift + drag (left mouse button)
around them. Then right-click and group clips (or Ctrl + G).



Alpha manipulation

Contents

Alpha manipulation
General Information about Alpha Manipulation
Compositing Reference Material

Effects in this category

Alpha gradient
Alpha operations
Alpha Shapes
Chroma Key
Color selection
Key spill mop up
Mask0mate
Motion Tracker
Rotoscoping

General Information about Alpha Manipulation

Alpha Manipulation, more commonly known as Chroma Key compositing is
an effect that changes the background of the picture to a different background
the editor may want.

More information can be found on the pages for the effects themselves:

Chroma Key (for simple chroma key effects)
Color selection (for complex chroma key effects)

Compositing Reference Material



For some background, the Wikipedia article in alpha compositing
[https://en.wikipedia.org/wiki/Alpha_compositing] is useful. See also Porter, Thomas; Tom
Duff (1984). “Compositing Digital Images”. Computer Graphics 18 (3):
p253–259 1984 pdf [https://keithp.com/~keithp/porterduff/p253-porter.pdf]

https://en.wikipedia.org/wiki/Alpha_compositing
https://keithp.com/~keithp/porterduff/p253-porter.pdf


Alpha gradient

Contents

Alpha gradient

This is the Frei0r alphagrad [https://www.mltframework.org/plugins/FilterFrei0r-alphagrad/]
MLT filter, see also Frei0r-alphagrad readme
[https://github.com/dyne/frei0r/blob/master/src/filter/alpha0ps/readme] file.

Fills the alpha channel with a gradient.

https://www.mltframework.org/plugins/FilterFrei0r-alphagrad/
https://github.com/dyne/frei0r/blob/master/src/filter/alpha0ps/readme


Alpha operations

Contents

Alpha operations
Parameters

Display
Display input alpha
Operation
Threshold
Shrink/grow amount
Invert

Tutorial 1

This is the Frei0r alpha0ps [https://www.mltframework.org/plugins/FilterFrei0r-alpha0ps/]
MLT filter - Display and manipulation of the alpha channel.

Use this to shrink, grow, threshold and visualize the alpha channel.

This plugin can shrink, grow, threshold and invert the alpha channel. It is
mainly intended to improve keying edges. It can also display the alpha
channel in various ways, to enable quick assessment of the effect.

It is cascadable, so for example one can do a soft shrink first and then
threshold, which gives a slightly different result than a hard shrink.

Parameters

Display

What to display. There are seven options: Image, Alpha as gray, Gray + red,
Selection on black, Selection on gray, Selection on white, and Selection on
checkers.

https://www.mltframework.org/plugins/FilterFrei0r-alpha0ps/


This effect lets the unchanged input image though - this plugin is intended to
change only the alpha channel…

Display input alpha

Use input alpha for the display function above. (Check what alpha we are
getting on the input).

Operation

Select the operation to be done on the alpha channel. Currently there are eight
choices: NO OP, Shave, Shrink hard, Shrink soft, Grow hard, Grow soft,
Threshold, and Blur.

Shave try to remove the “hairy” stuff, and also shrinks the selection a bit.

The hard operations introduce no new values to the alpha channel, so if you
have a “hard” key (only 0 and 255) it will stay that way.

The soft operations will introduce interpolated values, making the edge
softer.

Note

The shave, shrink and grow operations are quite slow, because they do
many conditional operations on each pixel.

Threshold

This is only used for the Threshold operation.

Shrink/grow amount

How far the shrinking/growing will extend.

Invert



Inverts the input alpha channel, transparent will become opaque and vice
versa.

 

 

Tutorial 1

Shows usage of alpha operations - Shrink hard as well as the following
effects: Chroma Key, Denoiser, and Key Spill Mop Up.

https://youtu.be/l43Hz7YEcYU

https://youtu.be/l43Hz7YEcYU


Alpha Shapes

Contents

Alpha Shapes
Shape Options
Tilt
Position X and Y
Size X and Y
Transition Width
Operations
Min and Max Operations - Worked examples

This is the Frei0r alphaspot [https://www.mltframework.org/plugins/FilterFrei0r-alphaspot/]
MLT filter, see also Frei0r-alphaspot readme
[https://github.com/dyne/frei0r/blob/master/src/filter/alpha0ps/readme] file.

https://www.mltframework.org/plugins/FilterFrei0r-alphaspot/
https://github.com/dyne/frei0r/blob/master/src/filter/alpha0ps/readme


Use this in combination with a Composite Transition to place areas of
transparency onto an overlaying clip such that the underlying clip shows
through in places defined by geometric shapes. By default, the area of
transparency is outside the shape that is drawn. Inside the shape is an area of
opacity where the overlaying clip is visible.

Shape Options

This controls the shape of the area of opacity that the effect will create.

Shape options are Rectangle, Ellipse, Triangle, and Diamond.

Tilt

This controls the angle the shape appears on the screen. The units are in
1000ths of a full rotation. Eg, a factor of 250 is one-quarter of a circle turn
and 500 is a 180 turn. I.e., 1000 tilt units = 360 degrees.

Position X and Y

This defines the position of the shape on the screen.

Size X and Y

Defines the size of the shape.

Transition Width

Defines the width of a border on the shape where the transparency grades
from inside to outside the shape.

Operations



Operations define what is to happen when you have more than one Alpha
effect on the clip.

Operations are Write On Clear, Max, Min, Add, and Subtract:

Write On Clear = existing alpha mask is overwritten
Max = maximum( existing alpha mask, mask generated by this filter)
Min = minimum(existing alpha mask, mask generated by this filter)
Add = existing alpha mask + mask generated by this filter
Subtract = existing alpha mask - mask generated by this filter

See the worked examples below to understand what these operations do.

Min and Max Operations - Worked examples

These examples are performed on a simple composite transition with a video
file on Video track 1 and a color clip (yellow) on Video track 2.

Alpha shapes effect draws areas of opacity onto the image. The addition of
this filter (with the default settings of Min = 0 and Max =1000) makes the
whole frame transparent except for an area of opaqueness where the top
image can be seen.

The Max and Min controls adjust the opacity of the image inside and outside
of the shape respectively. A setting of 1000 is 100% opaque. A setting of
zero is 0% opaque (i.e., 100% transparent).

Max control



The Max control regulates how opaque it is inside the shape. At Max = 1000
it is completely opaque inside the shape and nothing of the background image
shows through.



At Max = 500 it is semi-transparent inside the shape and you can see the
background bleeding through.



At Max = 0 inside the shape is completely transparent - the same as the rest
of the foreground image - and you can see all background.

Min Control

The Min control adjusts how opaque it is outside the shape. When Min = 0
outside the shape is completely transparent (opacity of zero) and at Min =
500 we see something of the foreground appears outside the shape.



At Min = 1000 the opacity outside the shape is 100% and nothing of the
background appears.

Combining Alpha Shapes - Operations



In this example, I have a Triangle alpha shape defined as shown and this is at
the top of the effect stack with operation Write on clear.

Which appears like this on its own.

And I have Rectangle alpha shape as shown which is at the bottom of the
effect stack. Note the Max = 500 - i.e., 50% opacity inside the rectangle.



Which appears like this when on its own.

In the images below I demonstrate the effect of different alpha operations on
the Rectangle alpha shape.

Write on Clear - the existing alpha mask is overwritten



add = existing alpha mask + mask generated by this filter.

Note that areas with 1000 + 500 opacity would be 150% opaque. But you
cant get 150% opaque so they look the same as the 100% opaque areas.



subtract = existing alpha mask - mask generated by this filter.

Note that areas with 0 - 500 opacity would be minus 50% opaque. But you
cant get -50% opaque so they look the same as the 0% opaque areas.

max = maximum( <existing alpha mask> , <mask generated by this filter>)



min = minimum( <existing alpha mask> , <mask generated by this filter>)



Chroma Key

Contents

Chroma Key
Basic Chroma Keying Tutorial
Video Tutorial
See also

This effect allows you to do Chroma Keying (also known as Green Screen or
Blue Screen) in Kdenlive. Chroma keying is where you remove backgrounds
of a similar colour. This effect is a very basic. For a more complication
alpha manipulation/background removal effect, use Color selection.

For black backgrounds, the Transitions - Screen is slightly more effective.

Here are some video tutorials on how to use chroma key.

Basic Chroma Keying Tutorial

1. Select the clip you want to chroma key in the timeline.
2. Search for “chroma key” in the effects tab, and drag it onto the

properties tab.
3. Press on the button that looks like a water droplet, and then click on the

background of the video. This will chroma key out the background.
4. Use the variance slider to control the amount of background chroma

keyed out. This will require adjustment if your chroma key didn’t
immediately turn out perfect.

Video Tutorial

https://youtu.be/bMwbffYIS40

https://youtu.be/bMwbffYIS40


See also

Rotoscoping effect. Rotoscoping is where you manual draw a region, and
everything outside/inside that region will disappear. This is useful for
backgrounds with multiple different colours.

Key Spill Mop Up effect in the Misc group. The Key Spill Mop Up effect can
be used to improve the edges of the blue screen effect - when edge problems
are caused by “keyspill”. Keyspill is when the color of the screen used for
colorkeying spills onto the subject due to light reflection.

Color selection which also does color based alpha selection, but in a much
more detailed fashion. Use it for less contrasting or more complex
backgrounds.



Color selection
Chroma-Key

The Chroma-Key is a more advanced version of the Chroma Key effect.
Chroma-Key allows for some basic feathering (by changing the Edge Mode)
and much more fine-grained control over how much & in which way you
remove the background.

This is better for backgrounds that have less contrast with the foreground, or
more complex backgrounds. For simple backgrounds (such as green, blue,
red or possibly black), use the Chroma Key effect.

Basic Technique

Contents

Color selection
Chroma-Key
Basic Technique
All Options

See Also

Find a clip with a background (preferably multiple, or slightly complex,
because the “chroma key effect” can do easy backgrounds such as green or
blue). Add the Chroma-Key effect to the clip.

After this, either choose the color using the little droplet button. Press the
droplet button, and then click on the background part of the clip you want to
remove. Adjust the Delta sliders until the background is removed correctly.
This might need to experimenting. If you find it isn’t removing the
background well, try changing the “selection subspace” and experiment



again. If you experimented and cycled through all the “selection subspaces”,
and the background isn’t still removed properly, then it is probably too
complicated for Kdenlive to remove. At this point, you will need to use
Rotoscoping.

If the effect took lots of time to experiment, and you will need to use this
effect again, then click on the three horizontal lines in the top right corner,
and then click Save effect. Give the effect a name, and save. You can now
search for this specific effect in your effects tab.

All Options

Here is an outline of all the options:



Color to select:
The color to select. This is the color that will be transparent/the only
color that is opaque.

Invert selection:
When ON (default), the selected color will be transparent. When OFF the
selected color will be opaque. Keeping the selected color opaque may be
more effective if the foreground is simple and the background is
complicated.

Selection subspace:
The options are: RGB (Red Green Blue), ABI and HCI (Hue Chromacity
Intensity).

These different options yield different results. While RGB should yield
the sharpest and best results, sometimes (as user themickyrosen-left have
seen from experience) the other option, HCI & ABI, can yield much
better results than RGB. So if RGB isn’t producing good results then try
on of the other options.

Note

Previews of video chroma keyed using HCI will be slow since it has to
calculate values for every single pixel.

Edge Mode:
Options are: Hard, Fat, Normal, Skinny, Slope

If the Edge Mode is set to slope, you can use the “slope” slider. This
slider determines the smoothness of the edges. The higher the value, the
smoother the edges of your color selection will be.

“Hard” means there is no feathering (edges are not smooth at all). Any
part of the image/video is either fully opaque and fully transparent. This
means there will be no blue between the removed parts and the remaining



parts whatsoever, and this option is useful if your chroma key turned out
to be perfect.

The remaining options (“Fat”, “Normal” and “Skinny”) create a gradual
transition between transparent and opaque. The fatter the choice, the
more the selected areas are filled towards the rim (AKA more feathering
for fatter choices). This is useful if your color selection did not turn out
that well.

Delta XXXX:
These three parameters determine the tolerance of the chroma keying. The
higher the value, the more of the background is removed. The lower the
value, less is removed. A bit of experimenting is required to find the
correct values for each clip.

See Also

See also Chroma Key which does color based alpha selection but is a bit
simpler.

This page [https://www.worqx.com/color/index.htm] covers some Color Theory to help
understand Hue, Chroma, Luminance, etc.

https://www.worqx.com/color/index.htm


Key spill mop up
This effect is used when using chroma keying (otherwise known as
greenscreen or Chroma Key effect). Its purpose is to compensate for the fact
that sometimes the color from the green or blue screen reflects onto the
subject and will make them a shade of blue or green - especially around the
edges. This is known as “keyspill”. This effect can attempt to compensate for
this issue.

Tutorial

Contents

Key spill mop up
Tutorial
Details

This tutorial shows usage of the following effects: Key Spill Mop Up, blue
screen, alpha operations - shrinkhard and denoiser.

Note: This video is outdated. In newer versions of Kdenlive have the Key
Spill Mop Up effect installed by default, and it is no longer required to use a
composite transition.

https://youtu.be/l43Hz7YEcYU

Details

The README file for the Key Spill Mop Up is this:

DESCRIPTION:

https://youtu.be/l43Hz7YEcYU


After some experimentation with chroma keying, it looked to me that there is
no single method of key cleaning, that works in all situations, like keyspill on
bright, keyspill on dark, etc. So I included several cleaning options, which
can be used alone or in combination. In short, it offers three ways of pixel
selection (masking), that can be combined with four types of color changing
operations. The three selection / masking modes are based on:

similarity to key color
transparency
closeness to the edge

and the four things that can be done to the selected pixels are:

move away from the key color (De-Key)
move towards an target color (Target)
desaturate
luma (brightness) adjust.

MASKS:

Color difference masks are based on the color of the image, and do not
depend on the alpha from the preceding keying, except for ignoring the 100%
transparent areas, to increase speed.

Transparency and Edge masks are based on the alpha channel from the
preceding keying operation. Transparency masks will affect only the parts
that are neither 100% opaque nor 100% transparent, based on the alpha
values from the preceding keying operation. The effect will be proportional
to the transparency.

Note

If a “hard key” was used in the preceding keying, there will be no areas that
T operations could affect. Edge masks will affect only pixels close to the
edge, with the effect diminishing away from the edge. The outer edge is the
edge of the fully opaque part, where the alpha from the preceding keying is
1.0 (255).



Note

The edge masking algorithm is not yet what I would like it to be. I will
have to look some more into this, and improve it, so consider it a
“temporary solution” that will change in the future.

All masks can be further pruned with two parameters: an “hue gate”, which
will limit the mask to hues close to the key hue, and an “saturation
threshold”, which will limit the mask to areas with color saturation above a
threshold.

CASCADING:

This plugin can be cascaded, but it is not possible to get the same color
based mask in the second instance, because the colors will be changed by the
first instance. To enable two operations with the same mask, each plugin
instance can do two operations. With transparency and edge masks,
cascading is a bit easier. If the hue gate and saturation threshold are not used,
transparency and edge masks can be exactly the same in cascaded plugins.

PARAMETERS:

Key color: This should be the same or similar to the key color used for the
preceding keying operation.

Target color: This is only used when “Target” operation is used with one of
the masks. The colors in the affected areas will be moved towards this color,
according to the “Amount” parameter.

Mask type: Selects the type of mask that will determine where the color
altering operations will occur.

Tolerance: For the color difference mask, the range of colors around the key,
that will be 100% affected. For the transparency mask, the “amplification”.
For the edge mask, the width of the affected area.



Slope: For the color difference mask, the range of colors outside of
“Tolerance”, that will be gradually less affected. No function for the
transparency and edge masks.

Hue gate: Reduces the mask according to difference from key hue, to prevent
change to pixels that are within the mask, but not polluted by key.

Saturation threshold: Reduces the mask according to color saturation, to
avoid affecting the neutral areas.

Operation 1: Selects which of the four possible operations will be done on
the mask-selected pixels. Apart from no operation, there are four
possibilities: De-key, Target, De-saturate and Luma adjust.

Amount 1: The amount of the selected operation 1, how much the colors will
change.

Operation 2, Amount 2: Enable a second operation to be performed with the
same mask.

Show mask: This will show the selected mask as a greyscale image, to help
with fine tuning of the masks. Should be OFF for the final render.

Mask to Alpha: Copies the active mask to the alpha channel. For all normal
spill cleaning operations, this should be OFF. By setting it ON, the Key Spill
Mop Up itself can be used as a keyer, or to generate some special effects.



Mask0mate
Rectangular Alpha Mask

Contents

Mask0mate
Rectangular Alpha Mask

Previously known as Mask0Mate. This is the Frei0r mask0mate
[https://www.mltframework.org/plugins/FilterFrei0r-mask0mate/] MLT filter.

Creates an rectangular alpha-channel mask.

https://www.mltframework.org/plugins/FilterFrei0r-mask0mate/


Motion Tracker
New in version 19.04.0.

Contents

Motion Tracker
What is Motion Tracking?
How to track a region of a video?
Tracking algorithms

KCF
CSRT
MOSSE
MIL
MedianFlow
DaSiam

Frame shape
Shape color
Blur type

What is Motion Tracking?

Motion tracking is the process of locating a moving object across time.
Kdenlive uses OpenCV (Open Source Computer Vision Library)
[https://opencv.org/about/] for motion detection.

– Wikipedia [https://en.wikipedia.org/wiki/Video_tracking]

https://opencv.org/about/
https://en.wikipedia.org/wiki/Video_tracking


How to track a region of a video?

The basic workflow for tracking a region consists of:

Select the desired region to track on the Project Monitor.
Choose a tracking algorithm.
Click on the Analyse button.



When Analyse is done you can export the keyframes to the clipboard by
click on  and choose Copy keyframes to clipboard. See: Exchange
keyframes across effects

Tracking algorithms

KCF



Kernelized Correlation Filters

Pros: Accuracy and speed are both better than MIL and it reports tracking
failure better than MIL.

Cons: Does not recover from full occlusion.

CSRT

In the Discriminative Correlation Filter with Channel and Spatial Reliability
(DCF-CSR), we use the spatial reliability map for adjusting the filter support
to the part of the selected region from the frame for tracking. This ensures
enlarging and localization of the selected region and improved tracking of the
non-rectangular regions or objects. It uses only 2 standard features (HoGs
and Colornames). It also operates at a comparatively lower fps (25 fps) but
gives higher accuracy for object tracking.

MOSSE

Minimum Output Sum of Squared Error

MOSSE uses an adaptive correlation for object tracking which produces
stable correlation filters when initialized using a single frame. MOSSE
tracker is robust to variations in lighting, scale, pose, and non-rigid
deformations. It also detects occlusion based upon the peak-to-sidelobe
ratio, which enables the tracker to pause and resume where it left off when
the object reappears. MOSSE tracker also operates at a higher fps (450 fps
and even more).

Pros: It is as accurate as other complex trackers and much faster.

Cons: On a performance scale, it lags behind the deep learning based
trackers.

MIL



Pros: The performance is pretty good. It does a reasonable job under partial
occlusion.

Cons: Tracking failure is not reported reliably. Does not recover from full
occlusion.

MedianFlow

Pros: Excellent tracking failure reporting. Works very well when the motion
is predictable and there is no occlusion.

Cons: Fails under large motion.

DaSiam [https://arxiv.org/pdf/1808.06048.pdf]

The DaSiamRPN visual tracking algorithm relies on deep-learning models to
provide extremely accurate results.

In order to use the DaSiam algorithm you need to download the AI models
and place them in:

Linux

$HOME/.local/share/kdenlive/opencvmodels.

Flatpak

$HOME/.var/app/org.kde.kdenlive/data/kdenlive/opencvmodels

Windows

%AppData%/kdenlive/opencvmodels

Press Win + R (Windows key and R key simultaneously) and copy
%AppData%/kdenlive/. Then create the folder opencvmodels

1. https://files.kde.org/kdenlive/motion-
tracker/DaSiamRPN/dasiamrpn_kernel_cls1.onnx

https://arxiv.org/pdf/1808.06048.pdf
https://files.kde.org/kdenlive/motion-tracker/DaSiamRPN/dasiamrpn_kernel_cls1.onnx


2. https://files.kde.org/kdenlive/motion-
tracker/DaSiamRPN/dasiamrpn_kernel_r1.onnx

3. https://files.kde.org/kdenlive/motion-
tracker/DaSiamRPN/dasiamrpn_model.onnx

Frame shape

soon

Shape color

soon

Blur type

Four blur types are available: Median blur, Gaussian blur, Pixelate, Opaque
fill

https://files.kde.org/kdenlive/motion-tracker/DaSiamRPN/dasiamrpn_kernel_r1.onnx
https://files.kde.org/kdenlive/motion-tracker/DaSiamRPN/dasiamrpn_model.onnx


Rotoscoping

Contents

Rotoscoping
What is Rotoscoping?
How to draw the region in Kdenlive?
How to move the mask to follow the action - keyframes
Rotoscoping options greyed out
Examples
Example 1.How to make rotoscoping selection.
Tutorial with Rotoscoping

What is Rotoscoping?

“In the visual effects industry, the term rotoscoping refers to the technique of
manually creating a matte for an element on a live-action plate so it may be
composited over another background.”

– Wikipedia [https://en.wikipedia.org/wiki/Rotoscoping]

Draw a region on one video track, and everything outside/inside that region
will disappear, showing the video track underneath.

https://en.wikipedia.org/wiki/Rotoscoping


How to draw the region in Kdenlive?

The region is drawn by adding nodes along your region. These act as edges
for your rotoscope, and there is a line between each node. The line between
each node can be made into a Bézier curve [https://en.wikipedia.org/wiki/Bézier_curve]
using “handles”.

Add nodes to the node by left clicking the mouse.

Close the region by right clicking the mouse on one of the nodes.

Change the position of the region by moving a node.

https://en.wikipedia.org/wiki/B%C3%A9zier_curve


Make a line curved by dragging the control “handles”. These are the two dots
on the ends of the straight lines that appear on the curve (see screen shot
above).

To define if it is the inside or the outside of the curve that is transparent
toggle the Invert checkbox.

In a previous version of Kdenlive you could add a new nodes by clicking on
the line between existing nodes. You could subtract nodes by right clicking
on them. But it looks like you can not do this with the 17.04 & 18.04 version.

How to move the mask to follow the action -
keyframes

To make the drawn mask follow the action in a clip…



Move the position in the clip by dragging the carat on the time line (1 or 3 in
screenshot below) or by using the time code control in the rotoscope effect (2
in the screenshot).

Click Add keyframe (5 in the screen shot).

Now adjust the position of the nodes in the curve to match the action.

Kdenlive will calculate a path to move the nodes from the position they were
in the previous key frame to the position you put them in at this keyframe. So
you do not have to draw a curve for every frame in the clip.

To remove a key frame move to the frame with the key frame using the Go to
previous keyframe (4) or Go to next keyframe (6) and then click the red X
that which becomes Add keyframe (5) when you are on an existing keyframe.



This effect is based on the MLT FilterRotoscoping
[https://www.mltframework.org/plugins/FilterRotoscoping/].

Rotoscoping options greyed out

https://www.mltframework.org/plugins/FilterRotoscoping/


When you first add the rotoscope effect the keyframe options in it are greyed
out. You can not even add a new keyframe.

Solution. Click in the project monitor and start drawing your rotoscope
matte. Then the rotoscope keyframe options become enabled.

Examples

Examples of what you can do with the Rotoscoping effect.

https://youtu.be/h36S-awjLBk

https://youtu.be/nFv46XQUO34

Example 1.How to make rotoscoping selection.

1. Choose Color, from the main menu to allow work with color scope.

https://youtu.be/h36S-awjLBk
https://youtu.be/nFv46XQUO34


For this example, the Sun object will be chosen for changing tone. Come
back to edit mode.

2. Head over to effects menu, type in Rotoscoping then drag it over video
to see further instructions.



3. By clicking the left mouse button for selection object and right mouse
click to complete selection.



4. Come back to color menu then vectorscope via drop-down at the bottom
right-hand corner choose YUV paint mode.



5. Choose color balance for color grading.



Tutorial with Rotoscoping

This video is about green screen on Kdenlive but he does use rotoscoping in
it too.

https://youtu.be/_6gxHLCFhLQ

https://youtu.be/_6gxHLCFhLQ


Analysis and Data

Contents

Analysis and Data

The Analysis and Data category of effects are useful for getting information
about your video material rather than manipulating the imagery. The
exception is Timeout Indicator - it can be used to add an effect to your video.

Effects in this category

Audio Spectrum Filter
Oscilloscope
Video Values

Audio Wave
RGB Parade
Timeout Indicator
Vectorscope Window



Audio Spectrum Filter

Contents

Audio Spectrum Filter

This is the audiospectrum [https://www.mltframework.org/plugins/FilterAudiospectrum/]
MLT filter.

It is a audio visualization filter that draws an audio spectrum on the image.

https://www.mltframework.org/plugins/FilterAudiospectrum/


Oscilloscope

Contents

Oscilloscope

This is the Frei0r pr0file [https://www.mltframework.org/plugins/FilterFrei0r-pr0file/] MLT
filter.

2D video oscilloscope.

https://www.mltframework.org/plugins/FilterFrei0r-pr0file/


Video Values

Contents

Video Values

This is the Frei0r pr0be [https://www.mltframework.org/plugins/FilterFrei0r-pr0be/] MLT
filter.

Measures video values.

https://www.mltframework.org/plugins/FilterFrei0r-pr0be/


Artistic Effects
Effects in this category

Binarize
Charcoal
Dust
Grain
Old Film
Scratchlines
Vignette Effect



Binarize

Contents

Binarize

Create a black and white image.



Charcoal

Contents

Charcoal

This is the Charcoal [https://www.mltframework.org/plugins/FilterCharcoal/] MLT filter.

Charcoal drawing effect.

https://youtu.be/fI1YrZcT26k

https://youtu.be/1XpJCI6tHSc

https://youtu.be/m-_MFMSb75w

https://www.mltframework.org/plugins/FilterCharcoal/
https://youtu.be/fI1YrZcT26k
https://youtu.be/1XpJCI6tHSc
https://youtu.be/m-_MFMSb75w


Dust

Contents

Dust

See dust filter [https://www.mltframework.org/plugins/FilterDust/] from MLT.

Add dust and specks to the video clip, as in old movies.

https://youtu.be/h0s0PBfpcEE

https://youtu.be/wbX7Df8rC0M

https://www.mltframework.org/plugins/FilterDust/
https://youtu.be/h0s0PBfpcEE
https://youtu.be/wbX7Df8rC0M


Grain

Contents

Grain

https://youtu.be/1HXNz3Ykdq4

https://youtu.be/1HXNz3Ykdq4


Old Film

Contents

Old Film

This is the OldFilm [https://www.mltframework.org/plugins/FilterOldfilm/] MLT filter.

Moves the video up and down and adds random brightness changes, making
it look like old film footage.

https://youtu.be/0g1xDo-pwm0

https://youtu.be/PuQTd6D2Y2Y

https://www.mltframework.org/plugins/FilterOldfilm/
https://youtu.be/0g1xDo-pwm0
https://youtu.be/PuQTd6D2Y2Y


Scratchlines

Contents

Scratchlines

This is the Lines [https://www.mltframework.org/plugins/FilterLines/] MLT filter.

Adds scratch lines over the picture.

https://youtu.be/F8gZhHDQQBE

https://youtu.be/3laMxZBwqqY

https://www.mltframework.org/plugins/FilterLines/
https://youtu.be/F8gZhHDQQBE
https://youtu.be/3laMxZBwqqY


Vignette Effect

Contents

Vignette Effect

This is the Vignette [https://www.mltframework.org/plugins/FilterVignette/] MLT filter.

Vignette around a point with adjustable smoothness, radius, position and
transparency.

https://youtu.be/FJrYRD6RzJ4

https://www.mltframework.org/plugins/FilterVignette/
https://youtu.be/FJrYRD6RzJ4


Audio channels
The Audio channels group in the Effect List has the following effects:

balance
copy_channels
mono_to_stereo_splitter
pan
swap_channels



Audio Correction
Effects in this category

Contrast
Gain
Mono Amplifier
Audio Correction - Mute
Stereo Amplifier
Volume (keyframable)



Contrast

Contents

Contrast

This is the Sox contrast [https://www.mltframework.org/plugins/FilterSox-contrast/] MLT
filter.

Process audio using a SoX effect.

https://www.mltframework.org/plugins/FilterSox-contrast/


Gain

Contents

Gain

An effect to increase or decrease the volume of a clip without the use of
keyframes.

The effect changes volume it terms of percentage, not decibel like the effect
Volume (Keyframable)
[https://userbase.kde.org/Kdenlive/Manual/Effects/Audio_Correction/Volume_(keyframable)].

https://userbase.kde.org/Kdenlive/Manual/Effects/Audio_Correction/Volume_(keyframable)


Mono Amplifier

Contents

Mono Amplifier

This is the LADSPA filter number 1048
[https://www.mltframework.org/plugins/FilterLadspa-1048/] from MLT.

https://www.mltframework.org/plugins/FilterLadspa-1048/


Audio Correction - Mute

Contents

Audio Correction - Mute

This effect mutes the sound track on the video. The audio on the track will
not be audible.



Stereo Amplifier

Contents

Stereo Amplifier

This is the LADSPA filter number 1049
[https://www.mltframework.org/plugins/FilterLadspa-1049/] from MLT.

https://www.mltframework.org/plugins/FilterLadspa-1049/


Volume (keyframable)

Contents

Volume (keyframable)

This is an audio effect to change the volume of a clip using keyframes
(change of effect over time.) Volume (Keyframable) uses decibels as
opposed to Gain [https://userbase.kde.org/Kdenlive/Manual/Effects/Audio_Correction/Gain].

https://userbase.kde.org/Kdenlive/Manual/Effects/Audio_Correction/Gain


Audio Effects

Contents

Audio Effects

The following effects are available under the Effects List ‣ Audio. The links
below are to the MLT framework documentation for these audio effects.
Somewhat better documentation may be found at Steve Harris’ LADSPA
Plugin Docs here [http://plugin.org.uk/ladspa-swh/docs/ladspa-swh.html].

4 x 4 pole allpass [https://www.mltframework.org/plugins/FilterLadspa-1218/]

Aliasing [https://www.mltframework.org/plugins/FilterLadspa-1407/]

Allpass delay line cubic spline interpolation
[https://www.mltframework.org/plugins/FilterLadspa-1897/]

Allpass delay line linear interpolation
[https://www.mltframework.org/plugins/FilterLadspa-1896/]

Allpass delay line noninterpolating [https://www.mltframework.org/plugins/FilterLadspa-
1895/]

AM pitchshifter [https://www.mltframework.org/plugins/FilterLadspa-1433/]

Artificial latency [https://www.mltframework.org/plugins/FilterLadspa-1914/]

Audio Divider (Suboctave Generator)
[https://www.mltframework.org/plugins/FilterLadspa-1186/]

Audio Levels [https://www.mltframework.org/plugins/FilterAudiolevel/]

Audio Pan [https://www.mltframework.org/plugins/FilterPanner/]

http://plugin.org.uk/ladspa-swh/docs/ladspa-swh.html
https://www.mltframework.org/plugins/FilterLadspa-1218/
https://www.mltframework.org/plugins/FilterLadspa-1407/
https://www.mltframework.org/plugins/FilterLadspa-1897/
https://www.mltframework.org/plugins/FilterLadspa-1896/
https://www.mltframework.org/plugins/FilterLadspa-1895/
https://www.mltframework.org/plugins/FilterLadspa-1433/
https://www.mltframework.org/plugins/FilterLadspa-1914/
https://www.mltframework.org/plugins/FilterLadspa-1186/
https://www.mltframework.org/plugins/FilterAudiolevel/
https://www.mltframework.org/plugins/FilterPanner/


Auto phaser [https://www.mltframework.org/plugins/FilterLadspa-1219/]

Barry’s Satan Maximiser [https://www.mltframework.org/plugins/FilterLadspa-1408/]

Bode frequency shifter [https://www.mltframework.org/plugins/FilterLadspa-1431/]

Bode frequency shifter (CV) [https://www.mltframework.org/plugins/FilterLadspa-1432/]

Chebyshev distortion [https://www.mltframework.org/plugins/FilterLadspa-1430/]

Comb delay line cubic spline interpolation
[https://www.mltframework.org/plugins/FilterLadspa-1888/]

Comb delay line linear interpolation [https://www.mltframework.org/plugins/FilterLadspa-
1887/]

Comb delay line noninterpolating [https://www.mltframework.org/plugins/FilterLadspa-
1889/]

Comb Filter [https://www.mltframework.org/plugins/FilterLadspa-1190/]

Compand [https://www.mltframework.org/plugins/FilterAvfilter-compand/]

Constant Signal Generator [https://www.mltframework.org/plugins/FilterLadspa-1909/]

Crossfade [https://www.mltframework.org/plugins/FilterLadspa-1915/]

Crossfade (4 outs) [https://www.mltframework.org/plugins/FilterLadspa-1917/]

Crossover distortion [https://www.mltframework.org/plugins/FilterLadspa-1404/]

DC Offset Remover [https://www.mltframework.org/plugins/FilterLadspa-1207/]

Decimator [https://www.mltframework.org/plugins/FilterLadspa-1202/]

Declipper [https://www.mltframework.org/plugins/FilterLadspa-1195/]

Delayorama [https://www.mltframework.org/plugins/FilterLadspa-1402/]

https://www.mltframework.org/plugins/FilterLadspa-1219/
https://www.mltframework.org/plugins/FilterLadspa-1408/
https://www.mltframework.org/plugins/FilterLadspa-1431/
https://www.mltframework.org/plugins/FilterLadspa-1432/
https://www.mltframework.org/plugins/FilterLadspa-1430/
https://www.mltframework.org/plugins/FilterLadspa-1888/
https://www.mltframework.org/plugins/FilterLadspa-1887/
https://www.mltframework.org/plugins/FilterLadspa-1889/
https://www.mltframework.org/plugins/FilterLadspa-1190/
https://www.mltframework.org/plugins/FilterAvfilter-compand/
https://www.mltframework.org/plugins/FilterLadspa-1909/
https://www.mltframework.org/plugins/FilterLadspa-1915/
https://www.mltframework.org/plugins/FilterLadspa-1917/
https://www.mltframework.org/plugins/FilterLadspa-1404/
https://www.mltframework.org/plugins/FilterLadspa-1207/
https://www.mltframework.org/plugins/FilterLadspa-1202/
https://www.mltframework.org/plugins/FilterLadspa-1195/
https://www.mltframework.org/plugins/FilterLadspa-1402/


Diode Processor [https://www.mltframework.org/plugins/FilterLadspa-1185/]

DJ EQ [https://www.mltframework.org/plugins/FilterLadspa-1901/]

DJ EQ (mono) [https://www.mltframework.org/plugins/FilterLadspa-1907/]

DJ flanger [https://www.mltframework.org/plugins/FilterLadspa-1438/]

Dyson compressor [https://www.mltframework.org/plugins/FilterLadspa-1403/]

Exponential signal decay [https://www.mltframework.org/plugins/FilterLadspa-1886/]

Fast overdrive [https://www.mltframework.org/plugins/FilterLadspa-1196/]

Fast Lookahead limiter [https://www.mltframework.org/plugins/FilterLadspa-1913/]

Flanger [https://www.mltframework.org/plugins/FilterLadspa-1191/]

FM Oscillator [https://www.mltframework.org/plugins/FilterLadspa-1415/]

Foldover distortion [https://www.mltframework.org/plugins/FilterLadspa-1213/]

Fractionally Addressed Delay Line [https://www.mltframework.org/plugins/FilterLadspa-
1192/]

Frequency tracker [https://www.mltframework.org/plugins/FilterLadspa-1418/]

Gate [https://www.mltframework.org/plugins/FilterLadspa-1410/]

Giant flange [https://www.mltframework.org/plugins/FilterLadspa-1437/]

Glame Bandpass Analog Filter [https://www.mltframework.org/plugins/FilterLadspa-1893/]

Glame Bandpass Filter [https://www.mltframework.org/plugins/FilterLadspa-1892/]

GLAME Butterworth Highpass [https://www.mltframework.org/plugins/FilterLadspa-1904/]

GLAME Butterworth Lowpass [https://www.mltframework.org/plugins/FilterLadspa-1903/]
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Glame Butterworth X-over Filter [https://www.mltframework.org/plugins/FilterLadspa-
1902/]

Glame Highpass Filter [https://www.mltframework.org/plugins/FilterLadspa-1890/]

Glame Lowpass Filter [https://www.mltframework.org/plugins/FilterLadspa-1891/]

Gong beater [https://www.mltframework.org/plugins/FilterLadspa-1439/]

Gong model [https://www.mltframework.org/plugins/FilterLadspa-1424/]

GSM simulator [https://www.mltframework.org/plugins/FilterLadspa-1215/]

GVerb [https://www.mltframework.org/plugins/FilterLadspa-1216/]

Harmonic generator [https://www.mltframework.org/plugins/FilterLadspa-1220/]

Hermes Filter [https://www.mltframework.org/plugins/FilterLadspa-1200/]

Higher Quality Pitch Scaler [https://www.mltframework.org/plugins/FilterLadspa-1194/]

Hilbert transformer [https://www.mltframework.org/plugins/FilterLadspa-1440/]

Impulse convolver [https://www.mltframework.org/plugins/FilterLadspa-1199/]

Inverter [https://www.mltframework.org/plugins/FilterLadspa-1429/]

Karaoke [https://www.mltframework.org/plugins/FilterLadspa-1409/]

L/C/R Delay [https://www.mltframework.org/plugins/FilterLadspa-1436/]

LFO Phaser [https://www.mltframework.org/plugins/FilterLadspa-1217/]

LS Filter [https://www.mltframework.org/plugins/FilterLadspa-1908/]

Mag’s Notch Filter [https://www.mltframework.org/plugins/FilterLadspa-1894/]

Matrix Spatialiser [https://www.mltframework.org/plugins/FilterLadspa-1422/]

Matrix: MS to Stereo [https://www.mltframework.org/plugins/FilterLadspa-1421/]
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Matrix: Stereo to MS [https://www.mltframework.org/plugins/FilterLadspa-1420/]

Modulatable delay [https://www.mltframework.org/plugins/FilterLadspa-1419/]

Mono to stereo [https://www.mltframework.org/plugins/FilterLadspa-1406/]

Multiband EQ [https://www.mltframework.org/plugins/FilterLadspa-1197/]

Multivoice Chorus [https://www.mltframework.org/plugins/FilterLadspa-1201/]

Pitch Scaler [https://www.mltframework.org/plugins/FilterLadspa-1193/]

Plate reverb [https://www.mltframework.org/plugins/FilterLadspa-1423/]

Pointer cast distortion [https://www.mltframework.org/plugins/FilterLadspa-1910/]

Rate shifter [https://www.mltframework.org/plugins/FilterLadspa-1417/]

Retro Flanger [https://www.mltframework.org/plugins/FilterLadspa-1208/]

Reverse Delay (5s max) [https://www.mltframework.org/plugins/FilterLadspa-1605/]

Ringmod with LFO [https://www.mltframework.org/plugins/FilterLadspa-1189/]

Ringmod with two inputs [https://www.mltframework.org/plugins/FilterLadspa-1188/]

SC1 [https://www.mltframework.org/plugins/FilterLadspa-1425/]

SC2 [https://www.mltframework.org/plugins/FilterLadspa-1426/]

SC3 [https://www.mltframework.org/plugins/FilterLadspa-1427/]

SC4 [https://www.mltframework.org/plugins/FilterLadspa-1882/]

SC4 mono [https://www.mltframework.org/plugins/FilterLadspa-1916/]

SE4 [https://www.mltframework.org/plugins/FilterLadspa-1883/]

Signal sifter [https://www.mltframework.org/plugins/FilterLadspa-1210/]
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Simple amplifier [https://www.mltframework.org/plugins/FilterLadspa-1181/]

Simple Delay Line [https://www.mltframework.org/plugins/FilterLadspa-1043/]

Simple delay line cubic spline interpolation
[https://www.mltframework.org/plugins/FilterLadspa-1900/]

Simple delay line linear interpolation
[https://www.mltframework.org/plugins/FilterLadspa-1899/]

Simple Delay Line, noninterpolating [https://www.mltframework.org/plugins/FilterLadspa-
1898/]

Simple High Pass Filter [https://www.mltframework.org/plugins/FilterLadspa-1042/]

Simple Low Pass Filter [https://www.mltframework.org/plugins/FilterLadspa-1041/]

Sine Oscillator (Freq:Audio,Amp:audio)
[https://www.mltframework.org/plugins/FilterLadspa-1044/]

Sine Oscillator (Freq:Audio,Amp:control)
[https://www.mltframework.org/plugins/FilterLadspa-1045/]

Sine Oscillator (Freq:control,Amp:audio)
[https://www.mltframework.org/plugins/FilterLadspa-1046/]

Single band parametric [https://www.mltframework.org/plugins/FilterLadspa-1203/]

Sinus wavewrapper [https://www.mltframework.org/plugins/FilterLadspa-1198/]

Smooth Decimator [https://www.mltframework.org/plugins/FilterLadspa-1414/]

Sox band [https://www.mltframework.org/plugins/FilterSox-band/]

Sox bass [https://www.mltframework.org/plugins/FilterSox-bass/]

Sox echo [https://www.mltframework.org/plugins/FilterSox-echo/]

Sox flanger [https://www.mltframework.org/plugins/FilterSox-flanger/]
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Sox gain [https://www.mltframework.org/plugins/FilterSox-gain/]

Sox phaser [https://www.mltframework.org/plugins/FilterSox-phaser/]

Sox stretch [https://www.mltframework.org/plugins/FilterSox-stretch/]

State Variable Filter [https://www.mltframework.org/plugins/FilterLadspa-1214/]

Step Demuxer [https://www.mltframework.org/plugins/FilterLadspa-1212/]

Surround matrix encoder [https://www.mltframework.org/plugins/FilterLadspa-1401/]

Tape Delay Simulation [https://www.mltframework.org/plugins/FilterLadspa-1211/]

Transient mangler [https://www.mltframework.org/plugins/FilterLadspa-1206/]

Triple band parametric with shelves [https://www.mltframework.org/plugins/FilterLadspa-
1204/]

Valve rectifier [https://www.mltframework.org/plugins/FilterLadspa-1405/]

Valve saturation [https://www.mltframework.org/plugins/FilterLadspa-1209/]

VyNil (Vinyl Effect) [https://www.mltframework.org/plugins/FilterLadspa-1905/]

Wave shaper [https://www.mltframework.org/plugins/FilterLadspa-1187/]

Wave Terrain Oscillator [https://www.mltframework.org/plugins/FilterLadspa-1412/]

z-1 [https://www.mltframework.org/plugins/FilterLadspa-1428/]
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Blur and Hide
Effects in this category

Auto Mask
Blur
Box Blur
Glow
Obscure
Softglow
Square Blur



Auto Mask
Deprecated since version 21.08: Use Motion Tracker instead

Contents

Auto Mask
Demo
How to apply Auto Mask
Motion Tracking

Deleting Motion Tracking Data

This effect can be used to mask peoples faces. It uses motion estimation to
track subjects and mask faces. It is the AutotrackRectangle
[https://www.mltframework.org/docs/FilterAutotrackRectangleDiscussion/] MLT filter.

Demo

https://youtu.be/rRg_i5C8_Hc

How to apply Auto Mask

See video below on how to use this effect. Warning: The effect is not 100%
reliable.

https://youtu.be/ZD0WOsX6B5A

Motion Tracking

The Auto Mask effect can also be used to track motion of an object and use it
later as keyframes for an effect / transition.

https://www.mltframework.org/docs/FilterAutotrackRectangleDiscussion/
https://youtu.be/rRg_i5C8_Hc
https://youtu.be/ZD0WOsX6B5A


Note

The method described here is a re-purposing of the motion tracking data
that the Auto Mask effect calculates. You do not need to follow the method
described below to generate an Auto Mask that will obscure faces. The
instructions in the above video should be enough. Nor can you use the
method described below to improve the tracking of the mask created by the
Auto Mask effect.

To use this feature, first, add the clip you want to analyze in the timeline, and
add the “Auto Mask” effect to it - Figure 1.

Go to the first frame where your object is visible, and adjust the yellow
rectangle so that it surrounds the object, like the hand in Figure 1.

Then press the Analyse button in the effect options. This will start an analysis
of the clip (you can follow its progress in the Project Bin view).



When the job is finished, the motion tracking data is stored in the clip
properties. To use this data, you can, for example, add a title clip and affine
transition over the clip you just analyzed, like in the screenshot in Figure 2.

Next step is to import the motion data in the transition. To do this, first, select
the clip you have analyzed, then select the transition using the Ctrl key so
that both items are selected. Finally, go in the transitions’s Options menu.

Select Import keyframes from clip. You can now delete the “Auto Mask”
effect from the clip in the timeline and play the project to see your title clip
following the object.



Checking the Limit keyframe number checkbox in the “Import Keyframes”
dialog (Figure 4) will cause Kdenlive to only import every nth frame (where
n is the number selected in the combo box). This is a useful feature if you
want to manually edit the keyframes that are imported because it allows you
to limit the number of keyframes you will need to manually edit. If this
checkbox is not checked then you import a keyframe for every frame that is in
the source clip.

Deleting Motion Tracking Data

The motion tracking data is saved with the Clips. You can view this data
from the clip properties Analysis tab - Figure 5. Delete the data using button



1.



Blur

Contents

Blur

Blurs the entire image.



Box Blur

Contents

Box Blur

This is the Boxblur [https://www.mltframework.org/plugins/FilterBoxblur/] MLT filter.

Separate horizontal and vertical blur.

The unit for the boxblur “hori” and “vert” parameters is “pixels”. For each
pixel in the image, the parameters indicate what pixels will be mixed with it
in order to create the blur effect. For example, if you set “hori” to 5, then
each pixel will be blurred with the sample that is 5 pixels away on each side.

https://youtu.be/MBO-STDoj_Y

Not 100% sure if this sample is Box Blur or Square Blur. The caption
on this sample was translated from Spanish. Original Spanish was
“Difuminar en cuadro”.*

https://youtu.be/0Q_BtThC-V0

https://www.mltframework.org/plugins/FilterBoxblur/
https://youtu.be/MBO-STDoj_Y
https://youtu.be/0Q_BtThC-V0


Glow

Contents

Glow

This is the Frei0r glow [https://www.mltframework.org/plugins/FilterFrei0r-glow/] MLT
filter.

Creates a Glamorous Glow.

https://youtu.be/vh4lrkFaVWc

https://youtu.be/UtBWFrYN9kA

https://www.mltframework.org/plugins/FilterFrei0r-glow/
https://youtu.be/vh4lrkFaVWc
https://youtu.be/UtBWFrYN9kA


Obscure

Contents

Obscure

See the Obscure [https://www.mltframework.org/plugins/FilterObscure/] MLT filter.

Hide a region of the clip.

https://youtu.be/NL8cBqJc-WU

https://youtu.be/oIu9FQwVx0c

https://www.mltframework.org/plugins/FilterObscure/
https://youtu.be/NL8cBqJc-WU
https://youtu.be/oIu9FQwVx0c


Softglow

Contents

Softglow

This is the Frei0r softglow [https://www.mltframework.org/plugins/FilterFrei0r-softglow/]
MLT filter.

Softglow Applied

https://www.mltframework.org/plugins/FilterFrei0r-softglow/


The frame without the Softglow



Square Blur

Contents

Square Blur

This is the Frei0r squareblur [https://www.mltframework.org/plugins/FilterFrei0r-squareblur/]
MLT filter.

Variable-size square blur.

https://youtu.be/mNP3LTy7nao

Not 100% sure if this sample is Square Blur or Box Blur. The caption
on this sample was translated from Spanish. Original Spanish was
“Difuminar de cuadro”*

https://youtu.be/dMJqPhO0DEQ

https://www.mltframework.org/plugins/FilterFrei0r-squareblur/
https://youtu.be/mNP3LTy7nao
https://youtu.be/dMJqPhO0DEQ


Color
Effects in this category

Chroma Hold
Greyscale
Hue Shift
Invert
Primaries
RGB Parade
Saturation
Sepia
Technicolor
Tint



Chroma Hold

Contents

Chroma Hold

This is the Chroma_hold [https://www.mltframework.org/plugins/FilterChroma_hold/] MLT
filter.

Makes image greyscale except for chosen color.

https://youtu.be/XDJEzN4XEXo

https://youtu.be/dXnFsOjS734

https://www.mltframework.org/plugins/FilterChroma_hold/
https://youtu.be/XDJEzN4XEXo
https://youtu.be/dXnFsOjS734


Greyscale

Contents

Greyscale

This is the Greyscale [https://www.mltframework.org/plugins/FilterGreyscale/] MLT filter.

Convert colour image to greyscale.

https://youtu.be/5L9KTfJFw80

https://youtu.be/bgNd2bHnvSY

https://www.mltframework.org/plugins/FilterGreyscale/
https://youtu.be/5L9KTfJFw80
https://youtu.be/bgNd2bHnvSY


Hue Shift

Contents

Hue Shift

This is the Frei0r hueshift0r [https://www.mltframework.org/plugins/FilterFrei0r-hueshift0r/]
MLT filter.

Shifts the hue of a source image.

https://youtu.be/Mq_G-AFznoc

https://youtu.be/J7RCdP0-4Qs

https://youtu.be/D9w-I8hb3kU

https://www.mltframework.org/plugins/FilterFrei0r-hueshift0r/
https://youtu.be/Mq_G-AFznoc
https://youtu.be/J7RCdP0-4Qs
https://youtu.be/D9w-I8hb3kU


Invert

Contents

Invert

This is the Invert [https://www.mltframework.org/plugins/FilterInvert/] MLT filter.

Inverts colors.

https://youtu.be/7jQt8xmdSzI

https://www.mltframework.org/plugins/FilterInvert/
https://youtu.be/7jQt8xmdSzI


Primaries

Contents

Primaries

This is the Frei0r primaries [https://www.mltframework.org/plugins/FilterFrei0r-primaries/]
MLT filter.

https://youtu.be/gjgQphzQZrQ

https://www.mltframework.org/plugins/FilterFrei0r-primaries/
https://youtu.be/gjgQphzQZrQ


RGB Parade

Contents

RGB Parade

This is the Frei0r rgbparade [https://www.mltframework.org/plugins/FilterFrei0r-rgbparade/]
MLT filter.

In ver 17.04 this is found in the Analysis and Data category of Effects.

Displays a histogram of R, G and B components of the video data.

https://youtu.be/KaxBEhzS8fk

This is different from the RGB Parade from the View Menu because the
Effect version writes the histogram into the output video whereas the View
Menu version just displays the histogram widget in the application while you
preview your project.

https://www.mltframework.org/plugins/FilterFrei0r-rgbparade/
https://youtu.be/KaxBEhzS8fk


Saturation

Contents

Saturation

This is the Frei0r saturat0r [https://www.mltframework.org/plugins/FilterFrei0r-saturat0r/]
MLT filter.

Adjusts the saturation of a source image.

See TheDiveo’s blog [https://thediveo-e.blogspot.com/2013/10/grading-of-hero-3-above-
waterline.html] for an example of the usage of the Saturation effect.

https://youtu.be/rWqlQaWtCFs

https://youtu.be/reOG42ZzrZA

https://www.mltframework.org/plugins/FilterFrei0r-saturat0r/
https://thediveo-e.blogspot.com/2013/10/grading-of-hero-3-above-waterline.html
https://youtu.be/rWqlQaWtCFs
https://youtu.be/reOG42ZzrZA


Sepia

Contents

Sepia

This is the Sepia [https://www.mltframework.org/plugins/FilterSepia/] MLT filter.

Turns clip colors to sepia.

https://youtu.be/gD5bJBJp79M

https://youtu.be/wVFfb4E9ztQ

https://www.mltframework.org/plugins/FilterSepia/
https://youtu.be/gD5bJBJp79M
https://youtu.be/wVFfb4E9ztQ


Technicolor

Contents

Technicolor

This is the Tcolor [https://www.mltframework.org/plugins/FilterTcolor/] MLT filter.

https://youtu.be/hDLp5IymciA

https://www.mltframework.org/plugins/FilterTcolor/
https://youtu.be/hDLp5IymciA


Tint

Contents

Tint

This is the Frei0r tint0r [https://www.mltframework.org/plugins/FilterFrei0r-tint0r/] MLT
filter.

https://youtu.be/kq7w1ZdS6GI

https://www.mltframework.org/plugins/FilterFrei0r-tint0r/
https://youtu.be/kq7w1ZdS6GI


Color Correction
Effects in this category

3 point balance
Apply LUT
Example of LUT Filter
Manually adjust the clip
Bezier Curves
Brightness
Brightness (keyframable)
Curves
Gamma
Levels
Lift/Gamma/Gain
RGB adjustment
SOP
White Balance
White Balance (LMS)



3 point balance

Contents

3 point balance

This is the Frei0r three_point_balance [https://www.mltframework.org/plugins/FilterFrei0r-
three_point_balance/] MLT filter.

https://youtu.be/ZFhfTsl7St8

https://www.mltframework.org/plugins/FilterFrei0r-three_point_balance/
https://youtu.be/ZFhfTsl7St8


Apply LUT

Contents

Apply LUT
Example of LUT Filter
Manually adjust the clip

This is the Avfilter lut3d [https://www.mltframework.org/plugins/FilterAvfilter-lut3d/] MLT
filter.

Apply a 3D Look Up Table (LUT) to the video. A LUT is an easy way to
correct the color of a video.

Supported formats:

.3dl (AfterEffects), .cube (Iridas), .dat (DaVinci), .m3d (Pandora)

Parameters:

Filename: File containing the LUT to be applied.

Interpolation Method: Can be Nearest, Trilinear or Tetrahedral. Defaults to
Tetrahedral.

Example of LUT Filter
Example of Manual workflow Before and after applying LUT

https://www.mltframework.org/plugins/FilterAvfilter-lut3d/


Figure 1 - View of the interface

Simple steps:

1. FREE LUTS – For our example, we rely on the files that can be
downloaded from the address https://goo.gl/OeIFkr

2. SEVEN CUBE FILES – Download the zip file, just extract it into a
folder: each of the files, which is then a simple text file, represents a
Look Up Table. Those examples were developed inspired by famous
films (whose titles are parodied in the file name).

3. Once package is downloaded and unpacked, open effects menu in the
right corner of the program window.

Figure 2 - View of main menu.

4. Then you need to find the LUT effect to apply. There are several, the
majority of which are maintained only for backwards compatibility but
not for any result. The right one is Apply LUT, in the section Color
correction.

https://goo.gl/OeIFkr


Figure 3 - Apply LUT

5. BALANCING – Adjusting color, for example col 3-point balance, you
need to insert the effect above that of the LUT. This allows you to
correct the image before it reaches the LUT, then obtaining
homogeneous results with other clips.

Figure 4 - Colour balance

Manually adjust the clip
In addition to the LUT, other effects can be used to manually correct the
colors

1. CHANGE OF SHADES – This allows, for example, to color the
background in blue and the actor in orange, widely used in classic



Hollywood postproduction setup. A faster but less detailed alternative
is Hue shift, which shifts all shades towards red or blue.

2. SATURATION – After changing the coloration of the image, with one of
the two effects that is presented, this allows saturate the color
differently depending on the brightness by drawing a curve on the canal
saturation.

Before and After



Bezier Curves

Contents

Bezier Curves

This is the Frei0r curves [https://www.mltframework.org/plugins/FilterFrei0r-curves/] MLT
filter by Maksim Golovkin and Till Theato.

Adjusts luminance or color channel intensity with curve level mapping.

See TheDiveo blog [http://thediveo-e.blogspot.de/2013/10/grading-of-hero-3-above-
waterline.html] for an example of how to use this effect to colour grade clips.

Curves is also an interface into this Frie0r filter.

https://www.mltframework.org/plugins/FilterFrei0r-curves/
http://thediveo-e.blogspot.de/2013/10/grading-of-hero-3-above-waterline.html


Brightness

Contents

Brightness

This is the Frei0r brightness filter [https://www.mltframework.org/plugins/FilterFrei0r-
brightness/] MLT filter.

Adjusts the brightness of a source image.

https://youtu.be/qDZVBPoaEzY

https://youtu.be/t4SfVod5zCE

https://www.mltframework.org/plugins/FilterFrei0r-brightness/
https://youtu.be/qDZVBPoaEzY
https://youtu.be/t4SfVod5zCE


Brightness (keyframable)

Contents

Brightness (keyframable)

This is the Brightness [https://www.mltframework.org/plugins/FilterBrightness/] MLT filter.

https://www.mltframework.org/plugins/FilterBrightness/


Curves

Contents

Curves

This is the Frei0r curves [https://www.mltframework.org/plugins/FilterFrei0r-curves/] MLT
filter.

Adjusts luminance or color channel intensity with curve level mapping.

The Bezier Curves filter is also an interface to this same Frei0r filter.

https://youtu.be/xJ0SyVzssfI

https://youtu.be/Uiu6KfM3T9s

https://www.mltframework.org/plugins/FilterFrei0r-curves/
https://youtu.be/xJ0SyVzssfI
https://youtu.be/Uiu6KfM3T9s


https://youtu.be/6S6SvdrxFBg

https://youtu.be/6S6SvdrxFBg


Gamma

Contents

Gamma

This is the Gamma [https://www.mltframework.org/plugins/FilterGamma/] MLT filter.

Changes gamma color value.

https://youtu.be/bceEqjbt2XM

https://youtu.be/v5KRzActKCQ

https://www.mltframework.org/plugins/FilterGamma/
https://youtu.be/bceEqjbt2XM
https://youtu.be/v5KRzActKCQ


Levels

Contents

Levels

This is the Frei0r levels [https://www.mltframework.org/plugins/FilterFrei0r-levels/] MLT
filter.

https://youtu.be/iMbohQnyFV4

https://www.mltframework.org/plugins/FilterFrei0r-levels/
https://youtu.be/iMbohQnyFV4


Lift/Gamma/Gain

Contents

Lift/Gamma/Gain

This is the Lift_gamma_gain [https://www.mltframework.org/plugins/FilterLift_gamma_gain/]
MLT filter.

Allows you to adjust the lift (impacting mainly shadows), gain (impacting
mainly highlights) and gamma (impacting mainly midtones). The color wheel
inputs allow to control the degree to which these effects apply to the R, G &
B color channels. By default, the white color at the centre of the colour
wheel is selected, meaning the effect applies equally to all three color
channels. By choosing another color on the color wheel, the effect will be
applied on the R, G & B channels in proportion to the RGB components that
make up that color.

https://www.mltframework.org/plugins/FilterLift_gamma_gain/


RGB adjustment

Contents

RGB adjustment

This filter is for simple manual color adjustment by RGB channel, either
through adding constants, or changing the channel gammas or gains.

Simple means that it works channel-wise, no crosstalk. The off-diagonal
elements of the transform matrix are zero - no color crosstalk, no color space
rotation. But this should be sufficient for many tasks. For example, when
shooting under tungsten light, the blue signal will not migrate into red, it will
simply be too small. Amplifying the blue (and a bit of green too) should be
all that is needed. Similar, an underwater shot will simply be red deficient,
needing some red boost, etc.

Parameters:

R,G,B:

These determine the change in each of the three color channels.

Action:

Add constant adds a fixed value between -150 and +150 (this is
sometimes called “black level” or “setup”).
Change gamma changes channel gamma between 0.3333 and 3.0.
Multiply multiplies channel with a value between 0.3333 and 3.0
(sometimes called “gain” or “contrast”).

Note



To apply more than one action above, use cascaded instances of
coloradj_RGB.

Note

Add constant simply shifts the RGB “cube” colorspace. This means, that on
one end we are left with empty space, which is filled with zeros, and on the
other end, values can “fall outside”, and in this case they will be truncated
to max (255). Change gain changes the size of the cube, keeping the
“black” corner fixed, affecting predominately highlights, but the other end
can still “fall out” and get 255 truncated. Change gamma keeps the whole
cube in the same place, just stretches and squeezes its interior, so no zero
filling or truncation is necessary.

To visualize this plugin’s actions, apply it to a gray gradient, and watch the
result with “pr0file”.

Keep luma:

Fixes the luma value, so that the sliders only affect color.

This is the Frei0r coloradj_rgb [https://www.mltframework.org/plugins/FilterFrei0r-
coloradj_rgb/] MLT filter.

https://www.mltframework.org/plugins/FilterFrei0r-coloradj_rgb/


SOP
Contents:

SOP/Sat Effect



SOP/Sat Effect

Contents

SOP/Sat Effect

This is the FilterFrei0r-sopsat [https://www.mltframework.org/plugins/FilterFrei0r-sopsat/]
MLT framework filter. It changes Slope, Offset, and Power of the color
components, and the overall Saturation, according to the ASC CDL (Color
Decision List) reference [https://en.wikipedia.org/wiki/ASC_CDL].

Changing the slope means multiplying the pixel value with a constant value.
Black pixels will remain black, while as brighter ones will be changed. All
effects can be observed well when applied on a greyscale gradient and
looking at the RGB Parade monitor.

You can use this effect to achieve proper white balance.

https://www.mltframework.org/plugins/FilterFrei0r-sopsat/
https://en.wikipedia.org/wiki/ASC_CDL


This filter implements a standard way of color correction proposed by the
American Society of Cinematographers: The Color Decision List, also
known as the ASC CDL.

More information about the ASC CDL can be found on wikipedia
[https://en.wikipedia.org/wiki/ASC_CDL].

The ASC CDL is a standard format for basic primary color correction
(primary meaning affecting the whole image and not only selected parts).

Basically there are two stages in the correction: 1. SOP correction for each
channel separately 2. Overall saturation correction

All corrections work on [0,1], so the RGB(A) values need to be transposed
from {0,…,255} to [0,1].

1. SOP correction
Slope: out = in * slope;   0 <= slope < \infty
Offset: out = in + offset;  -\infty < offset < \infty
Power: out = in^power;     0 < power < \infty

https://en.wikipedia.org/wiki/ASC_CDL


2. Saturation
Luma: Y = 0.2126 R + 0.7152 G + 0.0722 B (according to
Rec. 709)
Forall channels: out = luma + sat * (in-luma)

As the values may exceed 1 (or 0), they need to be clamped where necessary.

See Granjow’s blog where he uses the effect to adjust white balance of a
clip.



White Balance

Contents

White Balance

This is the Frei0r balanc0r [https://www.mltframework.org/plugins/FilterFrei0r-balanc0r/]
MLT filter.

Adjust the white balance / color temperature.

https://youtu.be/foPVqzBV_vM

https://youtu.be/BqmMi6L945E

https://www.mltframework.org/plugins/FilterFrei0r-balanc0r/
https://youtu.be/foPVqzBV_vM
https://youtu.be/BqmMi6L945E


White Balance (LMS)

Contents

White Balance (LMS)

This is the Frei0r colgate [https://www.mltframework.org/plugins/FilterFrei0r-colgate/] MLT
filter by Steiner H. Gunderson.

Do simple color correction, in a physically meaningful way.

Parameters:

Neutral Color: Choose a color from the source image that should be white.

Color Temperature: Choose an output color temperature, if different from
6500 K.

https://www.mltframework.org/plugins/FilterFrei0r-colgate/


Crop and Transform
Effects in this category

Edge Crop
LetterB0xed
Position and Zoom
Rotate and Shear
Rotate
Crop, Scale and Tilt
Transform



Edge Crop

Contents

Edge Crop

This effect by Dan Dennedy trim the edges of a clip.



LetterB0xed

Contents

LetterB0xed

This is the Frei0r letterb0xed [https://www.mltframework.org/plugins/FilterFrei0r-
letterb0xed/] MLT filter.

Adds Black Borders at top and bottom for Cinema Look.

https://youtu.be/9Ldjt0QZPzs

https://youtu.be/JBp8wQW-_Qw

https://www.mltframework.org/plugins/FilterFrei0r-letterb0xed/
https://youtu.be/9Ldjt0QZPzs
https://youtu.be/JBp8wQW-_Qw


Position and Zoom

Contents

Position and Zoom

Adjust size and position of clip using smooth affine transformations.
Formerly known as “Pan and Zoom”.

In this example we have two keyframes in the pan and zoom, one at the
beginning and one at the end. Size is 25% at the start keyframe and 100% at
the end. The images are centered on the screen at both keyframes.

https://youtu.be/0aSe1y6e4RE

See also this Chroma Key that describes how to use:

Alpha Manipulation -> Chroma Key
Rotoscoping
Composite Transition
Crop and Transform -> Pan and Zoom effect
Enhancement -> Sharpen
Alpha Manipulation -> Alpha operations

Tutorial: How to do pan and zoom with Kdenlive video editor - Peter
Thomson(YouTube) [https://youtu.be/B8ZPoWaxQrA]

https://youtu.be/0aSe1y6e4RE
https://youtu.be/B8ZPoWaxQrA


Rotate and Shear

Contents

Rotate and Shear

This would appear to be the Affine [https://www.mltframework.org/plugins/FilterAffine/]
MLT filter as defined in rotation.xml
(/usr/share/kdenlive/effects/).

Rotate clip in any 3 directions.

This screen shot shows settings for Rotate and Shear that can correct wide-
screen footage shot while holding the camera the wrong orientation.

Do a rotate X of 900 units (the units are in tenths of a degree). You can also
adjust the size with this effect.

https://youtu.be/WadSGu05HAw

https://www.mltframework.org/plugins/FilterAffine/
https://youtu.be/WadSGu05HAw


Rotate

Contents

Rotate

Rotates the image.

See also Affine Transition that can also achieve a similar effect.

https://youtu.be/Wfx1Cp5g6Mo

The units of rotation are tenths of a degree; e.g., 1800 = 180 degree rotation.

Rotate X rotates the frame in the plane of the screen.

Rotate Y and Rotate Z create the illusion of 3D rotation when used
dynamically with keyframes.

https://youtu.be/Wfx1Cp5g6Mo


The difference between Rotate Y and Rotate Z is that the apparent rotation
in Rotate Y appears to be around a horizontal axis. The rotation in Rotate Z
appears to be around a vertical axis.



Crop, Scale and Tilt

Contents

Crop, Scale and Tilt

This effect was previously named as Scale and Tilt and Crop, Scale and
Position.

This is the Frei0r scale0tilt [https://www.mltframework.org/plugins/FilterFrei0r-scale0tilt/]
MLT filter from Richard Spindler.

Scales, Tilts and Crops an Image

https://youtu.be/WV4bocj7ygw

See also Position and Zoom which can do very similar things and may do
them better.

https://www.mltframework.org/plugins/FilterFrei0r-scale0tilt/
https://youtu.be/WV4bocj7ygw


Transform

Contents

Transform

This is the Qtblend [https://www.mltframework.org/plugins/FilterQtblend/] MLT filter.

Manipulates Position, scale and opacity.

The Composition mode parameter of the effect is documented on the Qt
documentation under QPainter CompositionMode [https://doc.qt.io/qt-
5/qpainter.html#CompositionMode-enum].

https://www.mltframework.org/plugins/FilterQtblend/
https://doc.qt.io/qt-5/qpainter.html#CompositionMode-enum


Custom Effects

Contents

Custom Effects

The Custom Group in the Effect List is where effects appear when you
choose Save Effect from an effect in the Effects.

 

 



Distort
Effects in this category

Distort - Corners
Defish
Lens Correction
Mirror
Pixelize
Wave



Distort - Corners

Contents

Distort - Corners



Defish

Contents

Defish
PARAMETERS
SOME APPLICATION NOTES

This effect can transform footage shot with a fisheye lens, to look like it was
shot with a rectilinear lens, and vice versa. It can also be used to straighten
the video that was shot with one of these wide angle converters, which are
only slightly curvy, or with a semi-fisheye camera, like the GoPro Hero.

PARAMETERS

“Amount”



Controls the amount of (de)distortion applied to the video. It controls the
ratio of fisheye focal length to image half diagonal, but in an nonlinear
inverse way, to make the control more “comfortable”. It can be adjusted
beyond “reasonable” values (which differ between the mapping function
types), to produce some looney effects. When exploring this range, and the
image disappears, check the scaling, could be that the image became too big
or too small to see. For some unreasonable values the image might indeed
disappear, when there are math overflows or imaginary results… (types 1
and 2 are more prone to image vanishing). Anyway, when working in the
“special effect” range, it is always worth to try manual scaling. If the video
contains zooming through a curvy wide angle adaptor, the needed amount
will vary. In this case use keyframing.

“DeFish”

If checked, the transform direction is from fisheye to rectilinear, when not
checked, it is rectilinear to fisheye.

“Type”

Selects the fisheye angular mapping function used, among four possibilities:

equidistant
orthographic
equiarea
stereographic

Wikipedia has a nice article about these.

“Scaling”

Select among three auto scaling options and manual scale:

scale to fill
keep center scale
scale to fit
manual scale



“Fill” means that no empty borders will be left, but some of the input image
will be cropped. “Fit” means that no part of the input image will be cropped,
but there will be blank areas at the borders.

“Manual Scale”

When “Scaling” is set to manual scale, this control directly affects the image
scale, from 1/100 to 100X size. Only has effect when “Scaling” is set to
manual!

“Interpolator”

Selects among seven different interpolators. This allows one to make a
quality/speed tradeoff. The interpolators are ordered from fast, low quality
to (very) slow high quality. The spline interpolating polynomials are from
Helmut Dersch. For realtime use, option 0 is the fastest, in fact it is equal to
no interpolation. In most cases bilinear should be good enough, and on a
decent machine should still run in real time. Beyond bicubic, the quality gain
is marginal for a single resampling. Lanczos takes an eternity!

Nearest neighbor
Bilinear
Bicubic smooth
Bicubic sharp
Spline 4x4
Spline 6x6
Lanczos 16x16

“Aspect Type”

Selects among four pixel aspect ratio presets, and manual: To get the math
right, Defish0r needs to know the pixel aspect ratio.

Square pixels
PAL DV 1.067
NTSC DV 0.889
HDV 1.333
manual variable



“Manual aspect”

When “Aspect Type” is set to option manual variable, this control directly
affects the pixel aspect ratio, from 0.5 to 2. Only has effect when “Aspect
Type” is set to manual!

SOME APPLICATION NOTES

1. Tweaking the parameters for best defish

Take a shot of something like a brick wall or bathroom tiles, that has a lot of
horizontal and vertical straight lines. Be careful to keep the optical axis as
perpendicular as possible to the wall (=keep a maximally symmetrical image
in the viewfinder). Use this image to tweak the parameters, primarily amount,
type and aspect.

2. Some examples of Defish0r abuse

These were tried with PAL DV. These examples work best, when there is
some interesting action near the center of the image.

For a kind of roundish kaleidoscope, try this:

Amount=775, Defish = OFF, Type = equidistant, Scaling = manual scale,
Manual Scale = 300…400

Another crazy distortion:

Amount = 921, Defish = OFF, Type = stereographic, Scaling = manual scale,
Manual Scale = 191

For an effect, reminiscent of some scenes from the “2001 Space Odyssey” try
this:

Amount = 900, Defish = ON, Type = stereographic, Scaling = fill



Lens Correction

Contents

Lens Correction

This is the Frei0r lenscorrection [https://www.mltframework.org/plugins/FilterFrei0r-
lenscorrection/] MLT filter.

Allows compensation of lens distortion.

https://youtu.be/axQdm482Uto

https://youtu.be/cEwZzNRiVks

https://www.mltframework.org/plugins/FilterFrei0r-lenscorrection/
https://youtu.be/axQdm482Uto
https://youtu.be/cEwZzNRiVks


Mirror

Contents

Mirror

This is the Mirror [https://www.mltframework.org/plugins/FilterMirror/] MLT filter.

Provides various mirror and image reversing effects.

https://youtu.be/ao32j0dSVII

https://youtu.be/3-hcMZu52Vk

https://www.mltframework.org/plugins/FilterMirror/
https://youtu.be/ao32j0dSVII
https://youtu.be/3-hcMZu52Vk


Pixelize

Contents

Pixelize

This is the Frei0r pixeliz0r [https://www.mltframework.org/plugins/FilterFrei0r-pixeliz0r/]
MLT filter.

Pixelize input image.

https://youtu.be/iFj1y1OES2Q

https://youtu.be/jvuFSVGbVRg

https://www.mltframework.org/plugins/FilterFrei0r-pixeliz0r/
https://youtu.be/iFj1y1OES2Q
https://youtu.be/jvuFSVGbVRg


Wave

Contents

Wave

This is the Wave [https://www.mltframework.org/plugins/FilterWave/] MLT filter.

Make waves on your clip with keyframes.

https://youtu.be/8VDzfR-q_sc

https://youtu.be/KEijSvZ6vvc

https://www.mltframework.org/plugins/FilterWave/
https://youtu.be/8VDzfR-q_sc
https://youtu.be/KEijSvZ6vvc


Enhancement
Effects in this category

Denoiser
Sharpen
Spill Suppress



Denoiser

Contents

Denoiser
Tutorial 1

This is the Frei0r hqdn3d [https://www.mltframework.org/plugins/FilterFrei0r-hqdn3d/] MLT
filter - a High quality 3D denoiser from Mplayer.

Tutorial 1

Shows usage of the denoiser effect as well as: Chroma Key, Alpha
operations - shrinkhard and Key Spill Mop Up.

https://youtu.be/l43Hz7YEcYU

https://www.mltframework.org/plugins/FilterFrei0r-hqdn3d/
https://youtu.be/l43Hz7YEcYU


Sharpen

Contents

Sharpen

The sharpen tool is a port of unsharp mask
[https://en.wikipedia.org/wiki/Unsharp_masking] from Mplayer. The parameters are the
usual ones for unsharp masking. The “size” means the size of the blur, and the
amount is how much of the blurred version gets subtracted.

The Size parameter ranges from 0 to 1000, where 0 represents a 3x3
neighbourhood, 250 represents a 5x5 neighbourhood, and 1000 represents an
11x11 neighbourhood. Typically values from 0-250 are a good starting point.

The Amount parameter also ranged from 0 to 1000, and defaults to an input
value of 300. The default value of 300 represents a neutral input,
corresponding to a 0% sharpening. Increasing above 300 will increase the
sharpening amount, with 500 representing 100% sharpening, 700
representing 200% sharpening, and 1000 representing 350% sharpening. A
value of 500 (ie. 100% sharpening) is typically a good place to start.
Reducing the input to below 300 will result in a gaussian blurring of the
picture, with an input value of 0 representing a -150% “sharpening” (ie.
gaussian blurring).

See this Chroma Key that describes how to use.

Alpha Manipulation -> Chroma Key
Rotoscoping
Composite Transition
Crop and Transform -> Position and Zoom
Sharpen Effect
Alpha Manipulation -> Alpha operations

https://en.wikipedia.org/wiki/Unsharp_masking


https://youtu.be/l43Hz7YEcYU

https://youtu.be/l43Hz7YEcYU


Spill Suppress

Contents

Spill Suppress

Remove green or blue spill light from subjects shot in front of green or blue
screen.



Fade
Effects in this category

Fade From Black
Fade to Black

fade_in (audio effect)
fade_out (audio effect)



Fade From Black

Contents

Fade From Black

https://youtu.be/xkulfHyJm18

https://youtu.be/xkulfHyJm18


Fade to Black

Contents

Fade to Black

https://youtu.be/HKWeFL0DKJs

In version 17.04 of Kdenlive you can add Fade to Black and Fade from
Black effects with a single click. And you can adjust the length of the fade
with a drag of the mouse. Hover over the grey rectangle that appears in the
top corner at the end of the clip on the time line and a tool tip will appear
saying “Drag to Add or Resize a Fade Effect”. And if you do Drag you will
add a Fade to Black or a Fade From Black effect (depending on which end of
the clip you are working on).

https://youtu.be/08bTC3VPtqM

Adjusting the duration of the fade - older Kdenlive versions: Adjust the
duration of the fade by dragging the green blob that appears when you hover
over the triangle vertex (see pic below) or by using the Effects duration
slider.

https://youtu.be/HKWeFL0DKJs
https://youtu.be/08bTC3VPtqM




Misc Effects
Effects in this category

Audio Wave
Baltan
cairogradient
cairoimagegrid
Cartoon
Color Distance
Color Effect
Colorhalftone
Dance
Delay grab effect
Dither
Dynamic Text
Edge Glow
Equaliz0r
K-Means Clustering
Key Spill Mop Up
Misc - Light Graffiti
Lumakey Effect
Luminance
Medians
NDVI Filter
Nervous
nosync0r
Owdenoise
Regionalize
rgbnoise
Rgbsplit0r
scanline0r
sigmoidaltransfer
Sobel
tehroxx0r



Threshold
threshold0r
Timeout Indicator
twolay0r
Analysis and Data - Vectorscope
Vignette

atadenoise
bgsubtract
colorchannelmixer
colorlevels
colormatrix
cropdetect
dctdnoiz
deband
deflate
delay0r
delogo
deshake
dilation
drawbox
drawgraph
drawgrid
edgedetect
elbg
eq
erosion
face_blur
face_detect
fftfilt
flippo
framerate
fspp
glitch0r
gradfun
histeq
histogram



hqdn3d
hqx
hue
idet
inflate
lenscorrection
lightshow
lut
lutrgb
lutyuv
noise
pad
perspective
pp
pp7
random
removegrain
rotate
sab
shuffleplanes
signalstats
smartblur
spp
tblend
transpose
unsharp
uspp
vertigo
vid.stab_deshake
vid.stab_detect_and_transform
w3fdif
waveform
xbr
zmq
zoompan



Audio Wave

Contents

Audio Wave
Overlaying the Wave

This is the Audiowave [https://www.mltframework.org/plugins/FilterAudiowave/] MLT
filter.

In ver 17.04 this is found in the Analysis and Data category of Effects.

Display the audio waveform instead of the video. Author Dan Dennedy.

This does not work alone on audio-only clips. It must have video to
overwrite. A workaround is to apply this to a multi-track with a color
generator.

https://www.mltframework.org/plugins/FilterAudiowave/


Overlaying the Wave

This effect replaces the video. If you want the effect overlaying the video you
can do something like shown below.



Duplicate the video track on a track below the one with the Audio wave on
it.

Add a composite transition.

On the top video track (the one with the audio wave effect) add a Color
selection effect.

Make the color you are selecting black and check the invert selection.



Baltan

Contents

Baltan

https://youtu.be/BBdcOCrEcC4

https://youtu.be/BBdcOCrEcC4


cairogradient

Contents

cairogradient

This effect adds a gradient of colour across the frame.



cairoimagegrid

Contents

cairoimagegrid

This effect creates a grid of copies of the video footage as shown in the
screen shot.

You adjust the number of rows and columns in the image with the rows and
columns parameters. These take decimal fractions from zero to 1. The
maximum value of 1 means 20 rows or columns.

Number of rows/columns = (p X 20) + 1 [where p = the value of the row or
column parameter]

In this eg:

rows = 0.1 -> means (0.1 X 20) + 1 = 3 rows

columns = 0.2 -> means (0.2 X 20) + 1 = 5 columns



Cartoon

Contents

Cartoon

This is the Frei0r cartoon [https://www.mltframework.org/plugins/FilterFrei0r-cartoon/] MLT
filter.

Cartoonify video, do a form of edge detect.

https://youtu.be/92fI4znypEo

https://www.mltframework.org/plugins/FilterFrei0r-cartoon/
https://youtu.be/92fI4znypEo


Color Distance
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Color Distance

This is the Frei0r colordistance [https://www.mltframework.org/plugins/FilterFrei0r-
colordistance/] MLT filter.

Calculates the distance between the selected color and the current pixel and
uses that value as new pixel value.

https://youtu.be/eL8cFUJrUo0

https://youtu.be/4Ta9UE2nflU

https://youtu.be/7VRQyCUxYUQ

https://www.mltframework.org/plugins/FilterFrei0r-colordistance/
https://youtu.be/eL8cFUJrUo0
https://youtu.be/4Ta9UE2nflU
https://youtu.be/7VRQyCUxYUQ


Color Effect
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Color Effect

This is the Frei0r colortap [https://www.mltframework.org/plugins/FilterFrei0r-colortap/]
MLT filter.

Applies a pre-made color effect to image.

Possible effects are:

xpro, sepia, heat, red_green, old_photo, xraym, esses and yellow_blue.

https://www.mltframework.org/plugins/FilterFrei0r-colortap/


Colorhalftone

Contents

Colorhalftone

Filters image to resemble a halftone print in which tones are represented as
variable sized dots.



Dance
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Dance

This effect causes the video frame to dance around the screen.

Add this effect to a video and include another video track below it and a
composite transition between the two tracks.

https://youtu.be/gqxU1nvh6JI

https://youtu.be/gqxU1nvh6JI


Delay grab effect

Contents

Delay grab effect

This effect is available from the misc group.

This is the Frei0r delaygrab [https://www.mltframework.org/plugins/FilterFrei0r-delaygrab/]
MLT filter by Bill Spinhover, Andreas Scheffler and Jaromil.

Delayed frame blitting mapped on a time bitmap.

https://youtu.be/t6rsEdDiuAQ

https://youtu.be/vh63RxHm8Lg

https://www.mltframework.org/plugins/FilterFrei0r-delaygrab/
https://youtu.be/t6rsEdDiuAQ
https://youtu.be/vh63RxHm8Lg


Dither

Contents

Dither



Dynamic Text
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Dynamic Text

The “Dynamic Text” effect allows you to overlay a timecode - which counts
up relative to the start of the clip or timeline it is applied to.

Hint: You can add effects to entire video tracks by clicking on the Track
Header and choosing Timeline ‣ Add Effect. Video tracks that have effects
added to them are marked with a yellow star in the Track Header.

If you add this effect to the Video track rather than individual clips the
timecode will not reset at the beginning of the next clip but rather count
across the whole length of your project.

See also the Rendering option in the render dialog to add time code or frame
count to the entire rendered project.

https://youtu.be/A4ObXRhi6ZM

https://youtu.be/A4ObXRhi6ZM


Edge Glow

Contents

Edge Glow

This is the Frie0r edgeglow [https://www.mltframework.org/plugins/FilterFrei0r-edgeglow/]
MLT filter.

In version 15.n of Kdenlive this is in the Blur and Hide section.

https://youtu.be/d0MvA_7VuJk

https://youtu.be/Cl0Z8FXULbQ

https://www.mltframework.org/plugins/FilterFrei0r-edgeglow/
https://youtu.be/d0MvA_7VuJk
https://youtu.be/Cl0Z8FXULbQ


Equaliz0r

Contents

Equaliz0r

This is the Frei0r equaliz0r [https://www.mltframework.org/plugins/FilterFrei0r-equaliz0r/]
MLT filter.

Equalizes the intensity histograms.

(Moved to Color section in ver 15.n).

https://youtu.be/KdlxSA2gs68

https://youtu.be/w8qqpJmdGug

https://www.mltframework.org/plugins/FilterFrei0r-equaliz0r/
https://youtu.be/KdlxSA2gs68
https://youtu.be/w8qqpJmdGug


K-Means Clustering

Contents

K-Means Clustering

This is the Frei0r cluster [https://www.mltframework.org/plugins/FilterFrei0r-cluster/] MLT
filter.

Clusters of a source image by color and spatial distance.

https://youtu.be/a3Yz2xJWmN8

https://youtu.be/qwTD__a5oqo

https://www.mltframework.org/plugins/FilterFrei0r-cluster/
https://youtu.be/a3Yz2xJWmN8
https://youtu.be/qwTD__a5oqo


Key Spill Mop Up

Contents

Key Spill Mop Up
Tutorial
Details

Warning

This page is outdated. You may find the new one here: Key spill mop up.

This effect is used when using chroma keying (otherwise known as
greenscreen or Chroma Key effect). Its purpose is to compensate for the fact
that sometimes the color from the green or blue screen reflects onto the
subject and will make them a shade of blue or green - especially around the
edges. This is known as “keyspill”. This effect can attempt to compensate for
this issue.

The effect may be found in the Misc Effects group or in the Alpha
manipulation group (version >= 0.9.3)

Tutorial

This tutorial shows usage of the following effects: keysplillm0pup, blue
screen, alpha operations - shrinkhard and denoiser

https://youtu.be/l43Hz7YEcYU

Details

https://youtu.be/l43Hz7YEcYU


The README for the keyspillm0pup is this:

DESCRIPTION:

After some experimentation with chroma keying, it looked to me that there is
no single method of key cleaning, that works in all situations, like keyspill on
bright, keyspill on dark, etc. So I included several cleaning options, which
can be used alone or in combination. In short, it offers three ways of pixel
selection (masking), that can be combined with four types of color changing
operations. The three selection / masking modes are based on:

similarity to key color
transparency
closeness to the edge

and the four things that can be done to the selected pixels are:

move away from the key color (De-Key)
move towards an target color (Target)
desaturate
luma (brightness) adjust.

MASKS:

Color difference masks are based on the color of the image, and do not
depend on the alpha from the preceding keying, except for ignoring the 100%
transparent areas, to increase speed.

Transparency and Edge masks are based on the alpha channel from the
preceding keying operation. Transparency masks will affect only the parts
that are neither 100% opaque nor 100% transparent, based on the alpha
values from the preceding keying operation. The effect will be proportional
to the transparency.

Note

If a “hard key” was used in the preceding keying, there will be no areas that
T operations could affect. Edge masks will affect only pixels close to the



edge, with the effect diminishing away from the edge. The outer edge is the
edge of the fully opaque part, where the alpha from the preceding keying is
1.0 (255).

Note

The edge masking algorithm is not yet what I would like it to be. I will
have to look some more into this, and improve it, so consider it a
“temporary solution” that will change in the future.

All masks can be further pruned with two parameters: an “hue gate”, which
will limit the mask to hues close to the key hue, and an “saturation
threshold”, which will limit the mask to areas with color saturation above a
threshold.

CASCADING:

This plugin can be cascaded, but it is not possible to get the same color
based mask in the second instance, because the colors will be changed by the
first instance. To enable two operations with the same mask, each plugin
instance can do two operations. With transparency and edge masks,
cascading is a bit easier. If the hue gate and saturation threshold are not used,
transparency and edge masks can be exactly the same in cascaded plugins.

PARAMETERS:

Key color: This should be the same or similar to the key color used for the
preceding keying operation.

Target color: This is only used when “Target” operation is used with one of
the masks. The colors in the affected areas will be moved towards this color,
according to the “Amount” parameter.

Mask type: Selects the type of mask that will determine where the color
altering operations will occur.



Tolerance: For the color difference mask, the range of colors around the key,
that will be 100% affected. For the transparency mask, the “amplification”.
For the edge mask, the width of the affected area.

Slope: For the color difference mask, the range of colors outside of
“Tolerance”, that will be gradually less affected. No function for the
transparency and edge masks.

Hue gate: Reduces the mask according to difference from key hue, to prevent
change to pixels that are within the mask, but not polluted by key.

Saturation threshold: Reduces the mask according to color saturation, to
avoid affecting the neutral areas.

Operation 1: Selects which of the four possible operations will be done on
the mask-selected pixels. Apart from no operation, there are four
possibilities: De-key, Target, De-saturate and Luma adjust.

Amount 1: The amount of the selected operation 1, how much the colors will
change.

Operation 2, Amount 2: Enable a second operation to be performed with the
same mask.

Show mask: This will show the selected mask as a greyscale image, to help
with fine tuning of the masks. Should be OFF for the final render.

Mask to Alpha: Copies the active mask to the alpha channel. For all normal
spill cleaning operations, this should be OFF. By setting it ON, the
keyspillm0pup itself can be used as a keyer, or to generate some special
effects.



Misc - Light Graffiti

Contents

Misc - Light Graffiti

https://vimeo.com/18497028

https://vimeo.com/20217266

https://vimeo.com/18497028
https://vimeo.com/20217266


Lumakey Effect

Contents

Lumakey Effect

In version 15.n of Kdenlive this is in the Misc category of effects.

The Lumakey effect changes the clip’s alpha channel. To see its effect, you
need a transition (like the Composite transition that is available in tracks)
and another clip beneath.



Luminance

Contents

Luminance

This is the Frei0r luminance [https://www.mltframework.org/plugins/FilterFrei0r-luminance/]
MLT filter.

Creates a luminance map of the image.

(Moved to Color section in ver 15.n).

https://youtu.be/2NlTk95kCY8

https://youtu.be/0wiM77K-ENQ

https://www.mltframework.org/plugins/FilterFrei0r-luminance/
https://youtu.be/2NlTk95kCY8
https://youtu.be/0wiM77K-ENQ


Medians
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Medians

This filter implements several median type filters.

INTRODUCTION:

Median is a quite popular non-linear filter in image processing. Most often it
is used to remove impulsive noise, like “salt & pepper” noise, “dead” and
“hot” pixels, dirt on film, etc. This is because it behaves kind of “inversely”
compared to linear denoisers. The more a bad pixel stands out from the
surrounding area, the bigger residual it will leave with a linear filter - but the
more probably it will be eliminated by the median.

The down side is that the median operation is quite slow. As an order-
statistic filter, it is similar to sorting, that must be done for each pixel, so
using a fast algorithm is very important. For the small medians, the
algorithms of the type described in this page
[http://ndevilla.free.fr/median/median/src/optmed.c] are used here, with some small
modifications for a further slight improvement in speed. For the “Variable
size” median, code from [1] is used. The compound filters (ArceBI, ML3D,
ML3dEX) are made according to the formulas given in the corresponding
work [2]. For more info on median filtering see Wikipedia article
[https://en.wikipedia.org/wiki/Median_filter].

IMPLEMENTED ALGORITHMS:

Cross5
Median of the pixel with its top, bottom, left and right neighbor.

Square3x3

http://ndevilla.free.fr/median/median/src/optmed.c
https://en.wikipedia.org/wiki/Median_filter


Median of the pixel with the surrounding 8 pixels. (3x3 box)

Bilevel
First, make cross5 median, then make median of the pixel with its four
diagonal neighbors, and finally take the median of the pixel and the two
previously calculated medians. Slightly better preserves detail than the
simple medians above.

Diamond3x3
Takes median of the pixel with 12 neighboring pixels arranged in a
diamond pattern.

Square5x5
Median of the pixel with the 5x5 surrounding box.

Temp3
Temporal only median of three frames. Can be used to reduce single
frame time-impulsive noise like photoflash. Delays the video by 1 frame.

Temp5
Temporal only median of five frames. Can be used to reduce double
frame time-impulsive noise, but the artifacts on fast moving objects are
stronger than with temp3. Delays the video by 2 frames.

ArceBI
Spatio-temporal multilevel median, as described by Arce. See the
corresponding work [2]. Delays the video by 1 frame.

ML3D
Spatio-temporal multilevel median, as described by Alp. See the
corresponding work [2]. Delays the video by 1 frame.

ML3dEX
Spatio-temporal multilevel median. Further development of ML3D by
Kokaram, see the corresponding work [2]. Delays the video by 1 frame.

VarSize



[1]

[2] (1,2,3,4)

Simple spatial only median in a user selected size square box around
each pixel. The effect could be described as “quasi edge preserving,
corner rounding, small stuff eliminator”. Or maybe just an “artsy blur”.

PARAMETERS:

Type
Selects one of the eleven algorithms.

Size
Only active when “VarSize” type is selected. Determines the size of the
square area over which the median is taken.

Simon Perreault, Patrick Hebert: Median filtering in constant time, PDF
version [https://nomis80.org/ctmf.pdf], HTML version [https://nomis80.org/ctmf.html]

Anil Christopher Kokaram: Motion Picture Restoration, Ph.D.
thesis [https://citeseerx.ist.psu.edu/viewdoc/download?
doi=10.1.1.36.9618&rep=rep1&type=pdf]

https://nomis80.org/ctmf.pdf
https://nomis80.org/ctmf.html
https://citeseerx.ist.psu.edu/viewdoc/download?doi=10.1.1.36.9618&rep=rep1&type=pdf


NDVI Filter
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NDVI Filter

This is the Frei0r ndvi [https://www.mltframework.org/plugins/FilterFrei0r-ndvi/] MLT filter
by Brian Matherly.

This filter creates a Normalized Difference Vegetation Index (NDVI
[https://en.wikipedia.org/wiki/Normalized_Difference_Vegetation_Index]) false image from an
infrablue source.

https://www.mltframework.org/plugins/FilterFrei0r-ndvi/
https://en.wikipedia.org/wiki/Normalized_Difference_Vegetation_Index


Nervous
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Nervous

https://youtu.be/CUTPB8zZvcA

https://youtu.be/CUTPB8zZvcA


nosync0r
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nosync0r

This is the Frei0r nosync0r [https://www.mltframework.org/plugins/FilterFrei0r-nosync0r/]
MLT filter.

Video looks like a broken TV with bottom half of picture on the top of
screen.

https://youtu.be/91lPpm1nMTk

https://youtu.be/VO1Mele0lzU

https://www.mltframework.org/plugins/FilterFrei0r-nosync0r/
https://youtu.be/91lPpm1nMTk
https://youtu.be/VO1Mele0lzU


Owdenoise
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Owdenoise

This is the Avfilter owdenoise [https://www.mltframework.org/plugins/FilterAvfilter-
owdenoise/] MLT filter.

Denoise using wavelets.

https://www.mltframework.org/plugins/FilterAvfilter-owdenoise/


Regionalize
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Regionalize

Apply subeffects to a region defined by a clip’s alpha channel.

This is the Region [https://www.mltframework.org/plugins/FilterRegion/] MLT filter.

Arguments:

File A file whose alpha channel will “shape” the region. The string “circle”
is a shortcut but it requires pixbuf with the librsvg loader. The circle is
automatically stretched to the region to create an ellipse.

Region Properties may be set on the encapsulated region transition. See
“region” transition for details.

https://www.mltframework.org/plugins/FilterRegion/


rgbnoise
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rgbnoise

This is an effect in the Misc category.

This is the Frei0r rgbnoise [https://www.mltframework.org/plugins/FilterFrei0r-rgbnoise/]
MLT filter by Janne Liljeblad.

It adds RGB noise to image and takes one parameter noise in the range 0 to 1
which controls the amount of noise added.

https://youtu.be/zkJUitSzWYc

https://www.mltframework.org/plugins/FilterFrei0r-rgbnoise/
https://youtu.be/zkJUitSzWYc


Rgbsplit0r
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Rgbsplit0r

This is the Frei0r rgbsplit0r [https://www.mltframework.org/plugins/FilterFrei0r-rgbsplit0r/]
MLT filter.

This video effect is found in the Misc section of effects. The effect takes the
red, green and blue channels in the video and separates them by a given x and
y amount to produce a rainbowish effect.

https://www.mltframework.org/plugins/FilterFrei0r-rgbsplit0r/


scanline0r

Contents

scanline0r

This is the Frei0r scanline0r [https://www.mltframework.org/plugins/FilterFrei0r-scanline0r/]
MLT filter.

Interlaced black lines.

https://youtu.be/nJ2TE4SdaJM

https://youtu.be/St4P6Ziwmcw

https://www.mltframework.org/plugins/FilterFrei0r-scanline0r/
https://youtu.be/nJ2TE4SdaJM
https://youtu.be/St4P6Ziwmcw


sigmoidaltransfer

Contents

sigmoidaltransfer

This is the Frei0r sigmoidaltransfer [https://www.mltframework.org/plugins/FilterFrei0r-
sigmoidaltransfer/] MLT filter by Janne Liljeblad.

Desaturates image and creates a particular look that could be called Stamp,
Newspaper or Photocopy.

Two parameters:

Brightness: Controls Brightness of image. Range 0 to 1.

Sharpness: Controls sharpness of transfer. Range 0 to 1.

Both parameters default to 0 in Kdenlive - which is unfortunate because this
results in a totally black frame. You need to have numbers above zero to see
the effect.

https://www.mltframework.org/plugins/FilterFrei0r-sigmoidaltransfer/


Sobel

Contents

Sobel

This is the Frei0r sobel [https://www.mltframework.org/plugins/FilterFrei0r-sobel/] MLT
filter.

Sobel filter is an edge detection filter.

https://youtu.be/sSlJovKEZJk

https://www.mltframework.org/plugins/FilterFrei0r-sobel/
https://youtu.be/sSlJovKEZJk


tehroxx0r
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tehroxx0r

This is the Frei0r tehroxx0r [https://www.mltframework.org/plugins/FilterFrei0r-tehroxx0r/]
MLT filter.

Something videowall-ish.

The effect might not show up during preview but it does appear in the
rendered file.

This effect has one parameter – interval – with a range from zero to 1. This
parameter controls the number of small video frames which appear around
the border and how frequently they flash. Higher number = fewer frames and
slower flashing.

https://youtu.be/qyv15F834h4

https://youtu.be/ii47tIsYFHQ

https://www.mltframework.org/plugins/FilterFrei0r-tehroxx0r/
https://youtu.be/qyv15F834h4
https://youtu.be/ii47tIsYFHQ


Threshold
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Threshold

This is the Threshold [https://www.mltframework.org/plugins/FilterThreshold/] MLT filter.

Make monochrome clip.

Different to threshold0r.

https://www.mltframework.org/plugins/FilterThreshold/


threshold0r

Contents

threshold0r

This is the Frei0r threshold0r [https://www.mltframework.org/plugins/FilterFrei0r-
threshold0r/] MLT filter.

Thresholds a source image.

https://youtu.be/Bx5frOYPlKU

https://youtu.be/PWueJhFlHsg

Different to Threshold.

https://www.mltframework.org/plugins/FilterFrei0r-threshold0r/
https://youtu.be/Bx5frOYPlKU
https://youtu.be/PWueJhFlHsg


Timeout Indicator
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Timeout Indicator

This is Frei0r timeout [https://www.mltframework.org/plugins/FilterFrei0r-timeout/] MLT
filter by Simon A. Eugster.

In ver 17.04 this is found in the Analysis and Data category of Effects.

This adds a little countdown bar to the bottom right of the video and is
available in ver. 0.9.5 of Kdenlive.

The settings in this screen shot produced the sample video below.

https://www.mltframework.org/plugins/FilterFrei0r-timeout/


https://youtu.be/ry3DLZD_bRc

https://youtu.be/ry3DLZD_bRc


twolay0r

Contents

twolay0r

This is the Frei0r twolay0r [https://www.mltframework.org/plugins/FilterFrei0r-twolay0r/]
MLT filter.

Dynamic thresholding.

https://youtu.be/yEPzS6AKFyo

https://youtu.be/N9TpjQmVSyQ

https://www.mltframework.org/plugins/FilterFrei0r-twolay0r/
https://youtu.be/yEPzS6AKFyo
https://youtu.be/N9TpjQmVSyQ


Analysis and Data - Vectorscope

Contents

Analysis and Data - Vectorscope

This is the Frei0r vectorscope [https://www.mltframework.org/plugins/FilterFrei0r-
vectorscope/] MLT filter.

Displays the vectorscope of the video-data.

In ver 17.04 this is found in the Analysis and Data category of Effects.

It is recommended to use the vectorscope from Vectorscope Window,
because the effect Analysis and Data - Vectorscope is not correct - it uses a
graticule from an analog NTSC vectorscope, but equations from digital
video.

https://youtu.be/2ybBzDEjdRo

https://youtu.be/O1hbS6VZh_s

https://www.mltframework.org/plugins/FilterFrei0r-vectorscope/
https://youtu.be/2ybBzDEjdRo
https://youtu.be/O1hbS6VZh_s


Vignette

Contents

Vignette

This is the Frei0r vignette [https://www.mltframework.org/plugins/FilterFrei0r-vignette/] MLT
filter.

Lens vignetting effect, applies natural vignetting.

https://www.mltframework.org/plugins/FilterFrei0r-vignette/


Motion
Effects in this category

Motion - Freeze
Motion Effects - Speed



Motion - Freeze
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Motion - Freeze

This effect causes the video to freeze. If you add the effect and leave both
check boxes unchecked, the clip will be frozen for its entire length. To
change this, check either the Freeze Before or Freeze After option and move
the Freeze At slider to the time where you what the freeze to start or end. If
Freeze Before is selected, the video will be frozen at the start and then start
moving when it hits the Freeze At time. If Freeze After is selected, the video
will be moving at the start and then freeze when it hits the Freeze At time.
The audio in the video plays for the entire length, i.e. the Freeze effect does
not alter the audio.



Motion Effects - Speed
Attention

Deprecated since version 21.04: Use Change speed instead

Contents

Motion Effects - Speed

Make clip play faster or slower. Use of this effect mutes the audio of the clip.

The Stroboscope setting defines the number frames the effect skips when
playing back. For example, if Stroboscope is set to 5 then the effect will only
show every fifth frame but will show these frames for five times as long,
producing a jumpy, stroboscopic effect.

It has been reported that the Speed effect does not work very well on H.264-
formatted source video. It is recommended to transcode your source material
into the DNxHD format and apply the Speed effect to that. (forum post
[https://forum.kde.org/viewtopic.php?f=270&amp;t=121296&amp;p=311629#p311427])

https://forum.kde.org/viewtopic.php?f=270&amp;t=121296&amp;p=311629#p311427


Alphabetical List of Effects and Compositions
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Alphabetical List of Effects and Compositions

Note

The effects and compositions included will differ depending on the available plug-ins on the specific packaging on
each operating system. Kdenlive will auto-detect and make available any supported LADSPA plug-in packages
from your distribution. For the greatest compatibility, please use the AppImage version of Kdenlive.

Effect or Transition Name Type Category Description

3 point balance Video Effect
Color and
Image
correction

Balances colors along with 3 points (frei0r.t

3d_fft_denoiser Video Effect Grain and
Noise

Denoise frames using 3D FFT (Frequency D
(avfilter.fftdnoiz)

3-level_threshold Video Effect Stylize Dynamic 3-level thresholding (frei0r.threela

4 x 4 pole allpass Audio Effect

Steve
Harris’
SWH
plugins

LADSPA plugin (ladspa.1218)

acontrast Audio Effect Audio Simple audio dynamic range compression/ex

acrusher Audio Effect Audio Reduce audio bit resolution (avfilter.acrushe

acue Audio Effect Audio Delay filtering to match a cue (avfilter.acue)

addition transition Compositions Perform an RGB[A] addition operation of th
(frei0r.addition)

Addition_alpha transition Compositions Perform an RGB[A] addition_alpha operatio
sources (frei0r.addition_alpha)

addroi Compositions Add region of interest to frame (avfilter.addr

https://www.mltframework.org/plugins/FilterLadspa-1218/


Effect or Transition Name Type Category Description

adeclick Audio Effect Audio Remove impulsive noise from input audio (a

adenorm Audio Effect Audio Remedy denormals by adding extremely low
(avfilter.adenorm)

aderivative Audio Effect Audio Compute derivative of input audio (avfilter.a

aexciter Audio Effect Audio Enhance high frequency part of audio (avfilte

afftdn Audio Effect Audio Denoise audio samples using FFT (avfilter.a

afreqshift Audio Effect Audio Apply frequency shifting to input audio (avfi

aintergral Audio Effect Audio Compute integral of input audio (avfilter.aint

Aliasing Audio Effect

Steve
Harris’
SWH
plugins

LADSPA plugin (ladspa.1407)

alimiter Audio Effect Audio Audio lookahead limiter (avfilter.alimiter)

allpass Audio Effect Audio Apply a two-pole all-pass filter (avfilter.allp

Allpass delay line cubic spline
interpolation Audio Effect

Steve
Harris’
SWH
plugins

LADSPA plugin (ladspa.1897)

Allpass delay line linear interpolation Audio Effect

Steve
Harris’
SWH
plugins

LADSPA plugin (ladspa.1896)

Allpass delay line noninterpolating Audio Effect

Steve
Harris’
SWH
plugins

LADSPA plugin (ladspa.1895)

aloop Audio Effect Audio Loop audio samples (avfilter.aloop)

https://www.mltframework.org/plugins/FilterLadspa-1407/
https://www.mltframework.org/plugins/FilterLadspa-1897/
https://www.mltframework.org/plugins/FilterLadspa-1896/
https://www.mltframework.org/plugins/FilterLadspa-1895/


Effect or Transition Name Type Category Description

Alpha gradient Video Effect Alpha, Mask
and Keying

Fill the alpha channel with the specified grad
(frei0r.alphagrad)

Alpha operations Video Effect Alpha, Mask
and Keying Display and manipulation of the alpha chann

Alpha Shapes Video Effect Alpha, Mask
and Keying Draws simple shapes into the alpha channel 

alphastrobing Video Effect Alpha, Mask
and Keying

Strobes the alpha channel to 0. Many other fi
alpha channel, in that case this needs to be la

alphaatop transition Compositions The alpha ATOP operation (frei0r.alphatop)

alphain transition Compositions The alpha IN operation (frei0r.alphain)

alphaout transition Compositions The alpha OUT operation (frei0r.alphaout)

alphaover transition Compositions The alpha OVER operation (frei0r.alphaover

alphaxor transition Compositions The alpha XOR operation (frei0r.alphaxor)

AM pitchshifter Audio Effect

Steve
Harris’
SWH
plugins

LADSPA plugin (ladspa.1433)

anlmdn Audio Effect Audio Reduce broadband noise from stream using N
(avfilter.anlmdn)

aphaser Audio Effect Audio Add a phasing effect to the audio (avfilter.ap

aphaseshift Audio Effect Audio Apply phase shifting to input audio (avfilter.

Apply LUT Video Effect
Color and
Image
correction

Apply a Look Up Table (LUT) to the video. 
way to correct the color of a video. Supporte
(AfterEffects), .cube (Iridas), .dat (DaVinci)
(avfilter.lut3d)

https://www.mltframework.org/plugins/FilterLadspa-1433/


Effect or Transition Name Type Category Description

apulsator Audio Effect Audio Audio Pulsator (avfilter.apulsator)

arndn Audio Effect Audio Reduce noise from speech using recurrent N
(avfilter.arnndn)

Artificial latency Audio Effect

Steve
Harris’
SWH
plugins

LADSPA plugin (ladspa.1914)

asidedata Audio Effect Audio Manipulate audio frame side data (avfilter.as

asoftclip Audio Effect Audio Audio soft clipper (avfilter.asoftclip)

asubboost Audio Effect Audio Show time domain statistics about audio fram

astats Audio Effect Audio Boost subwoofer frequencies (avfilter.asubb

asubcut Audio Effect Audio Cut subwoofer frequencies (avfilter.asubcut)

asupercut Audio Effect Audio Cut super frequencies (avfilter.asupercut)

asuperpass Audio Effect Audio Apply high order Butterworth band-pass filte
(avfilter.asuperpass)

asuperstop Audio Effect Audio Apply high order Butterworth band-stop filte
(avfilter.asuperstop)

Audio Divider (Suboctave Generator) Audio Effect

Steve
Harris’
SWH
plugins

LADSPA plugin (ladspa.1186)

audio_equalizer_(avfilter) Audio Effect Audio Apply two-pole peaking equalization (EQ) f
(avfilter.equalizer)

audio_levels Audio Effect Audio Compute the audio amplitude (audiolevel)

audio_pan Audio Effect Audio Pan an audio channel, adjust balance, or adju

https://www.mltframework.org/plugins/FilterLadspa-1914/


Effect or Transition Name Type Category Description

Audio Spectrum Filter Video Effect On Master An audio visualization filter that draws an au
image (audiospectrum)

Audio Wave Video Effect On Master Display the audio waveform instead of the v

audio_waveform_filter Audio Effect Audio An audio visualization filter that draws an au
the image (audiowaveform)

audiomap Audio Effect Audio audiomap (audiomap)

Auto Mask Video Effect Alpha, Mask
and Keying

Hide a selected zone and follow its moveme
(autotrack_rectangle)

Auto phaser Audio Effect

Steve
Harris’
SWH
plugins

LADSPA plugin (ladspa.1219)

average_blur Video Effects Blur and
Sharpen Apply average blur filter (avfilter.avgblur)

bandpass Audio Effect Audio Apply a two-pole band-pass filter (avfilter.b

bandreject Audio Effect Audio Apply a two-pole Butterworth band-reject fi
(avfilter.bandreject)

balance Video Effect
Color and
Image
correction

Extracts Blue from Image (frei0r.B)

Barry’s Satan Maximiser Audio Effect

Steve
Harris’
SWH
plugins

LADSPA plugin (ladspa.1408)

bass Audio Effect Audio Boost or cut lower frequencies (avfilter.bass

Bezier Curves Video Effect
Color and
Image
Correction

Color curves adjustment (frei0r.curves)

https://www.mltframework.org/plugins/FilterLadspa-1219/
https://www.mltframework.org/plugins/FilterLadspa-1408/


Effect or Transition Name Type Category Description

bilateral Video Effect Misc Apply Bilateral filter (avfilter.bilateral)

Binarize Video Effect Stylize Make monochrome clip (threshold)

binarizedynamically Video Effect Stylize Dynamic thresholding (frei0r.twolay0r)

biquad Audio Effect Audio Apply a biquad IIR filter with the given coef
(avftiler.biquad)

bluescreen0r Video Effect Alpha, Mask
and Keying Color to alpha (blit SRCALPHA) (frei0r.blu

Blur Video Effect Deprecated Blur using 2D IIR filters (exponential, lowpa
(frei0r.IIRblur)

Bode frequency shifter Audio Effect

Steve
Harris’
SWH
plugins

LADSPA plugin (ladspa.1431)

Bode frequency shifter (CV) Audio Effect

Steve
Harris’
SWH
plugins

LADSPA plugin (ladspa.1432)

Box Blur Video Effect Blur and
Sharpen Box blur (separate horizontal and vertical bl

Box Blur Video Effect Blur and
Sharpen Apply a boxblur algorithm to the input video

Brightness Video Effect
Color and
Image
correction

Adjusts the brightness of a source image (fre

Brightness (keyframable) Video Effect
Color and
Image
correction

Change the image brightness with keyframes 

https://www.mltframework.org/plugins/FilterLadspa-1431/
https://www.mltframework.org/plugins/FilterLadspa-1432/


Effect or Transition Name Type Category Description

burn Compositions
Perform an RGB[A] dodge operation betwee
using the generalized algorithm: D = saturati
depletion of 0, of ((255-A)*256) / (b+1) (fre

BurningTV – Deprecated Video Effect Deprecated burningtv

bw0r Video Effect
Color and
Image
correction

Turns image Black/White (frei0r.bw0r)

cairo_affine_blend Compositions
Composites second input on first input apply
transformations, opacity, and blend mode
(frei0r.cairoaffineblend)

cairo_blend Compositions Composites second input on the first input w
blend mode and opacity (frei0r.cairoblend)

cairogradient Video Effect Generate Draws a gradient on top of image. Filter is g
and end points, colors and opacities.

cairoimagegrid Video Effect Generate Create a video grid (frei0r.cairoimagegrid)

Cartoon Video Effect Stylize Cartoonify video, do a form of edge detect (f

Cartoon Video Effect Misc Contrast Adaptive Sharpen (avfilter.cas)

Charcoal Video Effect Stylize Charcoal drawing effect (charcoal)

Chebyshev distortion Audio Effect

Steve
Harris’
SWH
plugins

LADSPA plugin (ladspa.1430)

Chroma Hold Video Effect
Color and
Image
correction

Make image greyscale except for chosen col

chromahold Video Effect
Color and
Image
correction

Removes all color information for all colors
one (avfilter.chromahold)

https://www.mltframework.org/plugins/FilterLadspa-1430/


Effect or Transition Name Type Category Description

Chroma Key Video Effect Alpha, Mask
and Keying Make Selected Color transparent (chroma)

chroma_shift Video Effect Stylize Shift chroma pixels horizontally and/or verti
(avfilter.chromashift)

chromanr Video Effect Misc Reduce chrominance noise (avfilter.chroman

ciescope Video Effect Utility Video CIE scope (avfilter.ciescope)

cmyk_adjust_(avfilter) Video Effect
Color and
Image
correction

Apply CMYK correction to specific color ra
(avfilter.selectivecolor)

color_balance Video Effect
Color and
Image
correction

Modify intensity of primary colors (red, gree
frames (avfilter.colorbalance)

color_channel_mixer Video Effect
Color and
Image
correction

Modifies a color channel by adding the value
other channels of the same pixels (avfilter.co

Color Distance Video Effect Stylize
Calculates the distance between the selected
current pixel and uses that value as a new pix
(frei0r.colordistance)

Color Effect Video Effect Stylize Applies a pre-made color effect to image (fr

color_hold Video Effect
Color and
Image
correction

Remove all color information all RGB color
one (avfilter.colorhold)

Color selection Video Effect Alpha, Mask
and Keying

Chroma Key with more advanced options (e
models). Use if basic chroma key is not work
(frei0r.select0r)

color_only Compositions Perform a conversion to color only of the sou
hue and saturation values of input2 (frei0r.co



Effect or Transition Name Type Category Description

colorcontrast Video Effect Stylize
Calculates the distance between the selected
current pixel and uses that value as a new pix
(frei0r.colordistance)

colorcorrect Video Effect Stylize Applies a pre-made color effect to image (fr

colorize Video Effect
Color and
Image
correction

Colorizes image to selected hue, saturation a
(frei0r.colorize)

colorize Video Effect
Color and
Image
correction

Overlay a solid color on the video stream (a

colorlevels Video Effect
Color and
Image
correction

Adjust video input frames using levels (avfil

colormatrix Video Effect Image
Adjustment Convert color matrix (avfilter.colormatrix)

colortemperature Video Effect Misc Adjust color temperature of video (avfilter.c

Comb delay line cubic spline
interpolation Audio Effect

Steve
Harris’
SWH
plugins

LADSPA plugin (ladspa.1888)

Comb delay line linear interpolation Audio Effect

Steve
Harris’
SWH
plugins

LADSPA plugin (ladspa.1887)

Comb delay line noninterpolating Audio Effect

Steve
Harris’
SWH
plugins

LADSPA plugin (ladspa.1889)

Comb Filter Audio Effect

Steve
Harris’
SWH
plugins

LADSPA plugin (ladspa.1190)

https://www.mltframework.org/plugins/FilterLadspa-1888/
https://www.mltframework.org/plugins/FilterLadspa-1887/
https://www.mltframework.org/plugins/FilterLadspa-1889/
https://www.mltframework.org/plugins/FilterLadspa-1190/


Effect or Transition Name Type Category Description

comb_splitter Audio Effect

Steve
Harris’
SWH
plugins

LADSPA plugin (ladspa.1411)

compand Audio Effect Audio LADSPA plugin (ladspa.1430)

compensationdelay Audio Effect Audio Audio Compensation Delay Line (avfilter.co

Composite Transition Compositions A key-framable alpha-channel compositor fo
(composite)

compositeandtransform Compositions Composites second input on the first input w
blend mode, opacity and scale (qtblend)

Constant Signal Generator Audio Effect

Steve
Harris’
SWH
plugins

LADSPA plugin (ladspa.1909)

Contrast Audio Effect Audio
correction Process audio using a SoX effect

contrast Video Effect
Color and
Image
correction

Adjusts the contrast of a source image (frei0

copy_channels Audio Effect Audio Copy one audio channel to another (channelc

Distort - Corners Video Effect
Transform,
Distort and
Perspective

Four corners geometry engine (frei0r.c0rners

crop_by_padding Video Effect
Transform,
Distort and
Perspective

This filter crops the image to a rounded recta
padding it with a color (qtcrop)

Crop, Scale and Tilt Video Effect
Transform,
Distort and
Perspective

Scales, Tilts and Crops an Image (frei0r.scal

https://www.mltframework.org/plugins/FilterLadspa-1909/


Effect or Transition Name Type Category Description

Crossfade Audio Effect

Steve
Harris’
SWH
plugins

LADSPA plugin (ladspa.1915)

Crossfade (4 outs) Audio Effect

Steve
Harris’
SWH
plugins

LADSPA Plugin (ladspa.1917)

crossfeed Audio Effect

Steve
Harris’
SWH
plugins

Apply headphone crossfeed filter (avfilter.cr

Crossover distortion Audio Effect

Steve
Harris’
SWH
plugins

LADSPA plugin (ladspa.1404)

crystalizer Audio Effect Audio Simple audio noise sharpening filter (avfilte

Curves Video Effect
Color and
Image
correction

Color curves adjustment (frei0r.curves)

Dance Video Effect On Master An audio visualization filter that moves the i
proportional to the magnitude of the audio sp

darken Compositions Perform a darken operation between two sou
value fo both sources) (frei0r.darken)

datascope Video Effect Utility Video data analysis (avfilter.datascope)

dblur Video Effect
Transform,
Distort and
Perspective

Non rectilinear lens mappings (frei0r.defish0

DC Offset Remover Audio Effect

Steve
Harris’
SWH
plugins

LADSPA plugin (ladspa.1207)

https://www.mltframework.org/plugins/FilterLadspa-1915/
https://www.mltframework.org/plugins/FilterLadspa-1917/
https://www.mltframework.org/plugins/FilterLadspa-1404/
https://www.mltframework.org/plugins/FilterLadspa-1207/


Effect or Transition Name Type Category Description

dctdnoiz Video Effect Deprecated Denoise frames using 2D DCT frequency do
(avfilter.dctdnoiz)

deband Video Effect Image
Adjustment

Remove banding artifacts from input video. I
banded pixels with an average value of refer
(avfilter.deband)

Decimator Audio Effect

Steve
Harris’
SWH
plugins

LADSPA plugin (ladspa.1202)

Declipper Audio Effect

Steve
Harris’
SWH
plugins

LADSPA plugin (ladspa.1195)

deesser Audio Effect Audio Apply a de-essing to the audio (avfilter.dees

Defish Video Effect
Transform,
Distort and
Perspective

Non rectilinear lens mappings (frei0r.defish0

deinterlace_qsv Video Effect Misc QuickSync video deinterlacing (avfilter.dein

Delayorama Audio Effect

Steve
Harris’
SWH
plugins

LADSPA plugin (ladspa.1402)

delogo Video Effect Deprecated Perform an RGB[A] difference operation be
sources (frei0r.difference)

Denoiser Video Effect Grain and
Noise High Quality 3d denoiser (frei0r.hqdn3d)

deshake Video Effect Misc Feature-point based video stabilization filter
(avfilter.deshake_opencl)

despill Video Effect Alpha, Mask
and Keying

Remove unwanted contamination of foregrou
reflected color of greenscreen or bluescreen

https://www.mltframework.org/plugins/FilterLadspa-1202/
https://www.mltframework.org/plugins/FilterLadspa-1195/
https://www.mltframework.org/plugins/FilterLadspa-1402/


Effect or Transition Name Type Category Description

difference Compositions Plasma (frei0r.distort0r)

dilation Video Effect Image
Adjustment Apply dilation effect (avfilter.dilation)

Diode Processor Audio Effect

Steve
Harris’
SWH
plugins

LADSPA plugin (ladspa.1185)

dissolve Compositions Fade out one video while fading in the other 

Distort Video Effect
Transform,
Distort and
Perspective

Plasma (frei0r.distort0r)

Dither Video Effect Deprecated Dithers the image and reduces the number of
(frei0r.dither)

divide Compositions Perform an RGB[A] divide operation betwe
input1 is the numerator, input2 the denominat

DJ EQ Audio Effect

Steve
Harris’
SWH
plugins

LADSPA plugin (ladspa.1901)

DJ EQ (mono) Audio Effect

Steve
Harris’
SWH
plugins

LADSPA plugin (ladspa.1907)

DJ flanger Audio Effect

Steve
Harris’
SWH
plugins

LADSPA plugin (ladspa.1438)

dnn_processing Video Effect Misc Apply DNN processing filter to the input
(avfilter.dnn_processing)

https://www.mltframework.org/plugins/FilterLadspa-1185/
https://www.mltframework.org/plugins/FilterLadspa-1901/
https://www.mltframework.org/plugins/FilterLadspa-1907/
https://www.mltframework.org/plugins/FilterLadspa-1438/


Effect or Transition Name Type Category Description

dodge Compositions
Perform an RGB[A] dodge operation betwee
using the generalized algorithm: D = saturati
(A*256)/(256-B) (frei0r.dodge)

drawbox Video Effect Generate Draw a colored box on the input video (avfi

drawgrid Video Effect Generate Draw a colored grid on the input video (avfi

drmeter Audio Effect Audio Measure audio dynamic range (avfilter.drme

Dust Video Effect Stylize Add dust and specks to the video, as in old m

Dynamic Text Video Effect Stylize Overlay text with keywords replaced (dynam

dynaudnorm Audio Effect Audio Dynamic Audio Normalizer (avfilter.dynaud

Dyson compressor Audio Effect Audio

Edge Crop Video Effect
Transform,
Distort and
Perspective

Trim the edges of a clip (crop)

Edge Glow Video Effect Stylize Edge glow filter (frei0r.edgeglow)

edgedetect Video Effect
Transform,
Distort and
Perspective

Detect and draw edges. The filter uses the C
algorithm (avfilter.edgedetect)

elastic_scale_filter Video Effect
Transform,
Distort and
Perspective

This is a frei0r filter which allows to scale v
linearly (frei0r.elastic_scale)

elbg Video Effect Stylize Apply posterize effect, using the ELBG algor

emboss Video Effect Stylize Creates embossed relief image of source ima

Equaliz0r Video Effect
Color and
Image
correction

Equalizes the intensity historgrams (frei0r.eq

https://www.mltframework.org/plugins/FilterLadspa-1403/


Effect or Transition Name Type Category Description

erosion Video Effect Image
Adjustment Apply erosion effect (avfilter.erosion)

estdif Video Effect Misc Apply edge Slope Tracking deinterlace (avfi

Exponential signal decay Audio Effect

Steve
Harris’
SWH
plugins

LADSPA plugin (ladspa.1886)

exposure Video Effect Misc Adjust exposure of the video stream (avfilter

extrastereo Audio Effect Audio Increase difference between stereo audio cha
(avfilter.extrastereo)

Fade From Black (video effect) Video Effect Motion Fade video from black (brightness)

fade_in (audio effect) Audio Effect fade Fade in audio track (volume)

fade_out (audio effect) Audio Effect fade Fade out audio track (volume)

Fade to Black (video effect) Video Effect Motion Fade video to black (brightness)

fast_lookahead_limiter Audio Effect

Steve
Harris’
SWH
plugins

LADSPA plugin (ladspa.1913)

Fast overdrive Audio Effect Audio

fft Audio Effect Audio
An audio filter that computes the FFT of the 
does not modify the audio or the image. It on
and stores the result in the “bins” property o

fill_boarders Video Effect
Transform,
Distort, and
Perspective

Fill borders of the input video, without chan
dimensions. Sometimes video can have garb
and you may not want to crop video input to 
some number (avfilter.fillborders)

https://www.mltframework.org/plugins/FilterLadspa-1886/
https://www.mltframework.org/plugins/FilterLadspa-1196/


Effect or Transition Name Type Category Description

filp_horizontally Video Effect
Transform,
Distort and
Perspective

Horizontally flip the input video (avfilter.hfl

firequalier Audio Effect Audio Finite Impulse Response Equalizer (avfilter.

Flanger Audio Effect

Steve
Harris’
SWH
plugins

LADSPA plugin (ladspa.1191)

flanger Audio Effect Audio Apply a flanging effect to the audio (avfilter.

flip_vertically Video Effect
Transform,
Distort and
Perspective

Vertically flip the input video (avfilter.vflip)

flippo Video Effect
Transform,
distort and
Perspective

Flipping X and Y axis (frei0r.flippo)

FM Oscillator Audio Effect

Steve
Harris’
SWH
plugins

LADSPA plugin (ladspa.1415)

Foldover distortion Audio Effect

Steve
Harris’
SWH
plugins

LADSPA plugin (ladspa.1213)

Fractionally Addressed Delay Line Audio Effect

Steve
Harris’
SWH
plugins

LADSPA plugin (ladspa.1192)

Motion - Freeze Video Effect Motion Freeze video on a chosen frame (freeze)

Frequency tracker Audio Effect

Steve
Harris’
SWH
plugins

LADSPA plugin (ladspa.1418)

https://www.mltframework.org/plugins/FilterLadspa-1191/
https://www.mltframework.org/plugins/FilterLadspa-1415/
https://www.mltframework.org/plugins/FilterLadspa-1213/
https://www.mltframework.org/plugins/FilterLadspa-1192/
https://www.mltframework.org/plugins/FilterLadspa-1418/


Effect or Transition Name Type Category Description

Gain Audio Effect Audio
Correction Adjust the audio volume without keyframes (

Gamma Video Effect
Color and
Image
correction

Adjusts the gamma value of a source image (

Gamma Video Effect
Color and
Image
correction

Change gamma color value (gamma)

Gate Audio Effect

Steve
Harris’
SWH
plugins

LADSPA plugin (ladspa.1410)

gaussian_blur Video Effect Blur and
Sharpen Apply Gaussian Blur filter (avfilter.gblur)

Giant flange Audio Effect Stylize LADSPA plugin (ladspa.1437)

Glame Bandpass Analog Filter Audio Effect

Steve
Harris’
SWH
plugins

LADSPA plugin (ladspa.1893)

Glame Bandpass Filter Audio Effect

Steve
Harris’
SWH
plugins

LADSPA plugin (ladspa.1892)

GLAME Butterworth Highpass Audio Effect

Steve
Harris’
SWH
plugins

LADSPA plugin (ladspa.1904)

GLAME Butterworth Lowpass Audio Effect

Steve
Harris’
SWH
plugins

LADSPA plugin (ladspa.1903)

https://www.mltframework.org/plugins/FilterLadspa-1410/
https://www.mltframework.org/plugins/FilterLadspa-1437/
https://www.mltframework.org/plugins/FilterLadspa-1893/
https://www.mltframework.org/plugins/FilterLadspa-1892/
https://www.mltframework.org/plugins/FilterLadspa-1904/
https://www.mltframework.org/plugins/FilterLadspa-1903/


Effect or Transition Name Type Category Description

Glame Butterworth X-over Filter Audio Effect

Steve
Harris’
SWH
plugins

LADSPA plugin (ladspa.1902)

Glame Highpass Filter Audio Effect

Steve
Harris’
SWH
plugins

LADSPA plugin (ladspa.1890)

Glame Lowpass Filter Audio Effect

Steve
Harris’
SWH
plugins

LADSPA plugin (ladspa.1891)

glitch0r Video Effect Motion Adds glitches and block shifting (frei0r.glitc

Glow Video Effect Blur and
Hide Creates a Glamorous Glow (frei0r.glow)

Gong beater Audio Effect

Steve
Harris’
SWH
plugins

LADSPA plugin (ladspa.1439)

Gong model Audio Effect

Steve
Harris’
SWH
plugins

LADSPA plugin (ladspa.1424)

gradfun Video Effect Grain and
Noise Debands video quickly using gradients (avfi

Grain Video Effect Deprecated Grain over the image (grain)

grain_extract Compositions Perform an RGB[A] grain-extract operation 
sources (frei0r.grain_extract)

grain_merge Compositions Perform an RGB[A] grain-merge operation b
sources (frei0r.grain_merge)

https://www.mltframework.org/plugins/FilterLadspa-1902/
https://www.mltframework.org/plugins/FilterLadspa-1890/
https://www.mltframework.org/plugins/FilterLadspa-1891/
https://www.mltframework.org/plugins/FilterLadspa-1439/
https://www.mltframework.org/plugins/FilterLadspa-1424/


Effect or Transition Name Type Category Description

Greyscale Video Effect
Color and
Image
correction

Discard color information (greyscale)

GSM simulator Audio Effect

Steve
Harris’
SWH
plugins

LADSPA plugin (ladspa.1215)

GVerb Audio Effect

Steve
Harris’
SWH
plugins

LADSPA plugin (ladspa.1216)

haas Audio Effect Audio Apply Haas Stereo Enhancer (avfilter.haas)

hard_limiter Audio Effect

Steve
Harris’
SWH
plugins

LADSPA plugin (ladspa.1413)

hardlight Compositions Perform an RGB[A] hardlight operation betw
sources (frei0r.hardlight)

Harmonic generator Audio Effect

Steve
Harris’
SWH
plugins

LADSPA plugin (ladspa.1220)

hdcd Audio Effect Audio Apply High Definition Compatible Digital (H
(avfilter.hdcd)

Hermes Filter Audio Effect

Steve
Harris’
SWH
plugins

LADSPA plugin (ladspa.1200)

Higher Quality Pitch Scaler Audio Effect

Steve
Harris’
SWH
plugins

LADSPA plugin (ladspa.1194)

https://www.mltframework.org/plugins/FilterLadspa-1215/
https://www.mltframework.org/plugins/FilterLadspa-1216/
https://www.mltframework.org/plugins/FilterLadspa-1220/
https://www.mltframework.org/plugins/FilterLadspa-1200/
https://www.mltframework.org/plugins/FilterLadspa-1194/


Effect or Transition Name Type Category Description

highpass Audio Effect Audio Apply a high-pass filter with 3dB point frequ
(avfilter.highpass)

highshelf Audio Effect Audio Apply a high shelf filter (avfilter.highshelf)

Hilbert transformer Audio Effect

Steve
Harris’
SWH
plugins

LADSPA plugin (ladspa.1440)

histogram_equalizer Video Effect
Color and
Image
correction

This filter applies a global color histogram e
per-frame basis (avfilter.histeq)

Histogram Video Effect Utility Compute and draw a color distribution histo
video (avfilter.histogram)

hqx Video Effect Image
Adjustment

Scale the input by 2, 3 or 4 using the hq*x ma
algorithm (avfilter.hqx)

Hue Compositions Perform a conversion to hue only of the sour
hue of input2 (frei0r.hue)

Hue Shift Video Effect
Color and
Image
correction

Shifts the hue of a source image (frei0r.huesh

Impulse convolver Audio Effect

Steve
Harris’
SWH
plugins

LADSPA plugin (ladspa.1199)

interlace_field_order Video Effect Image
Adjustment Transform the field order of the input video (

interleavedeinterleave Video Effect Image
Adjustment Deinterleave or interleave fields (avfilter.il)

Invert Video Effect
Color and
Image
correction

AllNegate (invert) the input video (avfilter.n

https://www.mltframework.org/plugins/FilterLadspa-1440/
https://www.mltframework.org/plugins/FilterLadspa-1199/


Effect or Transition Name Type Category Description

Invert Video Effect
Color and
Image
correction

Invert colors (invert)

invert0r Video Effect
Color and
Image
correction

Inverts all colors of a source image (frei0r.in

Inverter Audio Effect

Steve
Harris’
SWH
plugins

LADSPA plugin (ladspa.1429)

K-Means Clustering Video Effect Deprecated Clusters of a source image by color and spat
(frei0r.cluster)

Karaoke Audio Effect

Steve
Harris’
SWH
plugins

LADSPA plugin (ladspa.1409)

kernel_deinterlacer Video Effect Image
Adjustment

Deinterlace input video by applying Donald 
kernel deinterlacing. Works on interlaced pa
produce progressive frames (avfilter.kerndei

Key Spill Mop Up Video Effect Alpha, Mask
and Keying

Reduces the visibility of key color spill in ch
(frei0r.keyspillm0pup)

kirsch Video Effect Misc Apply kirsch operator (avfilter.kirsch)

L/C/R Delay Audio Effect

Steve
Harris’
SWH
plugins

LADSPA plugin (ladspa.1436)

ladspa Audio Effect Audio Process audio using LADSPA plugins (ladsp

Lens Correction Video Effect
Transform,
Distort and
Perspective

Allow compensation of lens distortion (frei0

https://www.mltframework.org/plugins/FilterLadspa-1429/
https://www.mltframework.org/plugins/FilterLadspa-1409/
https://www.mltframework.org/plugins/FilterLadspa-1436/


Effect or Transition Name Type Category Description

Lens Correction Video Effect
Transform,
Distort and
Perspective

Correct radial lens distortion (avfilter.lensco

lenscorrection Video Effect misc

LetterB0xed Video Effect
Transform,
Distort and
Perspective

Adds black borders at the top and bottom for
(frei0r.letterb0xed)

Levels Video Effect
Color and
Image
correction

Adjust levels (frei0r.levels)

LFO Phaser Audio Effect

Steve
Harris’
SWH
plugins

LADSPA plugin (ladspa.1217)

Lift/Gamma/Gain Video Effect Color
Correction

lightshow Video Effect On Master An audio visualization filter that colors the i
the magnitude of the audio spectrum (lightsho

lighten Compositions Perform a lighten operation between two sou
value of both sources) (frei0r.lighten)

limiter Video Effect
Color and
Image
correction

Limits the pixel components values to the sp
[min,max] (avfilter.limiter)

loudness_meter Audio Effect Audio Measure audio loudness as recommended by
(Loudness_meter)

lowpass Audio Effect Audio EBU R128 loudness normalization (avfilter.l

lowshelf Audio Effect Audio Apply a low-pass filter with 3dB point frequ
(avfilter.lowpass)

lighten Audio Effect Audio Apply a low shelf filter (avfilter.lowshelf)

https://www.mltframework.org/plugins/FilterLadspa-1217/


Effect or Transition Name Type Category Description

LS Filter Audio Effect

Steve
Harris’
SWH
plugins

LADSPA plugin (ladspa.1908)

luma Composition Applies a stationary transition between the c
frames (luma)

Lumakey Effect Video Effect Alpha, Mask
and Keying

This filter modifies image’s alpha channel as
luma value. This is used together with a com
two images so that bright or dark areas of so
overwritten on top of the destination image (

lumaliftgaingamma Video Effect
Color and
Image
correction

Filter can be used to apply lift gain and gamm
luma values of an image (lumaliftgammagain

Luminance Video Effect
Color and
Image
correction

Creates a luminance map of the image (frei0r

Mag’s Notch Filter Audio Effect

Steve
Harris’
SWH
plugins

LADSPA plugin (ladspa.1894)

Matrix Spatialiser Audio Effect

Steve
Harris’
SWH
plugins

LADSPA plugin (ladspa.1422)

Matrix: MS to Stereo Audio Effect

Steve
Harris’
SWH
plugins

LADSPA plugin (ladspa.1421)

Matrix: Stereo to MS Audio Effect

Steve
Harris’
SWH
plugins

LADSPA plugin (ladspa.1420)

lighten Compositions Replace the alpha channel of track A with th
track B (matte)

https://www.mltframework.org/plugins/FilterLadspa-1908/
https://www.mltframework.org/plugins/FilterLadspa-1894/
https://www.mltframework.org/plugins/FilterLadspa-1422/
https://www.mltframework.org/plugins/FilterLadspa-1421/
https://www.mltframework.org/plugins/FilterLadspa-1420/


Effect or Transition Name Type Category Description

mcompand Audio Effect Audio Multiband Compress or expand audio dynam
(avfilter.mcompand)

:compositions Compositions Perform an RGB[A] multiply operation betw
sources (frei0r.multiply)

Medians Video Effect Deprecated Implements several median-type filters (frei0

Mirror Video Effect
Transform,
Distort and
Perspective

Flip your image in any direction (mirror)

mixdown Audio Effect Audio Mix all channels of audio into a mono signal
channels (mono)

Modulatable delay Audio Effect

Steve
Harris’
SWH
plugins

LADSPA plugin (ladspa.1419)

Mono Amplifier Audio Effect Misc

mono_to_stereo_splitter Audio Effect

Steve
Harris’
SWH
plugins

LADSPA plugin (ladspa.1406)

monochrome Video Effect Misc Convert video to gray using custom color filt
(avfilter.monochrome)

motion_compensation_deinterlacing Video Effect Image
Adjustment Apply motion-compensation deinterlacing (a

Motion Tracker Video Effect Alpha, Mask
and Keying Select a zone to follow its movements (open

Multiband EQ Audio Effect

Steve
Harris’
SWH
plugins

LADSPA plugin (ladspa.1197)

https://www.mltframework.org/plugins/FilterLadspa-1419/
https://www.mltframework.org/plugins/FilterLadspa-1197/


Effect or Transition Name Type Category Description

multiply Compositions Perform an RGB[A] multiply operation betw
sources (frei0r.multiply)

Multivoice Chorus Audio Effect

Steve
Harris’
SWH
plugins

LADSPA plugin (ladspa.1201)

Audio Correction - Mute Audio Effect Audio
Correction

NDVI Filter Video Effect Utility This filter creates a false image from a visib
(frei0r.ndvi)

Nervous Video Effect Motion Flushes frames in time in a nervous way (fre

nikon_d90_stairstepping_fix Video Effect Utility

Removes stairstepping artifacts from Nikon D
Sharp lines in videos from the Nikon D90 sh
9th line, assumedly due to poor downsamplin
smoothed out with this filter if they become t
(frei0r.d90stairsteppingfix)

normalise Audio Effect Audio
Correction

Correct audio loudness as recommended by 
(loudness)

normalise Audio Effect Audio
Correction Dynamically normalise the audio volume (vo

normaliz0r Video Effect
Color and
Image
correction

Normalize (aka histogram stretch, contrast st
(frei0r.normaliz0r)

normalize_rgb_video Video Effect
Color and
Image
correction

Normalize RGB video (aka histogram stretch
stretching). See:
https://en.wikipedia.org/wiki/Normalization
(avfilter.normalize)

nosync0r Video Effect
Transform,
Distort and
Perspective

Broken TV (frei0r.nosync0r)

https://www.mltframework.org/plugins/FilterLadspa-1201/
https://en.wikipedia.org/wiki/Normalization_(image_processing


Effect or Transition Name Type Category Description

Obscure Video Effect Blur and
Hide

Old Film Video Effect Stylize Moves the Picture up and down and random 
(oldfilm)

Oscilloscope Video Effect Utility 2D video oscilloscope (frei0r.pr0file)

Oscilloscope Video Effect Utility 2D Video Oscilloscope (avfilter.oscilloscop

overlay Compositions
Perform an RGB[A] overlay operation betw
sources, using the generalised algorithm: D =
(255 - A)) (frei0r.overlay)

pad Video Effect Stylize

pan Audio Effect Audio
Channels Adjust the left/right spread of a channel (pan

phase Video Effect Image
Adjustment

Delay interlaced video by one field time so t
changes (avfilter.phase)

photosensitivity Video Effect Misc Filter out photosensitive epilepsy seizure-ind
(avfilter.photosensitivity)

pillar_echo Video Effect
Transform,
Distort and
Perspective

Create an echo effect (blur) outside of an are
(pillar_echo)

Pitch Scaler Audio Effect

Steve
Harris’
SWH
plugins

LADSPA plugin (ladspa.1193)

Pixelize Video Effect Stylize Pixelize input image (frei0r.pixeliz0r)

Plate reverb Audio Effect

Steve
Harris’
SWH
plugins

LADSPA plugin (ladspa.1423)

https://www.mltframework.org/plugins/FilterLadspa-1193/
https://www.mltframework.org/plugins/FilterLadspa-1423/


Effect or Transition Name Type Category Description

Pointer cast distortion Audio Effect

Steve
Harris’
SWH
plugins

LADSPA plugin (ladspa.1910)

Position and Zoom Video Effect
Transform,
Distort and
Perspective

Adjust size and position of clip (affine)

posterize Video Effect Stylize Posterizes image by reducing the number of c
(frei0r.posterize)

pp Video Effect Utility

prewitt Video Effect Stylize Apply prewitt operator to input video stream

Primaries Video Effect Stylize Reduce image to primary colors (frei0r.prim

r Video Effect
Color and
Image
correction

Extracts Red from Image (frei0r.R)

Rate shifter Audio Effect

Steve
Harris’
SWH
plugins

LADSPA plugin (ladspa.1417)

Mask0mate Video Effect
Transform,
Distort and
Perspective

Creates a square alpha-channel mask (frei0r

Regionalize Compositions Use alpha channel of another clip to create a

rescale Video Effect Image
Adjustment

Scale the producer video frames size to matc
filter is designed for use as a normaliser for 
(rescale)

Retro Flanger Audio Effect

Steve
Harris’
SWH
plugins

LADSPA plugin (ladspa.1208)

https://www.mltframework.org/plugins/FilterLadspa-1910/
https://www.mltframework.org/plugins/FilterLadspa-1417/
https://www.mltframework.org/plugins/FilterLadspa-1208/


Effect or Transition Name Type Category Description

Reverse Delay (5s max) Audio Effect

Steve
Harris’
SWH
plugins

LADSPA plugin (ladspa.1605)

RGB adjustment Video Effect
Color and
Image
correction

Simple color adjustment (frei0r.coloradj_RG

rgb_parade_MLT Video Effect Utility Display a histogram of R, G and B componen
(frei0r.rgbparade).

rgba_shift Video Effect Stylize Shift R/G/B/A pixels horizontally and/or ver
(avfilter.rgbashift)

rgbnoise Video Effect Deprecated Adds RGB noise to image (frei0r.rgbnoise)

Rgbsplit0r Video Effect Stylize RGB splitter and shifting (frei0r.rgbsplit0r)

Ringmod with LFO Audio Effect

Steve
Harris’
SWH
plugins

LADSPA plugin (ladspa.1189)

Ringmod with two inputs Audio Effect

Steve
Harris’
SWH
plugins

LADSPA plugin (ladspa.1188)

roberts Video Effect Stylize Apply roberts cross operator to input video 
(avfilter.roberts)

Rotate Video Effect
Transform,
Distort and
Perspective

Rotate clip in any 3 directions (affine)

Rotate and Shear Video Effect
Transform,
Distort and
Perspective

Rotate clip in any 3 directions (affine)

rubber_band_mono_pitch_shifter Audio Effect Audio LADSPA plugin (ladspa.2979)

https://www.mltframework.org/plugins/FilterLadspa-1605/
https://www.mltframework.org/plugins/FilterLadspa-1189/
https://www.mltframework.org/plugins/FilterLadspa-1188/


Effect or Transition Name Type Category Description

rubber_band_mono_pitch_shifter Audio Effect Audio Adjust the audio pitch using the Rubberband 

rubber_band_mono_pitch_shifter Audio Effect Audio LADSPA plugin (ladspa.2979)

Rotoscoping Video Effect Alpha, Mask
and Keying Keyframable vector based rotoscoping (roto

Saturation Composition Perform a conversion to saturation only of th
using the saturation level of input2 (frei0r.sa

Saturation Video Effect
Color and
Image
correction

Adjusts the saturation of a source image (fre

SC1 Audio Effect

Steve
Harris’
SWH
plugins

LADSPA plugin (ladspa.1425)

SC2 Audio Effect

Steve
Harris’
SWH
plugins

LADSPA plugin (ladspa.1426)

SC3 Audio Effect

Steve
Harris’
SWH
plugins

LADSPA plugin (ladspa.1427)

SC4 Audio Effect

Steve
Harris’
SWH
plugins

LADSPA plugin (ladspa.1882)

SC4 mono Audio Effect

Steve
Harris’
SWH
plugins

LADSPA plugin (ladspa.1916)

scale_cuda Video Effect Stylize

https://www.mltframework.org/plugins/FilterLadspa-1425/
https://www.mltframework.org/plugins/FilterLadspa-1426/
https://www.mltframework.org/plugins/FilterLadspa-1427/
https://www.mltframework.org/plugins/FilterLadspa-1882/
https://www.mltframework.org/plugins/FilterLadspa-1916/


Effect or Transition Name Type Category Description

scale_qsv Video Effect misc QuickSync video scaling and format convers
(avfilter.scale_qsv)

scanline0r Video Effect Generate Interlaced black lines (frei0r.scanline0r)

scdet Video Effect Misc Detect video scene change (avfilter.scdet)

Scratchlines Video Effect Grain and
Noise Scratchlines over the picture (lines)

Transitions - Screen Compositions
Perform an RGB[A] screen operation betwe
using the generalised algorithm: D = 255 - (2
(frei0r.screen)

scroll Video Effect Misc Scroll input video (avfilter.scroll)

SE4 Audio Effect

Steve
Harris’
SWH
plugins

LADSPA plugin (ladspa.1883)

Sepia Video Effect
Color and
Image
correction

Turn clip colors to sepia (sepia)

set_range Video Effect Blur and
Sharpen Force color range for the output video frame

shape_adaptive_blur Video Effect
Color and
Image
correction

Shape Adaptive Blur (avfliter.sab)

shapealpha Video Effect
Alpha,
Mask, and
Keying

Create an alpha channel (transparency) base
resource (shape)

sharp-unsharp Video Effect Blur and
Sharpen Sharpen or Blur your video (avfilter.unsharp

Sharpen Video Effect Deprecated Unsharp masking (port from Mplayer) (frei0

https://www.mltframework.org/plugins/FilterLadspa-1883/


Effect or Transition Name Type Category Description

shear Video Effect Misc Shear transform the input image (avfilter.she

shufflepixels Video Effect Misc Shuffle video pixels (avfilter.shufflepixels)

shuffleplanes Video Effect misc

sigmoidaltransfer Video Effect Stylize
Desaturates image and creates a particular lo
called Stamp, Newspaper, or Photocopy
(frei0r.sigmoidaltransfer)

Signal sifter Audio Effect

Steve
Harris’
SWH
plugins

LADSPA plugin (ladspa.1210)

signalstats Video Effect Stylize

silencedetect Video Effect Stylize Detect silence (avfilter.silencedetect)

Simple amplifier Audio Effect

Steve
Harris’
SWH
plugins

LADSPA plugin (ladspa.1181)

Simple delay line cubic spline
interpolation Audio Effect

Steve
Harris’
SWH
plugins

LADSPA plugin (ladspa.1900)

Simple delay line linear interpolation Audio Effect

Steve
Harris’
SWH
plugins

LADSPA plugin (ladspa.1899)

Simple Delay Line, noninterpolating Audio Effect

Steve
Harris’
SWH
plugins

LADSPA plugin (ladspa.1898)

simple_high_pass_filter Audio Effect Audio LADSPA plugin (ladspa.1042)

https://www.mltframework.org/plugins/FilterLadspa-1210/
https://www.mltframework.org/plugins/FilterLadspa-1181/
https://www.mltframework.org/plugins/FilterLadspa-1900/
https://www.mltframework.org/plugins/FilterLadspa-1899/
https://www.mltframework.org/plugins/FilterLadspa-1898/


Effect or Transition Name Type Category Description

simple_low_pass_filter Audio Effect Audio LADSPA plugin (ladspa.1041)

sine_oscillator Audio Effect Audio LADSPA plugin (ladspa.1044)

sine_oscillator Audio Effect Audio LADSPA plugin (ladspa.1045)

sine_oscillator Audio Effect Audio LADSPA plugin (ladspa.1046)

Single band parametric Audio Effect

Steve
Harris’
SWH
plugins

LADSPA plugin (ladspa.1203)

Sinus wavewrapper Audio Effect

Steve
Harris’
SWH
plugins

LADSPA plugin (ladspa.1198)

slide Compositions Slide image from one side to another (compo

smartblur Video Effect Blur and
Sharpen

Blur the input video without impacting the ou
(avfilter.smartlblur)

Smooth Decimator Audio Effect

Steve
Harris’
SWH
plugins

LADSPA plugin (ladspa.1414)

Sobel Video Effect Stylize Sobel filter (frei0r.sobel)

Sobel Video Effect Stylize Apply sobel operators to input video stream 

Softglow Video Effect Stylize Does softglow effect on highlights (frei0r.so

softlight Compositions Perform an RGB[A] softlight operation betw
sources (frei0r.softlight)

SOP/Sat Effect Video Effect
Color and
Image
correction

Changes Slope, Offset, and Power of the col
the overall Saturation, according to the ASC
Decision List) (frei0r.sopsat)

https://www.mltframework.org/plugins/FilterLadspa-1203/
https://www.mltframework.org/plugins/FilterLadspa-1198/
https://www.mltframework.org/plugins/FilterLadspa-1414/


Effect or Transition Name Type Category Description

Sox band Audio Effect Audio Process audio using a SoX effect (sox)

Sox band Audio Effect Audio Sox band audio effect (sox)

Sox bass Audio Effect Audio Sox bass audio effect (sox)

Sox echo Audio Effect Audio Sox echo audio effect (sox)

Sox flanger Audio Effect Audio Sox flanger audio effect (sox)

Sox gain Audio Effect Audio Sox gain audio effect (sox)

Sox phaser Audio Effect Audio Sox phaser audio effect (sox)

Sox stretch Audio Effect Audio Sox stretch audio effect (sox)

Spill Suppress Video Effect Enhancement

speechnorm Audio Effect Audio Speech Normalizer (avfilter.speechnorm)

spill_suppress Video Effect Alpha, Mask
and Keying

Remove green or blue spill light from subjec
green or blue screen (frei0r.spillsupress)

spotremover Video Effect Alpha, Mask
and Keying

Replace an area with interpolated pixels. Th
are interpolated from the nearest pixel.

Square Blur Video Effect Blur and
Hide Square Blur (frei0r.squareblur)

State Variable Filter Audio Effect

Steve
Harris’
SWH
plugins

LADSPA plugin (ladspa.1214)

Step Demuxer Audio Effect

Steve
Harris’
SWH
plugins

LADSPA plugin (ladspa.1212)

https://www.mltframework.org/plugins/FilterSox-band/
https://www.mltframework.org/plugins/FilterSox-band/
https://www.mltframework.org/plugins/FilterSox-bass/
https://www.mltframework.org/plugins/FilterSox-echo/
https://www.mltframework.org/plugins/FilterSox-flanger/
https://www.mltframework.org/plugins/FilterSox-gain/
https://www.mltframework.org/plugins/FilterSox-phaser/
https://www.mltframework.org/plugins/FilterSox-stretch/
https://www.mltframework.org/plugins/FilterLadspa-1214/
https://www.mltframework.org/plugins/FilterLadspa-1212/


Effect or Transition Name Type Category Description

Stereo Amplifier (version >= 0.9.10) Audio Effect Audio
Correction LADSPA plugin (ladspa.1049)

stereo_to_mono Audio Effect Audio
Correction Copy one channel to another (channelcopy)

stereoscopic_3d Video Effect VR360 and
3D

Convert between different stereoscopic imag
(avfilter.stereo3d)

stereotools Audio Effect Audio Apply various stereo tools (avfilter.stereotoo

stereowiden Audio Effect Audio Apply stereo widening effect (avfilter.stereo

subtract Compositions Perform an RGB[A] subtract operation of the
from input1 (frei0r.subtract)

super2xsai Video Effect Image
Adjustment

Scale the input by 2x using the Super2xSaI p
(avfilter.super2xsai)

superequalizer Audio Effect Audio Apply 18 band equalization filter (avfilter.su

Surround matrix encoder Audio Effect

Steve
Harris’
SWH
plugins

LADSPA plugin (ladspa.1401)

swap_channels Audio Effect Audio
Channels

Move the left channel to the right and the righ
(channelswap)

swapuv Video Effect
Color and
Image
correction

Swap U and V components (avfilter.swapuv)

Tape Delay Simulation Audio Effect Audio
Channels

Move the left channel to the right and the righ
(channelswap)

TAP AutoPanner Audio Effect TAP Plugins LADSPA plugin (ladspa.2146)

TAP Chrous/Flanger Audio Effect TAP Plugins LADSPA plugin (ladspa.2159)

https://www.mltframework.org/plugins/FilterLadspa-1401/
https://www.mltframework.org/plugins/FilterLadspa-1211/
https://www.mltframework.org/plugins/FilterLadspa-2146/
https://www.mltframework.org/plugins/FilterLadspa-2159/


Effect or Transition Name Type Category Description

TAP DeEsser Audio Effect TAP Plugins LADSPA plugin (ladspa.2147)

TAP Dynamics (M) Audio Effect TAP Plugins LADSPA plugin (ladspa.2152)

TAP Dynamics (St) Audio Effect TAP Plugins LADSPA plugin (ladspa.2153)

TAP Equalizer Audio Effect TAP Plugins LADSPA plugin (ladspa.2141)

TAP Equalizer/BW Audio Effect TAP Plugins LADSPA plugin (ladspa.2151)

TAP Fractal Doubler Audio Effect TAP Plugins LADSPA plugin (ladspa.2156)

TAP Pink/Fractal Noise Audio Effect TAP Plugins LADSPA plugin (ladspa.2155)

TAP Pitch Shifter Audio Effect TAP Plugins LADSPA plugin (ladspa.2150)

TAP Reflector Audio Effect TAP Plugins LADSPA plugin (ladspa.2154)

TAP Reverberator Audio Effect TAP Plugins LADSPA plugin (ladspa.2142)

TAP Rotary Speaker Audio Effect TAP Plugins LADSPA plugin (ladspa.2149)

TAP Scaling Limiter Audio Effect TAP Plugins LADSPA plugin (ladspa.2145)

TAP Sigmoid Booster Audio Effect TAP Plugins LADSPA plugin (ladspa.2157)

TAP Stereo Echo Audio Effect TAP Plugins LADSPA plugin (ladspa.2143)

TAP Tremolo Audio Effect TAP Plugins LADSPA plugin (ladspa.2144)

TAP TubeWarmth Audio Effect TAP Plugins LADSPA plugin (ladspa.2158)

TAP Vibrato Audio Effect TAP Plugins LADSPA plugin (ladspa.2148)

https://www.mltframework.org/plugins/FilterLadspa-2147/
https://www.mltframework.org/plugins/FilterLadspa-2152/
https://www.mltframework.org/plugins/FilterLadspa-2153/
https://www.mltframework.org/plugins/FilterLadspa-2141
https://www.mltframework.org/plugins/FilterLadspa-2151/
https://www.mltframework.org/plugins/FilterLadspa-2156/
https://www.mltframework.org/plugins/FilterLadspa-2156/
https://www.mltframework.org/plugins/FilterLadspa-2150/
https://www.mltframework.org/plugins/FilterLadspa-2154/
https://www.mltframework.org/plugins/FilterLadspa-2142/
https://www.mltframework.org/plugins/FilterLadspa-2149/
https://www.mltframework.org/plugins/FilterLadspa-2145/
https://www.mltframework.org/plugins/FilterLadspa-2145/
https://www.mltframework.org/plugins/FilterLadspa-2143/
https://www.mltframework.org/plugins/FilterLadspa-2144/
https://www.mltframework.org/plugins/FilterLadspa-2158/
https://www.mltframework.org/plugins/FilterLadspa-2148/


Effect or Transition Name Type Category Description

tape_delay_simulation Audio Effect

Steve
Harris’
SWH
plugins

LADSPA plugin (ladspa.1211)

Technicolor Video Effect
Color and
Image
correction

Oversaturate the color in video, like in old T
(tcolor)

tehroxx0r Video Effect Misc Something videowall-ish (frei0r.tehRoxx0r)

thistogram Compositions Uses Input 1 as a UV Map to distort Input 2 (

Threshold Video Effect Stylize Thresholds a source image (frei0r.threshold0

Timeout Indicator Video Effect Utility Timeout indicators e.g. for slides (frei0r.time

Tint Video Effect
Color and
Image
correction

Maps source image luminance between two 
(frei0r.tint0r)

tmedian Video Effect Misc Pick median pixels from successive frames (

tmidequalizer Video Effect Misc Apply Temporal Midway Equalization (avfi

tonemap_vaapi Video Effect Misc VAAPI VPP for tone-mapping (avfilter.tonem

Transform Video Effect
Transform,
Distort and
Perspective

Position, Scale and opacity, (qtblend)

Transform Compositions Perform an affine transform on for compositi

Transient mangler Audio Effect

Steve
Harris’
SWH
plugins

LADSPA plugin (ladspa.1206)

transparency Video Effect Alpha, Mask
and Keying Tunes the alpha channel (frei0r.transparency

https://www.mltframework.org/plugins/FilterLadspa-1206/


Effect or Transition Name Type Category Description

transpose Video Effect
Transform,
Distort and
Perspective

Transpose rows with columns in the input vi
flip it (avfilter.transpose)

treble Audio Effect Audio Boost or cut upper frequencies (avfilter.trebl

tremolo Audio Effect Audio Apply tremolo effect (avfilter.tremolo)

Triple band parametric with shelves Audio Effect

Steve
Harris’
SWH
plugins

LADSPA plugin (ladspa.1204)

Typewriter Text Effect Misc Typerwriter effect v0.3.3 (typewriter)

untile Video Effect Misc Untile a frame into a sequence of frames (av

v360 Video Effect Misc Convert 360 projection of video (avfilter.v3

value Transition Applies a stationary transition between the c
frames (composite)

Valve rectifier Audio Effect

Steve
Harris’
SWH
plugins

LADSPA plugin (ladspa.1405)

Valve saturation Audio Effect

Steve
Harris’
SWH
plugins

LADSPA plugin (ladspa.1209)

Analysis and Data - Vectorscope Video Effect Utility Display a vectorscope of the video data (fre

Vectorscope Window Video Effect Utility Display 2 color component values in the two
(which is called a vectorscope) (avfilter.vec

vertigo Video Effect Motion Alpha blending with zoomed and rotated ima

vibrato Audio Effect Audio Apply vibrato effect (avfilter.vibrato)

https://www.mltframework.org/plugins/FilterLadspa-1204/
https://www.mltframework.org/plugins/FilterLadspa-1405/
https://www.mltframework.org/plugins/FilterLadspa-1209/


Effect or Transition Name Type Category Description

video_noise_generator Video Effect Grain and
Noise Add noise on video input frame (avfilter.noi

videoquality_measurement Transition

This performs the PSNR and SSIm video qua
by comparing the B frames to the reference f
the numbers to stdout in space-delimited form
another tool. The bottom half of the B frame 
top half of the A frame for visual comparison

Video Values Video Effect Utility Measure video values (frei0r.pr0be)

Vignette Video Effect Generate Natural Lens vignetting effect (frei0r.vignette

Vignette Effect Video Effect Generate Adjustable Vignette (vignette)

vocoder Audio Effect Audio LADSPA plugin (ladspa.1337)

Volume (keyframable) Audio Effect Audio
Correction Adjust the audio volume with keyframes (vo

vpp_qsv Video Effect Misc Quick Sync Video VPP (avfilter.vpp_qsv)

vr360_equirectangular_mas Video Effect VR360 and
3D

Adds a black matte to the frame. Use this if y
360 camera but only want to use part of the 3
example if you and the film crew occupy the 
the camera (frei0r.bigsh0t_eq_mask)

vr360_equirectangular_to_rectilinear Video Effect VR360 and
3D

converts an equirectangular frame (panorami
frame (what you’re used to seeing). Can be u
will be shown in a 360 video viewer. Delay
mapping on a time bitmap (frei0r.bigsh0t_eq

vr360_hemispherical_to_equirectangular Video Effect VR360 and
3D

Converts a video frame with two hemispheri
single equirectangular frame. The plugin assu
hemispheres are in the frame (freior.bigsh0t_

vr360_rectilinear_to_equirectangular Video Effect VR360 and
3D

Converts a rectilinear (a normal-looking) im
equirectangular image. Use this together with
place “normal” footage in a 360 movie
(frei0r.bigsh0t_rect_to_eq)



Effect or Transition Name Type Category Description

vr360_stabilize Video Effect VR360 and
3D

Stabilizes 360 footage. The plugin works in 
analysis and stabilization. When analyzing fo
frame-to-frame rotation, and when stabilizin
high-frequency motion (shake) (frei0r.bighsh

vr360_transform Video Effect VR360 and
3D Rotates a panoramic image (frei0r.bigsh0t_tr

VyNil (Vinyl Effect) Audio Effect

Steve
Harris’
SWH
plugins

LADSPA plugin (ladspa.1905)

Wave Video Effect Deprecated Makes waves on your clip with keyframes (w

Wave shaper Audio Effect

Steve
Harris’
SWH
plugins

LADSPA plugin (ladspa.1187)

Wave Terrain Oscillator Audio Effect

Steve
Harris’
SWH
plugins

LADSPA plugin (ladspa.1412)

White Balance Video Effect Color
Correction

White Balance Video Effect
Color and
Image
correcting

Adjust the white balance / color temperature

White Balance (LMS) Video Effect
Color and
Image
correcting

Do simple color correction, in a physically m
(frei0r.colgate)

Composition - Wipe Compositions Applies a stationary transition between the c
frames (composite)

https://www.mltframework.org/plugins/FilterLadspa-1187/
https://www.mltframework.org/plugins/FilterLadspa-1412/


Effect or Transition Name Type Category Description

xbr Video Effect Image
Adjustment

Apply the xBR high-quality magnification fil
designed for pixel art. It follows a set of edg
see https://forums.libreto.com/t/xbr-algorithm
(avfilter.xbr)

yadif_cuda Video Effect Misc Deinterlace CUDA frames (avfilter.yadif_cu

yaepblur Video Effect Misc Yet another edge preserving blur filter (avfil

z-1 Audio Effect

Steve
Harris’
SWH
plugins

LADSPA plugin (ladspa.1428)

zmq Video Effect misc

zoompan Video Effect
Transform,
Distort and
Perspective

Apply Zoom and Pan effect (avfilter.zoompa

zscale Video Effect Misc Apply resizing, colorspace and bit depth con
(avfilter.zscale)

https://forums.libreto.com/t/xbr-algorithm-tutorial/123
https://www.mltframework.org/plugins/FilterLadspa-1428/


Speech to text
New in version 21.04.0.

Warning

Speech to text doesn’t work with version 21.04.2 due to Vosk API
[https://github.com/alphacep/vosk-api] issues. Use version 21.04.1 or 21.04.3 and
later versions.

Install Python

Python 3 needs to be installed on your computer as well as the vosk and srt
python modules:

Linux

On most Linux distributions python is installed by default. You can check if
that is the case for you too by running python3 -V in a terminal. If python is
missing just search the internet, there are lots of instructions around.

To install vosk and srt open a terminal and run: pip3 install vosk srt

Windows

1. Download python from https://www.python.org/downloads/ for
installation on your computer.

2. Download this batch file (Install_vosk_srt.zip). After download a
double click starts the installations.

Install a language

https://github.com/alphacep/vosk-api
https://www.python.org/downloads/


Goto Settings ‣ Configure Kdenlive… ‣ Speech to Text page

Click on the link to get a language model.

Drag & drop the language you want from the vosk-model download page to
the model window, and it will download and extract it for you.



If you have problems press on the Check configuration button.

Speech recognition

Creating subtitle by speech recognition

1. Mark the timeline zone you want to recognize (adjust the blue line).
2. Click on the Speech recognition icon.
3. Choose the language.



4. Choose how the selected zone should be applied.
5. Press on the Process button.

The subtitle gets created and inserted automatically.

Remark: Only timeline zone is implemented for now in automatic subtitles.

Remark to 4: The default is to analyze only the timeline zone (all tracks) (the
blue bar in the timeline ruler). Set the zone in the timeline to what you want
to analyze (use I and O to set in and out points). Selected clips option
analyses the selected clip only.

Creating clips by speech recognition

This is useful for interviews and other speech-related footage. Enable the
View ‣ Text Edit menu item.



Select a clip in the project bin.

1. If needed set in/out point in the clip monitor and enable Selected zone
only selection box. This will only recognize the text inside the zone.

2. Choose the correct language.
3. Press the Start Recognition button.
4. Selecting the text you want to either.
5. Put into the timeline.
6. Save edited text as a new playlist.
7. Add a Bookmark. You can jump to these bookmarks in the timeline with

the Alt + arrow shortcut or edit the bookmark by double click.
8. Delete the selection.
9. Here you can search in the text.

10. And navigate up or down in the text.

Silence detection

Open the clip in the clip monitor and open the speech editor window (View ‣
Speech Editor) .

Select your language or Install a language and download the model for it.

Then click Start Recognition button.

Once this is done, click on the time-code where no-speech is indicated and
just hit the delete key. Repeat the operation for all the parts you want to
remove, including where someone says what you don’t want to listen in your
final edit.

Once finished, make sure Selected zone only is disabled, click on the Save
button on the lower left part of the speech editor window and after few
seconds a new playlist is added in the project bin without silence and
without the text you don’t want.



Subtitle
New in version 20.12.0.

The subtitling tool allows you to add and edit subtitles directly in the
timeline on a special subtitle track or by using the new subtitle window. You
can also import (SRT/ASS) and export (SRT) subtitles.

There are 3 ways to add subtitle:

Menu
Project ‣ Subtitle ‣ Add Subtitle

Keyboard
Shift + S adds a subtitle.

Icon and Mouse
Click Add Subtitle icon in the timeline toolbar to open the subtitle
track in the timeline.
Double-click in the subtitle track to add a subtitle.

Adding and editing text

Add or editing text either directly into the subtitle clip or in the subtitle
window.



Adjust the length of subtitle

Grab the end of a subtitle with the mouse and lengthen or shorten it as
needed. Set subtitle in/out can be achieved with the same shortcut as to set
clip in/out (left/right parenthesis shortcut).

Subtitle window

The subtitles window allows easier editing and also makes it possible
to easily navigate between subtitles with the Left and Right buttons.
With the plus sign button, you can add subtitles.



The scissors are mostly here for divide subtitles: let’s say your subtitle
text is too long and you want to make it 2 different subtitles. Put the
cursor in the text widget where you want to cut and click the scissors, it
will split the text between 2 different subtitle items. The scissors are
only working when the playhead is over the subtitle itself.
The tick button adds the text to the subtitle.

New in version 22.08.

This is a global, simple subtitle styling possibility. It only allows one style
for all subtitles of the project. Accessible through the “T drop” icon in the
subtitle edit widget.

Import and export subtitle

New in version 22.08: Allows importing .vtt (Web Video Text Tracks) and
.sbv (YouTube) files.



Importing SRT, ASS, VTT and SBV subtitle file: Project ‣ Subtitles ‣
Import Subtitle File

Exporting SRT subtitles only: Project ‣ Subtitles ‣ Export Subtitle File

Tip

SRT supports markup for: bold, italic, underline, text color and line break.

<b>text in boldface</b>

<i>text in italics</i>

<u>text underlined</u>

<font color="#00ff00"> text in green</font> you can use the
font tag only to change color.
And all combined: <font color="#00ff00"><b><i><u>All
combined</u></i></b></font>

Line break: Add on the end of each line a <br> (for break). Now the
.srt file is stored correct and reopened with the line break. The
subtitle in the subtitle window will be all in 1 line after several save
but the breaks is working.

Alt + arrow jumps from subtitle to subtitle.

New in version 21.04.0.

Spelling check

Spelling check for subtitle is integrated and shows incorrect words by a red
wiggly line. Right-click on the word and you get a list of possible words you
can choose by click on it.





Titles

Contents

Titles
Create and Edit Title

Add Items
Select Items
Adjust Items

Typewriter
Scroll Title Vertically
Scroll Title Horizontally
Save a Title
Load a Title
Title Template

Built In
Download new title template

Template Titles - User-Defined
Create a Template Title
Use the Template Title

How to fade titles in and/or out
How to fade in more than one title sequentially
FAQ

Titles are text elements that can be added to the timeline and appear over the
top of other clips. Titles are created in the The Project Bin and then dragged
to the timeline like other video clips.

If you want titles to overlay other footage, you put title clips above (on video
track 2 for example) and have the other footage below (on video track 1 for
example). You also need to retain the affine transition that is automatically
added to the title clips if you want the footage visible underneath.



Create and Edit Title

Create a Title: Choose Project ‣ Add Title Clip or right-click in an empty
area in The Project Bin and choose Add Title Clip.

Edit a Title: Double click the title clip either in the project bin or in the
timeline. Or right-click the title clip in the project bin and select Edit Clip.

In the title window (1):

Select an item by clicking on it.

Edit text by double-clicking.

Once your edit is done click Update Title (bottom right).

Add Items



From the toolbar (green marked area) choose:

Text Alt+T and click into the title window (1)

Rectangle Alt+R and in the title window (1) drag the mouse to draw a
rectangle

Ellipse Alt+E and in the title window (1) drag the mouse to draw a ellipse.

Image Alt+I brings up a file chooser where you can choose an image to be
inserted into your title (1).

Default selection is Text for a new title clip.

Alt + S brings you back to Selection Tool (icon with the 4 arrows, yellow
marked)

Items can be placed behind each other by selecting them and changing the Z-
index: (top right corner) to a lower value or with the 4 icons left to the Z-
index

Select Items



Yellow marked area. Make sure Selection Tool is selected or press Alt + S.

In the title window (1) clicking on an item.

Holding Shift to select several items by clicking on it.

Ctrl + A selects all items.

You can select items with one of the 5 selection possibilities (yellow marked
area, bottom left), from left to right:

1. If you have a selection: Keep only images selected
2. If you have a selection: Keep only text items selected
3. Deselect everything
4. Select All
5. If you have a selection: Keep only rect items selected

Adjust Items



Red marked areas: All items can be adjusted in position, size, level,
alignment and properties either with the mouse or by entering values.

Holding Shift move selected items vertical only.

Holding Shift + Alt move selected items horizontally only.

Once done click Create Title (bottom right) or Update Title.

Typewriter

New in version 21.04.0.



The beloved typewriter effect is back. By default it expands text by
characters, but other modes like expansion by words and lines are also
available.

Frame step
Tells how fast next element will be displayed. The speed is constant
over the whole clip and effect period.

Values: 1-240, default: 25

Variation / Sigma
Allows for introducing small fluctuation to the step length.

Values 0-20, default: 0

Seed



The random generator for fluctuations is initialized with constant
seed to assure predictable pattern. The seed parameter changes the
initial value of random generator.

Values: 0-100, default 0

Expansion mode
By character: types character by character

By word: types word by word

By line: types line by line

Custom: custom macros (not implemented)

Scroll Title Vertically

Put a long title onto the title window. Zoom out so you can see it all. The text
should run off the top (or bottom) of the viewable area.

Select the Animation tab and check the Edit start viewport option. Now drag
the start rectangle to above the viewable area.

Check the Edit end viewport option and drag the end rectangle to below the
viewable area.

Press the OK button and preview the scrolled title.



The text in the above title scrolls up the screen. It is as if the camera starts on
the “start rectangle” and then pans down to the “end rectangle”.

To make the text scroll faster, set the Duration: field (highlighted in red in
the image above) to a smaller value. To make the text scroll slower, set it to
a larger value.

Note: changing the length of the title clip on the timeline does not change the
scrolling speed. If the length of the clip on the timeline is longer than the
duration specified in the title editor, the titles will pause on the screen
between the time the title’s duration expires until the end of the clip.

If the length of the clip on the timeline is shorter than the duration specified in
the title editor, the scrolling will not complete before the title clip finishes.



Note: the above description of title behaviour with respect to duration only
applies to titles that don’t get edited after they have been placed on the
timeline. If you expand the length of a title clip on the timeline and then edit
the title (by double-clicking it in the Project Bin), its apparent duration will
become the length that it currently has on the timeline (i.e., the scrolling will
not pause at the end anymore) but the duration displayed in the title editor
will not have changed.

Scroll Title Horizontally

Use the instructions for vertical scrolling - just put the start and stop
rectangles off to the sides of the screen rather than the top and bottom.

Save a Title

Blue marked area: Press the Save As button on the tool bar.

Title Editor toolbar when title editor is wide enough for the whole toolbar
to display. The toolbar items are: Selection Tool, Add Text, Add
Rectangle, Add Ellipse, Add Image, Open Document and Save As.

or select Save as from the toolbar overflow menu which can be found under
the >> button on the toolbar - see picture.

Title Editor toolbar when title editor is not wide enough for the whole
toolbar to display. The toolbar items that do not fit can be accessed from the
>> button that appears at the end of the toolbar.

Choose a save location within your project.

The titles are saved as .kdenlivetitle type documents.

Load a Title



Blue marked area: Press the Open Document button on the Title Clip editor
toolbar or choose Open document from the >> menu and load up a title
saved earlier.

Title Template

Built In

Kdenlive has some built-in title templates that can be accessed from the
Template: drop-down list found on the bottom of the Title Clip window - see
below.

Download new title template



Blue marked area: To install more title templates press the Download New
Title Templates… icon on the tool bar when you are in the title editor.

If you have a good title template, you can post it here
[https://store.kde.org/browse/cat/335/] so that other Kdenlive users can download it
through Download New Title Templates… and use it.

Once these title templates are installed, they can be accessed via the drop
down on the template dialog.

The .kdenlivetitle files that supply these templates are installed to:

Linux

$HOME/.local/share/kdenlive/titles

Flatpak

$HOME/.var/app/org.kde.kdenlive/data/kdenlive/titles

Windows

https://store.kde.org/browse/cat/335/


%AppData%/kdenlive/titles

Press Win + R (Windows key and R key simultaneously) and copy
%AppData%/kdenlive/.

Template Titles - User-Defined

Template Titles allow you to create a template for other titles in your project.
You create the template title with the settings that all the titles in the project
should have and then base subsequent titles on the template. If you decide to
change the look of your titles, you only need change the template title and the
titles based on this template will automatically update to reflect any
formatting changes you made to the template title.

Create a Template Title

Choose the Add Title Clip item from the Add Clip drop down and create a
title with the text %s in it and formatted how you desire it. Save this title as
described above.

Use the Template Title

Choose the Add Template Title item from the Add Clip drop down and
choose the title with the %s in it that you just saved.

Right-click this clip in the Project Bin and select Clip Properties item.



Enter the text that this title should display into the text field in the dialog that
appears.

Drag the title to the timeline.

The %s in the template will be replaced with the text that you enter in the
Text: field.



A known issue with template titles is that text centering does not work
correctly for text replacing the %s.

How to fade titles in and/or out

To make titles fade in and out, you modify the transition which gets
automatically added between the title and the track below. The modifications
consist of adding keyframes into the transition and adjusting the opacity of the
transitions at these keyframes. In version 0.9.3 it is an Affine Transition
transition that is automatically added between the title and the track below. In
ver 0.9.2 it is a Composite Transition.

In the image below we have four keyframes (labeled 1 to 4). The first
keyframe is the one currently displayed and we can see that the opacity on
this keyframe is zero. The opacity at keyframes 2 and 3 is 100%. The opacity
at the 4th keyframe is zero percent. The overall effect is that the title fades in
between keyframe 1 and keyframe 2. And then it fades out between keyframe
3 and keyframe 4 .



How to fade in more than one title sequentially

To create a title sequence like this …

https://youtu.be/IIV87bFjfo0

You put three titles on three different tracks but you make all three affine
transitions go to the same empty video track (instead of the tracks directly
below them, which is the default). See timeline screenshot below.

https://youtu.be/IIV87bFjfo0


FAQ

Q: How to duplicate a title clip to modify it slightly.

A: You can save a copy of the title (see Titles) and then create a new title
based on that saved version as described Titles. Or you could use the Titles
functionality to base the two slightly different titles on the one template.



Transitions

Contents

Transitions
Mixes
Compositions
Available Transitions

In Kdenlive a transition is a wipe or dissolve composition between two
overlapping clips.

There are two ways of adding transitions in Kdenlive: Mix clips, aka same
tracks transitions, and the legacy way, which is transitions between clips on
different tracks.

Wipes are greyscale images in .pgm (Portable GreyMap) format, and during
the transition the composition track will be displayed in the darkest areas of
the wipe image first. If the wipe is inversed, the composition track will
become visible in the brightest areas of the wipe image first instead. You can
download more wipes (by clicking the download button in the wipe
composition properties) or create your own and load them by clicking the
folder button.

Mixes

New in version 20.12.

Mixes are transitions between clips on the same track.



Kdenlive with mixed clips in the timeline. The toolbar button is
circled with red, and the transition properties are on the right.

To use it:

Ensure that there is at least half a second worth of frames at the end of
both clips (outside the timeline clip). Without that, Kdenlive will not
apply the transition, but display an error message.
Select either clip. If there are clips in both ends of the one selected, the
transition will be added nearest the playhead.

Ready to add the transition:

Keyboard: Press the U key.
Mouse: double-click at the point where the clips meet. This does not
require a clip to be selected.
Toolbar: Press the Mix Clips button on the timeline toolbar.

The transition length defaults to one second equally distributed between the
two clips. You can drag either end of the transition to adjust.

The default transition is dissolve, but you can select (click) the transition and
edit the wipe method and properties as desired in the effect/transition stack
window.



The composition method is set to Luma, and it does not make sense to change
that, since there will not really be a transition. Other methods are meant for
compositing two videos, not transitioning between them.

Select the desired wipe from Wipe Method.
The Reverse option reverses the transition.
The Softness: slider will affect the edges of wipe transitions.
Set the desired duration.
Since 21.08: select the alignment of the transition, either left, centered
(default) or right.

To delete the transition, select it and press the Delete key.

Tip

To apply only transitions on either the video or audio track just lock the
track on which you don’t want a transition to be applied and add transitions
by one of the above ways on the other track.

Compositions

Compositions are transitions between clips on different tracks. This is the
legacy way of doing transitions in Kdenlive.



To the left the purple one-click circle to add a wipe composition.
In the middle the composition bar, and on the right the properties.

To add a transition:

Adjust your clips so that they overlap.
Hold the mouse wheel over the top clip bottom corner, and click the
purple circle appearing (the Status Bar will say “Click to add a
composition”), or alternatively right-click either clip and select Insert a
composition… ‣ Wipe.

The default transition is a dissolve, to change that select (click) the
composition bar to show the effect/composition stack window.

The transition, when added this way, will cover the overlapping area
between the clips.

You can:

Select a composition track. The default is “Automatic” which is likely
the correct choice in this case.
Select a wipe.
Enable Inverse to inverse the wipe.
Enable Revert to revert the order of the videos in the transition (which
you probably do not want).

If you move or adjust your clips after adding the transition, you need to refit
it manually if desired. You can drag the entire transition with the select tool,
and adjust its duration by dragging either end.

Available Transitions

addition transition
Addition_alpha transition
Affine Transition
Alpha operation transitions
alphaatop transition



alphain transition
alphaout transition
alphaover transition
alphaxor transition
Composite Transition
Hue
Transitions - Screen
Composition - Wipe



addition transition

Contents

addition transition

This is the Frei0r addition [https://www.mltframework.org/plugins/TransitionFrei0r-addition/]
MLT transition.

Perform an RGB[A] addition operation of the pixel sources.

https://www.mltframework.org/plugins/TransitionFrei0r-addition/


Addition_alpha transition

Contents

Addition_alpha transition

This is the Frei0r addition_alpha [https://www.mltframework.org/plugins/TransitionFrei0r-
addition_alpha/] MLT transition.

Perform an RGB[A] addition_alpha operation of the pixel sources.

https://www.mltframework.org/plugins/TransitionFrei0r-addition_alpha/


Affine Transition

Contents

Affine Transition
Example 1
Disolve using Affine Transition
Rotation using Affine Transition
Example 2 - Rotate Y

Generates image rotation in 3D space, skew and distortion.

Provides keyframable animated affine transformations with dissolve
functionality.

In many applications, this transition can be used instead of a Composite
Transition and this provides a workaround to the composite transition “green
tinge” bug reported by some. (Mentioned in legacy Mantis bug tracker ID
2759.

Example 1

https://youtu.be/hylowKurZaw

https://youtu.be/hylowKurZaw


Disolve using Affine Transition

To add a Dissolve, change the opacity to zero percent.

Rotation using Affine Transition

To rotate the image, add a keyframe and enter values for rotation. The units
are 10ths of degrees. (e.g. 900 = 90 degree rotation).

Rotate X rotates the frame in the plane of the screen. Rotate Y and Rotate
Z create the illusion of 3D rotation when used dynamically with keyframes -
see example below.

You can create a similar effect using the Rotate effect from the Crop and
Transform group.

Example 2 - Rotate Y



https://youtu.be/IAWMIL7c9K4

This example is created using 3 keyframes. The second keyframe is shown
below with a Rotate Y value of 1800 (=180 degrees). Keyframe one and
keyframe three both have Rotate Y values of zero.

 

The difference between Rotate Y and Rotate Z is that the apparent rotation
in Rotate Y appears to be around a horizontal axis. The rotation in Rotate Z
appears to be around a vertical axis.

https://youtu.be/IAWMIL7c9K4


Alpha operation transitions

Contents

Alpha operation transitions

The following transitions all perform alpha operations between the two
video tracks:

Addition_alpha transition
addition transition
alphaatop transition
alphain transition
alphaout transition
alphaover transition
alphaxor transition

These transitions only have an effect if the videos on the tracks have alpha
channel information in them.

The Alpha Channel information is supplied by one of the Alpha
manipulation. This Alpha Channel data describes which regions of the video
track is transparent and how transparent it should be. Until you define some
alpha channel data using an Alpha manipulation changes in the alpha
operation transition settings will have no visible effect.

The alpha operation transitions define how the two different alpha channel
information should be combined to produce the final image. These operations
are implementing the operations described at Wikipedia page on Alpha
Compositing [https://en.wikipedia.org/wiki/Alpha_compositing].

In the examples below the yellow clip has a triangle alpha shape with min=0
and max=618. This translates to 0% opacity outside the triangle and 61.8%
opacity inside the triangle. Ie the alpha channel in the yellow track say show

https://en.wikipedia.org/wiki/Alpha_compositing


all the track underneath outside the triangle and show 38.2% of the
underneath track inside the triangle.

The Green clip has a rectangle alpha shape with min=0 and max=1000. This
translates to make the clip 100% transparent outside the rectangle and 0%
transparent inside the rectangle.

alphaxor transition



alphaout transition



alphain transition



alphaatop transition



alphaover transition



alphaatop transition

Contents

alphaatop transition

This is the Frei0r alphaatop [https://www.mltframework.org/plugins/TransitionFrei0r-
alphaatop] MLT transition.

The alpha ATOP operation.

Yellow clip has a triangle alpha shape with min=0 and max=618.

Green clip has rectangle alpha shape with min=0 and max=1000.

alphaatop is the transition in between.

https://www.mltframework.org/plugins/TransitionFrei0r-alphaatop




alphain transition

Contents

alphain transition

This is the Frei0r alphain [https://www.mltframework.org/plugins/TransitionFrei0r-alphain/]
MLT transition.

The alpha IN operation.

Yellow clip has a triangle alpha shape with min=0 and max=618.

Green clip has rectangle alpha shape with min=0 and max=1000.

alphain is the transition in between.

https://www.mltframework.org/plugins/TransitionFrei0r-alphain/




alphaout transition

Contents

alphaout transition

This is the Frei0r alphaout [https://www.mltframework.org/plugins/TransitionFrei0r-alphaout/]
MLT transition.

The alpha OUT operation.

Yellow clip has a triangle alpha shape with min=0 and max=618.

Green clip has rectangle alpha shape with min=0 and max=1000.

alphaout is the transition in between.

https://www.mltframework.org/plugins/TransitionFrei0r-alphaout/




alphaover transition

Contents

alphaover transition

This is the Frei0r alphaover [https://www.mltframework.org/plugins/TransitionFrei0r-
alphaover/] MLT transition.

The alpha OVER operation.

Yellow clip has a triangle alpha shape with min = 0 and max =618.

Green clip has rectangle alpha shape with min=0 and max =1000.

alphaover is the transition in between.

https://www.mltframework.org/plugins/TransitionFrei0r-alphaover/




alphaxor transition

Contents

alphaxor transition

This is the Frei0r alphaxor [https://www.mltframework.org/plugins/TransitionFrei0r-alphaxor/]
MLT transition.

The alpha XOR operation.

Yellow clip has a triangle alpha shape with min=0 and max=618.

Green clip has rectangle alpha shape with min=0 and max=1000.

alphaxor is the transition in between.

https://www.mltframework.org/plugins/TransitionFrei0r-alphaxor/




Composite Transition

Contents

Composite Transition
Alpha operations
Tutorial 1
Tutorial 2 - composite transition and Blue Screen
Tutorial 3 - Video Masks

The Composite transition combines the video data from two video tracks into
one. This transition is used in combination with Alpha Channel information
supplied by one of the Alpha manipulation or by the use of a Composite
Transition. This Alpha Channel data describes how the data from the two
video tracks should be combined. Until you define some alpha channel data
using an Alpha manipulation or a Wipe File, changes in the Composite
transition settings will have no visible effect.

Note: The disadvantages of the Composite transition are: luma bleed, and
less precise position control. When compared to Affine, the Composite
transition, it does not support rotation or skewing but it is much faster, albeit
at the cost of luma bleed.

Alpha operations



Alpha operation options are Over, And, Or and Xor:

Operation Over

The clip with alpha information is located on the top track: the selected
color acquires transparency.
The clip with alpha information is located on the bottom track: we see
only the top clip.

Operation And

The clip with alpha information is located on the top track: the selected
color becomes transparent.



The clip with alpha information is located on the bottom track:
everything in the image becomes transparent, except for the selected
color.

Operation Or clears any alpha information

Operation Xor

The clip with alpha information is located on the top track: everything
in the image becomes transparent, except for the selected color.
The clip with alpha information is located on the bottom track: the
selected color acquires transparency.



Tutorial 1

See this Chroma Key that describes how to use:

Alpha Manipulation -> Chroma Key
Rotoscoping
Composite Transition.
Crop and Transform -> Position and Zoom
Enhancement -> Sharpen
Alpha Manipulation -> Alpha operations

Tutorial 2 - composite transition and Blue Screen

Tutorial showing how to use the “Blue screen” function, composite transition
and Effects to animate one image moving over another in the Kdenlive video
editor.

https://youtu.be/M8hC5FbIzdE

Tutorial 3 - Video Masks

This tutorial uses the Composite transition and a custom video mask (a.k.a. a
Wipe File or matte [https://en.wikipedia.org/wiki/Matte_(filmmaking)]) to create an effect
where you can make it appear that one video is playing on the screen of a
still of a computer monitor.

The mask/matte is created with GIMP.

Save your mattes to /usr/share/kdenlive/lumas.

It would appear that you need to stop and restart Kdenlive in order for it to
pick up new matte/wipe files saved in the above folder.

There appears to be a defect in this functionality which means that when the
composite is on 100% Opacity, the wipe file does not work. You need to
change it to 99% to make the effect kick in.

https://youtu.be/M8hC5FbIzdE
https://en.wikipedia.org/wiki/Matte_(filmmaking)


https://youtu.be/FIpnGlRY27U

Screenshot of Composite transition using a custom wipe file to mask out a
section of video - as described in Tutorial 3.

Aspirational goal - a compositing experiment made using detonation films
free sample effects.

Warning: video below may be inappropriate for some users.
https://youtu.be/vo-xntF1bns

https://youtu.be/FIpnGlRY27U
https://youtu.be/vo-xntF1bns


Hue

Contents

Hue

This is the Frei0r hue [https://www.mltframework.org/plugins/TransitionFrei0r-hue/] MLT
transition.

Perform a conversion to hue only of the source input1 using the hue of input2.

https://www.mltframework.org/plugins/TransitionFrei0r-hue/


 



Transitions - Screen

Contents

Transitions - Screen

This is very much like Chroma Key but it works with footage filmed against
a black background.

Timeline showing how to apply the “Screen” transition.



This video composites a video of fire filmed on a black background into
another bit of footage using the Screen transition.

https://youtu.be/GkFdHcf9jbY

https://youtu.be/GkFdHcf9jbY


Composition - Wipe

Contents

Composition - Wipe

In this composition one shot replaces another by traveling from one side of
the frame to another or with a special shape.

The Wipe composition contains the following parameters:

Softness: Determines the softness of the transition between the top and
bottom clips.



Wipe Method: Selecting a luma file allows you to shape the
composition in different shapes.
Invert: changes the direction of motion of the luma file. That is, if the
file radial.pgm is selected in the “Wipe Method” parameter and the
image of the clip of the upper track disappears in a gradually decreasing
circle until it is replaced by the clip of the lower track. And if the
parameter is selected, on the contrary, the clip image on the lower track
will appear in a growing circle until it fills the entire monitor.
Revert: If there is a sharp transition (without the correct effect)
between the clips and only then the luma file, turn on the “Revert”
parameter so that the composition works correctly.

You can Download New Wipes from the KDE server.

There was a defect with the download new wipe files - it did not download
them to where they are needed. They should go here
~/.local/share/kdenlive/lumas/HD/, but were going here
~/.local/share/kdenlive/lumas/.

To fix manually create a HD folder and move the .pgm files there.

See also Composite Transition.
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Rendering

Contents

Rendering
Rendering Dialog
Rendering Preset Categories
Full Project
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Guide Zone
Guide Multi-Export
More Option
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Create Custom Render Presets
Rendering In Batch mode
Variable Bit Rate - earlier Versions
Constant Bit Rate - earlier Versions

Rendering is the process where the edited clips are saved into a single
complete video clip. During the rendering process the video can be
compressed and converted to a number of different video formats (aka
codecs).

The rendering dialog is brought up from the render button  from selecting
Project ‣ Render menu item or by the Ctrl + Enter shortcut.

Rendering Dialog

Changed in version 22.04.



Download New Render Profiles

Rendering Preset Categories



Kdenlive offers many different rendering presets to choose from. The
rendering presets are grouped into categories. See picture Above.

Full Project



Full Project radio button is the default setting. Kdenlive render from the first
clip until the last clip in the timeline.

Selected Zone

Selected Zone radio button, Kdenlive will only render that portion of the
project which has a selected zone created for it. See Monitors.

Guide Zone

Guide zone radio button makes use of Guides to define a region of the
project that is to be rendered. See Rendering Using Guides and Rendering
Scripts.

Guide Multi-Export

New in version 22.04.



Guide Multi-Export radio button makes use of Guides categories to be
rendered.

The selection of guide categories indicates which guides categories will be
considered for rendering. In the example above, there are the following
options:

“All Categories”: This leads to four files:

projectname-begin.mp4 (from 00:00:00 to “guide1”)
projectname-guide1.mp4 (from “guide1” to “guide2”)
projectname-guide2.mp4 (from “guide2” to “guide3”)
projectname-guide3.mp4 (from “guide3” to the end)

“Category 0 (purple)”: This leads to three files:

projectname-begin.mp4 (from 00:00:00 to “guide1”)
projectname-guide1.mp4 (from “guide1” to “guide2”)



projectname-guide2.mp4 (from “guide2” to the end)

“Category 1 (blue)”: This leads to two files:

projectname-begin.mp4 (from 00:00:00 to “guide3”)
projectname-guide3.mp4 (from “guide3” to the end)

If guides are behind the last timeline clip, they are ignored.
If a guide sits right at the beginning of the timeline, the name of that
guide is used instead of “begin”.
If two guides have the same name, an underscore and a number will be
added to the file name.

More Option

More Option show you more options for rendering.

Render Overlay

This option overlays a time code or frame count over the rendered video.
This will put the overlay over the entire rendered project. Alternatively you
can use the Dynamic Text effect to overlay selected regions of the video.

Export Metadata

Check this to have the metadata which has been entered under Project
Settings Dialog placed into the metadata of the rendered file.



And this is the metadata on the resulting clip (rendered with Export
Metadata checked).



$ ffprobe dog_rotated_meta_data.mp4 

Metadata: 
major_brand     : isom 
minor_version   : 512 
compatible_brands: isomiso2avc1mp41 



title           : Bailey 
encoder         : Lavf53.21.1 
copyright       : VSF 

Export Audio Checkbox

This is an unusual one. Instead of a normal on/off checkbox toggle, the
Export Audio checkbox cycles among three choices.

As if that weren’t confusing enough, the Export audio (automatic) option
may appear different depending on your combination of distribution, desktop
environment and theme. See three examples below:

Regardless of how the checkbox on the Export audio (automatic) option may
appear on your installation, rest assured that when that option is showing, it
is enabled.

So what do the three options mean?

Export audio (automatic) means detect if an audio track is present and write
the audio track if found

Export audio, when checked, means write an audio track in the rendered file
even if there is no audio track to write.

Export audio, when unchecked, means do not write an audio track in the
rendered file.

The difference in behavior between enabling Export audio versus Export
audio (automatic) can be seen in the situation where you have a video on the



timeline but there is no audio track on the timeline and the video in the video
track also does not have an audio track. An example of such a situation is
shown in the screenshot below.

In this situation, if you render with Export audio (automatic), the rendered
file will not have an audio track (Result 1 on screenshot below). But if you
render with Export Audio checked, then the rendered file will contain an
audio track – the track will however be empty (Result 2 on screenshot
below).



FFprobe on file generated from an audio-less track using Export audio
(automatic). Note only one stream – Stream #0.0 – a video stream. Kdenlive
automatically detected there was not an audio track and so it did not write
one.

$ ffprobe dog_rotated_exp_audio_auto.mp4 

  Metadata: 
    major_brand     : isom 
    minor_version   : 512 
    compatible_brands: isomiso2avc1mp41 
    encoder         : Lavf53.21.1 
Duration: 00:00:03.62, start: 0.000000, bitrate: 12592 kb/s 
Stream #0.0(und): Video: h264 (High), yuv420p, 1280x720 [PAR 
1:1 DAR 16:9], 12587 kb/s, 27.83 fps, 27.83 tbr, 30k tbn, 
55.66 tbc

FFprobe on file generated from an audio-less track using Export audio
checked. Note two streams – Stream #0.0 and Stream #0.1 – the latter being
an aac audio track. We forced Kdenlive to write an audio track even though
there was not any source audio to write.

$ ffprobe dog_rotated_exp_audio.mp4 

 Metadata: 
   major_brand     : isom 
   minor_version   : 512 
   compatible_brands: isomiso2avc1mp41 
   encoder         : Lavf53.21.1 
 Duration: 00:00:03.62, start: 0.000000, bitrate: 12598 kb/s 

Stream #0.0(und): Video: h264 (High), yuv420p, 1280x720 [PAR 
1:1 DAR 16:9], 12587 kb/s, 27.83 fps, 27.83 tbr, 30k tbn, 
55.66 tbc 
Stream #0.1(und): Audio: aac, 48000 Hz, stereo, s16, 2 kb/s

In cases where there is an audio track …



Rendering with Export audio unchecked will produce a file with no audio
track – result 4 in the screenshot above. Rendering with Export audio
(automatic) (result 3 in the screenshot above) or with Export audio checked
will produce files with Audio tracks.

Encoder Threads

Determines the value of Encoding threads passed to melt. For encoding to
certain codecs, namely MPEG-2, MPEG-4, H.264, and VP8, kdenlive can
use more than one thread and thus make use of multiple cores. Increase this
number to take advantage of this feature on multi-core machines. See melt
doco - threads [https://www.mltframework.org/plugins/ConsumerAvformat/#threads] and melt
FAQ [https://www.mltframework.org/faq/#does-mlt-take-advantage-of-multiple-cores-or-how-do-i-
enable-parallel-processing] on multi-threading.

Create Custom Render Presets

https://www.mltframework.org/plugins/ConsumerAvformat/#threads
https://www.mltframework.org/faq/#does-mlt-take-advantage-of-multiple-cores-or-how-do-i-enable-parallel-processing


 Creates a new preset based on the project profile.

 Downloading additional user created presets.

 Save the selected preset under a new name.

 Save the preset under the current name i.e. replace it.

   Will open the Save Render Preset dialog (also shown in the
screenshot below) and the Parameters section will be filled in with the
render parameters of the preset that you had selected when you clicked either
of the  or  or  button. You can edit values in the parameters and save
your own custom render preset.

Creating new groups: When you save a preset and enter a group name that
does not yet exist, the group will be created.



The parameters are not limited by the UI, you can add custom parameters in
the box Additional Parameters under the tab Other.

The parameters in the rendering presets are melt parameters. For an
explanation of their meaning, check the melt documentation
[https://www.mltframework.org/docs/] or type melt -help in a command prompt.

See also Render Profile Parameters.

Rendering In Batch mode

If you have a lot of rendering jobs to do, you can use Kdenlive to create
rendering scripts which you can accumulate and then execute in batch mode

https://www.mltframework.org/docs/


overnight. See Rendering Using Guides and Rendering Scripts.

Alternatively, once you have submitted a rendering job on a project and it is
up and running in the Job Queue, you can drag the render window out of the
way and edit the project some more or load a new project and render that
one too. The second render job submitted will go into the Job Queue.
Editing the project after a render job is submitted will not change the settings
on that job.

Variable Bit Rate - earlier Versions



Warning

The instructions of this section are probably out-dated please help us to
improve the documentation! See Get involved

When a variable bitrate (VBR) profile is selected, the File Size section
displays a drop down for choosing the Video quality you want. This quality
figure is a codec-dependent number representing the quality of the video that



will be rendered. Generally, lower numbers mean higher quality video and
larger file sizes (e.g. x264, MPEG2, VPx), but some codecs use opposite
order (e.g. Theora). Profiles provided with Kdenlive offer these numbers
ordered from best quality (almost lossless) to lower quality (still not
degrading too much). The exact file size that is produced can not be
predicted when using the VBR method. The idea behind this is that you
specify a certain quality of video that you want through the entire video and
the encoding optimizes bitrate to give you that constant quality, lowering data
size for low action scenes and using more bits for high action scenes.

Example: 1min 55 seconds of 720 x 576 H.264 iPhone footage rendered at
quality 15 with the H.264/AAC High Profile would produce a file size of
186 Mb. Whereas rendering the same footage at quality quality 20 produced
an 83Mb file.

Constant Bit Rate - earlier Versions

Warning

The instructions of this section are probably out-dated please help us to
improve the documentation! See Get involved



When a constant bitrate (CBR) profile is selected, the File Size section
displays a drop down for choosing the Video bitrate you want. This is
similar to the version <=0.9.8 behaviour of Kdenlive. You select the video
bitrate you want and the video is encoded at that video bitrate across its
entire length.
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Render Profile Parameters - How to read them

Changed in version 22.04.



 

 



Kdenlive now makes use of “property presets” delivered by the melt project
(see melt doco [https://www.mltframework.org/docs/presets/]). These presets are
referenced by the properties=<preset> syntax. In the example illustrated, the
render profile is referencing lossless/H.264. This refers to a property preset
found in file H.264 found on the system at
/usr/share/mlt/presets/consumer/avformat/lossless.

All the <presets> referenced in the render settings in Kdenlive will be
referring to presets found at
/usr/share/mlt/presets/consumer/avformat/ (on a default install).
Note that you reference presets found in subdirectories of this folder using a
<dirname>/<profile> syntax as shown in the example above.

properties=lossless/H.264 
g=120
crf=%quality 
ab=%audiobitrate+'k'

The preset files found at /usr/share/mlt/presets/consumer/avformat/
are simple text files that contain the melt parameters that define the
rendering. An example is shown below. These are the same parameters that
were used in earlier versions of Kdenlive – see next section for how to read
those.

https://www.mltframework.org/docs/presets/


Contents of lossless/H.264:

f=mp4 
acodec=aac 
ab=384k 
vcodec=libx264 
intra=1
vb=0
g=0
bf=0
preset=medium 
qscale=1
qp=0
coder=ac 
 
<!--T:28--> 
meta.preset.extension=mp4 
meta.preset.note=Intra-frame only, lossless compressed MPEG-4 
AVC with AAC audio 

Scanning Dropdown

This option controls the frame scanning setting the rendered file will have.
Options are Force Progressive, Force Interlaced and Auto.

Auto causes the rendered file to take the scanning settings that are defined in
the Project Settings Dialog. Use the other options to override the setting
defined in the project settings.

Render Profile Parameters - How to read them



Warning

The instructions of this section are probably out-dated please help us to
improve the documentation! See Get involved

The parameters that go into a render profile derive from the ffmpeg program.

This is a worked example to show how you can understand what these
parameters mean using the ffmpeg documentation.

In the example above the parameters are:

f=dvd 
vcodec=mpeg2video 
acodec=mp2 
b=5000k 
maxrate=8000k 
minrate=0
bufsize=1835008
mux_packet_s=2048
mux_rate=10080000
ab=192k 
ar=48000
s=720x576 
g=15
me_range=63
trellis=1
profile=dv_pal_wide 
pass=2

Looking up the ffmpeg help [https://linux.die.net/man/1/ffmpeg] translates these
parameters as shown below.

Main option is:

-f fmt            force format 

Video options are:

https://linux.die.net/man/1/ffmpeg


-vcodec codec     force video codec ('copy' to copy stream) 
-pass n           select the pass number (1 or 2) 
-b bitrate        set bitrate (in bits/s) 
-vb bitrate       set bitrate (in bits/s) 
-s size           set frame size (WxH or abbreviation) 
-me_range         <int>   E.V.. limit motion vectors range 
(1023 for DivX player) 
-trellis          <int>   E.VA. rate-distortion optimal 
quantization 

Audio options are:

-acodec codec     force audio codec ('copy' to copy stream) 
-ab bitrate       set bitrate (in bits/s) 
-ar rate          set audio sampling rate (in Hz)

The AVCodecContext AVOptions include:

-b                <int>   E.V.. set bitrate (in bits/s) 
-maxrate          <int>   E.V.. set max video bitrate 
tolerance (in bits/s) 
-minrate          <int>   E.V.. set min video bitrate 
tolerance (in bits/s) 
-g                <int>   E.V.. set the group of picture size 

So all the render profile options are documented here in the ffmpeg
documentation.

See also MLT doco [https://www.mltframework.org/docs/presets/] on
ConsumerAvFormat.

See also HOWTO Produce 4k and 2K videos, YouTube compatible
[https://forum.kde.org/viewtopic.php?f=272&amp;t=124869#p329129].

https://www.mltframework.org/docs/presets/
https://forum.kde.org/viewtopic.php?f=272&amp;t=124869#p329129
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Purpose

When editing video, time means everything. Especially how long it takes you
to edit the clips, project, or footage you are working on. If you ever need to
export sequences of your timeline separately, Kdenlive offers a great way to
do this. You can set guides in your project that establish zones. You then can
generate rendering scripts that will export these zones at a later date, during
your sleep, or while you hunt and find food. Let’s check out how to do this.

Picking Sections with Guides

Start by adding a clip into the timeline. I’ve added some retro footage about
airplanes. Cool.



Next we want to add a guide for a specific section of the clip on the timeline.
You can add a guide by selecting Timeline in the menu and then slide down to
Guides and select Add Guide from the menu. Right clicking the top of the
timeline also gives you the option Add Guide. If you want to, you can also
edit the guides you have set by right clicking on the timeline.

After selecting this option, a window appears giving you the Position of the
guide and a field to add a comment. Labeling the guide won’t hurt anyone, so



I’ll name my first guide the extraordinary Section 1. A dark blue line appears
vertically down through the tracks on your timeline.

I’ll add a few more guides and then we’ll start rendering.

The screenshot shows the 6 guides I have put in my project. They chop up the
existing clip as I want for my project (that hopefully will become the first hit
retro-experimental film…). Now we can export scripts that, when executed,
will render these guide zones.



Generating Rendering Scripts

Start by clicking on the Render button in your toolbar, the one with the red
circle surrounded by a white and black ring. You can also select this by going
to the Project ‣ Render menu item (Ctrl + Return).

The new window gives us many choices about how to render our video.
Look at the bottom of the window. We need to select the Guide zone option.
Selecting this will allow us to render our project using the guides we made



earlier. Be sure and name the output file to a unique name for each script we
will create. Otherwise the scripts will overwrite the different guide zones
and not do what you wanted.

We now can choose which guides will establish the regions of video we
want to export using the pull down menus next to From and to. I’ll cut out the
Beginning and instead use section 1 to Section 1 End, the guide names I
defined earlier.



Now I can render this to a file or generate a script that will render this guide
zone to a file. Click Generate Script and a dialog appears asking you to
name the script. Kdenlive stores the clips in
/yourhomedirectory/kdenlive/scripts



After saving the script, the top tab in the window switches to Scripts. This
lists all the scripts you have generated for the current project.

I went ahead and generated 3 scripts based on the guide zones I set up in my
timeline. Be sure and keep the .sh extension otherwise the rendering script
will not be generated.

Starting Your Rendering Scripts

Once each script is generated, you need to start each one. You should be in
the script tab and see your scripts listed. Start the process by selecting the
script and clicking the Start Script button. Do this for each script.



After clicking each script, you are switched to the Job Queue tab. Here you
will see what script is being run and how many more are waiting to be run. If
you have a large queue, you can take advantage of the nifty checkbox in the
bottom left: Shutdown computer after renderings

Starting Your Rendering Scripts in a Command
Line Terminal



For troubleshooting purposes there could be times that you want to run the
render script in a terminal prompt. Rendering in the terminal can produce
error logging information that can assist in debugging rendering issues.

To render the video in the terminal …

Note the location where Kdenlive has saved the .sh script (see Figure
8)
Open a terminal and change directories to the location of the .sh script
execute the .sh script

$ cd /home/earl/kdenlive/scripts 
 
$ sh render_section_1.sh 

or

$ ./render_section_1.sh 

Summary

Creating guides can help organize your project while you work on it and
when you share it with the world. You can use guides to keep track of areas
or to generate rendering scripts that will do the mundane task for you. This
feature makes exporting sections of your project quite easy. There are also
other ways to take advantage of rendering sections and guide zones using
guides. Have fun. Explore!
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Frequently Asked Questions
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Frequently Asked Questions
What components does Kdenlive use?
How do I fix Audio Sync Issues?

What components does Kdenlive use?

In effect, Kdenlive is a front end to melt
[http://www.mltframework.org/bin/view/MLT/MltMelt] - which uses the MLT video
framework. The MLT video framework relies on the FFMPEG project.
Kdenlive writes sh.mlt XML files that code the edit points and transitions
and it then calls /usr/bin/kdenlive_render and /usr/bin/melt to
render the video.

How do I fix Audio Sync Issues?

Often this is caused by having mixtures of different audio sources in the
project. Audio encoded with VBR (be it pure audio like MP3 or video with
audio) can be problematic.

If your audio source is from a video file try extracting the audio from your
video sources and transcoding the audio to WAV format. If you use the
Extract Audio feature of Kdenlive to do this it will write a .wav file for you.

If you have a pure audio source try transcoding that to WAV.

lame --decode file.mp3 file.wav 

http://www.mltframework.org/bin/view/MLT/MltMelt


Installation Troubleshooting
Many problems encountered in Kdenlive are caused by installation problems
(missing or mismatching packages). Kdenlive uses the MLT framework to
process all video operations, and MLT uses many other libraries like
FFmpeg, Frei0r, …

Here are some tips to understand what might be wrong for you, depending on
the error message you get on startup. If this does not help you, check the
forums.

Your MLT installation cannot be found or Cannot
start MLT backend

There is obviously something wrong with your MLT installation. Either it is
not installed or not in a standard location. You can test your MLT installation
from a terminal, type: melt color:red This should bring up a red window
(press q to close it).

If you see an error message, try reinstalling MLT or check that you don’t
have several versions installed on the system.
If you see the red window, check where your MLT is installed: which
melt. Then delete Kdenlive’s config file ($HOME/.config/kdenliverc)
and restart Kdenlive.

Missing package

A dependency is missing and it is recommended to install it.

Frei0r

This package provides many effects and transitions. Without it, Kdenlive’s
features will be reduced. You can simply install frei0r-plugins from your



package manager.

Breeze icons

Many icons used by Kdenlive come from the Breeze Icons package. Without
it, many parts of the UI will not appear correctly. You can simply install
breeze-icon-theme or breeze-icons from your package manager.

MediaInfo

Download and install MediaInfo from here [https://mediaarea.net/MediaInfo/Download]

Missing MLT module

An MLT dependency is missing and it is required to install it.

SDL is used to output audio. Install libsdl 1.x` from your package manager.

Avformat is the FFmpeg module. Make sure you have ffmpeg installed on
your system.

The following codecs were not found on your
system…

Some audio / video codecs are not installed by default. Installing a package
called libavcodec-extra might solve the problem.

On openSuse, you need to add the packman repository [https://www.opensuse-
community.org/], then enable replace vendor package
[https://en.opensuse.org/SDB:Vendor_change_update#Full_repository_Vendor_change] on the
packman repository.

https://mediaarea.net/MediaInfo/Download
https://www.opensuse-community.org/
https://en.opensuse.org/SDB:Vendor_change_update#Full_repository_Vendor_change


Windows issue with scopes
Note

New in version 21.12.2: All video scopes are working with DirectX.

Workaround: Change the backend to OpenGL (Settings ‣ OpenGL Backend
‣ OpenGL)

If it’s still not working go to: Help ‣ Reset Configuration and try again.
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Troubleshooting and Common Problems
Kdenlive warns me about missing codecs, I cannot render in
some formats
Kdenlive is too large on my screen. I cannot make it smaller.
I want to trim videos without re-encoding them. How can I do
this?
I want to apply an effect, for example a watermark, to the whole
project. What is the best way to do this?
My monitor plays distorted images, or generally something it
really should not.
I want to back out to a previous release.

Kdenlive warns me about missing codecs, I cannot
render in some formats

There are several possible reasons for this:

1. You have installed the codecs after Kdenlive’s installation. To force
Kdenlive to check available codecs on your system, run the
configuration wizard: Settings ‣ Run Config Wizard. Complete the
wizard and restart Kdenlive to be sure that codecs have been detected.

2. The codecs are not available on your system. Kdenlive uses the codecs
from your FFmpeg or Libav library. Due to licensing issues, some



distributions do not provide all codecs by default and you might need to
install an extra package. On Ubuntu/Mint for example, you must install a
package called libavcodec-extra-xx. After that, check the codecs again
as explained in the first step.

3. Last possibility is that your FFmpeg or Libav version is buggy and does
not report all supported codecs. Kdenlive releases after 0.9.2 have an
option to try using codecs even if they seem unsupported: Settings ‣
Configure Kdenlive and check the Bypass codec verification option.

Kdenlive is too large on my screen. I cannot make
it smaller.

This usually happens when too many widgets are open. Each widget label
takes a minimum amount of space in width. Close some (e.g. via the View
button) and consider using layouts (View ‣ Save Layout As).

I want to trim videos without re-encoding them.
How can I do this?

You cannot do this with Kdenlive. (Please try Avidemux [http://avidemux.org/]
instead.) The reason is that, for splitting, files need to be treated in a very
different manner (the file itself needs to be edited, whereas Kdenlive renders
frames into a new file). See also: https://forum.kde.org/viewtopic.php?
f=272&amp;t=116144&amp;p=286144&amp;hilit=clips+without+render+an
gain#p286144.

I want to apply an effect, for example a watermark,
to the whole project. What is the best way to do
this?

Create a new project with the same project profile and import the project on
which you want to apply the effect as a clip (Project ‣ Add Clip). See also:
How to: Add a Watermark in Kdenlive [http://vimeo.com/13610402] on Vimeo.

http://avidemux.org/
https://forum.kde.org/viewtopic.php?f=272&amp;t=116144&amp;p=286144&amp;hilit=clips+without+render+angain#p286144
http://vimeo.com/13610402


My monitor plays distorted images, or generally
something it really should not.

Please check your Settings ‣ Configure Kdenlive ‣ Playback settings. Try to
disable OpenGL if it is enabled, or use a different driver. Kdenlive may need
to be restarted.

I want to back out to a previous release.

See Notes at Installation.
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these issues and their workarounds.

Title tool, display real background not working in
“DirectX” backend

Something with the settings went wrong. Go to: Help ‣ Reset Configuration
and try again.

Render problems

After rendering you get de-synced audio or wrong effects or black frames at
end of the last clip: download version 20.08.1 or higher from the download
page [https://kdenlive.org/en/download]. If you still experience problems see
Windows issues.

Scopes doesn’t show anything

Windows issue with scopes

Audio crackling while playback

CRL + SHIFT +, (comma), select Playback ‣ audio backend and play
around with WinMM (Win7), Wasapi (Win10), DirectSound to see what give
the best result. Restart Kdenlive after each switch.

This application failed to start because no Qt
platform plugin could be initialized

Hit CTRL + SHIFT + , (comma) > environment > make sure the paths point
to the same path as “MLT profiles folder”.

Download: qt.conf. Put the file qt.conf into the “bin” folder (the folder
where kdenlive.exe is)

https://kdenlive.org/en/download


First time use of Kdenlive

This issue should be solved with Windows version 19.04.2-6. That
kdenliverc is correct set up please start Kdenlive twice (start -> close ->
start). Then start your work.

Intel graphic card driver

Updated Intel graphic driver versions lead to a corrupted Kdenlive GUI.

Solution 1: Open Kdenlive. Move the mouse to the top. The menus are
showing up. Try to reach Settings -> openGL backend -> enable
OpenGLES/DirectX. Restart Kdenlive. This should solve your Intel graphic
driver issue.

Maybe this statement helps: Corrupted GUI [https://forum.kde.org/viewtopic.php?
f=265&t=161309#p425882].

Solution 2: Press Win + R (Windows key and R key simultaneously) and type
appdata. Go to local and within it open kdenliverc with an editor. Search
for [misc] and delete [misc] and the following entry. . Restart Kdenlive.

Timeline: right-click menu close immediately after
releasing mouse button

Don’t use the style Fusion.

Go to: Settings -> Style and choose Default or Windows.

Icons are missing

Go to: settings -> untick force breeze icon theme. Kdenlive restarts and you
should see the icons.

https://forum.kde.org/viewtopic.php?f=265&t=161309#p425882


Cannot open projects made with previous version,
timeline snaps back, cannot import clip

Go to: Help ‣ Reset configuration.

If this is not solving the problem: Press Win + R (Windows key and R key
simultaneously) and type appdata. Go to local and within it rename
kdenliverc to kdenliverc.old. Start Kdenlive -> do nothing -> close
Kdenlive -> and restart Kdenlive again.

If you have still problems delete proxy clips and other cached data by going
to Project menu > Project Setting > Cache Data tab > there you can delete
cached data.

If you have still problems try Windows issues.

Windows 10: timeline stuttering or Kdenlive
hangs.

Most probably you got a major Win10 update (i.e 1809). If so you have to
update all drivers for audio and video.

Intel driver can be updated with this updater: Intel updater
[https://downloadcenter.intel.com/en/download/28425/Intel-Driver-Support-Assistant].

“Clip is invalid, will be removed”

This bug can appear if you do a clean reinstall of Kdenlive (see above).
Simply close and open Kdenlive once, and it should be fixed.

Additionally this can be a problem either with the kdenliverc file (see here
Windows issues) or you have some mismatch in the “local” folder (see here
Windows issues).

Any critical bug

https://downloadcenter.intel.com/en/download/28425/Intel-Driver-Support-Assistant


This describes the process of doing a clean install on Windows®.

Firstly, delete your normal Kdenlive folder (containing the application)

Access the Appdata folder (Win + R and then type APPDATA in full caps).
Go to local and search for folder kdenlive.

Note

If you have any saved effects or clips stored in your library, make a backup
of the library folder.

Then once you have backup up your library folder, delete the kdenlive
folder.

Reinstall the latest version of Kdenlive from the download page
[https://kdenlive.org/en/download]

JPG files appear as white picture after rendering

This issue should be solved with Windows version 19.04.0. If not convert
the JPG to PNG and it renders correctly.

Play/Pause Issue

This issue is solved with Windows version 18.08.2 (30. Oct 2018). Get the
current version from the download page [https://kdenlive.org/en/download].

Qt rendering crash

Hit CTRL + SHIFT + , (comma) > environment > make sure the paths point
to the same path as “MLT profiles folder”.

When switching from kdenlive for windows 17.12 > 18.04/18.08, a Qt
rendering crash appears. To make sure this doesn’t happen, you need to edit

https://kdenlive.org/en/download
https://kdenlive.org/en/download


the kdenliverc file in the appdata/local folder. To access your appdata,
press Win + R (Windows key and R key simultaneously) and type appdata.
Go to local and within it rename kdenliverc to kdenliverc.old.

Kdenlive cannot be deleted, running process on
exit

This issue is solved with Windows version 18.12.1. Get the current version
from the download page [https://kdenlive.org/en/download].

If you want to reinstall Kdenlive or re-run Kdenlive, it may tell you “The file
or folder is open in another program”. Windows® then won’t let you delete
or re-run Kdenlive.

To fix this you have to kill the running process: press and hold Ctrl +
Shift + Esc & expand the task manager by clicking all details. Then find
kdenlive.exe & dbus-daemon.exe, and click End task for both of them.

Or download the: Kdenlive-kill.zip. Unpack it and just double-click the
batch file which kills all running Kdenlive processes.

Kdenlive crash at start up, Kdenlive cannot be
uninstalled

If Kdenlive crash at startup or if the uninstaller doesn’t work delete the entire
folder: C:/Program Files/kdenlive.

Re-install Kdenlive

You have to manually delete in the start menu the Kdenlive folder.

Kdenlive crash or green Monitor

Get all newest Windows® updates. Afterwards, update your graphic card
driver and your sound card driver and your printer driver. Some crashes

https://kdenlive.org/en/download


could occur of incompatibility of the graphics card and sound card with the
newest Windows®10 updates (18.09 update). After you have updated the
drivers re-start the computer and try again by starting kdenlive.exe.

If this is not solving the problem switch your standard printer to “Microsoft
XPS Document Writer” and try again to start Kdenlive.

Delete the kdenliverc file as descript here under Windows issues.

Make sure you set processing thread to 1: Ctrl + Shift + , (comma) >
Environment > Processing thread > set to 1

General Issues
The current Kdenlive version (November 2018, version 18.08.3) has a few
issues that have workarounds.

Audio Pops and Ticks in Render

If this problem appears make sure the audio file is: 16-bit PCM WAV.
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Introducing Color Scopes
Submitted by Granjow on Mon, 08/30/2010 - 23:10

With kdenlive 0.7.8 I added some color scopes, used for displaying color
information. In this section I will give a brief overviews over scopes in
general and explain the most basic scope, the histogram, in detail.

Color correction. This is a really important topic in video editing. It starts
with simple stretching of the tonal range if the brightness is not ideal, goes on
with white balance to ensure that white remains white and not blue, and
finally ends with creating looks which make your video look unique.
(Remember the blueish Minority Report
[https://en.wikipedia.org/wiki/File:Minority_Report_bleached.jpg]? The contrasty The
Departed
[https://web.archive.org/web/20160328033801/http://www.wbshop.com/product/code/1000121856.do]?)

For color correction we basically need two things, Effects for changing the
colors and Scopes for monitoring the changes. The first scope I’m showing
now is, as already mentioned, the histogram:

https://en.wikipedia.org/wiki/File:Minority_Report_bleached.jpg
https://web.archive.org/web/20160328033801/http://www.wbshop.com/product/code/1000121856.do


Basic Scope Options

Let’s first take a look at the basic options available in all scopes.

Auto Refresh automatically refreshes the scope if the project/clip
monitor changes. During the process of color correction you’ll want to
keep this option enabled. When not color correcting, it should be
disabled as it usually heavily impacts the performance of playback.
(There is a lot of calculations going on in the scopes.)
Realtime tries to maintain a certain frame rate in the scopes by dropping
part of the color information received (e.g. taking a look at every 8th
pixel only instead of every single pixel).



Note that you can always update a scope by clicking on it.

So far about scopes in general. Now let’s take a closer look at the Histogram.



How the Histogram works
Submitted by Granjow on Mon, 08/30/2010 - 23:10

When the Histogram receives an updated image from one of the monitors,
each of these pixels consist of a Red, Green, and Blue component. Each of
these values lies within a range of 0 and 255, which are the numbers you can
represent with one Byte. 0 means that the component is not shining at all (i.e.
it is black), 255 means that it is shining as bright as possible.

The Histogram is merely statistics; it shows how often a component of a
certain brightness occurs. So what the Histogram then does is actually quite
simple:

1. Take the first pixel
2. Look at the Red value (= x) of the pixel. Increase the height of the bar at

position x of the histogram by 1. Example: If the red value is 0, increase
the height of the bar at position 0 (that is at the very left) of the
histogram by 1. If it is 42, increase bar 42 by 1. And so on.

3. Repeat the previous step with Green and Blue.
4. Look at R, G, and B together and calculate the Luma value. Luma is the

perceived Luminance of this pixel. See further below how it is
calculated (if you are interested).

5. Repeat these steps for all other pixels on the image.

What the Histogram shows

The Histogram only shows the distribution of the luminance of the selected
components – nothing more, nothing less. Also when looking at the RGB
channels separately, instead of at the calculated Luma component only, you
cannot really guess the colors in the image.

Really? Yes. Take a look at these two images.



Exactly the same Histogram. Totally different colors. (What you can do is
guessing the color tone; see below.) But what is the histogram good for now?

To answer this question, I would like to point an article from the «Cambridge
in Colour»: Understanding Digital Camera Histograms: Tones and Contrast
[https://www.cambridgeincolour.com/tutorials/histograms1.htm] and the second part
Luminance & Color [https://www.cambridgeincolour.com/tutorials/histograms2.htm].
Although written for digital photo cameras, exactly the same applies for
digital video cameras. Both articles are easy to read and understand (and
may also be of interest for experienced users).

Histogram example: Candlelight

https://www.cambridgeincolour.com/tutorials/histograms1.htm
https://www.cambridgeincolour.com/tutorials/histograms2.htm


Two special things about this histogram.

Most pixels are dark, according to the Luma component (white). Though
there is no total black: Notice that the Luma component shows «min: 8».
Nevertheless, the blue component does reach 0. This means that the
darkest pixels are still slightly orange and didn’t lose all color
information yet.
There is quite some clipping. A lot of R values are sticking at the very
right, at 255. Having a peak at 255 usually means that we lost
information because some regions were too bright for the camera sensor
with the current sensitivity settings. This could have been solved by
lowering the sensitivity, but then the book and nearly everything else
would be black. In this case the candles cause the clipping. (Not too bad
here, because the lost detail isn’t important for the image.)

The RGB components also show very well that the shadows are not neutral
grey but orange, otherwise the color heaps on the left would, as in the
gradient histogram above, have their center at the same position. There isn’t
a lot to correct here, what could be done is raising the shadows with a
Curves effect, but this is a matter of taste and the intended mood for the final
movie.



Histogram example: Underexposed ABC

We immediately notice two things:

The RGB peaks are at the same position, near the middle. The white
wall is the brightest part, so this peaks are from the white wall. As they
are not shifted, the white balance should be okay (the image confirms
that). Note that the Histogram is not very accurate for white balance.
Later I will introduce a much more accurate scope.
The image is too dark. The brightest component, red, only reaches a
value of 170. The white wall is actually grey.

Monitoring correct exposure is the Histogram’s strength! The exposure can
be corrected with curves as well, but this time I will use the Levels effect.



I’ve lowered the Input white level of the Luma channel until one of the RGB
components reached 255. Lowering the input white level further would cause
clipping on the wall and lost image information. (Which may be desired in
certain circumstances!)

This process is called Stretching of the tonal range.

Histogram options

In kdenlive 0.7.8 the histogram can be adjusted as follows:

Components – They can be enabled individually. For example, you
might only want to see the Luma component, or you want to hide the
Sum display.

Y or Luma is the best known Histogram. Every digital camera
shows it, digikam, GIMP, etc. know it. See below how it is
calculated.
Sum is basically a quick overview over the individual RGB
channels. If it shows e.g. 5 as the minimum value, you know
that none of the RGB components goes lower than 5.
RGB show the Histogram for the individual channels.

Unscaled (Context menu) – Does not scale the width of the histogram
(unless the widget size is smaller). Just a goodie if you want to have it
256 px wide.

Luma mode (Context menu) – This option defines how the Luma value
of a pixel is calculated. Two options are available:



Rec. 601 uses the formula Y' = 0.299 R' + 0.587 G' +
0.114 B'

Rec. 709 uses Y' = 0.2126 R' + 0.7152 G' + 0.0722
B'

Most of the time you will want to use Rec. 709 which is, as far as I know,
mostly used in digital video today.

Sample files

The sample files used above can be downloaded here:

Histogram-bw.png [http://granjow.net/uploads/kdenlive/samples/Histogram-bw.png]
Histogram-col.png [http://granjow.net/uploads/kdenlive/samples/Histogram-col.png]
abc-underexposed.avi [http://granjow.net/uploads/kdenlive/samples/abc-
underexposed.avi] (26 MB; 720/24p)
candlelight.avi [http://granjow.net/uploads/kdenlive/samples/candlelight.avi] (14 MB;
720/24p)

Summary

The Histogram is a great tool for exposure correction, together with the
Curves and the Levels effects. It helps to avoid clipping (burned out areas)
and crushed blacks (the opposite) when applying effects.

Thanks for reading! Continue with the Waveform and the RGB Parade.

Please drop your comments below.

Simon A. Eugster (Granjow)

http://granjow.net/uploads/kdenlive/samples/Histogram-bw.png
http://granjow.net/uploads/kdenlive/samples/Histogram-col.png
http://granjow.net/uploads/kdenlive/samples/abc-underexposed.avi
http://granjow.net/uploads/kdenlive/samples/candlelight.avi


The Waveform and The RGB
Parade
Submitted by Granjow on Tue, 09/14/2010 - 15:01

In my previous post I’ve introduced the Histogram that will be available in
kdenlive 0.7.8.

Next in the list of the Color Scopes I added are two closely related scopes:
Waveform and RGB Parade. Both of them do the same, Waveform for
Luma, RGB Parade for the RGB components. Therefore I will not always
explicitly point out that properties hold for both scopes and speak of
Waveform only.



How the Waveform works

The Waveform is kind of a 3D Histogram.

Yeah.

That’s nothing to do with the fact that the above image looks kind of 3D. So
where are the three dimensions?

1. The most obvious dimension is Luma; Dark pixels are at the bottom,
bright ones are at the top. So if all pixels in the Waveform stick at the
very top, your video is most likely white.

2. The second dimension is the horizontal position of the pixel in the
original image. That’s one of the things that makes the Waveform cool.
Pixels in the first column of your input video will also be painted in the



first column of the Waveform. This goes on until the scope reaches the
last column of the input video, which will be painted in the last column
of the Waveform.

3. The third dimension is the brightness of a pixel in the Waveform. The
brighter a point there, the more pixels in this column share this specific
brightness value.

Waveform example: Sunset

The Waveform looks quite impressive here. But what can we learn about the
image?

In the left third we’ve got some clipping. There are some bright spots
(which are the sun and the clouds).
The last third of the image is dark, but not black (no crushing). This
means that there is still a chance for color information. The image
confirms that; The tree does not look neutral but green with an orange
touch. Or the other way round?

That is where the RGB parade drops in now.



What we see is very slight crushing for blue on the tree, and more or less
equal parts of red and green as well. So if you thought the tree were green,
your brain fooled you. It is not. (Actually there is no green at all in the
image.) Also, blue nearly doesn’t clip at all, even in the sun. So it is still a
little bit orange, which is great.

Now, didn’t the Histogram show clipping and crushing as well? Yes, it did.
But it did not show where. That is a big benefit. As in some cases, if you see
that there is some clipping on a light bulb, you perhaps don’t mind increasing
the overall brightness of the image. It does increase clipping as seen on the
Histogram, but the Waveform shows that only the light bulb is clipped a little
more, which you can afford in our imaginary case.

RGB Parade example: Light Bulb

Wait … imaginary, I said? Actually I do have a short clip with light bulbs.
Which is quite interesting, not only due to the wrong white balance.



The RGB Parade reveals two things at first glance. You will at least
recognize the first one as well.

The fluorescent lamps are clipped. All channels are at 255 there, so
they are totally white.
The white balance is wrong. This can be told for sure. The ceiling is
white in reality. And in the very left quarter of the image there only
consists of the ceiling. This part should look equal in the RGB Parade,
but when e.g. comparing Red to Blue, you see that Red starts at 19
whileas Blue starts at 0. Furthermore, the Blue channel is much more
compressed. Its height in this area is 25, whileas the height of the Red
channel is about 50.

To achieve proper white balance here, we make use of a new effect called
SOP/Sat (if you want to know more about it: It implements the ASC Color
Decision List [https://en.wikipedia.org/wiki/ASC_CDL]. More to read also in the source
code comments [https://github.com/dyne/frei0r/blob/master/src/filter/sopsat/sopsat.cpp] of the
effect.) Curves would work as well (actually curves could do everything),
but let’s use a new effect here.

The first thing to decide is how bright the darkest spot should be. This can be
controlled with the Offset parameter. Reference is again the left part of the
Parades, the soon-to-be white ceiling. You can use your mouse to make the
Waveform or RGB Parade draw a horizontal line and display the value there.
I lifted all channels to 48 in this example:

https://en.wikipedia.org/wiki/ASC_CDL
https://github.com/dyne/frei0r/blob/master/src/filter/sopsat/sopsat.cpp


Second step is Stretching the channels. This is done with the Slope sliders.
The goal is again to find a neutral spot in the RGB Parade and use it as
reference. We could again use the ceiling on the left, but after some testing I
found out that the little wave in the middle of the scope works as well. Its
advantage is that it is slightly brighter than the ceiling, allowing to correct the
color cast more precisely.

And voilà, exposure and white balance are corrected.

When taking a look at the full-sized image (or when trying it yourself with the
sample clip available for download at the end of this article) you will notice
color waves in the image. This is the result of the stretching; We have blown
up the ceiling on the left from 25 px height to nearly 100 px. If the clip had
been exposured and white balanced correctly when shooting, we would have
100 distinct values there, but now there are only 25 different blue levels,
causing these steps. Also in the histogram the image looks torn apart.
(Another reason might be the high compression of the Nikon D90 clips.) This
effect is called Posterization [https://www.cambridgeincolour.com/tutorials/posterization.htm].

This is one of the reasons why more expensive cameras (and with that I mean
really expensive ones, like the RED One
[https://en.wikipedia.org/wiki/Red_Digital_Cinema], to name an extreme example) record

https://www.cambridgeincolour.com/tutorials/posterization.htm
https://en.wikipedia.org/wiki/Red_Digital_Cinema


videos in higher bit depth [https://www.cambridgeincolour.com/tutorials/bit-depth.htm].
Perhaps all clips you’ll ever encounter only store 8 bits per channel, so there
are 2 8 = 256 possible values for each channel. Having for example 10 bits
per channel would already result in 2 10 = 1024 possible values. This would
already have solved our problem.

But before you buy a RED one now – kdenlive does not support more than 8
bit yet.

Where you already can play with more than 8 bits per channel are RAW
[https://www.cambridgeincolour.com/tutorials/RAW-file-format.htm] images from DSLR
cameras. Supported by digikam [https://www.digikam.org/], RawTherapee
[http://www.rawtherapee.com/], and several more.

Waveform example: Leaf with hidden clipping

Looks perfect. Good exposure (says the eye and the Waveform), beautiful
colors.

Nevertheless, there is some clipping. It is just hidden by the Luma
calculation: For Luma, only pixels that are totally white are at the top of the
Waveform.

https://www.cambridgeincolour.com/tutorials/bit-depth.htm
https://www.cambridgeincolour.com/tutorials/RAW-file-format.htm
https://www.digikam.org/
http://www.rawtherapee.com/


Although the green leaf looks much brighter than the red tip, it is the Red
channel which clips at the tips. The thing is that our eyes are most sensitive
to Green, less to Red, and even less to Blue. That is also the reason why the
beam of a green laser is visible in the night sky, but a red one is not (unless
you’ve got a really strong one.)

Waveform example: High Key clip

This is a classical High Key [https://www.diyphotography.net/lighting-high-key-and-low-key/]
shot. Bright subject (but not clipped yet), white background.

https://www.diyphotography.net/lighting-high-key-and-low-key/


Waveform options

Paint Mode – Changes the paint mode for the Waveform. Usually
changes its brightness as well. Green also highlights pixels with values
0 or 255.
Luma mode (Context menu) – As for the Histogram you can choose how
to calculate Luma (Rec.601 or Rec.709).

Interesting detail: When color grading, some colorists prefer scopes with
neutral colors, and basically with neutral everything. Just greyscale, except
for the video itself. Why that? Quick answer: Afterimages
[https://en.wikipedia.org/wiki/Afterimage]. If you look at a green surface and then
immediately color grade an image by eye, there will be too much green in it.

RGB Parade options

Paint Mode – Changes the paint mode; see above.
Draw Axis (Context menu) – Draws an axis with 10 steps

https://en.wikipedia.org/wiki/Afterimage


Gradient reference line (Context menu) – Draws a line from bottom left
to top right. This is useful when testing color correction on a linear
gradient clip (Black on the left, White on the right), to observe changes
in each channels.

To explain the last point a little more in detail: A black/white gradient draws
a line from the bottom left to top right on the Waveform. When changing the
colors, e.g. with the SOP/Sat filter or with Curves, the line will change.
(Attention, effects working on the saturation will not have any effect on a
grayscale gradient!)

In this gradient above I have applied a SOP/Sat effect to give the blacks a
blueish touch and the mids and highs a warm touch. You can play around with
the gradient file and some color correction effects on the gradient file as
well. What the above is good for will be in the next part.

Clip Sources

windy-sunset.avi [http://granjow.net/uploads/kdenlive/samples/windy-sunset.avi] (22
MB; 720/24p)
fluorescent-wrong-whitebalance.avi
[http://granjow.net/uploads/kdenlive/samples/fluorescent-wrong-whitebalance.avi] (22 MB;
720/24p)

http://granjow.net/uploads/kdenlive/samples/windy-sunset.avi
http://granjow.net/uploads/kdenlive/samples/fluorescent-wrong-whitebalance.avi


red-leaf-tips.avi [http://granjow.net/uploads/kdenlive/samples/red-leaf-tips.avi] (13.5
MB; 720/24p)
highkey.avi [http://granjow.net/uploads/kdenlive/samples/highkey.avi] (13 MB;
720/24p)
Gradient_1080.png [http://granjow.net/uploads/kdenlive/samples/Gradient_1080.png] (10
kB, 1920×1080)

Summary

Waveform and RGB Parade are mighty scopes. Especially the RGB Parade.
Correcting the exposure is easy, with these scopes you can always keep track
of the levels of each color component. It is also possible to do white balance
by adjusting blacks first and whites afterwards because the horizontal axis in
the Scopes correspond to the horizontal axis in the video which allows to
detect spots that should be neutral.

Thanks for reading! Please drop your comments below.

Simon A. Eugster (Granjow)

Comments

yellow, Wed, 09/15/2010 - 16:40

Granjow, great work and write up. I see you use the ASC colour corrector.
Are you considering a Lift Gamma Gain 3 way? or is this an option already,
such as found in Colorista II?

Granjow, Thu, 09/16/2010 - 08:00

Thank you! Actually a 3-way color corrector was the initial goal, and when I
asked Stu Maschwitz (the author of colorista) he told me about the ASC
CDL. So I implemented the SOP/Sat effect first to play around with the
possibilities I had using the Color Decision List only. And noticed that I
couldn’t just implement a 3-way now because fine-tuning the values would

http://granjow.net/uploads/kdenlive/samples/red-leaf-tips.avi
http://granjow.net/uploads/kdenlive/samples/highkey.avi
http://granjow.net/uploads/kdenlive/samples/Gradient_1080.png


require at least a tiny bit of experience. Because everyone is doing it
differently [https://digitalfilms.wordpress.com/2010/03/13/] anyways ;)

You said Lift/Gain/Gamma. This is just another expression for
Slope/Offset/Power?

yellow, Thu, 09/16/2010 - 14:49

I believe LGG & SOP are different formulas and therefore assume apply the
‘corrections’ differently. But as you say so many variations of
implementation anyway, even choosing one or the other.

https://digitalfilms.wordpress.com/2010/03/13/


The Vectorscope
Submitted by Granjow on Sun, 10/10/2010 - 18:30

The last scope (after the Histogram and the Waveform and RGB Parade) that
is new to kdenlive 0.7.8 is the Vectorscope. This is actually the most
interesting scope because it is quite different from the other ones and,
secondly, is really useful for Color Grading.

How the Vectorscope works

There is one simple thing that makes the Vectorscope so special: It uses a
color space different than RGB. That sounds unspectacular, but it is not. The
previous scopes allow you to determine which brightness values exist in
your image, the Vectorscope shows which colors there are.



The Vectorscope supports two different color spaces: YUV and YPbPr. Both
of them have the Y in common, something you know from before: It is the
Luma component (Rec.601 in both cases). This, amongst others, comes from
black/white TV. When Color TV was introduced, some people actually
recognized that not everybody would immediately trash his old b/w TV and
buy a new one, so they still sent the b/w signal, but with two additional
channels: The blue difference and the red difference (to Luma), called U and
V. So that is how YUV [https://en.wikipedia.org/wiki/YUV] works (please take a look
at the image in its YUV components on the linked Wikipedia page).

The other color space, YPbPr [https://en.wikipedia.org/wiki/YPbPr] or its digital
counterpart YCbCr [https://en.wikipedia.org/wiki/YCbCr] respectively, are similar. If
you switch between the two color models in the Vectorscope (via the context
menu) you will notice that the colors are slightly shifted. YCbCr is used
basically everywhere in digital video.

So, what the Vectorscope does: It calculates the Luma value of a pixel, then
calculates the blue difference/red difference values. Then it throws the Luma
value away. Why that? It is because the Vectorscope is 2-dimensional. The
blue difference is on the horizontal axis, the red difference is on the vertical
axis. (There actually are three-dimensional vectorscopes which put the Luma
component on the third axis!)

Vectorscope example: Grayscale video

Now let’s take a look at how this actually looks like in a video.

https://en.wikipedia.org/wiki/YUV
https://en.wikipedia.org/wiki/YPbPr
https://en.wikipedia.org/wiki/YCbCr


Well … nothing? Close. There is a little pixel in the middle of the scope.
And that is the whole image. That looks a little disappointing now, but
actually it is great. All greys (plus black and white) are exactly in the middle.
Everything that is not in the middle has some color information (and the
further away it is from the middle, the higher its saturation aka.
chrominance). This will come in very handy when it comes to white balance.

Vectorscope example: Juggling balls

Juggling balls are more interesting, especially when they are colored. The
ones above are. I’ve switched on a YUV background (with fixed Luma)



which helps identifying the colors of pixel heaps on the scope. Two things
can be noticed:

here are six areas with high black density on the scope (which means
that many pixels share this hue):

1. One that points towards blue (bottom right),
2. A big one around yellow,
3. Two big ones around red,
4. A smaller one between red and yellow,
5. And the last one which you might have missed (I nearly did so

as well), between red and blue.

These are exactly the ball’s colors! Blue comes from the two balls
on the left, yellow from the yellow ball, the left red area is the pink
part of the left ball, the right part in red is the red ball on the right.
The part between red and yellow, which is actually orange, is the
background of the whole scene, and the last one between red and
blue is the violet part of the right red ball.

The orange background seems to connect all other areas. This is
something really amazing. Like magic. It will help doing white balance.
The neutral area will almost always seem to connect the other ones.

As the shot above is actually correctly white balanced, I will not maltreat it
here. But you should actually try! Download the sample below, add a
SOP/Sat effect and change the Offset parameters for the RGB values. (Don’t
forget to enable auto-refresh.)

Now perhaps you wonder how I could assign those spots to colors with
surety. Is it really the upper spot caused by the red ball? To find out (I didn’t
want to write wrong things here) I have masked the red ball out (with a Title
Clip I’ve drawn a white rectangle on). The spot then indeed disappeared.



The violet spot has disappeared as well, and also big parts of the yellow
spot because the white rectangle covers the yellow ball as well.

Vectorscope example: Musical box

Again, two things worth pointing out for this clip.

This shot of a Swiss Musical Box mainly consists of orange tones, all
points on the vectorscope lie between neutral (center) and orange. Not
too saturated orange tones as they come from the bronze/messing parts.
(I guess that is what they are.)



The white balance seems to be correct. The Vectorscope indicates that
there are neutral pixels (i.e. greys), and they seem to be the origin for
the other colors.

But when increasing the gain of the Vectorscope to 5× we see that the scope
image actually stops right before neutral.

If you open this clip and take a look at the Waveform you will notice that it
shows the same: Blue is too low, red is too high. To correct this minor color
cast we can use the SOP/Sat effect again, adjusting the Offset values. By
doing that the points on the Vectorscoped will be shifted around. A positive
red offset will make the points shift towards red at the top, a negative offset
shifts them towards the opposite direction (that is, towards the
complementary color
[https://web.archive.org/web/20160318213205/http://www.tigercolor.com/color-lab/color-theory/color-
theory-intro.htm#complementary] of red, cyan).

https://web.archive.org/web/20160318213205/http://www.tigercolor.com/color-lab/color-theory/color-theory-intro.htm#complementary


I adjusted the blue and red values such that there is some padding around the
neutral center. It is usually not enough to just let the first pixel hit the neutral
point because several factors like the material of the neutral object itself,
chromatic abberation (there is also a more accurate article about chromatic
aberration
[https://web.archive.org/web/20160318204109/http://toothwalker.org/optics/chromatic.html]) in
lenses, artifacts in the recorded video file. So usually neutral areas will not
share one single pixel in the vectorscope but have a certain diameter.
Therefore the padding.

Because this is a suitable clip for hue:

https://web.archive.org/web/20160318204109/http://toothwalker.org/optics/chromatic.html


Now what happened here? The hue has changed, and the points on the scope
look like rotated by 30 degrees. And indeed they did rotate. The Hueshift
effect changes the hue of all colors by a certain (configurable ;)) amount. In
the Vectorscope this becomes visible as a rotation around the center of the
scope.

Similarly, when changing the saturation/chroma, the dots on the vectorscope
will move closer to the center or further away from it.

Creating a look for your video

In the Histogram article’s introduction I mentioned creating looks with color
correction. This example covers part of the tip of the iceberg of this topic.
(The tip is the most important part of an iceberg because it tells you where
you can drive safely ;))

What is special about creating a look for a video? Let’s take a look at some
random clips:



Mostly different content and therefore different colors – as said: random.
One point of Color Grading is to give single clips a connection. This is not
limited to white balance only. White balancing a clip is about removing color
casts (which is a good thing because it gives you a neutral starting point). But
we can also add new colors.



These clips look much more like if they belonged together. This is the result
of Primary Color Correction (Primary means that it affects the whole image;
Secondary Color Correction would only affect parts of it, e.g. by using
masks, choosing color ranges, etc.): White balance (plus in some cases
reduction of saturation) followed by a SOP/Sat effect. The latter SOP/Sat
effect does something similar as the Blockbuster Effect; here the blacks
become blueish, the mids and the whites tend towards yellow.

See also this page
[http://www.kenstone.net/fcp_homepage/fcp_7_scopes_vectorscope_stone.html] for some hints
about Looks and the Vectorscope.

Vectorscope options

In kdenlive 0.7.8 you can adjust the Vectorscope as follows by right-clicking
it:

Export Background – Exports a color plane of the desired color space.
This is a goodie for interested people like me ;) It allows to export
RGB, YUV and YCbCr planes (like the ones you see when visiting the
Wikipedia articles about this color spaces).
75 % Box – Marks the position where color saturation reaches 75 % of
its maximum value. This may be interesting if you work for broadcast.
Colors exceeding this box were not regarded as broadcast safe
[https://en.wikipedia.org/wiki/Vectorscope#Video] – but before changing the
saturation to a max of 75 % better consult your broadcast company ;)
Draw axis – Draws the U/Pb (horizontal) and V/Cr (vertical) axis.
YUV and YPbPr – Switches between the two color spaces YUV and
YPbPr.

Clip Sources

raclette-greyscale.avi [http://granjow.net/uploads/kdenlive/samples/raclette-greyscale.avi]
(720/24p, 12 MB)
juggling-balls.avi [http://granjow.net/uploads/kdenlive/samples/juggling-balls.avi]
(720/24p, 11 MB)

http://www.kenstone.net/fcp_homepage/fcp_7_scopes_vectorscope_stone.html
https://en.wikipedia.org/wiki/Vectorscope#Video
http://granjow.net/uploads/kdenlive/samples/raclette-greyscale.avi
http://granjow.net/uploads/kdenlive/samples/juggling-balls.avi


Musical-box.avi [http://granjow.net/uploads/kdenlive/samples/Musical-box.avi]
(720/24p, 23 MB. Video from Nikon D90, Audio from Zoom H4n.)

Summary

The Vectorscope shows the hue and saturation distribution in a way we can
understand without problems. This is useful for quickly recognizing color
casts, but also helps judging the color distribution of a clip and match it to
others.

All scopes together fulfill another important task: They help matching video
from different light situations and different input sources (like a second
camera) regarding brightness and color. This is what you need Test Charts as
e.g. seen here [https://web.archive.org/web/20141006190923/http://www.image-
engineering.de/index.php?option=com_content&view=article&id=370:the-universal-test-target-utt-a-
new-approach&catid=1:latest-news&Itemid=97] for. Different cameras might have a
different dynamic range and different colors. So when combining these shots
you first shoot a test chart and then match exposure and color
[https://web.archive.org/web/20141010162133/http://www.hdcinematics.com/chapters/chapter2.html].
This is also widely covered in the book Color Correction for Video
[https://www.amazon.de/s?k=0240810783%2C+9780240810782&link_code=qs&sourceid=Mozilla-
search&tag=firefox-de-21] by Steve Hullfish and Jamie Fowler.

So — have fun with the scopes! May they guide you through your color
grading.

Thanks for reading!

Please drop your comments below.

Simon A. Eugster (Granjow)

What the I and the Q lines are good for

Submitted by Granjow on Fri, 11/26/2010 - 18:05

http://granjow.net/uploads/kdenlive/samples/Musical-box.avi
https://web.archive.org/web/20141006190923/http://www.image-engineering.de/index.php?option=com_content&view=article&id=370:the-universal-test-target-utt-a-new-approach&catid=1:latest-news&Itemid=97
https://web.archive.org/web/20141010162133/http://www.hdcinematics.com/chapters/chapter2.html
https://www.amazon.de/s?k=0240810783%2C+9780240810782&link_code=qs&sourceid=Mozilla-search&tag=firefox-de-21


In the next kdenlive version (or in the current SVN version, if you dare
compile it yourself :)) you will find a new option for the vectorscope: To
draw I/Q lines. What are they good for?

Where I/Q lines come from

You may remember from my blog post about the Vectorscope (see above) that
the Vectorscope uses a color space different than RGB. In the image above it
is YUV [https://en.wikipedia.org/wiki/YUV], in the image below it is YPbPr
[https://en.wikipedia.org/wiki/YPbPr]. They both share the property that the Y
component represents Luma only (i.e. how bright a pixel is), and the other
two components represent Chroma (colour) by expressing deviations from
neutral color on the red-green and yellow-blue axis. (These are
complementary colours each, so mixing them in equal parts results in neutral
again – which is why they can be used for the deviation.)

YUV is the standard color space for analog PAL television. NTSC, the
american analog TV standard, uses a color space I did not mention yet: YIQ
[https://en.wikipedia.org/wiki/YIQ]. The special thing about this color space is that the
I component was chosen such that skin tones (also known as flesh tones) lie
on the I line (orange-blue), and it was given more than four times as much

https://en.wikipedia.org/wiki/YUV
https://en.wikipedia.org/wiki/YPbPr
https://en.wikipedia.org/wiki/YIQ


bandwidth as the Q component (which represents the green-purple line; the
human eye is also less sensitive for changes on this line).

The Purpose of the I and the Q line

You might have guessed it already: The reason for displaying the Q and,
especially, the I line is to help with skin tones. There is a rule of thumb in
post production saying that all skin tones should approximately lie on the I
line. If it is not, you might want to color-correct your clip
[https://prolost.com/blog/2008/3/23/save-our-skins.html].

Why? If skin tones do not lie on the I line, they are likely to look unnatural.
Our eye is trained on skin tones ;) End of the story.

Clip sources

Only one this time.

skin1.avi (720p, 5.1 MB)

That’s it! Thanks for reading.

Feel free to post your comments below.

Simon A. Eugster (Granjow)

https://prolost.com/blog/2008/3/23/save-our-skins.html




The Audio Spectrum and the
Spectrogram
Submitted by Granjow on Sat, 12/25/2010 - 12:51

In the next version of Kdenlive you will again find new scopes. This time not
for video but for audio! I will also give some tips about audio in general
(recording, perception, etc.), not only about kdenlive’s scopes.

First of all, the scopes



Spectrogram screenshot

The audio scopes are documented in-depth in Audio Scopes for kdenlive
(PDF) [http://granjow.net/uploads/kdenlive/kdenlive-audioscopes.pdf]. You may skip the
technical/mathematical part — it is not necessary for understanding the
scope, and the maths behind is not very trivial. The rest might be interesting
though.

Nevertheless, a quick overview over the features currently available.

Audio Spectrum

This scope displays the frequency spectrum for each frame. Low frequencies
are on the left, high frequencies on the right. And the higher the bar, the
louder this frequency.

Loudness is measured in decibel [https://en.wikipedia.org/wiki/Decibel] in the
spectrum. (To be very precise, the unit used in the scope is dbFS
[https://en.wikipedia.org/wiki/DBFS], so 0 dB refers to the maximum possible loudness
that can be achieved with the digital input signal.) If all frequencies have
equal loudness, you can adjust the range to display by dragging vertically.
Simply dragging adjusts the lower threshold, Shift + drag adjusts the

http://granjow.net/uploads/kdenlive/kdenlive-audioscopes.pdf
https://en.wikipedia.org/wiki/Decibel
https://en.wikipedia.org/wiki/DBFS


maximum loudness to display. Horizontal dragging adjusts the maximum
frequency to display samples for.

But what is this display useful for? One thing is that, as described in the PDF
linked at the top, you can visually distinguish between good and bad sound
quality: If there are no frequencies higher than, like, 3 kHz, then the audio
quality most likely is not too good.

(If you have no clue how high 3 kHz are, which is nothing unusual since our
ears do not deliver numerical values to our brain, you can use a program like
SignalGen [https://arachnoid.com/SignalGen/index.html] or Audacity
[https://www.audacityteam.org/] to generate a sine wave with 3 kHz (which is 3000
Hz).)

Something else the frequency spectrum is useful for is to avoid clipping
[https://en.wikipedia.org/wiki/Clipping_(signal_processing)]. The same effect that can be seen
with colors, e.g. in the RGB parade, and actually with every signal that is
digitalized. More about this below.

Spectrogram

The Spectrogram [https://en.wikipedia.org/wiki/Spectrogram] does the same as the Audio
Spectrum: It shows the frequency distribution. With the difference though that
the frequencies are not shown for one frame only. Similar to the RGB Parade
for colors are stronger (louder) frequencies represented by brighter pixels;
this allows to put a whole frame’s spectrum in one line.

What the scopes might help in as well

To maintain equal loudness over multiple shots. Consider this review
[https://www.youtube.com/watch?app=desktop&v=ZWXU3mScCzM] about the Nikon D7000,
and listen at 7:00 and 11:00. At 7:00 you can hear the reviewer loud and
clear, at 11:00 you need to turn up the volume to even understand something.
This should not happen.

Sound

https://arachnoid.com/SignalGen/index.html
https://www.audacityteam.org/
https://en.wikipedia.org/wiki/Clipping_(signal_processing)
https://en.wikipedia.org/wiki/Spectrogram
https://www.youtube.com/watch?app=desktop&v=ZWXU3mScCzM


Now a few interesting details about sound.

Clipping

Audio levels on a Zoom H4n

As mentioned above sound can clip as well. Everyone has heard this already.
This is how it sounds (Extracts from James Edwards’ Greensleeves, cc-nc-
by-sa, link at the end of this article):

Original [http://granjow.net/uploads/kdenlive/samples/James-Edwards-Greensleeves-
original.ogg] (Just noticed that Firefox plays .ogg natively :) )
Volume increased by 24 dB: [http://granjow.net/uploads/kdenlive/samples/James-
Edwards-Greensleeves-overdriven-24dB.ogg] Massive clipping!
Volume afterwards decreased by 24 dB
[http://granjow.net/uploads/kdenlive/samples/James-Edwards-Greensleeves-overdriven-24dB-
reverted.ogg] — the clipping effect is irreversible

Clipping is also very well visible in the audio wave itself, if you e.g. open
the samples above with Audacity. (If you want to reproduce the above effect
with Audacity, make sure to select «allow overdrive», otherwise it will
prevent clipping [https://en.wikipedia.org/wiki/Dynamic_range_compression]. When
decreasing the volume afterwards do not use the same project since Audacity
actually stores values that are bigger than the maximum amplitude value (.aup
files only). This is great for editing, and perhaps one day we will have that
for color as well in kdenlive …)

So when may clipping occur?

http://granjow.net/uploads/kdenlive/samples/James-Edwards-Greensleeves-original.ogg
http://granjow.net/uploads/kdenlive/samples/James-Edwards-Greensleeves-overdriven-24dB.ogg
http://granjow.net/uploads/kdenlive/samples/James-Edwards-Greensleeves-overdriven-24dB-reverted.ogg
https://en.wikipedia.org/wiki/Dynamic_range_compression


1. When recording audio. The input gain can be adjusted on the audio
recorder. (Usually. For the Nikon D90 you cannot adjust anything for
example. But its audio is not really usable anyway.) If the gain is too
high, it might record for example low talking at a good volume, but clip
as soon as someone rises his/her voice. Therefore input gain is usually
adjusted such that the mean volume and peaks do not exceed a certain
limit. This limit depends on the expected dynamic audio range. A
common choice is −12 dB for the mean volume and maximally −6 dB
for peaks.

2. When editing. There are multiple volume effects in kdenlive. If you
raise the volume too much, you will experience clipping. (Try it.) To
prevent clipping in kdenlive, you actually do quite the same as when
recording audio. Try to keep peak values below −6 dB. If you need one
cut to be really much louder than the rest and you cannot raise it any
further, then you need to lower everything else.

Damping

The further away you are from the sound source, the quieter you hear it. Until
finally it will be as loud as the noise floor of your microphone and audio
recorder. To maintain a good SNR you will therefore usually try to keep your
microphone as close as possible to the sound source. Such that the signal is
much stronger than the noise (and with the input gain adjusted such that no
clipping occurs).

But that is not everything yet. (Actually the above point was not about
dampening at all but merely about wave propagation.) There is one
interesting aspect, which is that higher frequencies are absorbed much
stronger than low frequencies. Unlike the previous points this is not a
problem but rather an interesting variable: If you record someone’s voice and
want to put him far away in the video (next room for example), lower the
higher frequencies (using Audacity’s Equalizer effect for example).

Our ear

What is louder, a sine wave of 200 Hz or a sine wave of 4 kHz?



200 Hz Sine [http://granjow.net/uploads/kdenlive/samples/Sine-200Hz.ogg]
4000 Hz Sine [http://granjow.net/uploads/kdenlive/samples/Sine-4000Hz.ogg]

They have both been generated with the same amplitude (volume). But our
ear is most sensible on the frequencies we talk in. To read more about our
ear, Wikipedia [https://en.wikipedia.org/wiki/Hearing] is a good starting point.

Links

James Edwards [https://www.jamendo.com/artist/355390/james-edwards] at Jamendo
Damping of frequencies in air (PDF)
[https://web.archive.org/web/20140715193728/http://www.isi.ee.ethz.ch/teaching/courses/ak1/ak
ustik-schallausbreitung-im-freien.pdf], German
Capturing good sound [https://vimeo.com/blog/post/capturing-good-sound] at Vimeo,
about microphones.
Thread about audio and clipping
[https://web.archive.org/web/20140715164749/http://www.dvxuser.com/V6/showthread.php?
207009-Db-level-peaks-matter-in-this-situation&highlight=audio+clipping] at dvxuser.com (I
think it is a good idea to search for interesting forum threads there for
yourself if you are interested)

Thanks …

… for reading! I hope you will have fun with the scopes in the next kdenlive
version.

Simon A. Eugster (Granjow)

http://granjow.net/uploads/kdenlive/samples/Sine-200Hz.ogg
http://granjow.net/uploads/kdenlive/samples/Sine-4000Hz.ogg
https://en.wikipedia.org/wiki/Hearing
https://www.jamendo.com/artist/355390/james-edwards
https://web.archive.org/web/20140715193728/http://www.isi.ee.ethz.ch/teaching/courses/ak1/akustik-schallausbreitung-im-freien.pdf
https://vimeo.com/blog/post/capturing-good-sound
https://web.archive.org/web/20140715164749/http://www.dvxuser.com/V6/showthread.php?207009-Db-level-peaks-matter-in-this-situation&highlight=audio+clipping
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Shooting with your DSLR
Submitted by Granjow on Sun, 11/14/2010 - 21:27

This article is going to give some tips regarding shooting Video with your
DSLR and editing it in kdenlive afterwards.

Camera hardware

Lens

 

Generally Primes are preferred over zooms in video. (Some people, like me,
prefer it over zooms as well for photography — but this is a matter of taste
and of how you work.) Why that? A psychological reason is that eyes (at
least mine) cannot zoom either, so zooming is hardly ever used in video. The
technical reason is that Primes are cheaper to build whilst offering better
quality: Better sharpness, bigger aperture (for limiting the Depth of Field).
Opening the aperture gives you a very nice look. (Please also read
ArtInvent’s comment on this.)

Examples for very popular primes are the Nikon 50mm f/1.8D and the Canon
50mm f/1.8 II.

If you own such a lens, just don’t forget that you should not always shoot at
f/1.8. ;)



Filter

Directly related to the previous point about lenses. Shooting with an open
aperture works well as long as it is dark. In bright sunlight it will fail
because there is too much light falling on the sensor. Furthermore you are
forced to use a high shutter speed which makes movements look jerky; Most
of the time you will want to have some kind of motion blur because it looks
more natural to our eyes.

If you ever tried to follow a bird or another animal with your eyes in dawn,
you will know that our eyes do support motion blur.

So the trick is to remove some light with a filter called Neutral Density
Filter. You can see one on the right. (The piece of kneaded eraser is not part
of the filter.)

Shooting

Aperture, Shutter, and ISO

 

The same as for shooting stills. Really? Not quite. As written above you will
usually want to have the shutter speed lower than for photography in order to



get motion blur — around 1/50 s. (This is just a rule of thumb, as all rules in
video are; made to be broken.)

Also, some additional problems may arise due to the sensor being read out
line-wise. One I would like to mention are Rolling Shutter effects. Longer
exposure can, but need not, prevent such problems. It does if you are shooting
with fluorescent lamps. Shooting at high shutter speed shows wave patterns
from top to bottom of the screen, lowering it hides them if you hit the correct
shutter speed.

On the right: Two images I shot with my Nikon D90, the left one at lowest
ISO possible, the right one at highest possible.

Exposure

 

The image should be exposed as bright as possible (without too much
clipping!) if enough light is available. If you don’t need to boos the
brightness too much in post-production, you can avoid some noise in dark
areas.

White Balance

 

The White Balance should be set as accurate as possible because DSLRs
only support 8 bit per color channel (see also my article about the Waveform
Monitor). If done wrong, much of the color information is lost.



DSLRs also offer different camera profiles with different
Contrast/Saturation/etc. settings. Usually low saturation is preferred over
high saturation — especially because raising the saturation can be done in
post, and because high in-camera saturation settings can lead to color
clipping.

In the example images on the right you can see the difference. The left one
looked blueish due to wrong white balance and was corrected in post; much
of the tonal range of the blue colors has been lost. The right one has been shot
with proper white balance.

Autofocus

The in-camera autofocus may be fast enough to focus, but it will fail in the
most important moment. It is useful for getting the initial focus point, but
while shooting it should stay switched off.

Camera specific tips

Nikon D90

The Nikon D90 was the first DSLR offering video. 720/24p (AVI container).

D90 videos at 720p are scaled awfully. That’s why you can see stair-
stepping in sharp, skew lines. If this becomes perturbing for a clip, you can
apply the «Nikon D90 Stairstepping fix» frei0r filter. Written (but not
invented) by me :) See our Nikon D90 page
[https://web.archive.org/web/20160403024219/https://kdenlive.org/video-editor/nikon-d90] for an
example of how stairstepping looks like (before and after correction).

There is an extensive overview over the D90 video function at dvxuser.com:
Understanding and Optimizing the Nikon D90 D-Movie Mode Image
[https://web.archive.org/web/20160208161124/http://www.dvxuser.com/V6/showthread.php?146661-
Understanding-and-Optimizing-the-Nikon-D90-D-Movie-Mode-Image]

Canon EOS 550D/Ti2 (and Co.)

https://web.archive.org/web/20160403024219/https://kdenlive.org/video-editor/nikon-d90
https://web.archive.org/web/20160208161124/http://www.dvxuser.com/V6/showthread.php?146661-Understanding-and-Optimizing-the-Nikon-D90-D-Movie-Mode-Image


These cameras shoot 1080p (H.264 encoded, MOV container) — but record
video with a height of 1088 pixels. Prior to MLT 0.5.6 you have/had to crop
the additional 8 pixels with a crop effect from the top or the bottom of the
video, newer versions of MLT do this automatically.

DSLR related links

One can find tons of information about shooting in the internet. Some helpful
links listed below.

DSLR HD Video Tips: Shooting Basics — Introduction to DSLR video
shooting
Philip Bloom Gives Photographers A Basic Video Shooting Tip
[https://philipbloom.net/blog/shooting-video-with-a-dslr/] — How to get from photo to
video
7 Tips To Get Better Video from a DSLR Camera
[https://www.sportsshooter.com/news/2376] — Tips on shooting (not tech only)
Hurlbut Visuals Camera Protocol [https://vimeo.com/groups/28231/videos/15635719]
— Professional shooting workflow
Pro DSLR Video Tips from David Harry Stewart
[https://www.popphoto.com/how-to/2010/07/pro-dslr-video-tips-david-harry-stewart/] —
Interview containing several tips
Tips on Shooting Video With a D.S.L.R.
[https://webcache.googleusercontent.com/search?
q=cache:3CJdJI0nNW4J:https://gadgetwise.blogs.nytimes.com/2010/04/15/tips-on-shooting-
video-with-a-d-s-l-r/+&cd=1&hl=de&ct=clnk&gl=ch] — Various tips
How To Guide For Shooting HD Video With A DSLR Camera
[https://tubularinsights.com/hd-video-dslr-camera/] — Various tips

Summary

Summary? There is no such thing. You need to read everything, really :)

Have fun!

https://philipbloom.net/blog/shooting-video-with-a-dslr/
https://www.sportsshooter.com/news/2376
https://vimeo.com/groups/28231/videos/15635719
https://www.popphoto.com/how-to/2010/07/pro-dslr-video-tips-david-harry-stewart/
https://webcache.googleusercontent.com/search?q=cache:3CJdJI0nNW4J:https://gadgetwise.blogs.nytimes.com/2010/04/15/tips-on-shooting-video-with-a-d-s-l-r/+&cd=1&hl=de&ct=clnk&gl=ch
https://tubularinsights.com/hd-video-dslr-camera/


Please drop your comments below.

Simon A. Eugster (Granjow)



Using P2 footage from the
Panasonic HVX200 on GNU/Linux
(tested on Ubuntu)
Using footage from P2 cards is easy when you know how! The MXF files on
P2 cards cannot be read until you convert them with mxfsplit, a part of
FreeMXF. The conversion is lossless and the resulting files contain both
video and audio and can be edited in real time with Kdenlive (or Blender
2.5+) on most computers made within the last five years or so. Also,
FFMPEG can read these files. This process is very fast because there is no
transcoding and so can be done in the field while shooting just as fast as
simply transferring the original P2 files.

Step One: FreeMXF

Get the source code for MFXlib from here [http://sourceforge.net/projects/mxflib/].

Then configure, compile, and install it by running the following code in the
directory where you saved the source files:

./configure 
make 
sudo make install 

This will get mxfsplit (part of mxflib) working.

Step Two: Using mxfsplit

Here is a simple script that can be run in the terminal. It will convert all
MXF files in a chosen directory into usable files. Do a search and replace
for /source/directory and /destination/directory

http://sourceforge.net/projects/mxflib/


# /source/directory
# /destination/directory
#
# change to destination directory
cd /destination/directory 
#find all *.MXF files in a specific directory and loop 
through them using the variable 'i'
for i in /source/directory/*.MXF 
do
# use mxfsplit to convert files
STREAM=`mxfsplit -m $i | grep “File=” | cut -c 31-52`
# rename the files so they make sense, appending the word 
'converted' to the end of the basename 
mv *.Stream "`basename $i .MXF`converted.MXF"
#end loop
done

Conclusion

Now you have a script that can easily prepare footage for editing (e.g. with
Kdenlive or Blender) and for transcoding. FFMPEG can be used to
transcode the resulting .MXF files to whatever format is preferred. For
example, the following code would get the files ready for Youtube, Vimeo,
etc.:

cd ""
for i in *.* 
do 
ffmpeg -threads 2 -i $i -acodec libmp3lame -aq 192 -vcodec 
libx264 -vpre slow converted$i.mp4 
done



Tips & Tricks

Contents

Tips & Tricks

You can advance and retard the clip in the project monitor by rotating
the mouse wheel when the pointer is over the Timeline or over the
Monitors
You can advance and retard the clip in the Monitors by rotating the
mouse wheel when the pointer is over the Monitors
You can zoom the timeline by vertical drag on the ruler (if enabled in
Configure Kdenlive)
What’s this Full Luma



Useful Information
HOWTO Produce 4k and 2K videos, YouTube compatible
[https://forum.kde.org/viewtopic.php?f=272&t=124869#p329129]

Contents:

Adding meta data to mp4 video
Automatically Raising the Properties Pane
Color Hell: Ffmpeg Transcoding and Preserving BT.601
Compositing with transparency
Configuring the Default Transition Duration
Disable All Timeline Effects
Effects everywhere
Extract frame to project
Working with Extracted Frames in Higher Resolution than Project
Profile
Fixing Unwanted Slow Audio Fade-Ins with Some USB Audio Cards
Full Luma
How to editing audio volume with keyframes
How to fading in-out Kdenlive titles
Insert and Overwrite: advanced timeline editing
Kdenlive transitions
Library clips with image sequences, Titles, Color clips
Manage Cached Data
Restoring Audio Mixing
The “Smooth” Keyframe Interpolation
Editing Surround Sound with Kdenlive
The library: copy paste between projects
Timeline preview rendering

https://forum.kde.org/viewtopic.php?f=272&t=124869#p329129


Adding meta data to mp4 video
Adding a useful information to your video files – such as title, authors, the
date of production, and some description – can be quite helpful to both
yourself and your customers. This additional data – or meta data – can be
used by media players to organize your many video files. Unfortunately,
while adding such meta data to audio files is straightforward, adding useful
meta data to video files is … a nightmare. But don’t despair, as we’ve
compiled some useful information for you!

Project Meta Data



Kdenlive allows you to specify the meta information that should be added to
a rendered file. Just go to Project ‣ Project Settings, then select the second
tab named Metadata.

For your convenience, Kdenlive automatically adds the following four
elements to each new project:

title.
author – doesn’t work for .mp4 containers, but for .mov
containers; you may use artist instead with .mp4 containers.
copyright.
year – please note that this element does not work for video
rendered into MP4 containers (such as .mov and .mp4). See below
for more details. Use a date element instead. Oh, this year element
is actually quite pesky: you can delete it, but it will automatically
reappear. So simply ignore it … as ffmpeg does too.

But there are more elements that you actually may use with your MP4
containers.

MP4 Containers

Unfortunately, there are competing sets of meta data when working with MP4
containers. The older, standard MP4 set is rather limited in what additional
meta data can be used. Then, there is Apple iTunes, and that brings in a lot of
meta data, and even changes the allowed set from time to time. We will come
back to this difference in a second.

Unfortunately, information about what meta data can be used in which
situation is rather scarce, sometimes outdated, and sometimes plainly wrong.
Of course, this may also apply to this Toolbox article, but I’ve taken much
effort to cross-check things in real life. As Kdenlive uses ffmpeg
[https://www.ffmpeg.org/] for encoding, one would think that there’s plenty of
information – unfortunately, it’s not, and the scarce information is sometimes
plainly wrong. At some point, I’ve resorted to reading the source code in
order to find out which so-called MP4 atoms actually are supported and
through which element names (the magic happens inside

https://www.ffmpeg.org/


mov_write_ilst_tag() in moveenc.c
[https://github.com/FFmpeg/FFmpeg/blob/5a8b41b4a76fc6586ff6afff78e5f0aa7b25068a/libavformat/mov
enc.c#L2996]). Luckily, you don’t need to dive into the source anymore.

Finally, please note that other container formats, such as Matroska
[https://en.wikipedia.org/wiki/Matroska] (.mkv) or cough Audio Video Interleave
[https://en.wikipedia.org/wiki/Audio_Video_Interleave] (.avi), support yet other sets of meta
data elements. So, variance galore!

Ffmpeg Supported MP4 Container Meta
Information

But now for the real meat: here come the available meta data elements that
ffmpeg supports.

1. Please note that you must use the ffmpeg meta data keys from the
second column in the table below as the metadata keys in
Kdenlive’s Project Metadata dialog!

2. Ffmpeg supports different meta data elements, based on the type of
container. And this container type normally gets derived from the
container filename suffix (ending): in particular, .mp4 and .mov.

Element ffmpeg Meta
Data Key Description MOV MP4

(iTunes) Tag

Title title
The title of
this video.
(String)

✔ ✔ ©nam

https://github.com/FFmpeg/FFmpeg/blob/5a8b41b4a76fc6586ff6afff78e5f0aa7b25068a/libavformat/movenc.c#L2996
https://en.wikipedia.org/wiki/Matroska
https://en.wikipedia.org/wiki/Audio_Video_Interleave


Element ffmpeg Meta
Data Key Description MOV MP4

(iTunes) Tag

Year date

The date of
production.
Please note
that the
ffmpeg
documentation
is totally
wrong here,
there is no key
named year,
but only date.
(String)

✔ ✔ ©day

Copyright copyright
The copyright
of your video.
(String)

✔ ✔ ©cpy

Artist artist

The name of
the (video)
artist. Please
don’t use this
element for
the composer,
as there is a
dedicated
element
especially for
the composer,
see below.
(String)

✔ ✔ ©ART



Element ffmpeg Meta
Data Key Description MOV MP4

(iTunes) Tag

Album
Artist album_artist

The name of
the album
artist: this
may be a
guest artist or
a featured
artist. This
element can
also be left
out or be the
same name as
the artist.
(String)

✔ aART

Author author
The author of
the video.
(String)

✔ ©aut

Composer composer
The name of
the composer.
(String)

©wrt

Album album

The title or
the name of
this album.
(String)

✔ ©alb



Element ffmpeg Meta
Data Key Description MOV MP4

(iTunes) Tag

Description comment

A (content)
description of
this video.
For a
synopsis,
please see the
separate
element
instead.
(String)

✔ desc

Comment comment

A (short)
comment on
your video.
This will
probably a
comment set
by the
audience, not
at the time of
production.
(String)

✔ ©des

Comment comment

Same as
before, but
encoded in a
separate
element.
(String)

✔ ✔ ©cmt



Element ffmpeg Meta
Data Key Description MOV MP4

(iTunes) Tag

Synopsis synopsis

A synopsis, a
longer
description of
this video.
(String)

✔ ldes

Genre genre
The genre this
video belongs
to. (String)

✔ ✔ ©gen

Make make (String) ✔ ©mak

Model model (String) ✔ ©mod

Location location (String) ✔ ©xyz



Element ffmpeg Meta
Data Key Description MOV MP4

(iTunes) Tag

Grouping grouping

The name of a
group of
videos
somehow
belonging
together. In
contrast to the
album
element,
grouping
happens
inside (that is,
below) the
album level.
(String)

✔ ©grp

Show show

The name of
the TV show,
if applicable.
(String)

✔ tvsh



Element ffmpeg Meta
Data Key Description MOV MP4

(iTunes) Tag

Episode episode_id

Either the
episode name
or episode
number, for
display. If
necessary, use
the separate,
yet optional
episode
number
element for
correct
sorting.
(String)

✔ tven



Element ffmpeg Meta
Data Key Description MOV MP4

(iTunes) Tag

Episode
(Sorting) episode_sort

This element
is for sorting
only, but
never
displayed. It
allows
numerical
sorting of
episode
names that are
strings, but
not
(necessarily)
numbers. The
valid range is
limited to 0 to
255 only, so
this doesn’t
support all
those endless
telenovas, it
seems…
(Int8)

✔ tves

Season season_number

The season
number, in the
range of 0 to
255 only.
(Int8)

✔ tvsn



Element ffmpeg Meta
Data Key Description MOV MP4

(iTunes) Tag

Lyrics lyrics

Optional
lyrics for
badly sung
sing-along…
(String)

✔ ©lyr

Compilation compilation

If 1, then this
video file is
part of a
compilation. 0
otherwise.
(Int8)

✔ cpil

Network network (String) ✔ tvnn

Media Type media_type (Int8) ✔ stik

HD Video hd_video (Int8) ✔ hdvd

Gapless
Playback gapless_playback (Int8) ✔ pgap



Element ffmpeg Meta
Data Key Description MOV MP4

(iTunes) Tag

Encoding
Tool encoder

Not available
to us users, as
it gets
automatically
set by ffmpeg
itself; this is
set to the
libavformat
version string.

✔ ©swr

Encoding
Tool encoding_tool

Not available
to us users, as
it gets
automatically
set by ffmpeg
itself; this is
set to the
libavformat
version string.

✔ ©too

Notes

There is no way to add cover art or DVD art to MP4 containers through
ffmpeg, and in consequence, in Kdenlive. Instead, you need to resort to other
video container tagging tools, such as AtomicParsley
[https://sourceforge.net/p/atomicparsley/wiki/Home/].

Kdenlive leverages ffmpeg for encoding, so if ffmpeg doesn’t support certain
atoms, there’s no way for Kdenlive to get it into the rendered output file.

https://sourceforge.net/p/atomicparsley/wiki/Home/


Useful References

The following references give some more background information on ffmpeg
and meta data in .mov/.mp4 containers.

First, and foremost, the ffmpeg source code for reference, and
moveenc.c [https://sourceforge.net/p/atomicparsley/wiki/Home/] in particular.

mov_write_ilst_tag() is responsible to write the iTunes-
compatible tags for .mp4 containers.
mov_write_udta_tag() write the MPEG-standard tags
instead, when using a .mov container.

How To: Create/Write ID3 tags using ffmpeg
[https://jonhall.info/create_id3_tags_using_ffmpeg/] by Jon Hall. This article
finally got me on the right track. However, beware of a few
incorrect ffmpeg keys in Jon’s table (such as the TIT3 key, which I
think isn’t correct); these may be due to later changes in ffmpeg (or
whatever). In the end, since some of Jon’s keys didn’t work, I went
for the ffmpeg source code which is the authoritative source, of
course. Nevertheless, I’m very thankful to Jon and he is some of
the rare really good sources with good insight into the topic. Most
other source just tell you how to press some buttons on some
application, but don’t give you any clue as to what is actually going
on behind the scenes.
How To: Dump and Load metadata with ffmpeg [https://jonhall.info/how-
to/dump_and_load_metadata_with_ffmpeg/] by Jon Hall. Sheds more light on
how to work with meta data when it comes to ffmpeg.
FFmpeg Metadata [https://wiki.multimedia.cx/index.php?title=FFmpeg_Metadata]
article from the MultimediaWiki [https://wiki.multimedia.cx/index.php?
title=Main_Page].

https://sourceforge.net/p/atomicparsley/wiki/Home/
https://jonhall.info/create_id3_tags_using_ffmpeg/
https://jonhall.info/how-to/dump_and_load_metadata_with_ffmpeg/
https://wiki.multimedia.cx/index.php?title=FFmpeg_Metadata
https://wiki.multimedia.cx/index.php?title=Main_Page


Automatically Raising the
Properties Pane
New in version 16.12.0.

Depending on your workflow habits, you can configure when to raise the
properties pane (in case it’s currently hidden).

To configure when Kdenlive should automatically raise the properties pane,
go to Settings ‣ Configure Kdenlive then tab Timeline.

You should now see a group titled Raise properties pane when selecting in
timeline, which contains these three check boxes:

when selecting timeline clips,



when selecting transitions,
when selecting tracks.

Simply check the timeline elements for which you want the properties pane to
be automatically raised (shown) when you select them in the timeline.

The default (classic) behavior of Kdenlive is to automatically raise the
properties pane for all clips, transitions, and tracks.



Color Hell: Ffmpeg Transcoding
and Preserving BT.601
From time to time, you may get into weird digital video territory quite
unexpectedly. For instance, you just want to cut some screen records made on
mobile devices, such as tablets or mobile phones. What could possibly go
wrong? Colors, for instance…

“Run-of-the-Mill” Footage

The drama starts with screen recording footage that seems quite innocent and
normal at first sight. It may have been recorded on Android 7 devices using a
screen recording app (such as «AZ Screen Recording», but not the “Pro”
fake). And this footage has two slightly unusual properties:

a highly variable frame rate,
it’s using BT.601 [https://en.wikipedia.org/wiki/Rec._601] , instead of BT.709 like
so much HD footage these days.

Should cause no problems, right? Well…

As it turns out, Kdenlive’s media engine MLT [https://www.mltframework.org/] can
exhibit some issues with video footage that has a highly variable frame rate,
such as between 0.001 and 100+ fps. The symptoms are subtle, yet endanger
production quality: it seems as if MLT may well pick a future frame which is
way off in regions with a low framerate. While this isn’t an issue for a
suitably high framerate, this causes odd results in other places. For instance,
in my productions user touch interaction shows up even a few seconds before
the interaction will appear. This is probably caused by a very low fps during
the inactivity period just before the user interaction.

Alas, transcoding to a fixed frame rate surely is one of ffmpeg’s
[https://www.ffmpeg.org/] easy tasks (this example assumes a constant project
frame rate of 25 fps):

https://en.wikipedia.org/wiki/Rec._601
https://www.mltframework.org/
https://www.ffmpeg.org/


$ ffmpeg -i raw.mp4 -r 25 -crf 18 screen-rec.mp4

The constant frame rate cures the issues mentioned above, so the results are
as to be expected. Except…

Easy Transcoding: Color Me Bad

Unfortunately, the resulting video now shows shifted colors! It might not be
too obvious in the first place, but it can be quite prominent when you work
more with your footage. And it gets clearly visible to your audience in case
you are going to mix this footage side-by-side with further processed
versions of it, such as extracted frames for stills.

A more close inspection, either using Kdenlive’s built-in clip properties
pane or ffprobe [https://www.ffmpeg.org/ffprobe.html], reveals that the transcoded file
lacks the BT.601 color profile indication. Yet, ffmpeg did not transform the
colors at all during transcoding, and simply dropped the correct color profile
information!

Makeshift Measures

https://www.ffmpeg.org/ffprobe.html


Of course, there’s always Kdenlive’s ability to overwrite source clip
properties using the built-in clip properties pane.

Simply select the transcoded video clip in the project bin. Then go to the clip
properties pane and select its “Force Properties” tab which shows a writing
pen. Check “Colorspace” and then select “ITU-R 601”. Kdenlive now
applies the correct color profile.

While very easy, this method has its limitations; it’s fine while you keep
working solely inside the Kdenlive editor and its MLT renderer. But as
soon as you need to pull in external video tools, such as ffmpeg for image
extraction…, you will loose: these tools don’t know about Kdenlive’s source
clip property overrides. We thus need to get the correct color profile
information right into the transcoded video files themselves.

Preserving BT.601 in Transcoding

To make this matter worse, the seemingly obvious color profile
transformation -vf colormatrix=bt601:bt601 simply doesn’t work:
ffmpeg complains about not being to transform between the same input and
output color profile. Grrr.

It took quite some extensive searching until I found the missing puzzle piece
on Stack Exchange’s Video Production Q&A site: ffmpeg: explicitly tag
h.264 as bt.601, rather than leaving unspecified?

https://video.stackexchange.com/questions/16840/ffmpeg-explicitly-tag-h-264-as-bt-601-rather-than-leaving-unspecified


[https://video.stackexchange.com/questions/16840/ffmpeg-explicitly-tag-h-264-as-bt-601-rather-than-
leaving-unspecified]

There’s a catch to watch out for: BT.601 comes in PAL and NTSC flavors
which feature slightly different primary chromaticities, transfer curves, and
colorspaces. So check your raw footage first using ffprobe (or mediainfo)
which one has been used during recording in your case. Please note that it
doesn’t matter that your screen recording hasn’t standard definition (SD)
resolution at all, but it does matter when it comes to encoding color.

I’m Not Quite Dead Yet: PAL and NTSC DNA

So how do we find out if a given video recording file, say raw.mp4, uses the
PAL or NTSC color space? Of course, ffprobe comes to our rescue. But in
order to not get lost in all the nitty-gritty details ffprobe will throw at you,
we need to tame it using a few options and grep:

$ ffprobe -v error -show_streams raw.mp4 | grep color_

This should give you something along these lines:

color_range=tv color_space=bt470bg color_transfer=smpte170m
color_primaries=bt470bg

Someone surely thought that using a TV standard definition-related BT.601 is
a clever idea to record mobile device screens. Must have been a hipster with
a old-school tube TV sitting on his desk. Alas, the line color_space=...
will tell us whether we’re dealing with PAL (=bt470bg) or NTSC
(=smpte170m).

PAL

If it’s PAL chromaticities (=bt470bg), we then need to transcode as
follows:

$ ffmpeg -i raw.mp4



-color_primaries bt470bg -color_trc gamma28 -colorspace

bt470bg

-r 25 -crf 18 screen-rec.mp4

NTSC

For NTSC chromaticities (=smpte170m), we’ll need a different set of
primaries, transfer curve, and colorspace:

$ ffmpeg -i raw.mp4
-color_primaries smpte170m -color_trc smpte170m -colorspace

smpte170m

-r 25 -crf 18 screen-rec.mp4

In any case, Kdenlive/MLT now correctly see the transcoded video using the
BT.601 color profile. In addition, other media tools correctly detect the color
profile too – unless they are broken in that they don’t understand BT.601 at
all.



Compositing with transparency
When transparency is involved in both frames processed by one of
Kdenlive’s dynamic compositing transitions, the outcome may be surprising
to some of us users. Luckily, things aren’t as inexplicable as they appear, so
let’s dive right into transparency and transitions…

Transparency & Dynamic Transitions

When it comes to handling transparency, Kdenlive’s Kdenlive transitions fall
into two categories:

Affine: uses the so-called atop compositing operator.
Composite, Composite & Transform, Cairo (Affine) Blend: uses
the over compositing operator instead.

So what does these atop and over really mean? Let’s discover what these
compositing operators do using a typical title and semi-transparent
background example. For simplicity, we first will ignore the Opacity
parameter of the aforementioned transitions to keep things easier to grasp.
And after we’ve mastered this step, we will finally look at how the opacity
parameter fits into the full picture.

Affine: Atop Compositing

The result of the atop compositing is best explained at first by showing its
outcome: Text from the topmost title clip (partly) vanishes in those regions
where the underlying clip on the middle track is (semi) transparent.



The checkerboard clip on the bottom track just serves for illustrational
purposes, so we can better see the transparent regions.

Please notice how the two Affine transitions are chained: first, the upper
Affine composes the title clip onto the gradient background. Then, the lower
Affine composes the result onto the checkboard background.

But how does the Affine transition exactly handle transparency? Let’s look at
this hand-made illustration, where we have two pixels with some
transparency each (the alpha values, αA and αB). It’s important to not
confuse pixel transparency with the opaque parameter of transitions.

Our red pixel comes from the upper track frame (B), whereas the green pixel
stems from the lower track frame (A). An alpha of 0 means a completely
transparent pixel, whereas an alpha of 1.0 (or 255) means totally opaque
pixel.

The Affine transition now simply ignores the transparency information from
the upper frame pixel (the red one).

It solely uses the transparency information (green) contained in the lower
track frames! Or more mathematical: α = αA

And that’s the explanation why in our example above the title text vanishes in
those regions where the middle clip is transparent.



Composite & Co: Over Compositing

Again, we basically use the same setup as before, but this time we use
Composite & Transform in place of Affine transitions. We chain the
transitions as before, so that the lower transition works on the outcome of the
upper transition.

But look! The outcome is different! The result of the over operator is
probably more to the expectations of most users. Now, the top title clip
doesn’t get (sorry) clipped anymore.

As the over operation produces results more to the expectations of many
users, how does it handle transparency exactly?

Simply spoken: if you paint some semi-transparent pixel over another semi-
transparent pixel, then the result will be less transparent. It will be even
less transparent than the lower frame pixel transparency. This is what we
would probably expect from painting with semi-opaque paint.



Calculating the resulting transparency for two given pixels from an upper
frame (B) and a lower frame (A) is thus more involved this time.

Again, we start with the transparency of the lower frame pixel (green) as a
base. But this time, we can’t ignore the transparency of the (red) upper frame
pixel. But simply adding both transparencies wouldn’t yield sensible results;
what does a transparency of 2.0 or 511 mean?

So the red pixel transparency is scaled: you may think of shrinking the
original 0-1.0 scale into the available space above the green transparency
value. The resulting transparency then is the sum of the green base alpha
value, plus the rescaled red alpha value. Remember, we kind of paint over
the lower frame. For the formular-affines: α = αA + αB (1-αA)

Transition Parameter Opacity

The dynamic compositing transitions also feature a parameter called
Opacity. It’s easy to confuse it with pixel transparency, but it’s something
different. The opacity parameter applies to the upper frames (B) only. It is
kind of a master control … but how does it work?

Let’s start with the Affine transition, again. Above, we’ve seen that Affine
ignores the transparency of the (red) upper frame pixels. And Affine also
ignores the Opacity parameter when calculating the result pixel
transparency.



Instead, the Opacity parameter influences how the result pixel color gets
calculated: this is a linear interpolation between the color of the upper frame
(B) pixel and the lower frame (A) pixel. The Opacity now controls the exact
blending point. An opacity of 0.0 results in only the lower frame (B) pixel
color, while 1.0 solely yields the upper frame pixel (A) color. 0.5 would be
halfway between the two pixel colors.

To sum up: in case of the Affine transition, the Opacity parameter solely
affects color blending between upper frame (B) and lower frame (A) pixels.

Next, let’s look at the other transitions: Composite & Co.

As for the color blending, the same procedure applies that we’ve just seen
with the Affine transition: the Opacity parameter controls how much upper
frame (B) pixel color gets into the blend.

But when we look at how the transparency of the resulting pixel gets
calculated, things are starting to look different. We’ve seen that the
transparency of the upper frame (B) pixel gets scaled down in reverse
proportion of the lower frame (A) pixel transparency. The Opacity
parameter takes this even further: it additionally scales down the upper frame
(B) pixel transparency. Please see also the illustration.

In consequence, the Opacity parameter thus controls how much opacity of an
upper frame (B) pixel is applied at all. This way, you can fade in or out the
upper frame.



To sum up: in case of the Composite (&Co) transitions, the Opacity
parameter affects both color blending of upper frame (B) and lower frame
(A) pixels, as well as transparency of the upper frame (B).

Useful References

Wikipedia article on alpha compositing
[https://en.wikipedia.org/wiki/Alpha_compositing], with a reference to the original
Porter Duff SIGGRAPH’84 paper on «Compositing Digital Images».
the SVG Open 2015 paper by Craig Northway on understanding
compositing and color extensions in SVG 1.2 in 30 minutes!
[http://www.graphicalweb.org/2005/papers/abstractsvgopen/index.html] – especially the
Porter Duff operator table in chapter 6 with resulting alpha calculation
column.

https://en.wikipedia.org/wiki/Alpha_compositing
http://www.graphicalweb.org/2005/papers/abstractsvgopen/index.html


Configuring the Default Transition
Duration
New in version 16.08.1.

You can now configure the default duration for all newly created
transitions. Before this, all new transitions were always 65 frames long –
and this translated to varying default durations, depending on a project’s
frame rate. This new configuration option should appeal all those users who
work a lot with transitions.

Go to Settings ‣ Configure Kdenlive ‣ Misc category. Under the heading
Default Durations you’ll now find the new fifth option to configure the
default duration for newly created transitions. Enter a duration in the usual
format hh:mm:ss:ff.



Please note that the frames (:ff) field will be interpreted on the basis of the
current project’s framerate. In contrast, the other fields hh:mm:ss are
independent of the framerate.



Disable All Timeline Effects
Did you know that you can temporarily disable all timeline effects at
once? This may be helpful when you want to do some timeline work, yet
some performance heavy effects slow down this work. Alternatively, you
may want to consider using Kdenlive’s timeline preview.

You’ll find the corresponding option in the main menu Timeline ‣ Disable
Timeline Effects. This disables or re-enables all timeline effects, that is,
timeline clip effects and track effects.



However, please note that prior to Kdenlive 16.08.1, track effects are not
properly disabled or re-enabled by Timeline ‣ Disable Timeline Effects.

Please see Effects everywhere about how to temporarily disable bin clip
effects.



Effects everywhere
Did you know that you can apply effects not only to clips in the timeline, but
also to project bin clips and even to specific tracks in the timeline?

Clip Effects

Probably most of the time, many Kdenlive users will simply slap individual
effects on individual timeline clips. For instance, as lighting conditions vary
within the same source clip, multiple scenes taken from it might be in need of
individual grading. Or you need to crop and place an individual clip,
separately from others. So we’re all used to it, and we do it almost
unconsciously.

But in some situations, we would like to ease and speed up our timeline
work. Instead of laboriously setting up effect after effect on individual
timeline clips, we want to add effects to either a specific bin clip or a
timeline track once and for all…

Hint

Did you know that you can temporarily Disable All Timeline Effects? Use
Timeline ‣ Disable timeline effects.

Effects on Project Bin Clips

Effects on bin clips allow you to, for instance, color grade a clip itself. All
copies of it that you use in the timeline then will automatically use these
effects. Also, all changes you make to the bin clip will immediately become
effective on all copies in the timeline.

Note



Please note that bin clip effects are applied first, before any timeline clip
effects.

Apply Effects to Bin Clips

To apply effects to a clip in the project bin in general, simply drag and drop
an effect from the effects pane (1) into your clip in the project bin (2). The
parameters pane (3) then will switch to the effects applied to this particular
bin clip. Adjust as you like.

If you later need to return to the bin clip effects in order to edit them again,
simply select the clip in the project bin. The parameters pane (3) then will
automatically switch to your bin clip’s effect stack.

Compare Before/After Effects

Please note the split compare button at the top of the parameters pane (3):
when active, the clip monitor (4) shows your clip in a before/after fashion:

left half of clip monitor (4): your bin clip with all effects applied;
the text «effect» to the left of the red divider (4) is a reminder of
which side is showing effects, and which side is without effects.
right half: your bin clip without any effects applied.

While hovering your mouse cursor over the clip monitor, you should notice a
red vertical divider line appearing. Drag it to dynamically change the split



between the clip parts with/without effects.

Temporarily Disable Bin Clip Effects

You can (temporarily) disable all effects on a single bin clip, by selecting it
and then un-checking the Bin effects for… box at the top of the parameters
pane (3). This works exactly the same as with effects applied to timeline
clips.

Bin clips that have effects directly applied on them show the effects signet: a
star. It is overlaid on the clip thumbnail, as you can see to the right.

Temporarily disable ALL bin effects

You can also temporarily disable all bin effects at once, using either a
keyboard shortcut or a toolbar button. Unfortunately, this function is slightly
hidden, as there is (yet) no menu item for it. You’ll need to either configure a
shortcut for this action, or add the action to a toolbar:

To configure a keyboard shortcut, go to Settings ‣ Configure
Shortcuts…, then search for Disable Bin Effects. Now set your
desired shortcut, click OK. Done.
Alternatively, go to Settings ‣ Configure Toolbars…, then search
for the available action Disable Bin Effects. Add it to whatever
toolbar you like, such as the Timeline Toolbar by clicking the >
button. Click OK. Done.

You can now quickly disable and enable all bin effects at once using either
the shortcut or toolbar button you’ve configured above.

Effects on Tracks



Similar to effects on bin clips, you can also add effects to a specific timeline
track. For instance, you can set the crop and placement of clips on a specific
track, so you don’t need to copy these settings over and over again onto all
clips in this track. When you change a track effects, it immediately applies to
all clips on this track. Sweet.

Apply Effects to Tracks

To apply effects to a track in the timeline, simply drag and drop an effect
from the effects pane (1) into the desired track in your timeline (2). The
parameters pane (3) then will switch to the effects applied to this track.
Adjust effects as you like.

There’s one minor catch here: the split compare button unfortunately doesn’t
work here, as it applies to individual clips only. It doesn’t work for timeline
tracks.

If you later need to return to track effects in order to edit them again, simply
click into the header of the desired track. The parameters pane (3) then will
automatically switch to your track effect stack.

Temporarily Disable Track Effects

You can (temporarily) disable all effects for a track, by clicking into the
track header and then un-checking the Bin effects for… box at the top of the



parameters pane (3). This works exactly the same as with effects applied to
timeline clips.

Timeline tracks that have effects directly applied on them show the (usual)
effects signet: a star. It shows up after the clip title. In single-line layout, the
effects signet shows up in between the clip title and the track controls.



Extract frame to project
New in version 16.12.0.

If you happen to work a lot with still images from your video source material
in your Kdenlive project, then you may like the new Extract Frame to
Project, scheduled to debut in Kdenlive 16.12.0. Instead of the tedious mill
of extract clip, thinking of a usable image filename other than adshsgfg.png,
then finding this file again to add it to your project … simply let Kdenlive
propose a suitable filename, click OK, and you’re set.

Extract Frame to Project

The clip and project monitors now have a new context menu item Extract
frame to project, in addition to the existing Extract frame. This new menu



item not only extracts the currently shown frame, but also adds it
automatically to your project.

You’ll still see the Save Image dialog, but there’s additional convenience:
Kdenlive now proposes an image filename. This bases on either (in the clip
monitor) on the clip name, or (in the project monitor) on the project filename.
To avoid filename clashes when extracting multiple frames from the same
source clip or project, Kdenlive neatly adds the frame number. So, when
extracting frames from your clip named coolclip.mp4, the suggested image
names are like coolclip-f42.png, and so on. Of course, you can still use your
own filenames as before. But you’ll probably soon start to like just forgetting
about filenames, as it is so convenient to focus on content, not clip names.

The extracted image is immediately added to your project bin. If you use bin
folders, then the image gets added to your currently selected bin folder.

On purpose, Kdenlive does not switch to the project bin. This way, you can
focus on extracting the required still images from a source video clip,
without loosing context all the time. In contrast, with the exiting Extract
frame, you need to add the extracted still images at some time, so you need to
switch to the project bin, loosing the context on your source clip.



Working with Extracted Frames in
Higher Resolution than Project
Profile
Sometimes, you may need to work in your Kdenlive projects with images
stills extracted from your source footage. Now that’s easy, thanks to the
“extract frame…” and “extract frame to project…” items in the context menu
of the clip monitor. See also our earlier Toolbox post Extract Frame to
Project.

Now, there’s a gotcha to watch out for: Kdenlive currently extracts frames
according to your project settings. That means: if your source footage
happens to be of higher resolution than your project settings and even
different orientation, then the extracted frame will be in project frame format.
In consequence, extracted frame quality might noticeably differ from the same
video footage when used side-by-side in your project. Luckily, there’s help.

Project Profile … and Profile-Differing Footage

In some projects you may face source footage that doesn’t match the project
profile at all. For instance, when working with certain screen recordings,
especially when recorded on tablets and smartphone. The recordings might
be even in a different orientation.



Agreed, such footage might be a sign of the – rather hilarious – Vertical
Video Syndrome [https://www.youtube.com/watch?v=f2picMQC-9E] (link to YouTube
explanation). Or it might be the sign of an outstanding arthouse production.
But there are other sensible reasons, such as their use in tutorial videos: a
portrait mobile device screen can be easily composed with a 16:9 scene,
leaving room for additional illustrations, explanations, and so on.

To give a concrete example: recording the screen of an Android Tablet, say,
a Samsung Galaxy Tab S3 gives raw footage with a frame size of 1536×2048
pixels with 2:3 aspect ratio (because the portrait orientation). Even when
recording in landscape orientation, the 3:2 display aspect ratio isn’t ideal.
And you may very well want to record in original resolution in order to not
loose later downstream during production when you may need the reserve in
the raw footage.

Note

the frame rate displayed by Kdenlive for this footage (see screenshot) is
not even in the right ballpark. In fact, this footage has a widely varying

https://www.youtube.com/watch?v=f2picMQC-9E


frame rate (not to be confused with a variable bitrate), and
Kdenlive/MLT/ffmpeg seem to offer wild guesses here, maybe based on the
TV color range indicated for the video stream. But a 23500/1001 framerate
is used by NTSC, yet this has been recorded with PAL cromaciticies on a
PAL device. Anyway…

Unfortunately, if you need to work with still images extracted from such
source footage, then you might have already met a nasty surprise: Kdenlive’s
media engine MLT extracts still frames always according to the project
settings. Consider you have a FullHD 1920×1080 pixels 19:6 project. And
the screencast footage is 1536×2048 pixels with 2:3 portrait aspect ratio.
Then you end up with extracted frames of 1920×1080 pixels size with a
landscape 16:9 aspect ratio and a lot of transparent space, but not the
expected 1536×2048. So not only the resolution changed, but also the aspect
ratio.



Hardly what you want here, as our detail screenshot shows. When comparing
this clip monitor screenshot with the clip monitor screenshot taken from the
raw footage, you’ll notice their different qualities. It doesn’t matter which we
you prefer, the issue is that they noticeably differ.

This is a no-no when we need to use both the raw footage as well as the
extracted frames in the same project, especially adjacent to each other in the
timeline. The differences are clearly visible, unless you compress the
resulting video to the extreme of looking rather like a fake Barbapapa
[https://en.wikipedia.org/wiki/Barbapapa] episode (yep, I’m that old to have this seen in
its time).

Original Resolution Frame Extraction

Of course, after all timeline cuts have been mostly settled with the required
extracted frames for stills, we could then manually (re-) extract the frames in
their original resolution. Of course, this is not only a daunting but also error-
prone task. Been there, done that … never again.

https://en.wikipedia.org/wiki/Barbapapa


Fortunately, there’s the easy route using the so-called extract-frames
[https://gist.github.com/TheDiveO/57fd76e4d15252232aaacc7e422a79a2] bash shell script
(courtesy of your blog post author TheDiveO). Download the bash script
from the extract-frames GitHubGist
[https://gist.githubusercontent.com/TheDiveO/57fd76e4d15252232aaacc7e422a79a2/raw/b3e605eb7473
7916bffa55bbc1b907e29ee7016d/extract-frames] and make it executable ($ chmod u+x
extract-frames).

A word of caution: before you let loose anything on your Kdenlive
project directory that makes changes, make sure to have backed up your
project first. You have been warned. We take no responsibility for any
data losses or other losses you may experience.

Now run the script inside your project directory, where your frame image
PNGs are located together with the corresponding video files from which the
frames have been extracted. You always need to specify the Kdenlive project
filename in order to run the script:

$ extract-frames myproject.kdenlive

That’s all to it! You should now see also Kdenlive’s project bin noticing that
the image files have been updated. Thus, you can run the script while your
Kdenlive project is opened (at least that’s my experience so far).

What does this script actually do? It first scans for frame image PNGs with
filenames in the form xxx-f000000.png. Here, xxx is the filename (without
extension) of the corresponding video file from which the frame has been
extracted. At this time, the script only looks for corresponding video files
ending in .mp4 and .MP4.

The f000000 part now identifies the frame number from which the still frame
has been extracted. Now this is posing an interesting question: in which
reference system were these frames counted?

Remember that we wrote above that Kdenlive extracts frames from bin clips
using the project properties? So, the reference system for counting extracted
frame numbers is your project. And that’s the reason why you need to tell
extract-frames of your project: the script learns the project’s frame rate in

https://gist.github.com/TheDiveO/57fd76e4d15252232aaacc7e422a79a2
https://gist.githubusercontent.com/TheDiveO/57fd76e4d15252232aaacc7e422a79a2/raw/b3e605eb74737916bffa55bbc1b907e29ee7016d/extract-frames


order to correctly handle frame number. Without it, we would later extract
the wrong frames in case the raw footage has a different frame rate and thus
frame counting from your project.

Note

The frame image files can be located not only in the project directory, but
also in sub directories. The script won’t find any extracted frame PNG files
outside your project directory sub-tree, because it doesn’t scan your
Kdenlive project for extracted frames.

Note

Do not change the project frame rate afterwards, or the frame extraction
will get messed up. That’s because the frame numbers from the filenames
don’t match the project settings anymore.

After you’ve run the extract-frames script, you should notice in
Kdenlive’s clip properties pane that the extracted frame PNGs are now
having the correct original frame size and aspect ratio. Just for completeness:
the clip preview monitor now shows the same image quality as the original
raw footage does. So you’re all set to finalize and tape-out, erm, render your
project.



If you happen to see color changes at this stage, then please check out our
other Toolbox post about Color Hell: Ffmpeg Transcoding and Preserving
BT.601.

Work Flow in a Nutshell

Your overall workflow doesn’t change much, just throw running the
extract-frames script inside your Kdenlive project directory whenever
you need to update the frame image files with full-resolution images from
your raw footage. You can run and rerun the script at any time while you
work on your project.

But remember to not change the project frame rate while working on your
project, as this will put the frame numbers encoded in the filenames out of
sync.

References

extract-frames GitHubGist
[https://gist.githubusercontent.com/TheDiveO/57fd76e4d15252232aaacc7e422a79a2/raw/b3e605eb7473
7916bffa55bbc1b907e29ee7016d/extract-frames]

Vertical Video Syndrome [https://www.youtube.com/watch?v=f2picMQC-9E] – A PSA by
Glove and Boots on YouTube.

Color Hell: Ffmpeg Transcoding and Preserving BT.601

https://gist.githubusercontent.com/TheDiveO/57fd76e4d15252232aaacc7e422a79a2/raw/b3e605eb74737916bffa55bbc1b907e29ee7016d/extract-frames
https://www.youtube.com/watch?v=f2picMQC-9E


Fixing Unwanted Slow Audio Fade-
Ins with Some USB Audio Cards
Do you suffer from an unwanted slow audio fade-ins whenever starting
playback in the timeline or in the clip monitor, while you don’t have any
audio fade effects applied at all? Turns out this is some odd interference
between some(!) USB audio cards and the PulseAudio sound backend…

ALSA to the Res-Cue

Luckily, there’s an easy remedy in case you’re affected.

Go to the menu Settings > Configure Kdenlive, then in the configuration
dialog select the Playback section. Change the Audio driver from Automatic
to ALSA. Leave the Audio device set to “Default”, so your desktop audio
device settings apply.

Click OK, and you’re done.



Your timeline and bin clip audio playback should now be working as
expected, without any unwanted slow audio fade-ins anymore.

You’ll find the corresponding option in the main menu Timeline ‣ Disable
Timeline Effects. This disables or re-enables all timeline effects, that is,
timeline clip effects and track effects.

However, please note that prior to Kdenlive 16.08.1, track effects are not
properly disabled or re-enabled by Timeline ‣ Disable Timeline Effects.

Please see Effects everywhere about how to temporarily disable bin clip
effects.

Background Information

Please note that the unwanted ~2 seconds audio fade-in only happens with
some USB audio cards, but not others. I’ve noticed when trying a Steinberg
UR22mkII USB audio interface.

Using the UR22mkII in Kdenlive using the stock audio settings was
impossible, as the automatic fade-in made any voice over editing a complete
and utter fail. Curiously, the UR22mkII worked beautifully when I played
back audio using an Android tablet (that’s a beautiful aspect of the
UR22mkII: it’s designed to be used with mobile devices). For comparism,
my (much more bulky) Behringer QX1202USB doesn’t exhibit the strange
behavior even with the default audio settings in Kdenlive, or when using
PulseAudio.

And what is even more strange and surprising: at least some other software,
such as VLC, are unaffected either, even when using PulseAudio for audio
output.

Unfortunately, no-one was able to give me the solution; but luckily, in the end
I found it myself after some trial and error. Hopefully my solution is of help
to those Kdenlive users experiencing the same strange audio fade-in
behavior.



Full Luma

Contents

Full Luma
Advance Clip Property - Full Luma Range

Advance Clip Property - Full Luma Range

A clip can have its full luma flag set from the Clips

From this [http://www.kdenlive.org/forum/what-does-full-luma-exactly-do#comment-18298] forum
post by Yellow

The full luma option refers to video sources with luma recorded outside
of the typical ‘broadcast’, ‘restricted’ 16 - 235 8bit range.

This option fixes problems round tripping video files with luma outside
of the 16 - 235 8bit range. By default when we import a video it is
handled and displayed based on the 16 - 235 range, levels below ie: 0
to 15 and those above 235 to 255 are compressed to 0 and 255, so
shadows get overly dark and highlights saturated, in the preview within
Kdenlive for camera sources that are full range.

Then when we render out, those levels remain in the final video,
compressed shadows and saturated highlights, so there is a mismatch
between the levels in the video we import compared to that exported.
This only really matters for round tripping to an external
application.

For any playback on DVD’s, Blu-ray and including the web like Vimeo
or Youtube our video levels in the final rendered output should be in the

http://www.kdenlive.org/forum/what-does-full-luma-exactly-do#comment-18298


16 - 235 range, otherwise we see so called ‘gamma shifts’, ‘washed
out’ or saturated playback depending on playback handling.

However really we want to have control of the levels adjustment in
Kdenlive i.e.: 0 - 255 into 16 - 235 so full luma option changes the
handling of the files and preview / scopes are based on an alternative
YCbCr to RGB calculation.

By setting the full luma on, which should only be done for camera
sources known to be full range 0 - 255 or even 16 - 255 such as FS100,
Nex5, HV20, HV30 and probably many more consumer cameras. Canon
and Nikon DSLR’s too but a little more complicated, we can export
video with the levels as imported, BUT and it’s a big but, that is without
doing any RGB operations in Kdenlive, so no effects, color correction
etc. If any effects are added then the output will be restricted range
again.

For me I use full luma all the time, it allows roundtripping a video edit
and maintaining levels for grading in an external application that offers
32bit float precision. When it’s necessary to otherwise happy with
Kdenlive’s SOP/SAT and scopes.



How to editing audio volume with
keyframes
In this HOWTO video we show you how to edit the audio volume of a clip
using keyframes: learn how to add a Volume effect to adjust the volume of a
clip, how to add and edit keyframes in the effect properties, and how to
manage and edit keyframes directly in the timeline. Double click to add a
keyframe, remove a keyframe by dragging it above or below the clip.

[https://kdenlive.org/wp-content/uploads/2016/12/volume.mp4]

https://kdenlive.org/wp-content/uploads/2016/12/volume.mp4


How to fading in-out Kdenlive titles
In this short HOWTO video, we show you how to (smoothly) fade in and out
Kdenlive titles over a video clip, fading from and to transparency. The key to
success is to use a Composite & Transform transition with keyframes
(Affine and Composite will work too). Don’t use the Fade from/to Black
effects though, as these effects remove the title transparency information.

[https://kdenlive.org/wp-content/uploads/2017/01/Kdenlive-Title-Fading.mp4]

Notes

These are the individual steps shown in this HOWTO video:

1. Add a Composite & Transform transition to the title clip.
2. First keyframe: set the opacity to 0%. This marks the beginning of

the fade in (ramp up).
3. Second keyframe: add a new keyframe where you want the title to

be fully faded in, set the opacity to 100%. Set the type of the

https://kdenlive.org/wp-content/uploads/2017/01/Kdenlive-Title-Fading.mp4


keyframe to Linear.
The rationale to set this keyframe to Linear is that
otherwise Kdenlive (MLT) calculates a smooth curve
fitting to the previous and following keyframe, causing the
opacity value to overshoot. With a maximum possible
opacity of 100% you won’t notice. However, when you
use a maximum opacity of less than 100%, then this
overshooting may become visible.
Ensure that the first keyframe is Smooth. You can only
adjust the type of the first keyframes after you’ve added a
second keyframe.

4. Third keyframe: add another keyframe near the end where you
want to start fading out the title. Leave the opacity at 100%. Set the
keyframe type to Smooth.

5. Fourth keyframe: add a final keyframe, where you set the opacity to
0%.

Done.

In case you are scratching your head now, why this mixture of smooth and
linear interpolated keyframes? Then head over to our new article on The
“Smooth” Keyframe Interpolation.



Insert and Overwrite: advanced
timeline editing
New in version 15.12.0.

Kdenlive offers advanced timeline editing functions. In this article we’re
looking at the insert  and overwrite  advanced editing functions. A later
article then will cover the opposite lift  and extract  functions.

When inserting or overwriting some part in the timeline with some part from
a clip, we now face two zones, so how does this work out at all? We only
want to deal with three points, that is, with one zone and a point (for that
reason this is also sometimes termed three point editing). In consequence,
there are two different insert/overwrite operations:

1. insert/overwrite a clip zone into timeline at some point
(cursor/playhead), or

2. insert/overwrite a clip starting at some point into a timeline zone.

Insert Clip Zone into Timeline at Timeline Cursor



As we’re going to insert a clip zone into the timeline, first make sure that the
switch for using timeline zone is crossed out  (it’s off). This is also
shown in the screenshot. (You’ll find this switch above the track headers,
next to the track size zoom in/out controls.)

A visual clue (albeit a rather unintrusive one) is that the timeline zone bar is
now dimmed.

Next, mark the clip region of the source clip you want to insert into the
timeline. You do this as usual, using either the I and O shortcuts, or the set
zone in/out buttons of the clip monitor.

Now place the timeline cursor to where you want to start with the insert.

Also make sure to select the correct track for insertion – using the cursor
up and cursor down keys. (Remember that the currently selected track is
marked with the semi-transparent selection color, the exact color of which
depends on your particular color theme.)



Finally press the v shortcut, or click the insert clip zone toolbar button ,
or use Timeline ‣ Insertion ‣ Insert Clip Zone in Timeline.

Note

Insertion starts from the timeline cursor, and not from the timeline zone
start (because we chose to ignore it in our very first step).
Locked tracks are unaffected, such as the topmost track in our
example.
Unlocked tracks get affected in that whatever is at the insertion point
and later in the timeline gets shifted away to make room for the
insertion.

Insert Clip (from In Point) into Timeline Zone

This time, we’re going to insert some part of a clip to exactly fit into the
timeline zone. So we now need to switch on using the timeline zone . This
is also shown in the screenshot. (You’ll find this switch above the track
headers, next to the track size zoom in/out controls.)

A visual clue (albeit a rather unintrusive one) is that the timeline zone bar is
now bright.



This time, we only need to set the in point for our source clip. The out point
doesn’t matter, as it will be later determined automatically by the length of
the timeline zone.

Now, place mark the timeline zone into which you want to insert a part of
your source clip. Notice that the timeline cursor position now doesn’t matter.

Make sure to select the correct track for insertion – using the cursor up
and cursor down keys.

Finally press the V shortcut, or click the insert clip zone toolbar button ,
or use Timeline ‣ Insertion ‣ Insert Clip Zone in Timeline.

Note

Insertion starts from the beginning of the timeline zone, and not from
the timeline cursor position (because we chose to enable the timeline
zone in our very first step).
Locked tracks are unaffected, such as the topmost track in our
example.



Unlocked tracks get affected in that whatever is at the insertion point
and later in the timeline gets shifted away to make room for the
insertion.

Overwrite Timeline with Clip Zone

overwrite 

(will be documented later)

Overwrite Timeline Zone with Clip

overwrite 

(will be documented later)



Kdenlive transitions
Depending on their background in video editing, users may find Kdenlive
transitions somewhat confusing. Hopefully, this article clears up this
confusion surrounding Kdenlive transitions, at least to some degree.

Kdenlive Transitions: 3-in-1

In Kdenlive, transitions can roughly be classified into three different types
as follows:

Type of Transition Description

1. Clip-to-Clip
Transition

Gradually replaces one clip by another clip. Has
exactly two implicit keyframes, for start and end.
This is what many users usually understand
transitions to be.

2. Dynamic
Compositing

For combining two clips, and the way of
combination may vary with time. Supports user-
defined keyframes that allow to control at least
certain parameters.

3. Layer
Compositing

For combining two clips in a constant, static way:
much like you see layer compositing in image tools.
As no keyframes are supported, this type of
compositing is static, thus invariant of time.

Historically, Kdenlive borrows the term transition, with its 3-fold meaning,
directly from the multimedia engine MLT [https://mltframework.org/]. MLT does all

https://mltframework.org/


the video and audio processing according in your timeline. In the MLT
universe, transitions basically «merge» video frames from upper tracks with
video frames from lower tracks, producing result frames.

In contrast, many users experienced in video editing have come to know
transitions as a mechanism to transition between to adjacent clips. However,
Kdenlive doesn’t even support such in-track transitions. Instead you need to
place these clips on separate tracks, and then you add a Kdenlive transition
for combining these clips in some clever way.

1. Clip-to-Clip Transitions

Let’s start with those archetypical transitions most users would probably
expect when they hear the word transition: the dissolve, slide, and wipe
transitions. See for yourself…

Dissolve: gradually transitions from one clip to another. So it’s kind of fading
between the two clips. (See also the Wikipedia article on Dissolve.
[https://en.wikipedia.org/wiki/Dissolve_%28filmmaking%29])

Slide: gradually replaces one clip by another clip, by traveling from one side
of the frame to another (See also the Wikipedia article on Wipe
[https://en.wikipedia.org/wiki/Wipe_%28transition%29].)

https://en.wikipedia.org/wiki/Dissolve_%28filmmaking%29
https://en.wikipedia.org/wiki/Wipe_%28transition%29


Wipe: one clip gradually replaces another clip, often in form of some shape.
(See also the Wikipedia article on Wipe
[https://en.wikipedia.org/wiki/Wipe_%28transition%29].)

These three transitions don’t offer any (user-) keyframes. Instead, their start
and end keyframes are implicit and fixed to the start and end of the transition
respectively.

Because Kdenlive always uses two separate tracks for transitions, there’s
a peculiarity to note: normally, as time moves forward in the timeline, these
transitions change (or kind of fade) from the clip on the upper track to the
clip on the lower track. The somewhat strangely named transition parameter
Reverse allows you to switch the track roles: if Reverse is checked, then
these transitions change from the lower track to the upper track, as time
progresses.

Simply put:

▼ Reverse off: transition from upper track to ▼ lower track.

▲ Reverse on: transition from lower track to ▲ upper track instead.

2. Dynamic Compositing Transitions

https://en.wikipedia.org/wiki/Wipe_%28transition%29


To some degree, Kdenlive supports (simple) compositing in its timeline.
Actually, even this simple compositing can get you a long way in many
projects (as the above screenshot may hint at). Kdenlive currently offers the
following (keyframable) compositing transitions:

Affine – allows to size, rotate, skew, and position. Together with
keyframes, this transition is really versatile. Its only drawbacks
are: it is slower than other complex transitions (due to the affine
transformation), and it doesn’t support wipes (which only
Composite and Region support in this class of transitions).
Cairo Blend – a simple compositing transition, supporting several
compositing modes. In addition, the opacity of the upper frames
can be controlled. This transition also supports keyframes.
Cairo Affine Blend – this has the functionality of both Affine and
Composite: position, rotate (you can even control the center of
rotation!), and finally skew. And all this is keyframable.
Composite – allows keyframed dissolves, wipes, and swipes; and
all this in the same transition. In contrast to Affine, it does not
support rotation or skewing. The downsides of Composite are:
luma bleed, and less precise position control. When compared to
Affine, the Composite transition is much faster, albeit at the cost of
luma bleed.
Composite & Transform – this is a rather new transition that
made its debut with Kdenlive 16.04. It allows to easily composite
clips onto each other (supported several compositing modes), as
well as to move the upper track clips. However, there is neither
support for scaling, nor for rotation, but for dynamic opacity. But



keyframes are supported. In those situations, use Affine or Cairo
Affine Blend instead.
Region – like Composite, but restricted to a region in form of a
matte. In the Region transition properties, this matte is called the
Transparency clip.

Fun Fact: Admittedly, MLT and Kdenlive offer a lot of choice here;
probably too much choice. A non-representative poll in our official Kdenlive
G+ community showed that Composite is used the most often, followed by
Composite & Transform and Affine.

Compositing with Transparency

Composite & Transform is Kdenlive’s new darling, as it will make life
much easier for many, if not most Kdenlive users. When compared to Affine,
this new transition is also faster in the standard compositing cases.
Moreover, Composite & Transform defaults to the alpha compositing mode
(paint) over – which is what probably most users need when compositing. In
contrast, Affine uses the atop alpha compositing strategy that can drive
unexpected users mad. But see for yourself…

Composite & Transform: whatever semi or non-transparent is in the frame
from the upper track, it will be painted over the frame from the lower track.
Hence the name of this compositing mode: over. Please note: in the transition
properties, this mode is to be found as Compositing: Alpha Blend instead.

In addition, Composite, Cairo Blend, and Cairo Affine Blend also use the
same over compositing strategy, as Composite & Transform does. For Cairo
Blend and Cairo Affine Blend this Blend mode is called Normal instead.



Affine: as the simple rule of thumb, transparency is solely controlled by the
lower track. Any transparency information from the upper track simply gets
completely ignored. In consequence, if your lower frame has regions of full
transparency, whatever falls within them on the upper frame will be
invisible! You can see this result also in the screenshot.

At least at this time, Composite & Transform does not support this alpha
handling as Affine does.

Please see also for further information:

our separate Kdenlive article on Compositing with transparency.
the Wikipedia article on alpha compositing
[https://en.wikipedia.org/wiki/Alpha_compositing].
the SVG Open 2015 paper by Craig Northway on understanding
compositing and color extensions in SVG 1.2 in 30 minutes!
[http://www.graphicalweb.org/2005/papers/abstractsvgopen/index.html] – especially
the Porter Duff operator table in chapter 6 with resulting alpha
calculation column.

3. Layer Compositing Transitions

This third kind of Kdenlive/MLT transitions mostly work similar to layer
modes in image editors (such as GIMP <https://www.gimp.org/>`_). These
static layer compositing transitions do not have any parameters at all.
This category actually has the most Kdenlive transitions to offer:

Layer Compositing

Addition

https://en.wikipedia.org/wiki/Alpha_compositing
http://www.graphicalweb.org/2005/papers/abstractsvgopen/index.html


Addition Alpha
Burn
Color Only
Darken
Difference
Divide
Dodge
Grain Handling: Extract / Merge
Hardlight / Overlay
Hue
Lighten
Multiply
Overlay / Hardlight
Saturation
Screen
Softlight
Substract
UV Map
Value
Video Quality Management

Alpha Compositing

Alpha atop
Alpha in
Alpha out
Alpha over
Alpha XOR
Matte

Note

Kdenlive’s (or, MLT’s) fixed compositing transitions don’t have a
transparency parameter. To some extent, you may substitute the Cairo
Blend transition, which has an opacity parameter.



Note

Users are often asking for Kdenlive support of in-track transitions
(Dissolve, Slide, Wipe). Unfortunately, due to the way Kdenlive’s
multimedia engine MLT works, this requires a large amount of code
rewrite, not to mention extensive testing afterwards to ensure the expected
stability. Due to our limited developer resources, in-track transitions are
thus not on our near-term roadmap. We will gladly accept coding help,
so if you are willing to accept this challenge, please let us know!

New in version 21.08.

In-track or same-track transition is implemented with Kdenlive 21.08.



Library clips with image sequences,
Titles, Color clips
New in version 16.12.0.

Kdenlive 16.12.0 will see further improvements to its library clip
expansion (and, in consequence, to MLT playlist import). Not every
Kdenlive user will notice the improved functionality, as it affects only
library clips where the same image sequence or title is used multiple times.

In particular, if you (re) use the same image sequence clip, title clip, or even
color clip multiple times in the same library clip, such image sequences and
titles will only be added once to your project bin. Before Kdenlive 16.12.0,
multiple instances of the same clip in the timeline unfortunately resulted in
these clips getting added multiple times to the project bin. To emphasize, this
undesired behavior only affected image sequences, titles, and color clips.

When expanding a library Kdenlive 16.12.0 will now check image
sequences, titles, and color clips in the timeline for their content, clip name,
and original bin folder location. If there is a match, then such a timeline clip
will be added only once to your project bin.

Note

A “library clip” is a clip with the “.mlt” suffix, and in particular, a clip that
has been added to your personal Kdenlive library. They show up in
Kdenlive’s library pane.

Internally, when you select some clips & transitions from the timeline and
add them to Kdenlive’s library, these clips and transitions are stored in the
file system in a “.mlt” file (which is an MLT playlist to be precise), and
shown in the library widget as a new library clip.



Technically, Kdenlive projects are also MLT playlist files. When you add a
clip from the library pane to your project this simply adds the underlying
MLT playlist file to your project. But in contrast to other clips, such as an
MP4 video, you can “expand” library (that is, MLT playlist) clips to get
back the individual clips and transitions inside it.



Manage Cached Data
New in version 16.04.1.

Kdenlive 16.04.1 rather quietly introduced a useful new dialog, to be found
in the timeline toolbar: manage cached data. This dialog allows you to see
how much disk space your projects each eat up. You can then also selectively
clean up project-cached data when you don’t need it anymore after finishing
a project.

You’ll reach this new dialog via the timeline toolbar preview render button,
then Manage Cached Data.

This dialog then features two tabs: cached data for the current project, as
well as an overall view on all projects.

Current Project Tab



The Current Project tab gives a detail view on your currently loaded
project, with a nice pie chart. It shows you at a glance how much space
individual elements of your project need for caching; such as: the timeline
preview rendering cache, proxy clips, audio and video thumbnails.

Here, you can selectively delete only some cached data by simply clicking on
the corresponding trash can buttons.

To remove all cache data for the currently loaded project, clip on the bottom
trash can.

Finally, when you click on the link which is left to the bottom trash can, the
folder containing the project cache will open in your file manager.

All Projects Tab



The All Project tab gives a detail view on your currently loaded project,
with a nice pie chart. It shows you at a glance how much space individual
elements of your project need for caching; such as: the timeline preview
rendering cache, proxy clips, audio and video thumbnails.

Here, you can selectively delete only some cached data by simply clicking on
the corresponding trash can buttons.

To remove all cache data for the currently loaded project, clip on the bottom
trash can.

Finally, when you click on the link which is left to the bottom trash can, the
folder containing the project cache will open in your file manager.



Restoring Audio Mixing
New in version 16.08.

Nobody’s perfect. So yes, once in a while you may experience unexpected
odd audio mixing in Kdenlive projects. While audio from some tracks will
mix properly, audio from certain other tracks mutes all remaining tracks.
Rejoice! Kdenlive 16.08 now comes to your rescue.

Restoring proper audio mixing is easy:

1. Load your project into Kdenlive 16.08 (or later).
2. Add a new track to your timeline; whether it’s an audio or video

track doesn’t matter.
3. Then you may delete this track again, if you don’t plan to use it

anyway.
4. Check playback.
5. Save your project.

No, I’m serious – even if this sounds exactly like clueless support advice. If
you now play your project in the timeline, automatic audio mixing across all
timeline tracks should work again normally.

Note

This upgrades your Kdenlive projects to the most recent project version.
So you won’t be able to edit it again in an older or ancient Kdenlive
version.

As a few of my very own projects had issues with audio mixing I could
successfully fix them using Kdenlive 16.08. Enjoy!



The “Smooth” Keyframe
Interpolation
Did you ever wonder why Kdenlive’s smooth interpolation mode may
overshoot between keyframes? And how to tell Kdenlive to avoid such
situations?

I did wonder, and so I was starting to look behind the scenes and were
introduced to the strange world of smoothness. Don’t worry, there won’t be
any mathematics for you to learn and understand. Just watch the figures.
We’ll also show you how to avoid such overshots in those situations you
don’t want it. And for the really curious what the mathematics behind
“smooth” interpolation are: just see the end of this toolbox post.

The Fade-In Ramp

 

Let’s start with a simple ramp, as shown here. We use two keyframes, one
with a low value setting, and the other with a high value setting. The
particular values don’t matter. We set both keyframe to the interpolation
mode smooth.



The effect display inside the timeline clip looks like a straight ramp. But if
you watch the interpolated values closely while scrubbing the timeline, you
should notice that the slope of the ramp varies. At the end and beginning the
slope is smaller than in the middle, where it is higher.

But what exactly is going on here?

So I discovered this sweet tool GeoGebra [https://www.geogebra.org/] (Open
Source) for trying out the Mathematics inside Kdenlive’s MLT engine.

Eh, no panic!

This figure shows two keyframes P1=0 and P2=1, which is a fairly typical
ramp up setting. In case you already wonder: it doesn’t matter at which exact
frames the individual keyframes are. If that sounds odd, it probably is. But
this is how the underlying math works (you know: see the end for details).

The smooth interpolation that MLT will calculate is drawn as a thick green
line. It’s bend a little bit like the capital letter S, but then, not really too
much.

And if you look closely, then beginning and ending slope of the green line
aren’t horizontal ‒ at least what I expected at first.

You may wonder what the two other keyframes P0 and P3 are good for?
Well, the math underneath always require four keyframes in order to
interpolate segment-wise between any two adjacent keyframes. And if there
is no preceding (P0) or trailing (P1) keyframe, then we’ll simple repeat the
left (P1) or right (P2) keyframe.

https://www.geogebra.org/


Ramp-Up, and … Overshoot

 

Now let’s add a third keyframe, so this looks like a ramp with a plateau. This
is shown in the screen shots.

And now, the ramp gets a clearly visible bump instead of a sharp bend. Well,
this looks smooth, but not exactly what we may have intended? So why is this
the way it is?

This is now our ramp with a plateau: P0=0, P1=1, P2=2. Don’t worry about
the keyframe numbering, though.

Did you expect the plateau to be, well a straight plateau? Me too. But you
may have already notice that Kdenlive doesn’t exactly behave like this.



Instead, the interpolation math causes the interpolated values to overshoot, as
you can easily see in the figure.

What the underlying math does is this: the interpolation is smooth, so that the
slope to the left of P1 is the same as to the right of P1. Yeah, that’s a slightly
different “smooth” from what you might have been expecting.

If you want the plateau to be straight instead, then you must set the
interpolation mode of the keyframe P1 to linear instead. By the way, this
doesn’t change the previous smooth segment in any way. And this results in a
“rough bent” at P1, but luckily you probably won’t notice in most situations.

Ramp Up-Flat-Down

 

Let’s add another, fourth keyframe, so we have: ramp-up first, then flat, then
ramp-down. A fairly typical fade-in and fade-out keyframe template.

And look, what’s happening: we’ve good a hunch-back, but not a nice and
flat middle section. Gosh!



This time, we look at the middle section P1-P2. To the left, we see the up
ramp, to the right, the down ramp.

Again, smooth now means that there is no sharp bend in the segments.
Instead, the left+right slopes are continuous at P1 and P2; that is, in the
middle section. And this causes our interpolated value to overshoot. So
awful. So sad. Shhh.

Make Flat Great Again

 

Now, how do we get a flat top? Fortunately, that’s easy to achieve, as you
can see from the screenshots.

1. first keyframe: smooth,



2. second keyframe: interpolated(!),
3. third keyframe: smooth,
4. fourth keyframe: interpolated (albeit that does not really matter if there

are no further keyframes).

So great!

For the Curious (Furious?)

As you may (or rather may not) remember, Kdenlive’s rendering engine is the
MLT Multimedia Framework [https://www.mltframework.org/]. While MLT has
smooth interpolation
[https://www.mltframework.org/blog/v0.9.0_released_with_new_property_animation_api/] since
around mid-2013, Kdenlive only later caught up and now supports all three
interpolation modes linear, discrete, and finally smooth. As can be seen from
the MLT source code
[https://github.com/mltframework/mlt/blob/e8b92affcafbc206a5af0d446c446ed339d79a8b/src/framewor
k/mlt_property.c#L1087], smooth interpolation is done using a Catmull-Rom spline
[https://en.wikipedia.org/wiki/Centripetal_Catmull%E2%80%93Rom_spline]. In particular, MLT
uses the so-called “uniform” variant, because it is so simple. The downside
is that this smoothing sometimes has the unwanted property of overshooting,
especially when you least expect it.

https://www.mltframework.org/
https://www.mltframework.org/blog/v0.9.0_released_with_new_property_animation_api/
https://github.com/mltframework/mlt/blob/e8b92affcafbc206a5af0d446c446ed339d79a8b/src/framework/mlt_property.c#L1087
https://en.wikipedia.org/wiki/Centripetal_Catmull%E2%80%93Rom_spline


Editing Surround Sound with
Kdenlive
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Compose a Surround Sound Audio File
Muxing Video and Audio Together

At the time of writing, Kdenlive only supports rendering a project to a video
containing stereo audio. It is not possible to render to more audio channels or
to explicitly map audio tracks to channels in the rendered audio. In order to
edit and create surround sound, some manual steps, including external tools,
are required.

This guide is using a 6 channel 5.1 surround sound as example.

External Tools Used Here

Audacity [http://audacity.sourceforge.net/] - Free Audio Editor and Recorder
avconv [http://libav.org/avconv.html] - A Video and Audio Converter

Note

http://audacity.sourceforge.net/
http://libav.org/avconv.html


Kdenlive uses ffmpeg, while on (k)ubuntu, ffmpeg is deprecated and
avconv is used instead. So these (and possibly other) distributions already
have avconv installed.

Creating New Surround Sound

This guide describes one possible workaround using Audacity to create and
render a 5.1 surround sound audio track that can be added to the video
rendered by Kdenlive.

Note

More advanced features such as surround panning (i.e. let a sound move
from rear to front) are beyond the capabilities of Audacity - but it is
possible to create similar effects manually.

Create and Edit Surround Sound with Audacity

The following example of a simple 5.1 surround sound is used in this guide:

Some original field recording from the front (stereo)
Some voice from the (front) center (mono)
Some music from the rear (stereo)

If, like in this example, some original field recording from a video clip is
supposed to be used to create the surround sound audio track, it can be easily
extracted using Kdenlive with Extract Audio ‣ Wav 48000Hz from the
context menu of the clip. This creates a WAV audio file in the same folder
where the video clip is located.

The audio clips to be used in this example are:

Field.wav (stereo) for Front L+R
Voice.wav (mono) for Center



Music.mp3 (stereo) for Surround L+R (rear)

In a new Audacity project, they can be imported in the above order with File
‣ Import ‣ Audio…, the project should now look something like this:

The channel mapping for 5.1 surround sound is:

1 - Front Left
2 - Front Right
3 - Center
4 - LFE
5 - Surround Left
6 - Surround Right

Note

LFE (Low Frequency Effects) is often referred to as “subwoofer channel”,
which is not quite correct. A surround sound speaker setup is perfectly
valid without subwoofer. In this case the surround sound system will
redirect the LFE channel to “large” speakers, usually the front speakers.



The stereo track “Field” can now be mapped to Front L+R, “Voice” to Center
and “Music” to Surround L+R. There is just one problem: the Surround
(rear) speakers of a surround speaker system are usually “small” and not
able to reproduce low frequencies. So it would be necessary to map the low
frequency range of the “Music” track to the LFE channel, otherwise the music
might sound a little “thin”.

To do this, the “Music” track can simply be duplicated with Edit ‣ Duplicate
after selecting it, and then Split Stereo to Mono from the context menu of the
third track. Then one of the two mono tracks can be deleted; the other one can
be renamed to “LFE”.

Now the “Equalization…” effect could be used to cut off frequencies above
around 100Hz from the “LFE” track, and reverse, cut off frequencies below
around 100Hz from the “Music” track.

Note

Creating technically perfect surround sound is a science all its own and
thus beyond the scope of this guide - please refer to respective resources
on the web for details.

What remains for now is to make sure that the surround sound track has the
same length as the video track it should be added to. The video track used in
this example has a length of 1:00 minute, so the lengths of the audio tracks in
Audacity are adjusted accordingly:

The Audacity project should now look something like this:



The next thing to do is to export the project to a multichannel 5.1 surround
sound audio file. The format used here is AC-3 (Dolby Digital).

Before exporting, Audacity needs to be configured to allow exporting to a
multichannel audio file: In Edit ‣ Preferences, under Import/Export, select
“Use custom mix (for example to export a 5.1 multichannel file)”.

The project can now be exported into a 5.1 surround sound audio file:

Select File ‣ Export…
Provide a name for “Name” and select “AC3 Files (FFmpeg)”
Click Options… and choose “512 kbps” as “Bit Rate”

The “Advanced Mixing Options” dialog should show up. The number of
“Output Channels” should be 6 and the channel mapping should already be
correct:



The result of the export should be an *.ac3 file which is playable with e.g.
VLC or Dragon Player.

Muxing Video and Audio Together

The final step is to add the surround sound audio track to the video track,
assuming the video was rendered without audio.

Note

When muxing audio and video files into one file, the actual streams are just
copied, and not transcoded. So there is no quality loss to either the audio or
the video streams. Also, because the streams are just copied, muxing is
very fast.



Assuming the video track was rendered to Video.mkv and the surround
sound was exported to 5.1.ac3 the command to mux both to Video-
5.1.mkv with avconv would be:

avconv -i Video.mkv -i 5.1.ac3 -c copy -map 0:0 -map 1:0 
Video-5.1.mkv 

The result should be an MKV video containing a Dolby Digital 5.1 surround
sound audio track.

Editing Existing Surround Sound

When adding a clip with more than two channels to a project, Kdenlive
creates an audio thumbnail that correctly shows all audio channels:

The clip can be edited and (audio) effects applied to it, and all appears to
work just fine - but once rendering the project, it turns out that the audio track
in the resulting video file is 2 channels (stereo) only.

The following steps provide a manual workaround for this issue.

Extract and Split the Audio Track

The first step is to extract the audio track from the video clip. This can be
done in Kdenlive with Extract Audio ‣ Wav 48000Hz from the context menu
of the clip. This creates a WAV audio file in the same folder as where the
video clip is located.



The extracted WAV audio file can then be opened in Audacity, it should
show all 6 channels, these are:

1 - Front Left
2 - Front Right
3 - Center
4 - LFE
5 - Surround Left
6 - Surround Right

Note

LFE (Low Frequency Effects) is often referred to as “subwoofer channel”,
which is not quite correct. A surround sound speaker setup is perfectly
valid without subwoofer. In this case the surround sound system will
redirect the LFE channel to “large” speakers, usually the front speakers.

The idea now is to split the surround sound into four separate (stereo/mono)
audio files that Kdenlive can handle:

Front (stereo)
Center (mono)
LFE (mono)
Surround (stereo)

First, Audacity needs to be configured to not always export to stereo audio
files: In Edit ‣ Preferences, under Import/Export, select “Use custom mix
(for example to export a 5.1 multichannel file)”.

Now, tracks 1+2 and 5+6 should be turned into stereo tracks by choosing
Make Stereo Track from the context menu of the 1st and the 5th track,
respectively. This should result in 4 tracks, two stereo and two mono.

Next, the 4 tracks should be renamed to “Front”, “Center”, “LFE” and
“Surround” starting from the top, using Name… from the context menu of
each track.



The tracks now look like this:

After all this hard work, exporting the four tracks to four separate audio files
is easy with File ‣ Export ‣ Export Multiple…. Use “WAV” as “Export
format”, the rest of the settings should already be okay: “Split files based on:
Tracks” and “Name files: Using Label/Track name”.

The “Edit metadata” dialog might pop up for each track. It is fine to just say
OK. At the end there should be a confirmation dialog and four audio files
should have been exported: Front.wav, Center.wav, LFE.wav and
Surround.wav.

Import Audio Tracks into Kdenlive

The previously created audio files can now be added to the Kdenlive project
using Project ‣ Add Clip.

Since there are only two audio tracks in a project by default, it is necessary
to add two more using Project ‣ Tracks ‣ Insert Track before adding the four
audio tracks to the timeline.



The next thing to do is to group the four audio tracks with the video clip by
selecting all of them and then choosing Timeline ‣ Group Clips.

Note

Don’t forget to mute the original audio track in the video clip if necessary!

The Kdenlive project should now be ready for the usual editing, like cutting
clips and adding effects, and should look something like this:

Rendering the Project

Since it is not possible to render the project with a surround sound audio
track, some manual steps are necessary to work around this.

First, the video track needs to be rendered without audio. This is simply
done by rendering the project as it would normally be done, but without
audio, by deselecting the “Export audio” checkbox.



Then, each of the four surround sound audio tracks Front.wav, Center.wav,
LFE.wav and Surround.wav needs to be rendered into a separate audio file.
For each of them, do the following:

Mute all other audio tracks
Enter a respective file name for “Output file”
Select Audio only as “Destination”
Select profile “WAV 48000 KHz”
Make sure Export audio is checked

Note

Unfortunately, the mono tracks Center.wav and LFE.wav are rendered as
stereo tracks, and there seems to be no way to avoid this. But this can be



handled later in Audacity.

Compose a Surround Sound Audio File

Now the separate audio tracks rendered by Kdenlive need to be “merged”
into a single multichannel 5.1 surround sound audio file. This is again done
in Audacity:

Import Front.wav, Center.wav, LFE.wav and Surround.wav (in this
order!) using File ‣ Import ‣ Audio…

“Center” and “LFE” are now stereo, which is not what is needed. This can
be fixed by selecting Split Stereo to Mono from the context menu of each
track, and deleting one of the two resulting mono tracks.

Eventually, there should be four tracks in the Audacity project:

Front (stereo)
Center (mono)
LFE (mono)
Surround (stereo)

The project can now be exported into a 5.1 surround sound audio file:

Select File ‣ Export…
Provide a name for “Name” and select “AC3 Files (FFmpeg)”
Click Options… and choose 512 kbps as “Bit Rate”

The Advanced Mixing Options dialog should show up. The number of
Output Channels should be 6 and the channel mapping should already be
correct:



The result of the export should be an *.ac3 file which is playable with i.e.
VLC or Dragon Player.

Muxing Video and Audio Together

Since video and audio was rendered separately, both need to be multiplexed
into a single file containing both the video and audio stream.

Note

When muxing audio and video files into one file, the actual streams are just
copied, and not transcoded. So there is no quality loss to either the audio or
the video streams. Also, because the streams are just copied, muxing is
very fast.



Assuming the video track was rendered to Video.mkv and the surround
sound was exported to 5.1.ac3, the command to mux both to Video-
5.1.mkv with avconv would be:

avconv -i Video.mkv -i 5.1.ac3 -c copy -map 0:0 -map 1:0 
Video-5.1.mkv 

The result should be an MKV video containing a Dolby Digital 5.1 surround
sound audio track.



The library: copy paste between
projects
New in version 16.12.0.

The Library is Kdenlive’s way to copy and paste sets of clips and transitions
between different projects. As its name already hints at: it is not just a
clipboard, but instead it is a library for all the things you in more than a
single project. The Library came to life around Kdenlive 15.04 or so. Let’s
right dive into how to use the library in your daily Kdenlive workflow!

Step 1: Copy Stuff to Your Library

The Library is Kdenlive’s central place for copying and pasting between
projects.

If you don’t see yet the library pane, make sure to display using View ‣
Library.

Attention

The library should look slightly familiar, as it looks similar to the project
bin. However, while the project bin changes with each project, the library
is independent of your projects. It’s always the same library, there’s only
one of it.



Tip

A quite useful Kdenlive window layout is to group the library together with
the project bin, and optionally the project notes. This way, you don’t need
extra screen space for the library, yet it is no further away than just a single
click.

Next, select some timeline clips (together with their effects), as well as
transitions, in the timeline. You can load an existing project and select some
timeline clips and transitions at any time in order to copy it into your library.
There is no separate import. Simply load a project or create a new one.

Switch to the library pane, if you haven’t yet done so. Then press the
bookmark button (Add Timeline Selection to Library), which is located at
the bottom of the library pane. It’s the third button from the left.



Kdenlive now asks you to name your new library item. Give it some name,
and click OK to copy the selected timeline clips (with effects) and transitions
into your library.

Please note: at this time, the names of library item need to be valid
filenames.

Of course, you can even neatly organize your library items into folders, and
subfolders. This is similar to what you may have come to known from
Kdenlive’s (project) bin, where you also can use folders to organize your
project (source) clips.

Use the Add Folder button at the bottom of the library to create a new folder.
You can rearrange library items and folders at any time by simple dragging
them into their new place.

Step 2: Paste Library Item into (New) Project

Now switch to another Kdenlive project by loading it, or alternatively start
with a fresh project from scratch. Next, go to the library pane and select the
library item you want to paste into your project. Then, press the Add Clip to



Project button (up to Kdenlive 16.08.1 this is instead the + button, located in
the same place).

Your project bin now contains the new library item you’ve just added.

You can rename library items at any time: right click ‣ Rename Library Clip.

Step 3: Drag Library Item into Timeline

The selected library item has now been added to your (project) bin. You’ll
see this by switching to the (project) bin pane. You still have only a single
(library) clip at this stage. You can now drag it into the timeline, wherever
you want.

Please note: you cannot directly drag a library item from the library into
your timeline. You always need to add it to your project bin first.

Step 4: Expand Library Clip



Often, you next want to edit the contents of a library clip after you’ve placed
it on the timeline. Expanding means that you want to break up a library clip
into its contents for further editing. So, simply select the library clip in the
timeline. Then choose Timeline ‣ Current Clip ‣ Expand Clip.

Done! You can now edit the expanded contents as you would edit any other
timeline content.

Kdenlive has expanded all the clips inside the library item into its own bin
folder. This bin folder has the same name as the library clip, but without the
.mlt extension.



After successful expansion, you may now remove the original library clip
from your bin. It’s not needed anymore (as you can also tell from the missing
reference count).

Clip Expansion Details

Before Kdenlive 16.12.0, library clips will be expanded from the bottom
up; which may be counter-intuitive (depending on your point of view). Here,
bottom up means that in case a library clip contains multiple tracks, then you
need to place the library on a lower track so there is room above for the clip
to expand.

From Kdenlive 16.12.0 on, the contents of the library clip will be expanded
down from the track where it has been placed on and below. That is, place
your library on an upper track with suitable room below.

Anyway, if there aren’t enough tracks below the library clip, yet there are
enough tracks in the timeline, then Kdenlive will attempt to shuffle the
library clip up a number of tracks, before then expanding it.

Attention

In any case, to expand a library clip into its contents, you’ll always need
necessary free space in the timeline. This means that there cannot be any
clips or transitions within the start and end of the library clip on as many
adjacent tracks as to be needed when expanding a multi-track library item.
Simply put: just make sure that the library item has room to expand,



otherwise there can be other clips and transitions above and below the
library clip, they just need to be out of the area of expansion.

Please note: starting with Kdenlive 16.12.0, you can also expand a library
immediately below a transition; that is, the library clip is on the next lower
track in the timeline. This is useful for such cases where you, for instance,
have a clip running the full length of your project on the topmost track and
showing your company logo, channel logo, or something similar. If you then
use an explicit transition added to this clip over compositing, you can still
correctly expand the library clip on the second-topmost track.

Configuring Your Library Storage Location



All items in your Kdenlive library are stored in a user-configurable place
inside your file system. The default location, unless configured otherwise, is
where your other semi-temporary caching data is stored. Typically, this is
$HOME/.cache/kdenlive/library. Your library clips are then stored inside
this directory, as well as in subdirectories in case you also use library
folders.

To change the location of your library, go to Settings ‣ Configure Kdenlive.
Next, select the section Environment. Switch to the Default folders tab.
Locate the part titled Library folder, and deselect the option Use default
folder. Select or enter another location for your Kdenlive library.

Note

Please note: Kdenlive won’t move existing library files to the new location
you’ve set. You’ll need to do this manually using a file browser or from the
command line.



Timeline preview rendering
New in version 16.08.

Timeline preview rendering is an outstanding feature of Kdenlive. It
officially debuted in version 16.08. Preview rendering allows you to render
parts or your complete timeline in the background, so you can smoothly play
it back. This is especially useful when you work with complex track
compositions or use effects that are computationally intensive. Instead of
stuttering playback, you now get smooth playback. This way, you can check
that your timing of keyframes and effect is working out nicely. And you don’t
need to leave Kdenlive, as you would need when rendering your timeline to
an traditional video file.

Full-FPS Preview of Effect-Heavy Timeline Stuff

Raw source footage: a good example for Kdenlive’s new timeline preview
rendering is this: say, you have some FullHD source footage. Raw, your
system easily plays this clip back at its original frame rate of 25fps. This
isn’t even a job for proxy clips on a decent system.

But you may have already suspected: this raw footage is in dire need of some
serious processing before it can be shown to any audience…



Now let’s get effects-heavy. For production, we need to de-fish this
footage (action cams, you know). After defishing, we need some sharpening.
And then, we also have to decompress the tonal curve (Protune, y’know).
Wait, there’s more: saturation needs to be corrected too (again, Protune).

With these innocent four effects applied, look at the playback rate that’s
shown in the bottom right corner of the monitor: dismal six frames per
second! It crawls.

Unfortunately, proxy clips don’t help in this situation: proxy clips are low-
res and low-quality variants of the source clips, without any effects applied.
So our effects will slow down also proxy clips considerably.

You need timeline preview rendering.

HowTo: Timeline Preview Rendering

Please note: timeline preview rendering does not speed up timeline editing.
It speeds up the timeline playback. Why should you need that? For instance,
to check the correct timing of keyframed effects and transitions.

Preview rendering solely covers rendering the video part of the timeline. In
contrast, Kdenlive renders audio always independent of the preview
rendering. In particular, you can make audio changes at any time without
affecting preview rendering.



Timeline preview rendering is best controlled using the dedicated Timeline
Preview menu in the timeline toolbar. In addition, you can find most of the
menu items also in the main menu Timeline ‣ Timeline Preview ‣ …

Step 1: Set Preview Zone

Set the timeline zone in (I) and out (O) points for the zone you want to render
for preview.

Next, select Add Preview Zone (alternatively, Timeline ‣ Timeline Preview ‣
Add Preview Zone).

Note

For the first time, you won’t see any change yet.

Step 2: Render Preview Zone in Background



Select Start Preview Render (Timeline ‣ Timeline Preview ‣ Start Preview
Render). Or press Shift + Return. Or click on .

Note

You can even add multiple, non-continuous preview rendering zones.

A red bar appears (if it has not already been show): it’s located right
between the timeline ruler and the topmost track. As background rendering
progresses, this bar will slowly turn green, chunk by chunk.

You can continue to work at any part of your timeline while preview
rendering is active. However, as soon as you edit clips or transitions that
touch your preview zones, rendering will stop, and the affected preview
zones turn back to red. Simply restart rendering, if you need.

The preview is divided into chunks, where each is 25 frames in size; this
corresponds with 1s of playback length for 25fps projects.

Step 3: Enjoy Smooth Timeline Preview!

All green chunks of your timeline will now play back at full speed. You
should immediately notice that scrubbing such timeline zones will be much
faster too.



Timeline playback is now full 25fps, even as the corresponding timeline clip
makes heave use of effects (especially de-fish is computational intensive).

Notes

Smart Preview Undo/Redo

Kdenlive is smart enough to support some levels of undo and redo. So you
can check out the results of a two different effect settings by quickly undoing
and redoing the effect change without having to render anew the preview.

Preview Cache Storage



You can easily find out how much storage you are currently using for the
timeline preview. Use Project ‣ Project Settings, then select the tab Cache
Data.

You’ll now see a neat figure illustration cache data disc space consumption.
At any time, you can quickly remove the cache data used for the timeline
preview: simply click on the trash button next to row Timeline Preview.

Preview Profiles

Most of the time, it should suffice to leave the preview profile set to Auto.
Kdenlive then will select a suitable preview profile based on your project
profile.



In some rare cases, as with unusual frame rates, or when you want to control
the preview rendering encoding quality, then you can change the preview
profile, or create your own preview profile. Use the Manage timeline
preview profiles button next to the preview profile selection.

De-synchronized Preview

If for some reason the rendered preview should get out of sync with your
timeline editing, simply remove the corresponding preview zone (Remove
Preview Zone) or all preview zones (Remove All Preview Zones). This gets
you back to a sane preview state. Then add the zone back again (using Add
Preview Zone), and rerender.



Useful Resources
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Useful Resources

Another Kdenlive manual: flossmanuals [http://www.flossmanuals.net/how-to-use-
video-editing-software/]
Cutting and Splicing Video in KDEnlive
[http://www.linuceum.com/Desktop/KDEnliveVideo.php] by Linuceum
opensource.com tutorial [http://opensource.com/life/11/11/introduction-kdenlive]
Kdenlive Forum [https://forum.kde.org/viewforum.php?f=262]
Kdenlive Developer Wiki [https://community.kde.org/Kdenlive/Development]

Keyboard Stickers - courtesy of Weevil
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Get involved
Contribute to this Manual.
https://community.kde.org/Kdenlive/Workgroup/Documentation

https://community.kde.org/Kdenlive/Workgroup/Documentation
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File Not Found (404)
This page does not exist.

This might be because of the following:

We moved the manual from MediaWiki to Sphinx and with that came a
lot of reorganization.
The page has been deprecated.
Or a simple typo in the URL.

In all cases, you might be able to find the page you’re looking for by using the
search in the left hand navigation.
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